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Introduction Welcome to SigmaPlot® 8.0, SPSS' award-winning scientific graphing software which makes it easier for you to present your findings accurately using precise, publication-quality graphs, data analysis and presentation tools. SigmaPlot offers numerous scientific options such as automatic error bars, regression lines, confidence intervals, axis breaks, technical axis scales, non-linear curve fitting and a data worksheet for powerful data handling. This chapter introduces you to some of the basics of SigmaPlot, including: ➤



➤



An overview of SigmaPlot features (see page 10) Using SigmaPlot in Windows (see page 14) Using the toolbars (see page 15) Setting basic program options (see page 18) Examples of SigmaPlot graphs (see page 22)



➤



Getting help on using SigmaPlot (see page 20)



➤ ➤ ➤



SigmaPlot 8.0 is a state-of-the-art technical graphing program designed for the Windows platform. It is certified for Windows 95, Windows 98, Windows NT, Windows 2000, Microsoft Office 95, 98, and 2000. SigmaPlot 8.0 is specifically designed to aid in documenting and publishing research, specializing in the graphical presentation of results. Creating and editing graphs is easy. Simply click a Graph toolbar button, pick your data with the Graph Wizard, and you have your graph. You can also use templates to apply favorite graphs again and again. SigmaPlot also includes a powerful nonlinear curve fitter, a huge scientific data worksheet that accommodates large data sets, summary statistics, a mathematical transform language and much more. OLE2 technology is fully supported. You can annotate graphs with the MS Word Equation Editor, edit your graphs directly inside Word or PowerPoint, or plot your data with an Excel spreadsheet right inside SigmaPlot.
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New Features in SigmaPlot 8.0



0



New features in SigmaPlot 8.0 include: ➤



Create SigmaPlot graphs using Microsoft Excel You can use SigmaPlot directly inside Microsoft Excel! With just a click of a button, you can activate the SigmaPlot Graph Wizard and eliminate tedious cut and paste data preparation steps. Worried about date and time formats changing unexpectedly, or that you might lose data derived from in-cell formulas and macros? Fear no more. With SigmaPlot, you can generate professional graphs embedded in Excel worksheets to keep your raw data and graphs in one handy file.



➤



Save time by modifying objects and properties with new toolbar palettes Change colors, modify line thickness, add fills and other annotations using handy toolbar palettes in the main toolbar, not hidden in dialog boxes, as you would in other desktop products. Selectively edit objects on your graph, such as individual bars and lines, to show highlight groups or data.



➤



Modify multiple selections simultaneously to save unnecessary steps More Editing Flexibility Using the new Page toolbar, selectively edit objects on your graph, such as individual bars and lines, to show highlight groups or data. Modify multiple selections simultaneously to save unnecessary steps. ➤ Editing text is now easier than ever Editing text in the graph page is as easy as using your word processor or other presentation software. Type or edit text directly on the page without using a dialog box when changing axis labels, titles, legend text or free-form text. Select your text, then change font size, type, color and alignment with intuitive buttons visible from the toolbar. ➤



Gain greater control over legends Break the connection between the column titles in the worksheet and the legend labels in the graph to avoid numerous edits when using graph templates or gallery items. Lock legend text so that changing your worksheet columns doesn't affect your legend labels. Or, maintain the link between your data the graph legend when appropriate. Duplicate graphs with new data using graph templates and graphs without having to modify the legend labels.



➤



Multiple levels of undo Experiment with different annotations on your graph, then quickly undo the last several changes and start again. ➤ Import MS Access files (.MDB) directly into SigmaPlot. 10 New Features in SigmaPlot 8.0



 Introduction ➤



AutoSave You'll never have to worry about losing your work. SigmaPlot automatically saves a backup file. ➤ Other ease-of-use improvements Notebook windows retain size, shape, and position so there's no need to reconfigure your environment each time you work. You can now set a default zoom level for a new graph page.



Graph Types and Styles



➤



Easily insert equations on a graph page or report New Publication Features Support for vector EPS-CMYK, the preferred format for graphics publication. This is a vector, not bitmap, format, so files are smaller.



➤



New Export dialog box You supply the size of the image you want, and SigmaPlot calculates the optimal DPI.



SigmaPlot’s selectable Graph Type determines the structure of your graph. SigmaPlot provides many different types of two- and three-dimensional Cartesian (XY and XYZ) graphs, as well as pie charts and polar plots. Graph Style determines how data is plotted on a graph. Available styles depend on the selected Graph Type. SigmaPlot's Graph Wizard conveniently displays all available graph styles associated with each graph type.



Templates



The SigmaPlot template notebook contains a variety of page layouts. Apply these predetermined template attributes to previously saved pages and graphs, or create a user-defined template. Store your templates in a SigmaPlot Notebook Template file (.JNT). You may want to create your own template notebook.



Graph Defaults



Preset graph attribute default settings, such as size and position, font, and symbol, line and bar settings.



Axis Scales



Create multiple axes for 2D graphs. SigmaPlot, by default, automatically calculates axis ranges and enables each plot to contain separate X and Y axes. Tick Marks Use both major and minor axis tick marks and grid lines. Tick intervals, length, direction, thickness, and color are all adjustable; grid line types are also adjustable. Tick labels can be numeric, time series, or customized, using labels in a worksheet column. Axis Breaks You can specify an axis break with a different post-break tick interval.



Automatic Legends Smooth 2D and 3D Data



Generate legends automatically, or ungroup legends and individually customize text labels. Smooth sharp variations in independent values within 2D and 3D data sets using SigmaPlot smoothing algorithms.
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SigmaPlot Worksheet



The SigmaPlot worksheet is capable of containing data up to 32,000,000 rows by 32,000 columns. Enter data in columns or rows, and perform calculations either row-wise or column-wise. Worksheet cells within columns are adjustable, and capable of calculating up to 21 significant digits. Place labels, customized fill colors and patterns, and error bar direction codes into these cells in order to specify changes to graphs.



Microsoft Excel



Statistics



SigmaPlot uses automation communication standards to create and open Excel workbooks within SigmaPlot. This functionality enables you to run transforms, perform statistical tests, and graph data stored in Excel worksheets. Descriptive statistics are available for all your worksheet columns. The Statistics Worksheet lists basic statistics for all worksheet columns. Display linear regression lines with confidence and prediction intervals, chart error bars for graphs of column means, and run paired and unpaired t-tests between worksheet columns. Use the Histogram feature to compute and plot distributions for datasets up to 64,000 points in size.



Regression Wizard Transforms Drawing Tools Reports



The regression Wizard steps through curve fitting, plotting, and generating a report. Modify and compute data using SigmaPlot's comprehensive transform language. Change the font, size, and style of any text, and change the color, line type, thickness, and fill pattern of graphs and drawn objects with drawing tools. The SigmaPlot Report Editor displays regression results and features complete text editing functionality.



Installing SigmaPlot



0



SigmaPlot is installed on your computer from CD. The installation program automatically starts up when the CD is placed in the CD-ROM drive. The dialog boxes that guide you through the installation process are simple and selfexplanatory.



Σ System Requirements



In order to accomplish your installation, you will need to have your product registration number available. SigmaPlot 8.0 runs under the following systems: ➤ ➤
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Windows 95 Windows 98



 Introduction ➤



Windows 2000



➤



Windows NT 4.0



Excel Workbooks: Excel for Office 2000, 97, and 95 takes full advantage of SigmaPlot's functionality. Import excel workbooks into SigmaPlot. Hardware: Minimum requirements are 486 with 32 MB of RAM.



Serial Numbers



This unique SPSS serial number is located on the CD cover. Have this number available when you call for product support, payment, or system upgrade. Copy this number to the registration card and send it in to SPSS. Registration entitles you to: ➤



Unlimited technical support.



➤



System upgrades.



Installing SigmaPlot 13



 Introduction



Using SigmaPlot in Windows



0



SigmaPlot runs under the Windows operating system and functions within the standard Windows interface. For information on how Windows works, please refer to your Windows documentation. A brief explanation of standard Windows terminology as it applies to SigmaPlot is provided here. Figure 1–1 SigmaPlot



SigmaPlot Notebook File Name



Menu Bar Standard Toolbar 2D and 3D Graph Toolbars



Graph Style Gallery Graph Page Window



Column Statistics Window



Status Bar
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SigmaPlot Notebook Window



Worksheet Window



Page Toolbar
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Using Toolbars



0



Toolbars contain buttons for the most commonly used commands. Figure 1–2 Standard Toolbar Open



New Notebook



Print



Save



Copy



Cut



Redo



Paste Undo



New Excel Worksheet



View View Data Statistics



New New Worksheet Graph Page



Graph Wizard



Custom Zoom



Stop refresh



Zoom



Help



Refresh



Rotation



Increase Space



Legend Symbol



View Graph Page Properties



Figure 1–3 Formatting Toolbar Font



Italics Superscript Normal



Bold



Style



Figure 1–4 2D Graph Toolbar



Scatter Plot



Underline



Line Plot



Subscript



Align Left



Greek Characters



Area Plot



Line/Scatter Plot



Polar Plot



Align Right



Align Center



Ternary Plot



Color



Line Spacing



Horizontal Bar Chart



Vertical Bar Chart



Decrease Space



Pie Chart



Box Plot
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 Introduction Figure 1–5 3D Graph Toolbar



3D Scatter Plot



Contour Plot



3D Mesh Plot



3D Line Plot



3D Bar Chart



Figure 1–6 Page Toolbar The Page Toolbar parallels Graph Properties functionality.



Select Object Draw Line



Draw Arrow



Draw Box



Draw Ellipse



Line Properties



Fill Properties



Line Thickness



Line Ending



Symbol Fill Pattern Bring To Front Group Align



Viewing Toolbars



To view a toolbar: 1.



On the View menu, click Toolbars. The Toolbars dialog box appears.



2.



Select a toolbar to view.



3.



Click OK.



Figure 1–7 Toolbars Dialog Box placeholder??
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Hiding Toolbars



There are two ways to hide toolbars: ➤



Using a shortcut menu.



➤



Using the Toolbars dialog box.



To hide toolbars using the shortcut menu: 1.



Right-click the toolbar.



2.



On the shortcut menu, click Hide.



To hide toolbars using the Toolbars dialog box: 1.



On the View menu, click Toolbars. The Toolbars dialog box appears.



Changing Toolbar Button Appearance



Positioning Toolbars



2.



Clear the Toolbar you want to hide.



3.



Click OK.



The Large Buttons check box increases the size of Standard, Drawing, Properties, and Arranging toolbar buttons. The Color Buttons check box displays color toolbar buttons on your screen, rather than monochrome. The Show Tool Tips check box hides the toolbar help tags that appear as you drag the mouse over the toolbar. A toolbar can be moved from its default position to anywhere in the screen, and its positions can be changed from horizontal to vertical. To position a toolbar: ➤



Drag the move bar on a docked handle or drag the title bar on a floating tolbar to move it to another location.



Figure 1–8 Toolbars are docked by dragging a toolbar by its edge onto any SigmaPlot window border
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Setting Program Options



0



Use SigmaPlot’s program options to control application settings, as well as how worksheets and new pages and graphs will appear. To change program options: 1.



On the Tools menu, click Options. The Options dialog box appears.



Figure 1–9 Options Dialog Box



Worksheet Options



Page Options System Options



2.



Choose the appropriate tab and make changes.



3.



Make the appropriate user-defined changes.



Worksheet options include settings for numbers, statistics, date and time, worksheet display, default column width, number of decimal places, and use of engineering notation. Using this tab is described in Chapter 3, Worksheet Basics. Page options control graph page properties. Working with graph pages is explained in Graph Page Basics on page 95. The General tab of the Options dialog box controls application settings. Novice Prompting Novice prompts are warning, information, and confirmation messages that display before system operations occur. To disable novice prompting, clear the check box.



18 Setting Program Options



 Introduction Automatic Legends SigmaPlot creates a legend each time a graph is created, based upon the specifications of the graph. When this check box is selected, the legend appears by default. If this check box is cleared, legends are not automatically displayed, but can be displayed by selecting Show Legend in the Title and Legend tab of the Graph Properties dialog box. To learn more about automatic legends, see Graph Page Basics on page 95. Figure 1–10 Options Dialog Box System Tab



Retain window states Select to make SigmaPlot windows, toolbars, and palettes "sticky." That is, they will retain their size and position for your next SigmaPlot session. Fast 3D printing Prints graphs at a lower resolution to speed up printing. Backup Files Check this option to automatically create a backup file when saving any notebook. You can also select the extension SigmaPlot assigns to these files by selecting the With Extension edit box and typing three letters. These files appear in the directory where your original data files are stored. Save AutoRecovery info every Set how often you want SigmaPlot to automatically save your work. New Notebooks Use Excel Workbooks Select this option to open an Excel workbook each time you create a new notebook. See Chapter 2, Notebook Basics.
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 Introduction Fast Page Open Improves saving and opening times for graph pages by not saving the attributes for hidden objects. Retain Notebook Settings This option retains the windows and items open when the notebook was saved last, and reopens them the next time the notebook is open. When unchecked, time is saved when opening a notebook that had many open items. Excel Format Select an Excel format to use from the drop-down list. Percentile Method Select the method of computing percentiles when graphing error bars and creating box plots. See Chapter 6, Computing Percentile Methods. Template File Type the path and file name of the template file for SigmaPlot to use when creating new graph pages. Available templates are displayed in the Templates dialog box. For more information on applying and using templates, see Using Graph Pages as Templates on page 105. Layout File Type the path and file name of the layout template file for SigmaPlot to use when arranging graphs on a page. Available layout templates are displayed in the Arrange Graphs dialog box. For more information on arranging graphs, see Arranging Graphs on page 137. Gallery File Type the path and file name of the Graph Style Gallery file for SigmaPlot to use when creating graphs using the Graph Style Gallery. Available graph styles are displayed in the Graph Style Gallery. For more information the Graph Style Gallery, see Creating Graphs Using the Graph Style Gallery on page 182. Author Select and type your name, or any other name you want to appear in the Summary Information as Author for a selected notebook item. The name in this box is used by SigmaPlot as the default, but can be changed for individual documents by choosing Summary Info from the File menu.
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The Graph Defaults Tab



Graph defaults control attributes that are applied to all new graphs, including: ➤



Size and Position ➤ Font ➤



Settings for Symbols, Lines and Bars



To learn about graph defaults, see Graph Page Basics on page 95. Figure 1–11 Graph Defaults Tab
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Anatomy of SigmaPlot Graphs



0



A SigmaPlot graph consists of one or more plots of data, and one or more sets of axes. It uses a specific coordinate system (e.g., 2D Cartesian, 3D Cartesian, pie, or polar) and has a specific size and location on the page.



Plots are graphical representations of worksheet data. For example, view data as a vertical bar chart or change the plot to a horizontal bar chart, even after creating the graph. You can even display more than one plot on most graphs. Axes are the scales that determine position of the graph’s data points. Each axis contains tick marks that indicate the type of scale used. Scales range from linear to nonlinear within a Cartesian coordinate system. Customize tick mark labels with worksheet cells or use numeric or time series labels. The X, Y, and for 3D graphs, Z coordinates, are indicated on each axis by tick marks. An axis can use a linear numeric scale, nonlinear scales such as log, natural log, and probability, or a date/time scale. 2D graphs can have multiple sets of X and Y axes. The axes’ tick marks and tick labels, can be numeric, time series, or customized with worksheet column labels.
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 Introduction



2D Cartesian Graph



The following figures show examples of 2D Cartesian graphs available in SigmaPlot. Image art cut from a paint program and pasted onto the page using the Windows Clipboard 1200



Post break tick interval set to a new value



800



Y axis break at 75% along the axis length



Legend symbols and text labels



400



Number of Individuals



240



Error bars using worksheet column data



Grouped bar chart with specified bar and group widths



200



monospecies



160



with competition



120



80



Bar fill colors use a pattern from a worksheet column



40



0 1 months



3 months



5 months



7 months



9 months



11 months



X axis tick labels using text from a worksheet column



103



Scatter plot of color gradient filled symbols using a point plot style



102



Counts per Area



Common log scale Y axis with major and minor tick marks



99% confidence and predicted interval linear regression lines



101



Base and exponent log axis tick labels



Counts 1st Order Regression 95% Confidence Interval 95% Prediction Interval 100 January



April



July



1996



October



January



True Date and Time axis scale, displaying months and weeks
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 Introduction 5th and 95th percentiles displayed as symbols 30



Variable box widths can be used to express another variable dimension



Box Widths = Final Population 25



Tukey box plot with mean value lines



Lifespan (weeks)



20



15



10



5



Shaded graph backplane with Y axis grid lines



0 SP1



DL5



HX12



IND7



Diet



Tick mark direction pointing out



X axis tick labels using a category axis scale.



Graph Title



Scatter plot of column averaged data points, with Y error bars computed from the standard deviations



Population Growth with and without Inhibitor Top X axis with tick marks turned off



6



Y axis with a linear axis scale



Left Y axis title



Left Y axis with major tick marks



Population (colonies)



5



K1



Reference line



4



3



K2



Automatically generated legend



2



Spline line plot of data generated with the nonlinear curve fitter



1



Without Inhibitor With Inhibitor



0 0



2



4



6



8



10



12



Time (hours)



Numeric major tick labels
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X axis with a linear axis scale



Bottom X axis title



Right Y axis with tick marks turned off



 Introduction



Pie Chart Example



Use Pie charts to display a quick comparison of ratios in a data set. The example figure displays: ➤



Slice fills ➤ Text labels ➤



Exploded slices Exploded slices



Text labels



Hadean Eon Man Cenozoic Era Mesozoic Era Archean Eon



Paleozoic Era



Incremented fill colors



Proterozoic Eon
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Polar Plot Example



Use Polar plots to display modular data such as average monthly temperatures, or satellite positioning in the sky over a period of time. Average Monthly Temperatures April March May



Up to four radial axes can be displayed and the angles and lengths modified



120



February 100 80 60



June



40 20 0



The outer and inner angular axis can be made larger or smaller in diameter



January 0 20



July



40 60 80



November 100



Monthly series labeling



120 August October September



26 Anatomy of SigmaPlot Graphs



Tropics Forest Plains Desert



Major grid lines for the radial axis, and minor grid lines for the angular axis are shown



 Introduction



Contour Plot Example



A contour plot displaying major and minor



Use 2D Contour Plots to graph three dimensional data in two dimensions. The following example includes: ➤



Major and minor contour lines



➤



Contour labels



Major contour labels



Minor contour l ines drawn in a different color
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3D Cartesian Graph Examples



3D Cartesian Graphs include scatter, 3D trajectory and waterfall plots, mesh plots, and bar charts. The following figures contain examples of these plots, as well as some additional 3D features.



Incremented bar fill colors 3D grid lines



Shaded back planes
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 Introduction Overlapping and transparent meshes Z axis drawn at left side



Grid lines at major tick intervals



Light source shading Mesh plot with colored fills and lines



Y axis drawn at front bottom



Axes automatically move to the front view at any rotation



3D graph view can be displayed at any horizontal and vertical rotation



X axis drawn at front bottom



Front view frame lines



Scatter plot with drop lines



3D graphs can be displayed with varying perspectives (depth)
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Waterfall Plot Example



3D waterfall plots are stacked line plots along the Y axis of a 3D line plot. Because hidden lines are eliminated, waterfall plots are useful for showing trends of line plots. The following example includes: ➤



Incremented line fill color



➤



Eliminated “hidden” lines



Line fill color is incremented



5



4



Z Data



Hidden lines are eliminated



3



2



Stacked line plots are along the Y axis



1 1 2 0 100



3 80



60



X Data
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 Introduction



Area Plot Example



Area plots are 2D line plots with regions below or between curves filled with a color or pattern. Most commonly, an area plot is a line plot with shading that descends to the axis. You can add shade below a curve and shade in different directions. You can also identify intersecting sections. This example consists of two plots, and includes: ➤ ➤



A simple bar chart using hairline bars. A multiple area plot using the X many Y data format.



A Multiple Area Plot



A Simple Bar Chart
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SigmaPlot Help



0



SigmaPlot's online help uses new HTML online Help. View the HTML Help using Microsoft Internet Explorer version 4.0 or higher.



Customer Service



If you have any questions concerning your shipment or account, contact your local office; see page 33. Please have your serial number ready for identification when calling.



Training Seminars



SPSS Inc. provides both public and onsite training seminars for SPSS products. All seminars feature hands-on workshops. SPSS seminars will be offered in major U.S. and European cities on a regular basis. For more information on these seminars, call your local office; see page 33.



Tell Us Your Thoughts



Your comments are important. Please send us a letter and let us know about new and interesting applications using SPSS products. Write to SPSS Inc. Marketing Department, Attn.: Director of Product Planning, 233 South Wacker Drive, Suite 1100, Chicago, IL, 60606-6307.



Getting Technical Support The services of SPSS Technical Support are available to registered customers. Customers may call Technical Support for assistance in using SPSS products or for installation help for one of the supported hardware environments. To reach Technical Support, see the SPSS home page on the World Wide Web at http:// www.spss.com, or contact us:



In the U.S.: Telephone:



(510)412-2900 (8:00 A.M. to 5:00 P.M. Pacific Time)



Fax: E-mail:



(510)412-2909 [email protected]



Mail:



501 Canal Blvd., Suite F Richmond, CA 94804-2028



In Europe:
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Telephone: Fax: Email:



49 2104 / 95480 49 2104 / 95410 [email protected]



Mail:



Schimmelbuschstrasse 25 40699 Erkrath, Germany



0



 Introduction



Using This Manual



0



The SigmaPlot User’s Guide is designed to provide you with complete instructions on how to use SigmaPlot’s advanced graphing features. Referencing this manual along with SigmaPlot, you can create a wide variety of publicationquality scientific graphs on your IBM or compatible PC.



Conventions



The following conventions are used in this manual: ➤ ➤



New terms, such as Graph Wizard are shown in bold italic the first time they are introduced.



Important notes or information in this manual are flagged with a Σ symbol.



The User’s Guide includes chapters on Notebook, Worksheet, and Graph Page basics. It begins with the QuickStart, which gives you the basics of graph creation. The latter part of the book is reference material that covers more complex graph creation and details of using SigmaPlot.



Contacting SPSS Inc.



0



If you would like to be on our mailing list, contact one of our offices or distributors below. We will send you a copy of our newsletter and let you know about SPSS Inc. activities in your area. SPSS Inc. 233 South Wacker Drive Suite 1100 Chicago, IL 6066-6307 Tel: +312.329.2400 Fax: 312.329.3690 http://www.spss.com/products Outside the U.S.: SPSS Science Software GmbH Schimmelbuschstrasse 25 40699 Erkrath, Germany Tel: +49.2104.9540 Fax: 49.2104.95410 Or contact the distributor nearest you: http://www.spss.com/international/asc.html
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Notebook Basics The SigmaPlot notebook file contains all of your SigmaPlot data and graphs. You can export the notebook file to other applications, and accept data from other applications. This chapter covers: ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤



SigmaPlot notebook organization (see page 37) Creating notebooks and adding notebook items (see page 38) Renaming notebooks and notebook items (see page 43) Opening notebooks and notebook items (see page 44) Copying, pasting, and deleting notebook items (see page 45) Saving your work (see page 46) Exporting data, graphs and text reports (see page 46) Printing worksheets, pages and reports (see page 49)



SigmaPlot Notebook Structure



0



Each SigmaPlot notebook file contains many different documents arranged as a tree structure. This tree appears in the notebook window, with the notebook name at the top level, one or more sections at the second level, and one or more items at the third level. Within each section you can create one worksheet and an unlimited number of graph pages, reports, equations, and macros. Notebooks retain their size and position between each use of SigmaPlot. Every time you start SigmaPlot, a worksheet opens in the notebook window. To make a notebook window active or current, click it. You can also click the Notebook button on the SigmaPlot toolbar. From the notebook window, you can open, store, move, and delete notebook sections and items.
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 Notebook Basics For more information, see Opening Notebook Files and Items on page 44, and Copying, Pasting and Removing Notebook Items on page 45. Figure 2–1 Notebook Window



Modified Notebook Items Opening Multiple Notebook Items



An asterisk (∗) next to a notebook item indicates that the item has been modified since the last time the notebook file was saved. You can open multiple notebook items. Using the notebook to open and close multiple items will help you manage viewing multiple documents.



Figure 2–2 Example of Multiple Notebook Items Opened Open items are shown in the notebook as active items.



38 SigmaPlot Notebook Structure



 Notebook Basics



Notebook Item Names



The default startup notebook is named Notebook 1. It contains one notebook section, Section 1, and one worksheet, Data 1. When you save your notebook file, the name of the file appears at the top of the notebook window. Notebook files use a (.JNB) extension. The default names given to notebook sections and items are, Section (number), Data (number) or Excel (number), and Report (number). Regression equations are named when they are created. New items are numbered sequentially. Worksheets Worksheets contain data you analyze and graph. You can enter data, paste it, or import it from other sources. You can also automatically generate data and place it in worksheet columns. A worksheet automatically appears each time you start SigmaPlot. You can also open or create additional worksheets any time from within SigmaPlot. You can modify and manipulate worksheet data and appearance by using the functions described in see Using Transforms on Data in Excel Workbooks on page 93. SigmaPlot automatically calculates some basic statistical values for all worksheet columns. To see these values, on the View menu, click Column Statistics. Column Statistics are described in Descriptive Statistics for Worksheets on page 63. Graph Pages Graph pages are true graphical representations of a printed page that contain graphs, text, and other drawn and pasted objects. You can select and modify objects on graph pages using the Graph and Object properties dialog boxes, and with the graph and drawing toolbars. You can also manipulate objects graphically using your mouse. A page can contain an unlimited number of graphs and other objects, and you can create an unlimited number of pages for each worksheet. You can also paste graphics, OLE objects, and other objects onto a page. Excel Workbooks You can open Excel workbooks in SigmaPlot. If you open an Excel workbook, many Microsoft Excel menus and commands appear in SigmaPlot.



Σ



You can store and save data in the top sheets of an in-place active Excel workbook; however, you can only plot data on one sheet of the Excel workbook. To learn more about using Excel in SigmaPlot, see Using Excel Workbooks in SigmaPlot on page 88. Reports Reports are text–based pages where you enter, save and print formatted text. You can also paste graphics, OLE objects, and other objects into reports.
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 Notebook Basics Equations Use equations to perform nonlinear curve fitting using the Regression Wizard, or you can plot equations using the Plot Equation dialog box. See the Programming Guide for more information on regression.



Managing Notebook Sections



0



Notebook sections are place-holders in the notebook window. They contain notebook items, but no data. However, they can be named, opened, and closed. You cannot have sections within sections. You can create as many new sections as you want in a notebook. You may also create reports within each section to document the items in each section. Figure 2–3 shows several notebook sections containing notebook items. Figure 2–3 A SigmaPlot Notebook Window showing the tree structure of the Notebook, with open and closed sections Each item and section can have its own name, and all items can have separate author and description information.



To expand or collapse a section, double-click the section icon or click the (+) or () symbol.
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 Notebook Basics



Creating New Notebook Files and Items Creating a New Notebook File Creating a New Section



0



To create a new SigmaPlot notebook file, click the New Notebook toolbar button. A notebook with a single worksheet appears. You can create a new section in the notebook from the shortcut menu. To create a new section in the notebook using the shortcut menu: 1.



In the notebook, right-click to open the shortcut menu.



2.



On the shortcut menu, click New, and then click Section. A new section appears in the notebook.



Σ



Another method to create a new notebook section is to copy and paste a section in the notebook window. Whenever you copy and paste a section, its contents appear at the bottom of the notebook window. SigmaPlot names and numbers the section automatically. For example, if you copy notebook Section 3, the new section is named Copy of Section 3. Copied sections create copies of all items within that section as well.



Creating New Worksheets



Creating a new worksheet creates it in a new section that is appended to the end of the notebook. There can only be one worksheet per section. New Excel worksheets are limited to one worksheet only in the workbook. To create a new SigmaPlot worksheet: ➤



Click the New Worksheet button



on the Standard toolbar.



A new worksheet appears. To create a new Excel worksheet: ➤



Click the New Excel Worksheet button



on the Standard toolbar.



A new Excel Worksheet appears, which you can modify and save in the SigmaPlot notebook.



Σ Creating New Graph Pages



You can also copy and paste existing worksheets; see Copying, Pasting and Removing Notebook Items on page 45. You can create a new graph page by either clicking the New Page button on the Standard toolbar, or by using a page template. Templates consist of preformatted pages along with optional pre-created graphs. You can use any page as a template. For more information about using templates, see Using Graph Pages as Templates on page 105.
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 Notebook Basics To create a new graph page: 1.



Select the section in which you want the page to appears.



2.



Click the New Page button



on the Standard toolbar.



The Graph Page dialog box appears. 3.



Click Yes to create a graph; click No to create a blank graph page.



To use page templates: 1.



On the File menu, click New. The New dialog box appears.



Creating New Reports



2.



Select a template from the Type list.



3.



Descriptions of the templates appear under Description.



You can manually create a report, or use the Regression Wizard to automatically generate reports. See the Programming Guide for more information. To create a new report: 1.



Right-click the section where you want to create the report.



2.



On the shortcut menu, click New, and then click Report. A new report appears.



Creating New Equations



Use the shortcut menu in the notebook to create an equation using the Function dialog box. For more information on creating equations using the Regression Wizard, see the Programming Guide. For more information about plotting equations, see Plotting and Solving Equations on page 228. The Regression Wizard can also create regression equations. To create a new equation: 1.



Right-click the section where you want the equation to appear.



2.



On the shortcut menu, click New, and then Equation. The Function dialog box appears in which you enter the proper programming code. For more information, see the Programming Guide.
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 Notebook Basics



Renaming Notebook Files and Items



0



Use the Summary Information dialog box to change information that is stored with your notebook files, sections, and items. To change summary information: 1.



On the right side of the notebook window, click Summary. The Summary Info dialog box appears.



Figure 2–4 Use the Summary Information Dialog Box to Change Name, Author, or Comment of a Notebook Item



2.



Select the Entry Title, Author, or Description box, then type the new name.



3.



Click OK to close the dialog box. The new section, or item name appears in the notebook window.



In-place Editing Section and Item Names



You can change the name of a notebook section or item in the notebook itself without opening the Summary Information dialog box. To in-place edit: 1.



On the notebook window, click the section or item you want to rename.



2.



Click the file or item a second time.



3.



Type the new name.



4.



Press Enter. The new section or item name appears in the notebook window.
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 Notebook Basics



Opening Notebook Files and Items Opening Notebook Files



0



You can open SigmaPlot files and other types of files as SigmaPlot notebooks. To open a notebook file that is stored on a disk: 1.



Click the Open



button on the Standard toolbar.



The Open dialog box appears. Figure 2–5 Open Dialog Box



2.



Choose the appropriate drive and directory of the notebook file to open.



3.



Double-click the desired notebook file.



4.



If you want to open another type of file, choose the type of file from the Files of type list.



5.



Opening Worksheets, Reports, and Pages



Click Open.



You can open a worksheet, report, or page by double-clicking its icon in the notebook window. You can also select the item and click the Open button. Open worksheets, pages and report appear in their own window, and in the notebook as a colored icons. Double-clicking an item that is already open brings the item’s window to the front. Opening Multiple Items You can open as many items as your system’s memory allows. However, you can only simultaneously open items associated with the current notebook. If you open an item from a different notebook, the current items close, and the item in the other notebook opens.
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Copying, Pasting and Removing Notebook Items



0



Copying and pasting items in your notebook helps you to organize your SigmaPlot notebook and easily create copies of important data and graphs. You can copy and paste items within a notebook and from one notebook to another. You cannot copy a worksheet into a notebook section that already contains a worksheet. SigmaPlot always creates a new section for pasted worksheets that is appended to the end of the current notebook.



Copying and Pasting Notebook Items



Copying and pasting pages and worksheets between sections results in using graph pages as templates. To learn about creating and using templates, see Using Graph Pages as Templates on page 105. To copy and paste a notebook item: 1.



Open both the source and destination notebook file windows. The source notebook for a copied item must be open for a copy to take place.



2.



Right-click the item that you want to copy, and on the shortcut menu, click Copy.



3.



Right-click the section where you want to paste the item, and on the shortcut menu, click Paste. The selected item is pasted to the current notebook and section.



Removing a Notebook Item



Items removed from a notebook file using the Delete button are removed permanently. To remove an item from a notebook: ➤



Copying a Page to a Section with No Worksheet



Select the item and press Delete. The item is deleted.



If you copy a graph page into an empty section or a section that has no worksheet, you create an independent page. The independent page retains all its plotted data without the worksheet. You can store the pages from several different sections that have different data together this way. However, if you ever create or paste a worksheet into a section, all independent pages will revert to plotting the data from the new worksheet. Use independent pages as templates, or to draw or store objects. You cannot create graphs for an independent page until it is associated with a worksheet (and no longer independent).
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 Notebook Basics



Saving Your Work



0



Be sure to save your work at regular intervals. To save a notebook file for the first time: 1.



Click the Save button



.



The Save As dialog box appears. 2.



Navigate to the directory where you want to save your notebook.



3.



Type a name for the notebook in the File Name text box.



4.



Click Save to save the notebook file and close the Save As dialog box.



To save changes with the same name and path: 1.



Click the Save button



.



Your file is saved. To save to a new name and path, 1.



On the File menu, click Save As. The Save As dialog box appears.



2.



Navigate to the directory where you want to save your notebook.



3.



Type a name for the notebook in the File Name text box.



4.



Click Save to save the notebook file and close the Save As dialog box.



Exporting Notebooks and Notebook Items



0



Use SigmaPlot’s Export command to export worksheet, page and report contents as files of different formats.



Exporting Notebooks



Use the Export command to save SigmaPlot 8.0 notebooks as older SigmaPlot files. Any features exclusively supported by SigmaPlot 8.0 will be lost upon conversion. To export a notebook: 1.
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Click the notebook window.



 Notebook Basics 2.



On the File menu, click Export. The Export dialog box appears.



Exporting SigmaPlot Worksheets



Σ



3.



From the Files of type drop-down list, select a file format.



4.



Enter the file name, directory, and drive for the exported file.



5.



Click Export to create the file.



Exporting worksheets does not export associated graphs. To export the worksheet and the graph, you need to export the graph page to a SigmaPlot Graph (.SPW) file. You can only export the entire Sigma Worksheet. If you want to export a portion of the worksheet, delete the portion you don’t want to export, then export the remainder of the worksheet. When you export a SigmaPlot worksheet as a text file, tabs or commas separate the data columns and data is saved at full precision.



Σ



If you want to save a text file with data as it appears in the worksheet rather than at full precision, copy the selected data to the Clipboard, paste it into a text editor, and save it as a text file. To export a SigmaPlot worksheet: 1.



Select the worksheet you want to export by opening and viewing it, or selecting it in the notebook window.



2.



On the File menu, click Export. The Export File dialog box appears.



Exporting Graphs and Pages



3.



From the Files of type drop-down list, select a file format.



4.



Enter the file name, directory, and drive for the exported file.



5.



Click Export to create the file.



You can export SigmaPlot graphs and graph pages to other files formats. To export a graph or graph page: 1.



Select and view the graph page. If you want to export specific graph(s), select the graphs you want to export to a file.



2.



On the File menu, click Export. The Export File dialog box appears.
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 Notebook Basics 3.



Enter the file name, directory and drive for the export file destination.



4.



Click Export.



5.



If you chose one of the graphic file formats, a secondary dialog box appears, asking you to enter some graphic format information.



6.



Enter the desired DPI and Color Resolutions; for EPS files, these setting only affect the resolutions of the TIFF header, not the actual PostScript resolution. For metafiles, this setting affects only 3D graphs.



Figure 2–6 Export Tagged Info File Dialog Box



The higher the DPI and Color resolutions, the better quality the image, but also the larger the file. Limit the DPI and Color resolutions to the capability of the intended output device. For example, if you are going to create 600 dpi slide output, set the DPI resolution no larger than 600.



Exporting Reports



7.



If you want to export only the selected graph(s) or objects, select the Export Selected Only option.



8.



Click OK to create the exported file using the specified file name and graphic resolutions, if applicable.



You can only export the entire report. If you want to export a portion of the report, delete the portion you don’t want to export, then export the remainder as the file. To export a report: 1.



Select and view the report window you want to export.



2.



On the File menu, click Export. The Export File dialog box appears.



3.



From the Files of type drop-down list, select a file format.



4.



Enter the file name, directory, and drive for the exported file.



5.



Click Export to create the file.
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Printing Notebook Items



0



You can print active worksheets, graph pages, reports, and selected notebook items by clicking the Print button on the Standard toolbar.



Printing Worksheets



You can print any worksheet in a SigmaPlot notebook. To print the current worksheet: 1.



Select and view the worksheet. If you want to print only a portion of the columns in the active worksheet, select a block from the worksheet.



2.



Click the Print button default settings.



to print the worksheet using all the



To set printing options before you print the worksheet: 1.



From the File menu, click Print.



2.



The Print Data Worksheet dialog box appears.



3.



Specify whether you want to print the entire worksheet, only the selected cells in the worksheet, or a specified range of columns by selecting one of the options under Area to Print.



4.



Click OK to print the worksheet.



Figure 2–7 The Print Data Worksheet Dialog Box



To print column statistics: 1.



On the View menu, click Column Statistics. The column statistics worksheet appears.



2.



On the File menu, click Print. The Print dialog box appears.



3.



From the Name drop-down list, select the printer you wish to use.
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 Notebook Basics 4.



Click OK. The Print Data Worksheet dialog box appears.



Figure 2–8 The Print Data Worksheet Dialog Box for Columns Statistics



5.



To print the names of the statistics that appear in the row region of the worksheet, under Headers select Row Headings.



6.



Click OK to print.



To configure printer settings: 1.



On the Print Data Worksheet dialog box, click Setup. The Print dialog box appears.



2.



Click OK when you are satisfied with the Printer settings, or click Properties to edit the printer properties. Note that the Properties dialog box options vary from printer to printer.



Printing Graph Pages



You can print any graph in a SigmaPlot notebook. To print a graph page: 1.



Select and view the page window.



2.



Click the Print button



to print the page using all the default settings.



To set printing options before you print the graph page: 1.



On the File menu, click Print. The Print dialog box appears.



2.



Click Properties. The printer Properties dialog box appears.



3.
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Click OK when you are satisfied with the printer properties settings.



 Notebook Basics The Properties dialog box closes. Note that the Properties dialog box options vary from printer to printer. 4.



Click OK to print the report.



For more information on printer settings and use of high resolution output devices, “Printing Tips” on page 445. For more information on using Page Setup, see Changing Graph Page Format on page 154.



Printing Reports



You can print any report in a SigmaPlot notebook. To display a report as it will look when printed: ➤



On the File menu, click Print Preview. A preview of the report appears.



To print a report: 1.



Select and view the report window.



2.



Click the Print button



to print the report using all the default settings.



To set printing options before printing the report: 1.



On the File menu, click Print. The Print dialog box appears.



2.



Click Properties. The printer Properties dialog box appears.



3.



Click OK when you are satisfied with the printer properties settings. The Properties dialog box closes. Note that the Properties dialog box options vary from printer to printer.



4.



Printing Selected Notebook Items



Click OK to print the report.



You can print individual or multiple items from the notebook, including entire sections. To print one or more items or sections from the notebook: 1.



Select one or more items or sections from the notebook.



2.



Click the Print button



on the Standard toolbar to print the worksheet
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 Notebook Basics using all the default settings. To set printing options before printing a report, graph page, or worksheet: 1.



Open each item.



2.



Press Ctrl+P. The Print dialog box appears.



3.



Click Properties.



For information on printing worksheets, see Printing Worksheets on page 49. For information on printing graph pages, see Printing Graph Pages on page 50. For information on printing reports, see Printing Reports on page 51.
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Worksheet Basics Worksheets are the containers for the data you analyze and graph. They are spreadsheet-like in appearance but are much more limited in function, and are column rather than cell oriented. Type in, paste, or import data from other sources. You can also automatically generate and place data in worksheet columns by data transforms and statistical procedures. This chapter covers: ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤



Setting worksheet options (see page 54) Moving around the worksheet (see page 55) Entering data into a SigmaPlot worksheet (see page 57) Importing data into a SigmaPlot worksheet (see page 58) Descriptive statistics for worksheets (see page 63) Changing data display (see page 66) Selecting data (see page 75) Sorting data (see page 77) Cutting and pasting data (see page 78) Inserting and deleting columns and rows (see page 78) Switching data rows to columns (see page 81) Entering column and row titles (see page 85) Using Excel inside SigmaPlot (see page 88)
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 Worksheet Basics The following figure provides some worksheet definitions: Figure 3–1 Example of a SigmaPlot Worksheet



Row numbers and titles are listed along the left side of the worksheet. Select a cell by clicking it or using the arrow keys to scroll to it. Selected cells are highlighted.



Column numbers and titles appear here.



Setting Worksheet Display Options The Options dialog box Worksheet tab sets the display for: ➤



Numeric Date and Time ➤ Statistics ➤ Appearance ➤



Figure 3–2 The Options Dialog Box - Worksheet Tab
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 Worksheet Basics Click the Worksheet tab on the Options dialog box to select a numeric display type, change column width and decimal places, and turn on and off engineering notation. Figure 3–3 The Options Dialog Box Worksheet Tab Data and Time Options



Moving Around the Worksheet



0



You can move around the worksheet using scroll bars or, move the highlighted worksheet cursor with the keyboard. Function



Keystroke



Move one column right/left



→ or ←



Move one row up/down



↑ or ↓



Move one window view up/down



Page Up or Page Down



Move to end of column



End



Move to end of worksheet



End+End or Ctrl+End



Move to top of column



Home



Move to column one, row one



Home+Home or Ctrl+Home



Move to last column of next data block



Ctrl + →
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Going to a Cell



Move to first column of previous data block



Ctrl + ←



Move to top row of previous data block



Ctrl + ↑



Move to last row of last data block



Ctrl + ↓



Put cells into Edit mode



F2



You can move the worksheet cursor to any cell in the worksheet by specifying the column and row number in the Go to Cell dialog box. To go to a cell: 1.



On the Edit menu, click Go To. The Go to Cell dialog box appears.



Figure 3–4 Moving to a Specific Cell in the Worksheet



Using the Worksheet Shortcut Menu



2.



Enter the desired column and row number. To select the block of cells between the current highlight location and the new cell, click Extend Selection to Cell.



3.



Click OK to move to the new cell.



In addition to the menu commands and toolbar buttons referred to in the body of this manual, right-clicking the worksheet displays a shortcut menu. The
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 Worksheet Basics commands on the right-click shortcut menu are the same as the Edit menu: Cut, Copy, Paste, Delete, Transpose Paste, Insert Cells, and Delete Cells commands. Figure 3–5 Right-click Edit Worksheet Menu



Entering Data into a SigmaPlot Worksheet



0



This section describes entering data into SigmaPlot worksheet columns, and formatting the columns for numeric, label, or date and time display. To enter data in a SigmaPlot worksheet:



Entering Dates and Times



1.



Place the cursor in a cell.



2.



Type a number, label, or date and time value.



3.



Press Enter to move down one row, or use the arrow keys to move around the worksheet. You must press Enter before moving to another column.



Dates and times are entered using delimiters. The delimiters used are determined by the Windows regional settings. For more information, see Regional Settings on page 72.



Date Delimiters: The default date delimiter for most systems is the forward slash (/). An entry that displays only two fields of a date value is assumed to be day and month. If the second field’s value is greater than 31, months and years are assumed. Entries with two delimiters assume month/day/year. If you enter only two digits for the year, the current century is implied. Examples are given in the
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 Worksheet Basics following table (the twentieth century is assumed to be the current computer clock setting). Value Entered:



Resulting Date:



2/2



February 2



2/32



February, 1932



2/2/02



February 2, 1902



Time Delimiters: The default time delimiter is usually a colon (:). Entries displaying two fields of a time value are assumed to be hours and minutes. If PM is not specified, hours less than 12 are assumed to be morning hours. An entry with two colons assumes hours:minutes:seconds.



Insertion and Overwrite Modes



Press the Insert key or use the Edit menu Insertion Mode command to switch between overwrite and insert data entry modes.



If in Insertion mode, “Ins” appears in the status bar. A check mark next to the Insertion Mode command on the Edit menu also indicates that the worksheet is in insertion mode. If in Insertion Mode, new data entered in a cell does not erase the previous contents. Any existing data in the column is moved down one row. If you paste a block of cells, existing data is pushed down and/or to the right to make room for the pasted cells. If you cut or clear data, data below the deleted block moves up and/or to the left.



If not in Insertion Mode, the worksheet is in overwrite mode. Data entered into a cell replaces any existing data. If you paste a block of data, the block overwrites existing data.



Importing Files from Other Applications You can import data from other applications into an existing worksheet for graphing, worksheet display, or running regressions. When you import data, it appears at the position of the worksheet cursor. You can import the following file types can into SigmaPlot worksheets: ➤



SPSS (.sav) ➤ SigmaPlot 1.0 and 2.0 files (.SPW) ➤ SigmaPlot Macintosh 4 Worksheet
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 Worksheet Basics ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤



Σ



SigmaPlot Macintosh 5 Worksheet SigmaStat 1.0 files (.SNB) SigmaPlot and SigmaStat DOS files (.SPG, .SP5) TableCurve 2D and 3D files Microsoft Excel files (.XLS) Lotus 1-2-3 files (.WKS, .WK*) Quattro/DOS files (.WK*) dBase files (.DBF) Plain Text files (.TXT, .PRN, .DAT, .ASC) Comma Delimited files (.CSV) SigmaScan SigmaScanPro Worksheets SigmaScan Image Mocha Worksheets Axon Text and Binary formats



When you import data from another application that is left-justified, SigmaPlot assumes it is text. To import data: 1.



Place the cursor to the worksheet cell where you want the imported data to start.



2.



On the File menu, click Import. The Import File dialog box appears.



SPSS (.SAV)



3.



Select the type of file you want to import from the Files of Type drop-down list.



4.



Change the drive and directory as desired, select the file you want to read, then click Import, or double-click the file name. Depending on the type of file, the data is either imported immediately, or another dialog box appears.



If you are importing SPSS (.sav) files, the Import Worksheet dialog box appears prompting you to select variables to import. To select variables to import: 1.



In the Unselected Variables list, select a variable you want to import.



2.



Click the single > arrow to move that variable to the Selected Variables list. Click the double >> arrow to move the entire contents of the Unselected Variables list to the Selected Variables list.
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Σ SigmaPlot, SigmaStat, SigmaScan, Mocha Worksheets and DIF



Click Import to place the data in the SigmaPlot worksheet. SPSS data files use category data as the default data format. To learn how to create a graph using category data, see Creating Error Bar Plots Using Category Data on page 252. To learn how to create a SigmaPlot graph from within SPSS, see Creating SigmaPlot Graphs Using SPSS on page 188.



If you are importing a SigmaPlot, SigmaStat, SigmaScan, Mocha, or DIF file, a dialog box appears prompting you to select a range of data to import. Select the range of data by specifying the start and end of the range; the default is the entire range. Click Import to place the data in the SigmaPlot worksheet.



MS Excel, Lotus 1-2-3, Quattro, and dBase Files



If you want to use an Excel workbook as an actual Excel workbook within SigmaPlot, you must open the workbook instead of importing it. Importing places the Excel data into a SigmaPlot worksheet, and does not open the workbook as an actual Excel workbook. For more information on using Excel workbooks in SigmaPlot, see Using Excel Workbooks in SigmaPlot on page 88. When importing a spreadsheet or dBase file, the Import Spreadsheet dialog box appears.



Figure 3–6 Import Spreadsheet Dialog Box



Select either the entire spreadsheet or a specified range of cells. Specify cells using the standard 1-2-3 notation (e.g. A1:C50 for a range from cell a1 to cell c50). For dBase files, cell letters correspond to fields. When you have finished specifying the range to import, click Import. The selected data is imported. Note that the dialog box indicates whether or not the worksheet is in overwrite or insert mode, and where the imported data will begin.
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Σ



To import spreadsheet data from non-compatible programs, save the spreadsheet as either a Lotus or text file, then import that file.



Σ



Only the top sheet of an Excel workbook can be imported. If you attempt to import another worksheet, you will receive a warning message. If you want to move data from other sheets, use Copy and Paste.



Importing Text Files



If you are importing a text file, the Import Text dialog box appears. Use this dialog box to view the text file and to specify other delimiter types, or to build a model of the data file according to custom column widths.



Figure 3–7 Import Text Dialog Box



Σ



A quicker method of importing text is copying the data in your source application, then opening SigmaPlot and pasting the data. 1.



To specify a different column separator, select Delimiter to activate the delimiter options; then select the appropriate type. You can select commas, hyphens, or any other characters. For example, many databases use semicolons (;) as delimiters.



2.



To specify a model of the data, use dashes (-) to specify column widths, and bracket characters [ and ] to define the column edges. Use a vertical bar | character to indicate a single-character width column. Click Analyze to redisplay the appearance of the file using the new model.



3.



To save text import formats, enter a name into the Format scheme box, then click Add. Delete unwanted import formats using the Remove button.



4.



To specify a different range, enter the rows and columns to read, then click Analyze. You can use this feature to eliminate file headers and other undesired text.
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Importing Axon Files



When you are finished specifying the file parameters, click Import. The specified data from the file is imported.



SigmaPlot can import data files produced by Axon Instruments, Inc. laboratory equipment and data acquisition programs. SigmaPlot imports both text and binary data files; if you select one of these options, the Import Axon dialog box appears prompting you to select a range of data to import. The File selected is indicated in the dialog box title. Select the range of data by specifying the Row and Column ranges; the default is the entire range. Click Import to place the data in the SigmaPlot worksheet.



Figure 3–8 Import Axon File Dialog Box



Exporting Worksheet Data



0



Exporting worksheets does not export associated graphs. To export the worksheet and the graph, you need to export the graph page to a SigmaPlot Graph (.SPW) file. To export a SigmaPlot worksheet: 1.



Select the worksheet you want to export by opening and viewing it, or selecting it in the notebook window.



2.



On the File menu, click Export. The Export File dialog box appears.



Exporting Worksheets as Text Files



3.



Use the Files of type drop-down list to select a file format, and then enter the file name, directory, and drive for the exported file.



4.



Click Export to create the file.



When you export a SigmaPlot worksheet as a text file, tabs or commas are used to separate data columns and data is saved at full precision. If you want to save a text file with data as it appears in the worksheet rather than at full precision, copy the selected data to the Clipboard, paste it into a text editor, and save it as a text file.
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Exporting to Systat



When exporting SigmaPlot data to Systat, make sure that there are no text cells or indefinates (+/- •) in data columns you export, or they will be converted by Systat into text instead of numbers.



Descriptive Statistics for Worksheets



0



SigmaPlot automatically calculates a number of basic statistical values for all the data in your worksheet columns. For information on printing column statistics, see Printing Worksheets on page 49. To view the statistics for the currently selected worksheet: ➤



On the View menu, click Statistics. A check mark appears next to the Statistics command. The running calculations performed for each column appear in a Column Statistics window for that worksheet.



Figure 3–9 Column Statistics Worksheet



To close the Column Statistics window: ➤



Available Statistics



On the View menu, click Statistics again, or click the right corner of the worksheet window.



button in the upper



To determine the statistics shown in the Statistics windows, use the Statistics Options dialog box to (see Statistics Options on page 65). Most calculations ignore empty cells, missing values, and text. The following statistics appear in the Column Statistics window. Mean: The arithmetic mean, or average, of all the cells in the column, excluding the missing values. This is defined by:
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1 x = --n



∑ xi i=1



Std Dev: The sample standard deviation is defined as the square root of the mean of the square of the differences from their mean of the data samples xi in the column. Missing values are ignored. n



s =



i ----------n–1



∑ ( xi – x )



2



i=1



Std Err: The standard error is the standard deviation of the mean. It is the sample standard deviation divided by the square root of the number of samples. For sample standard deviation s:



s StdErr = ------n 95% Conf: The value for a 95% confidence interval. The end points of the interval are given by:



s x ± t ( v, z ) ------n where x is the mean, s is the sample standard deviation, and t(v,z) the t statistic for v = n−1 degrees of freedom and z = 1.96 standard normal percentile equivalent. 99% Conf: The value for a 99% confidence interval. The end points for this interval are computed from the equation for the 95% confidence interval using z = 2.576. Size: The number of occupied cells in the column, whether they are occupied by data, text, or missing values. Sum: The arithmetic sum of the data values in the column. Min: The value of the numerically smallest data value in the column, ignoring missing values. Max: The value of the numerically largest data value in the column. Min Pos: The smallest positive value. 64 Descriptive Statistics for Worksheets



 Worksheet Basics Missing: The number of cells in the column occupied by missing values, denoted with a double dash symbol (--). Other: Either text or an empty cell.



Statistics Options



To display only a portion of the available statistics, use the Worksheet Options dialog box, then select column statistics to show or hide. For more information on changing data display and column width options, see Sizing Columns and Rows on page 66. To specify which statistics are shown or hidden: 1.



On the View menu, click Statistics. The Column Statistics worksheet appears.



2.



On the Tools menu, click Options. The Options dialog box appears.



Figure 3–10 The Statistics Options Dialog Box



3.



Click the Worksheet tab.



4.



Select the statistic(s) you want shown or hidden.



5.



Use the Show and Hide buttons to move the statistics between the Shown and Not Shown lists.



6.



Select the appropriate options to change the column widths and data display.
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Displaying Worksheet Data



0



You can display data in your worksheet columns as: ➤



Text ➤ Numbers ➤ Date and Time values ➤ Graphic information Figure 3–11 Numbers are displayed in Column 1, dates are displayed in Column 2, and text is shown in Column 3



You can enter numbers, labels, and dates and times directly into the worksheet. You can also convert numbers to dates and times and vice versa. You can change column widths, number decimal places, or date and time format, and you can also change the color and thickness of the worksheet gridlines, and adjust data feedback colors. These operations are described in this section.



Sizing Columns and Rows



If the contents of your column exceed the column width, cell contents display as pound symbols (####). Label entries are truncated.



To change a column width, drag the boundary on the right side of the column heading until the column is the size you want. To change a row height, drag the boundary below the row heading until the row is the size you want. To adjust column width and row height using the Options dialog box: 1.



On the Tools menu, click Options. The Options dialog box appears.



2.



Click the Worksheet tab.



3.



In the Settings For list, click Appearance.
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Σ Changing the Appearance of the Worksheet Grid



4.



Set column width and row height in the Column Width and Row Height drop-down lists.



5.



Click OK to apply the changes and close the dialog box.



SigmaPlot is accurate to twenty-one significant digits regardless of how many decimal places you specify. You can change the color and thickness of worksheet grid lines. To change the grid appearance: 1.



On the Tools menu, click Options. The Options dialog box appears.



Setting Data Feedback Colors



2.



Click the Worksheet tab.



3.



In the Settings For list, click Appearance.



4.



Set color and thickness in the Color and Thickness drop-down lists.



5.



Click OK to apply the changes and close the dialog box.



Data Feedback highlights the cells and columns on the worksheet that correspond to the selected curve or datapoint’s X and Y values. You can change these colors on the Options dialog box. To change the data feedback colors: 1.



On the Tools menu, click Options. The Options dialog box appears.



Setting Decimal Places



2.



Click the Worksheet tab.



3.



In the Settings For list, click Appearance.



4.



Set data feedback colors and thickness in the X and Y drop-down lists.



5.



Click OK to apply the changes and close the dialog box.



The column width limits the number of decimal places allowed. The maximum number of decimal places cannot exceed the column width. To set the number of decimal places used for worksheet values: 1.



On the Tools menu, click Options.
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 Worksheet Basics The Options dialog box appears. Figure 3–12 Changing Worksheet Column Width



Changing Numbers Display



2.



Click the Worksheet tab.



3.



In the Settings For list, click Numeric.



4.



Select the number of decimal places from the Decimal Places drop-down list.



5.



Click OK to accept the changes and close the dialog box.



Display numbers in four ways in your worksheet using the Tools menu Options command. Numeric Display



Description



Example



E Notation When Needed



Displays worksheet data as scientific notation only when the length of the value exceeds the width of the cell. The default column width is twelve.



12.00



E Notation Always



Always displays data as scientific notation. The number of decimal places is set in the Decimal Places edit box.



12.00e+ 0
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Displays data with a fixed number of decimal places. Set the number of decimal places in the Decimal Places edit box. The number of decimal places allowed is limited by the column width—the maximum number of decimal places cannot exceed the column width. The default setting for decimal places is two.



12.00



General



Displays data exactly as you enter it in the worksheet.



12



To set the numeric display for your worksheet: 1.



View the worksheet.



2.



On the Tools menu, click Options. The Options dialog box appears.



Figure 3–13 Selecting Numbers Display Format



3.



Click the Worksheet tab.



4.



In the Settings For list, click Numeric.



5.



To set the numeric display, select a Numeric format setting from the Display As drop-down list.



6.



To use engineering scientific notation for worksheet values, select Engineering Notation.



7.



Click OK to accept the settings and close the dialog box.
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Changing Date and Time Display



SigmaPlot has a variety of date/time displays. When you enter a value into a date/ time formatted cell, SigmaPlot assumes internal date/time information about that value from the year to the millisecond. For example, if you enter a day and month, you can display the month and year. To view and modify the current settings: 1.



On the Tools menu, click Options. The Options dialog box appears.



Figure 3–14 Selecting a Date Display Format



2.



Click the Worksheet tab.



3.



In the Show Settings drop-down list, click Date and Time.



4.



To change the display Date format, type one of the following examples into the Date box, or select a format from the drop-down list:



Typing:



Displays:



M/d/yy



No leading 0 for single digit month, day or year



MM/dd/yy



Leading 0 for single digit month, day or year



MMMM



Complete month



dddd



Complete day



yyy or yyyy



Complete year
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Three-letter month



ddd



Three-letter day



gg



Era (AD or BC)



5.



6.



Day Zero



To change the display Time format, type one of the following examples into the Time box, or select a format from the drop-down list:



Typing:



Displays:



hh or h



12 hour clock



HH or H



Military hours



mm or m



Minutes



ss or s



Seconds



uu or u



Milliseconds



H: h: m: s: or u



No leading zeroes for single digits



HH: hh: mm: ss: uu



Leading zero for single digits



tt



Double letter AM or PM



t



Single letter AM or PM Click OK to accept the settings and close the dialog box.



Setting a Start Date is only necessary if you are importing numbers to be converted to dates, or converting dates to numbers for export. The starting data must match the date used by the other application.
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 Worksheet Basics Select a date from the Day Zero drop-down list, or type your own start date. The default start date is 1/1/1900. Figure 3–15 The Day Zero Drop-down List



Day Zero becomes the number 1.00 when you change from Date and Time to Numbers format. The basic unit of conversion is the day; that is, whole integers correspond to days. Fractions of numbers convert to times. Zero and negative numbers entered into the worksheet convert to days previous to the Day Zero start date. Conversion between date/time values and numbers can occur for the calendar range of 4713 BC to beyond the year 4,000 AD. The internal calendar calculates dates using the Julian calendar until September, 1752. After that, dates are calculated using the Gregorian calendar.



Σ



If you convert numbers to dates, a start date is applied. If you convert the dates back to numbers, be sure you use the same start date as when you converted them, or they will have a different value.



Regional Settings



Drop-down lists in the Options dialog box worksheet tab use the current date/time settings in your operating system. The Windows Regional Settings control date/ time delimiters, 12 or 24 hour clock, and AM/PM display. Date and time display formats may be affected by your operating system’s Regional Settings. For example, if your Time Zones are specified as British (English), your date values appear as dd/mm/yy. If the setting is US (English), your date values appear as mm/dd/yy. If you want to view or modify the current settings, or view alternative settings available on your system, click the Regional Settings button, or modify them directly from the Windows Control tab.
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Σ Switching Between Date and Time and Numeric Display



Date and time values appear on the worksheet using the date and time delimiters, generally a forward slash (/) or colon (:). For more information on entering dates and times, see Entering Dates and Times on page 57. You can convert between date/time and numeric display when: ➤



Importing data Switching numbers to dates ➤ Modifying the display between date, time and date/time ➤



To display worksheet cells in Date and Time format: 1.



View the worksheet.



2.



Select the data you wish to display in date/time format.



3.



On the Format menu, click Cells. The Format Cells dialog box appears.



Figure 3–16 The Format Menu Cells Dialog Box



4.



Click the Data tab.



5.



In the Type list, click Date and Time.



6.



Select date and time formats from the Date and Time drop-down lists. The sample box changes according to your choice.



7.



Click OK. The data is displayed showing the date, time, or date and time as specified.



Displaying Worksheet Data 73



 Worksheet Basics The dates and times that are entered as dates and times are automatically displayed as such.



Using Date/Time Format with Other Programs



You can copy date/time values from a SigmaPlot worksheet and paste them into other programs, such as an Excel workbook, or, you can copy date/time values from another program and paste them into a SigmaPlot worksheet. If the date/ time format you are pasting is larger than the worksheet column width, you may need to change the column width. If you are copying date/time values from another program to SigmaPlot, make sure that the program is displaying dates/times in a format that SigmaPlot accepts as valid data entry. For example, if you are pasting dates from Excel, make sure the dates are displayed as numbers separated by slashes (/), or whatever date delimiter Windows is set to. To change Excel formats, see your Excel reference, or, with an Excel worksheet active in SigmaPlot, choose Microsoft Excel Help from the Help menu to view the topic about Date and Time formats. Keep the following in mind when copying or importing date and time formatted data: ➤



Pasted or imported numeric data does not automatically convert to Date and Time format. You must be convert it using the same start date (Day Zero) that is used by the other program. ➤ When copying worksheet values, values are copied as numeric strings, not date/time. ➤ SigmaPlot recognizes Date and Time formats imported from Excel, but you will need to convert most other non-text dates and times from numbers to dates and time.



Setting Row and Column Size



To set row and column size for a selected block of data: 1.



Select a block of data on the worksheet.



2.



On the Format menu, click Cells. The Format Cells dialog box appears.



3.



Click the Rows and Columns tab. The Selected box reflects the selected block of rows and columns.



4.



Set column width and row height from the Column Width and Row Height drop-down lists.



5.



To apply the row and column formats to the whole worksheet, select Apply to Enter Worksheet.
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 Worksheet Basics Figure 3–17 The Format Menu Cells dialog box Rows and Columns tab



6.



Click OK to apply the changes and close the dialog box. The worksheet appears with new column and row sizes for the selected cells.



Changing Graph Appearance



Setting row height and column width from the Format Cells dialog box only changes the selected block of data. Set row and column defaults on the Appearance tab in the Tools menu Options dialog box. For more information, see Sizing Columns and Rows on page 66.



Selecting a Block of Data



0



There are several ways to select a block of worksheet cells. You can: ➤



Drag the mouse over the desired worksheet cells while pressing and holding down the left mouse button.
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Hold down the Shift key and press the arrow, PgUp, PgDn, Home, or End keys. ➤ Use the Go To command (see page 56). Figure 3–18 Selecting a Block of Data in the Worksheet



To select an entire column: 1.



Move the pointer above or below the column:



2.



Click or drag to highlight the desired column(s).



To select entire rows: 1.



Move the pointer to the left of the rows:



2.



Click or drag to select the desired row(s).



To select all the data in the worksheet: ➤



Click the worksheet icon in the upper left corner of the window.



To select the entire worksheet: ➤
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Sorting Data



0 Sort selected blocks of data in ascending or descending order according to the order in a key column.



Σ



Because the sort command sorts data in place, if you want the original data to remain intact, copy the data to a new location and sort the copied data. To sort selected data: 1.



Use the mouse or keyboard to select the data you want to sort. Only the selected columns and rows are sorted; unselected values within a column are ignored.



2.



On the Transforms menu, click Sort Selection. The Sort Selection dialog box appears.



Figure 3–19 The Sort Selection Dialog Box



3.



Select the key column by choosing the appropriate column title or column number from the Key Column drop-down list, or by typing the column title or column number in the Key Column box.



Σ



If you sort more than one column of data, the key column is used as the sorting index for all other selected data. The selected rows in any other columns are sorted according to the rows in the key column.



4.



Select either Ascending or Descending to sort your data in order of increasing or decreasing values.



5.



Click OK to sort the data in place and close the Sort Selection dialog box.
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Cutting, Copying, Pasting, Moving, and Deleting Data



0



Use the Edit menu commands to Cut, Copy, Paste, and Delete a selected cell or block. You can also use the Ctrl+X, Ctrl+C, and Ctrl+V shortcut keys or the toolbar buttons.



The Windows Clipboard Cutting and Copying Data



The Clipboard retains the last cut or copied objects. Subsequent cuts or copies overwrite the current Clipboard contents. For information about the Clipboard, see see Cutting, Copying and Pasting Graphs and other Page Objects on page 111. Cut removes a selected cell or block from the worksheet and copies it to the Clipboard. Copy copies data to the Clipboard without deleting it from the worksheet.



Pasting Data



To paste data, click or move the worksheet cursor to the cell where you want to paste the data, or to the upper-left corner of the block. On the Edit menu click Paste, click the Paste button on the Standard toolbar, or press Ctrl+V. Any data in the Clipboard is placed in the worksheet.



Moving Data



Move a block of data by cutting it, selecting the upper-left cell of the new location, then pasting the block. To learn more about inserting and deleting entire blocks of data, see the following section, Inserting Blocks of Cells, Columns, and Rows of Data on page 78.



Deleting Data



Use the Clear command to permanently erase selected data. This operation does not copy data to the Clipboard, and is faster than cutting.



Inserting Blocks of Cells, Columns, and Rows of Data



0



You can insert blank blocks cells, rows, and columns into the worksheet, and fill them with data. If you're moving and copying cells, you can insert them between the existing cells to avoid pasting over data. To insert a column, row, or blocks of cells into the worksheet: 1.



Drag the mouse over the region where you want the empty block of cells, column, or row to appear. The selected region of cells indicates exactly which cells will be inserted.



2.



On the Insert menu, click Cells.
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 Worksheet Basics The Insert Cells dialog box appears. Figure 3–20 Inserting an Empty Block of Data in the Worksheet



3.



Select the direction you want the existing data to shift when the cells are inserted, or to insert an entire column or row, select Insert Columns or Insert Rows. The column, row, or block of cells appears on the worksheet.



Figure 3–21 The Result of Inserting an Empty Block with Cells Shifted Down



Using the Shortcut Menu to Insert Data



You can insert columns by using the shortcut menu. Inserting columns shifts existing columns to the right. To insert data: 1.



Right-click the column number or title.
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 Worksheet Basics 2.



On the shortcut menu, click Insert Columns. The Insert Columns dialog box appears.



Figure 3–22 Insert Columns Dialog Box



3.



Specify the number of columns you want to insert in the Insert Columns box.



4.



Select which column to place the new columns in front of in the Before drop-down list.



5.



Click OK to insert the columns.



Deleting Blocks of Cells, Columns, and Rows of Data When you delete blocks of cells, columns, and rows, you are also permanently erasing the data. It will not be available on the Clipboard. To delete columns, rows, and blocks of cells from the worksheet: 1.



Drag the mouse over the block of cells, column, or row you with to delete.



2.



On the Insert menu, click Delete Cells. The Delete Cells dialog box appears.



3.



Select the direction you want the existing data to shift when the block is deleted, or to delete an entire column or row, select Delete Columns or Delete Rows.



4.



Click OK delete the block, columns, or rows. The existing data shifts in the specified direction.



Using the Shortcut Menu to Delete Data



You can delete columns by using the shortcut menu. Deleting columns shifts existing columns to the left. To delete columns: 1.



Right-click the column number or title.



2.



On the shortcut menu, click Delete Columns.
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 Worksheet Basics The Delete Columns dialog box appears. 3.



In the Delete columns list, specify the column or starting column of the block you want to delete.



4.



Click OK.



Switching Rows to Columns



0



You can rearrange data from a row-oriented format to a column orientation, or vice versa. When you swap data, SigmaPlot pastes contents with the row and column coordinates transposed. To swap data column and row positions: 1.



Select the block of data to transpose.



2.



Cut or copy the selected data.



3.



Select the cell where you want to begin pasting the data,



4.



On the Edit menu, click Transpose Paste. The data is pasted to the worksheet with the column and row coordinates reversed.



Removing Outliers and Other Data



0



You can manually omit or ignore an outlying point or group of points by converting the number to a text cell which removes the data point from both graphing and computation. To remove or ignore an outlier: 1.



Find the outlier on the graph, then click it to select the curve, pause, and then click again (do not double-click).



2.



View the worksheet.
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 Worksheet Basics The data for the selected symbol is indicated with colored highlighting. Figure 3–23 Selecting Data Points on a Worksheet



3.



Select the highlighted worksheet cell(s), then on the Format menu, click Cells. The Format Cells dialog box appears.



Figure 3–24 Format Cells Dialog Box



4.



Select Text from the Type list, then click OK. This converts the number to text characters; you can tell this if the alignment
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 Worksheet Basics of the cell changes to be left aligned. Figure 3–25 Graph with Removed Outlier



The data point is no longer plotted, and if you perform additional statistics on the graph, the data point will also be ignored.



Highlighting Outliers



Another way to remove an outlier is to cut the data and move it to another part of the worksheet. This is useful if you still want to plot the data but ignore the outlier. Then you can plot the moved outlier data a second plot to continue displaying the outlying data. To plot outlier data as a separate plot: 1.



Identify the worksheet cell(s) corresponding to the outlier(s). For more information, see Removing Outliers and Other Data on page 81.



2.



Select (highlight) the cells, and press Ctrl+X to cut them.
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 Worksheet Basics 3.



Move to another location in the worksheet and paste the data.



4.



Plot the outlier data by adding it as a second plot to your graph. Change the symbol color or other attributes to distinguish the data.



Figure 3–26 Moving Outlier Data to a Different Part of the Worksheet



Figure 3–27 Highlighted Outlier
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Entering and Promoting Column and Row Titles



0



Column and row titles label and identify columns and rows of data. Column titles appear in the Graph and Regression Wizards when you pick columns, identify columns for legends, and can be used instead of column numbers in transforms. To enter or edit a worksheet column or row title, double-click the title, and enter or edit the title. Press Enter to accept the new title. Labeling worksheet columns keeps previous number of column with the new added name. You must use at least one text character in every column title. If you need to use a number as column title, type a space character (by pressing the space bar) before the number.



Using the Column and Row Titles Dialog Box



You can enter and edit column and row titles using the Column and Row Titles dialog box. To enter or edit a column title: 1.



On the Format menu, click Column and Row Titles. The Column and Row Titles dialog box appears.



2.



Click the Column tab.



3.



Enter the column title in the Title box.



4.



To edit an existing title, move to that column by clicking the Next or Prev buttons, then edit the title.



5.



Click OK to close the Column Titles dialog box when you are finished editing column titles.



To enter or edit a row title: 1.



On the Format menu, click Column and Row Titles. The Column and Row Titles dialog box appears.



2.



Click the Row tab.



3.



Enter the row title in the Title box.



4.



To edit an existing title, move to that row by clicking the Next or Prev buttons, then edit the title.



5.



Click OK to close the Column and Row Titles dialog box when you are finished editing row titles.
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Using a Worksheet Row for Column Titles



Enter labels into a row, then use that row for worksheet column titles. This is useful for data imported or copied from spreadsheets. All the cells of the selected row are promoted, not just those cells which contain column titles. This may effect other data sets in the worksheet. To use a row for column titles: 1.



If necessary, enter the column titles you want to use in a single worksheet row.



2.



Select the cells in the row you want to use as column titles.



3.



On the Format menu, click Column and Row Titles. The Column and Row Titles dialog box appears.



Figure 3–28 Using Row Contents as Column Titles



4.



Click the Column tab. The row you wish to promote appears in the Promote row to titles box.



5.



To delete the original row once it has been promoted, select Delete Promoted Row.



6.



Click Promote. The selected row contents appear as column titles and the Column and Row Titles dialog box closes.



Using a Worksheet Column for Row Titles



Enter labels into a column, then use that column for worksheet row titles. This is particularly useful for data imported or copied from spreadsheets.
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 Worksheet Basics All the cells of the selected row are promoted, not just those cells which contain column titles. This may effect other data sets in the worksheet. To use a column for row titles: 1.



If necessary, enter the row titles you want to use in a single worksheet column.



2.



Select the cells in the row you want to use as row titles.



3.



On the Format menu, click Column and Row Titles. The Column and Row Titles dialog box appears.



Figure 3–29 Using Column Contents as Row Titles



4.



Click the Row tab. The column you wish to promote appears in the Promote column to titles box.



5.



Select Delete Promoted Column to delete the original column once it has been promoted.



6.



Click Promote. The selected column contents appear as row titles and the Column and Row Titles dialog box closes.



Using a Cell as a Column or Row Title



Use the Column and Row Titles dialog box to promote individual cells to column and row titles.
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 Worksheet Basics To promote individual cells: 1.



Click the cell on the worksheet that you want to promote to a column or row title.



2.



On the Format menu, click Column and Row Titles. The Column and Row Titles dialog box appears.



3.



Click the Row tab to promote a row cell to title; click the Column tab to promote a column cell to a title.



4.



Click Promote. The the content of the cell appears as the column title.



5.



Select Delete Promoted Column or Delete Promoted Row to delete the original cell once it has been promoted.



6.



Click Next or Prev to move to the next desired column or row, then follow steps 2 through 4.



Using Excel Workbooks in SigmaPlot



0



SigmaPlot supports Microsoft Excel workbooks which you can use to create graphs, run transforms, and perform regressions and other statistics on your data. Most Excel commands are available when Excel workbooks are viewed, as are the Excel toolbars. The SigmaPlot Graph, Statistics, and Transforms menus are
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 Worksheet Basics also available. When an Excel worksheet is in focus, all keyboard shortcuts are assigned to Excel’s hotkeys, not SigmaPlot’s. Figure 3–30 A New Excel Worksheet in SigmaPlot



Σ



Excel workbooks created by SigmaPlot are initially limited to a single worksheet. Excel workbooks with multiple worksheets that are opened by SigmaPlot as notebooks retain all sheets, but only the first sheet can be used for graphs and statistics. To open a new Excel worksheet: ➤



Unprotecting Excel Workbooks



Click the New Excel Worksheet



button on the Standard toolbar.



You cannot add, delete or move Excel worksheets or macros within workbooks within SigmaPlot until you unprotect the workbook. However, if you choose to unprotect an Excel workbook, do not delete the worksheet that is used by SigmaPlot. To unprotect an Excel workbook: 1.



Open an Excel workbook.



2.



On the Excel Tools menu, click Protection, and then click Unprotect Workbook.
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Using Excel as Default Workbooks



You can use Excel workbooks as the default SigmaPlot worksheet. To set Excel as the default worksheet: 1.



Close all open Excel workbooks.



1.



On the SigmaPlot Tools menu, click Options. The Options dialog box appears.



Figure 3–31 Selecting Excel Workbooks as the Default Worksheet for New Notebook



2.



Click the System tab.



3.



Select New Notebooks use Excel Workbook.



4.



Click OK to apply the changes and close the dialog box. All new notebooks will use Excel workbooks as the default worksheet.



Opening Other File Types With Excel



Using an Excel workbook as the default SigmaPlot worksheet, you can use Excel’s Open options and also open file types available to Excel. The following file types use the Excel Import filters if Excel workbooks are the default worksheet: ➤



MS Excel ➤ Lotus 1-2-3 ➤ dBase
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Plain Text ➤ SYLK Opened data files automatically appear in a new Excel workbook in a new notebook file.



Σ SigmaPlot Functionality within Excel Workbooks



To format data that opens into a single column, on the Excel Data menu, click Text Columns. To understand how Excel works with other applications, please see your Excel documentation. The following functions are unavailable when working with data in an in-place active Excel workbook: ➤



You cannot insert graphic cells into an Excel workbook for customized sequences of colors, lines, symbols, and patterns. When an Excel workbook is the active window, there is no Edit menu Insert Graphic Cells command. ➤ An Excel workbook does not have an associated Statistics worksheet. To view statistics for data in an Excel workbook, use Excel’s own statistics, or copy and paste the data into a SigmaPlot worksheet. To display the statistics worksheet for the active SigmaPlot worksheet, on the View menu, click Statistics.



Additional Features With Excel 97



Within sigmaPlot, you can use Excel’s advanced Print functions. You can also export Excel workbooks to the Excel *.XLS file format with the File menu Export command. Printing Excel Workbooks: To specify page setup functions for the active Excel workbook, on the File menu, click Page Setup to open the Page Setup dialog box. You can modify page, margins, headers and footers, and sheet settings.



Figure 3–32 Setting Printing Options Using Excel’s Page Setup Dialog Box
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 Worksheet Basics Exporting Excel Workbooks: You can export in-place active Excel workbooks to Excel’s native *.XLS file format, as well as any other format supported by Excel. To export Excel Workbooks: 1.



View the Excel worksheet.



2.



On the File menu, click Export. Excel’s Save As dialog box appears.



Σ Excel Toolbars



3.



Select the desired format from the Save as type drop-down list.



4.



Specify the drive and directory in which to save the file.



5.



Enter a file name.



6.



Click Save to save the file.



Under Excel 5.0, export and page setup are not available. An Excel workbook in SigmaPlot always uses Excel toolbar default settings of your last Excel session You can view any of Excel’s toolbars by choosing View/Toolbars. Select a toolbar to use from the Excel Toolbars dialog box; the toolbars appear near the workbook window.



Σ Creating SigmaPlot Graphs With Excel Workbooks



Switching from or closing an Excel workbook hides any Excel toolbars you may have displayed. An Excel worksheet works the same as a SigmaPlot worksheet when creating graphs. You can pre-select data before beginning a graph, or click or highlight columns from the Graph Wizard.
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 Worksheet Basics You can also create SigmaPlot graphs using Excel. For more information, see Creating SigmaPlot Graphs Using MicroSoft Excel on page 189. Figure 3–33 PIcking Data to Plot From an Excel Worksheet



Using Transforms on Data in Excel Workbooks



You can perform Transform menu commands and user-defined transforms on data in Excel worksheets. The transform language uses syntax which refers to columns numerically, or by the column titles currently assigned. When prompted to pick columns, you can select columns as you would on a SigmaPlot worksheet. To perform user-defined transforms on an Excel worksheet, use the corresponding column number in place of the column letter that appears in the gray heading area at the top of the column. For example, the transform function: col(1)=data(1,100) corresponds to inserting data values from 1 to 100 into column A of an Excel workbook. For more information, see the Programming Guide.



Using Statistics



You can use the statistics menu commands, including the Regression Wizard, with Excel worksheets.
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 Worksheet Basics When prompted to pick columns, select the columns from the Excel worksheet just as you would from a SigmaPlot worksheet. Results for statistics can be placed in Excel worksheets as well. Figure 3–34 Using the Regression Wizard with an Excel Worksheet
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Graph Page Basics Use Graph Pages to display and modify graphs that plot data from your worksheets. You can create as many graph pages as you wish per worksheet. New graph pages are associated with the current worksheet, and are placed in the current notebook section. This chapter describes how to work with graph pages, including: ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤



Setting page options (see page 96) Selecting page objects (see page 97) Adding another page to a graph (see page 102) Zooming in and out (see page 103) Using graph pages as templates(see page 105) Cutting, copying, and pasting graphs and other page objects (see page 111) Using OLE to paste, link, and embed objects (see page 112) Dragging and dropping graphs (see page 122) Hiding and deleting objects from pages (see page 123) Drawing objects on the page (see page 125) Modifying object colors and lines (see page 127) Moving and sizing graphs and objects (see page 131) Moving objects to the front or back (see page 134) Grouping and ungrouping objects (see page 135) Aligning page objects (see page 135) Arranging graphs (see page 137) Creating text labels (see page 143) Editing automatic graph legends (see page 148) Changing graph page format (see page 154) Using custom colors (see page 158)
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About Graph Pages



Graph pages are true graphical representations of a printed page that contain graphs, text, and other drawn and pasted objects. You can select objects on graph pages and modify them using the Graph and Object properties dialog boxes, and with the graph and drawing toolbars. You can manipulate all objects graphically using your mouse. A page can contain an unlimited number of graphs and other objects, and you can create an unlimited number of pages for each worksheet. You can also paste graphics, OLE (Object Linking and Embedding) objects, and other objects onto a page. Graph pages are created in several ways. Notebook Basics on page 37, describes a new graph page as a notebook item; see Creating a New Section on page 41. You can also create graphs using the Graph Style Gallery; see Creating Graphs Using the Graph Style Gallery on page 182. This chapter describes how to create a new graph page using templates; see Using Graph Pages as Templates on page 105.



Setting Page Options



0



Control graph page properties are using the Options dialog box Page tab. To open the Options dialog box, on the Tools menu, click Options, and then click the Page tab. Figure 4–1 Options Dialog Box Page Tab



Units: Sets the unit of measurement for rulers on the graph page (inches, millimeters, or points). These units appear in the Graph Properties and Object Properties dialog boxes. See Working with Page Objects on page 97.
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 Graph Page Basics Page Undo: Select to make available the Undo and Redo commands for changes you make to the graph page. Disabling Undo and Redo can speed graph page operations significantly; however, you cannot undo page editing. Stretch Maintains Aspect Ratio: Select to maintain the vertical-to-horizontal ratio of resized objects when dragging a selected graph with corner handles. Clear to resize objects disproportionately. Graph Object Resize with Graph: Select to automatically resize objects (axis labels, tick labels, the graph title, and the automatic legend) associated with the graph when resizing it. Clear to size objects individually. Show Rulers: Select to display horizontal and vertical rulers at the page window borders on the top and left-hand side of the page. Clear to keep the rulers hidden. Show Grid: Select to display grids on the graph page as either dots or lines in units as specified in the Units scroll-down list. Clear Show Grid to keep the grids hidden. Grid Density: Sets the interval and spacing for both x and y grid directions. You can choose a density value from the drop-down list, or enter any legitimate value. Color: Sets the color of the grid. You can change the grid from its default color of Cyan to another color available from the drop-down list. Snap-to: Select to “snap” all drawn, resized, or moved objects to the nearest grid point. When drawing or resizing, the current dragged corner or edge is snapped. When moving an object, the upper left corner is snapped.



Working with Page Objects



0



Using SigmaPlot menu commands, dialog boxes, and wizards you can create and modify graphs and other page objects. The Graph Wizard guides you in selecting the type and style of graph, and in adding plots and axes. The Graph Properties dialog box customizes the plots, axes, grids planes, titles and legends of your graph. Use it for more advanced modifications to your graph. The Object Properties dialog box modifies many graph attributes including drawn objects.
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 Graph Page Basics The Text Properties dialog box modifies font and paragraph text attributes for all text on a page. Use the Edit Text dialog box to enter and modify most text.



Selecting Page Objects



When you select text, drawn objects, or individual elements on the graph page, and then double-click, you open the dialog box specific to that element. To select a graph element, make sure you are in selection mode by clicking the Page toolbar Select Object button, or choose the Tools menu Select Object command, or press Ctrl+B. A check mark next to this command indicates that you are in selection mode. Selected objects are surrounded with square handles; selected axes and text are surrounded by dotted lines.



Figure 4–2 Selecting an Axis



Selecting Multiple Objects: To select multiple objects, hold down the Shift key while clicking objects, or drag a window completely around the objects you want



98 Working with Page Objects



 Graph Page Basics to select. When you select multiple objects, only the last selected object has solid black handles; the other objects have hollow handles. Figure 4–3 Selecting Multiple Objects



You can edit, copy, paste, move, size and scale, delete or hide all selected page objects, including graphs, text, drawn objects, and pasted objects. The following table summarizes the results of selecting various objects on the graph page.



Graph Wizard



Select:



By:



Opens:



Graphs



Double-click



Graph Properties dialog box/Plots tab



Plots



Double-click



Graph Properties dialog box/Plots tab



Axes



Double-click



Graph Properties dialog box/Axes tab



Tick marks



Double-click



Graph Properties dialog box/Axes tab



Tick labels



Double-click



Graph Properties dialog box/Axes tab



Axis titles



Double-click



Edit Text dialog box



Legends



Double-click



Edit Text dialog box



Fills or Lines



Right-click



Object Properties dialog box



The Graph Wizard guides you through a series of dialog boxes to select the type and style of graph, and to select worksheet data for plotting. After you create the graph, you can open the Graph Wizard to add or modify plots and axes. Chapter 5, Creating and Modifying Graphs discusses using the Graph Wizard at length.



Working with Page Objects 99



 Graph Page Basics Figure 4–4 The Graph Wizard Displaying a List of Graph Types



Graph Properties Dialog Box



To open the Graph Properties dialog box, double-click anywhere on the graph, or on the Graph menu, click Graph Properties. The Plots, Axes, and Graph tabs offer many customizing features. The tab that appears depends on where you click on the graph.



Figure 4–5 Graph Properties Plots Tab



For in-depth information, see Modifying Graphs on page 18.



Object Properties Dialog Boxes



Use the Object Properties dialog box to make simple modifications to the objects and graphs. The Line and Fill tabs change fill patterns, lines of your plots and objects. The Size and Position tab changes position, scaling and size for all objects. To open the Object Properties dialog box, select an object on the graph
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 Graph Page Basics page, right-click, and then on the shortcut menu, click Object Properties. Figure 4–6 Object Properties Dialog Box



For more information see Drawing Objects on the Page on page 125.



Text Properties Dialog Box



Use the Text Properties dialog box to change attributes of non-editable text, as well as attributes for multiple text labels, and making global text changes. Selecting text properties with no selected text sets the default attributes for new text labels.



Figure 4–7 Text Properties Dialog Box Font Tab



For more information on the Text Properties dialog box, see Formatting Text on page 146.



Edit Text Dialog Box



Use the Edit Text dialog box to create new text labels and edit existing labels. Open the Edit Text dialog box using the text tool, or by double-clicking a title or label.
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 Graph Page Basics You can format individual characters within a text string by selecting the text, and using the text toolbar buttons in the dialog box. Figure 4–8 Edit Text Dialog Box



Use the Edit Text dialog box to: ➤



Create and edit text labels. Edit graph and axis titles. ➤ Modify automatic legend labels. ➤



For more information on entering and editing text, see Arranging Graphs on page 137.



Adding Another Graph to a Page



0



You can add additional graphs to the current graph page by: ➤



Creating a new graph onto the current page. Copying a graph to the same page. ➤ Copying and pasting a graph from another page. ➤



To learn about adding additional plots to the same graph, see Adding New Plots on page 196.



Creating a New Graph for the Current Page



If you want to add a graph to a page by creating a new graph, first add the data for the new graph in the worksheet associated with the current graph page. View the active graph page, then either select a graph from the graph toolbars, choose the Graph menu Create Graph command, or click the Graph Wizard button . To learn more about graphs, see Creating and Modifying Graphs on page 163.



Copying a Graph on the Same Page



One of the quickest and the easiest ways to add a second graph is to copy the one you have already created, then modify it; see Cutting, Copying and Pasting Graphs and other Page Objects on page 111.
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Copying and Pasting a Graph from One Page to Another



You can copy a graph from a graph page within the current notebook section, or from a different notebook section. To copy a graph from one page to another: 1.



Select the graph you want to copy.



2.



Press Ctrl+C.



3.



Make the destination page the current page either by opening it, or if it is already open, select the graph page name from the Window menu. A check mark next to the page name indicates that it is the active window.



Σ 4.



If the destination page is in a different notebook than the source page, you must close the source page, and any other open work in the source notebook. Press Ctrl+V to paste the graph. The graph appears on the current page, and the graph data appears in the worksheet associated with the current page. Another method is dragging and dropping, as described in Dragging and Dropping Graphs on page 122.



Zooming In and Out



0



Use SigmaPlot View menu commands to control display of the worksheet window. You can view the page at several different levels of magnification, magnify the page centering on a specified page location, or choose a completely unobstructed view of the page.



Viewing the Full Page



To view the full page without toolbars, title bars, scroll bars, or the status bar, on the View menu, click Full Screen. The page appears without any obstructions. To return to normal view of the page, press any key on the keyboard. The screen returns to its normal appearance.



Magnifying the Page



There are three ways to change the magnification of the entire graph page: ➤



Select a zoom level from the toolbar drop-down list. You can also enter a custom zoom anywhere between 10 to 2500. ➤ Click the Custom Zoom button on the Standard toolbar to zoom in on a specific region of the page. The pointer changes to a magnifying glass; select
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 Graph Page Basics a region on the page by dragging the mouse, then release the mouse button. The region is zoomed to the selected area. Figure 4–9 Using the Zoom Pointer to Select a Region on the Page



➤



Use keyboard shortcuts while viewing the page window. The zoom keyboard shortcuts to view the page are: ➤ At 50% actual size, press Ctrl+5. ➤ At 100% actual size, press Ctrl+1. ➤ At 200% actual size, press Ctrl+2. ➤ At 400% actual size, press Ctrl+4 ➤ Entire page, press Ctrl+F ➤ Magnified for a specific region, press Ctrl+U



Using the Zoom Dialog Box



Use the Zoom dialog box to change the zoom level to fixed or custom levels. To change the zoom: 1.



On the View menu, click Zoom. The Zoom dialog box appears.



Figure 4–10 The Zoom Dialog Box



2.
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Choose the desired zoom level to fit the page to the window, or to zoom to a full screen view. Select Custom and move the slider or enter a specific zoom



 Graph Page Basics level to set a percentage of magnification. Figure 4–11 Graph Page Zomed to 200%



Using Graph Pages as Templates



0



Graph page templates simplify graph and graph page creation and modification. You can use templates to create pages and graphs with preset properties. For example, if you need to create a set of slides, you can open pages that are already set to attributes for slides.



Σ



Never use templates to add a graph to a page. Template pages are ordinary graph pages. Any graph page can act as a template page if it is copied to a section or used from the File menu New command to create a new page. All attributes from the page - size, color, margins, and orientation - are retained. Any graphs and other objects on the page are also duplicated. Template graphs automatically plot the worksheet column data that was selected when the graph was created. When applying a page to a worksheet, make sure your data is already arranged as required, or repick the data for the graph after applying the template. You can determine which columns are plotted by either looking at the worksheet footers, or you can open the Graph Properties dialog box for the template graph, and click the Plots tab, and then under Settings for, click Data.
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Σ How to Apply Templates



Graphs created by templates can be modified like any other graph. See Creating and Modifying Graphs on page 163. There are three methods for using pages as templates:



Method



Result



Using a template from the New Page command.



Creates a new page with attributes from the template applied.



Copying a graph page from one notebook section to another.



Creates a new page in a section, using the data in the existing worksheet for graphs.



Overwriting an existing page.



Replaces the existing page.



To create a new page with attributes from a template: 1.



On the File menu, click New. The New dialog box appears.



Figure 4–12 New Dialog Box



2.



Select Graph Page from the New drop-down list.



3.



Select the type of graph page you want to open from the Type scroll-down list.



4.



Click OK.



Copying a Page: The best method of applying a page template to a worksheet is to use an existing graph page as a template. The copied page acts as a template using the worksheet in the new section. For information on copying pages and other notebook items, see Copying, Pasting and Removing Notebook Items on page 45.
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Σ



If you plan to copy a page, set up your worksheet so that the data is in the appropriate columns before applying the template. You can also change the columns to plot after applying a template by selecting the plot, opening the Graph Properties dialog box, and using the Graph Wizard button. For more information on picking different columns to plot, see Picking Different Data for the Current Plot on page 194. Overwriting an Existing Page: When you apply a template to an existing graph page, all features of the existing page are lost. To apply a template to an existing page: 1.



Make the graph page the active window.



2.



On the File menu, click Templates. The Templates dialog box appears.



Figure 4–13 The Templates Dialog Box



3. Select a template from the Templates list. 4.



Click Apply.



To apply a template from a different notebook template file: 1.



Make the graph page the active window.



2.



On the File menu, click Templates. The Templates dialog box appears.



3.



Click Browse.



4.



Select the path and file name of the desired SigmaPlot Notebook or template file.
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Templates & Notebooks



5.



Click Open.



6.



Select a template from the Templates list in the Templates dialog box.



7.



Click Apply.



Store templates as pages in notebook files with the extension .JNT. You can open and edit template notebooks like any other notebook file; the different extension is only provided for organizational purposes. A sample template notebook, Template.jnt, is provided with SigmaPlot, and is set as the initial template source notebook.



Figure 4–14 TEMPLATE.JNT Notebook



TEMPLATE.JNT is the default source for new pages. It contains both pages with no graphs and pages with graphs. You can modify existing pages or add your own graphs or graph pages to TEMPLATE.JNT. Open the file, open the page you want to modify, then save your changes. You can add files by creating new pages or by copying pages from your notebooks to TEMPLATE.JNT; see Adding New Pages to Template.jnt on page 110. You can also create your own template notebook containing your own customized graph pages. Save template notebooks as SigmaPlot Template (.JNT) files, then specify that file to be your Template File; see “Changing the Template File Used for New Pages” below.



Changing the Page Created with the New Page Button



The New Page toolbar button automatically uses whichever page is titled Normal as the source for new pages. If you want to modify the attributes of your new page, open and modify the Normal page, or replace it with the desired page.
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 Graph Page Basics If there is no page named Normal in your template file, the page is formatted according to settings found in the SPW.INI file. See Troubleshooting on page 471 for more information on modifying these settings.



Changing the Template File Used for New Pages



SigmaPlot automatically uses the template notebook when you open a graph or graph page. Set the file name in the General tab of the Options dialog box. To change the source file template: 1.



On the Tools menu, click Options. The Options dialog box appears.



Figure 4–15 Options Dialog Box General Tab



2.



Click the General tab.



3.



Type the path and file name of the desired template file in the Template File field.



4.



Click OK. The notebook becomes the default template source.



Σ



If a valid default template source file is not specified, a default page is created instead. This page is a letter-sized, white portrait page by default.
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Adding New Pages to Template.jnt



You can add a previously created page to the Template.jnt notebook. To add a page to Template.jnt: 1.



On the File menu, click Open. The Open dialog box appears.



2.



Select Template Notebook from the Files of type drop-down list.



3.



Select Template.jnt from the SPW8 folder.



4.



Click Open.



5.



Open or view the notebook file containing the page you want to add to Template.jnt.



6.



Select the page you want to copy.



7.



Press Ctrl+C.



8.



Select the section of Template.jnt where you want to add the new page.



9.



Press Ctrl+V. The page is added to Template.jnt.



10. Save and close Template.jnt. 11. On the File menu, click New. The New dialog box appears. 12. Under New, select Graph page. The page you copied appears on the list.
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Cutting, Copying and Pasting Graphs and other Page Objects0 Cut and copy selected page objects to the Clipboard using the toolbar, or by using Edit menu commands.



Cutting and Copying Graphs



To cut or copy a graph or other page object select the graph or object to cut or copy by clicking it. To cut the item, click the toolbar button, choose the Edit menu Cut command, or press Ctrl+X. To copy the item, click the toolbar button, choose the Edit menu Copy command, or press Ctrl+C. A copy of the selected graph or object or is placed in the Clipboard. Since copied items remain in the Clipboard until replaced, you can paste as many copies as you want without having to cut or copy the object each time.



Pasting Objects



You can paste Clipboard contents to any open page, report, or into any other Windows application that supports Windows Metafiles or OLE (Object Linking and Embedding). To paste an object to a page, click where you want the object to appear, then press Ctrl+V. You can also press Shift+Insert, click the toolbar Paste button, or choose the Edit menu Paste command. For more information on OLE, see SigmaPlot and OLE on page 113. To learn about pasting objects and graphs between applications in general, see Using OLE to Paste, Link, and Embed Objects on page 112.



Σ



The Clipboard is a Microsoft Windows feature. To learn more about how the Clipboard works, refer to your Windows User’s Guide.
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Using OLE to Paste, Link, and Embed Objects



0



There are various ways to paste SigmaPlot objects into other applications, and vice versa. One method is using OLE (Object Linking and Embedding), which is fully supported by the SigmaPlot page. OLE provides the ability to move or copy information among supporting applications, and to use the applications interchangeably to modify the data.



Methods Of Placing Objects



You can copy, cut, and paste graphs among applications without using OLE. The method of placing objects depends on each application’s implementation. The following table shows how objects can be placed:



Type of Object



Destination Application



OLE object



Can be placed if application supports OLE.



Windows Metafile



Can be placed if application doesn’t support OLE, but supports pictures.



Enhanced Metafile



Can be placed in Windows applications only.



Bitmap



Can be pasted in applications that support bitmaps only (for example, Microsoft Paint).



Figure 4–16 A SigmaPlot Graph with Pasted Artwork
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Σ Commands to Place Objects



SigmaPlot and OLE



SigmaPlot always pastes an OLE object if it is available. The SigmaPlot graph and report pages support OLE. Graphs (not graph pages) pasted into SigmaPlot reports are always pasted as Windows metafiles. SigmaPlot provides the following commands and functions to place, link, and embed objects on a graph or report page:



Command or Function



Definition and Use



Paste Command



Embeds an OLE object, if there is one in the Clipboard. Connects to data in the originating application but not directly to a file. If there is no OLE object in the Clipboard, a non-editable picture or text is placed.



Paste Special Command



Allows you to choose Clipboard file types and to also embed objects and links.



Insert New Object Command



Directly creates and places an OLE object without using the Clipboard. Allows embedding the object or linking to a file.



Drag and Drop



Moves, or copies any Clipboard object (usually OLE).



SigmaPlot can place and receive OLE and other types of objects, such as scanned images, clip art, or text from a word processor. For example, you can place an equation created with the Microsoft Word Equation Editor into a SigmaPlot report, and edit it with the Word Equation Editor when it changes.



Figure 4–17 Example of an Microsoft Excel Equation Embedded into a SigmaPlot Report



Linking or Embedding Objects



Use Paste Special, Insert Object, and Ctrl+Drag to either link or embed the object in the page or report.
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 Graph Page Basics Linking appears to place a copy of the object in the destination application, but actually only places a reference to it. Therefore, the object is modified every time the original file is modified. You can only link to a file if you create an object using the Paste Special or Insert New Object commands, or if you drag and drop an object with the Ctrl key held down. Linking is useful when you need to update an embedded object when the file is updated. The disadvantage of linking objects is that you cannot open a referenced file if the locations of either the SigmaPlot file and the source file change. Embedding places a copy of the object in the destination application, and then you can edit it by activating its source application when you double-click it. Embedding does not use a reference file; the “file” is actually embedded completely in the SigmaPlot file. For example, if a Microsoft Word embedded object has been placed in a SigmaPlot report, and you double-click it, Microsoft Word opens. Word temporarily runs “under” SigmaPlot. When you are finished editing the item and close Word, SigmaPlot remains open. Embedding an object has the advantage of keeping all the associated data in one place, but can create large files.



Placing SigmaPlot Objects into Other Applications



You can paste SigmaPlot graphs and reports into other applications, and link or embed them for future editing with SigmaPlot. For example, you can paste a SigmaPlot graph into a Microsoft Word document (as an OLE object), and use the SigmaPlot Graph Properties dialog box to edit it by double-clicking the graph. When you link to SigmaPlot and double-click the graph or report, the notebook file containing the graph or report opens. See Placing SigmaPlot Graphs into Other Applications on page 115. You can change the source of any linked object, with the Change Source command. See Viewing and Modifying Object Links on page 120.



View as Icon



With OLE, the View as Icon feature allows you to place an icon representing the application that created the file in your data. For example, if you have a description of a graph written in a Microsoft Word document, you can embed it, and display it as an icon that shows on the graph page. If you want the object
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 Graph Page Basics displayed as an icon, check the Display As Icon option. Click the icon to view and edit the object in its source application. Figure 4–18 Displaying a Microsoft Word Document as an Icon on a Graph Page



Identifying Objects on the Graph Page



You can determine the type of object on the graph or report page with the Edit menu Object command. Select the object, then on the Edit menu click Object. The Object command changes to reflect the file type of the selected object. For example, if you select a bitmap object, the Object command displays Bitmap Image Object.



Placing SigmaPlot Graphs into Other Applications



You can copy or cut SigmaPlot graphs to the Windows Clipboard, then paste the graph directly into another document, like a word processing or desktop publishing page, without having to do any file exporting or importing. You can also drag and drop graphs directly from SigmaPlot into any other Windows program that supports OLE. See Dragging and Dropping Graphs on page 122 for more information. To paste a graph to another application: 1.



Select the graph to cut or copy.



2.



Press Ctrl+X or Ctrl+C. The graph is cut or copied.



3.



Open or switch to the other application, and click where you want the graph to appear.



4.



Paste the graph, typically using the Edit menu Paste command. If the graph isn’t an OLE object, try the Paste Special command, and select SigmaPlot Graph or SigmaPlot Graph Object. To create a link between SigmaPlot and the other application, click the Paste
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 Graph Page Basics Link button. To insure you are pasting an OLE object, use the Paste Special command. If a Paste Special command doesn’t exist, the application probably doesn’t support OLE. Figure 4–19 Using the Paste Special Dialog Box to Paste a Graph from SigmaPlot to another program



The SigmaPlot graph appears in the other application. 5.



You can now in-place activate the graph by double-clicking it, or open it in SigmaPlot, by choosing the Edit menu Object command. If the application does not support OLE, the SigmaPlot graph is pasted as a metafile or bitmap graphic.



SigmaPlot graphs pasted with the Edit menu Paste command take their plotted data with them in the form of the plotted graph (the worksheet is not shown). If
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 Graph Page Basics you want to view or edit the data, you must open the graph rather than simply editing it. Figure 4–20 Example of a SigmaPlot Graph Pasted into Microsoft Word for Office 97 as an OLE Object



Pasting Objects onto a Graph Page or Report



You can paste contents, including OLE objects, into both page and report documents. To paste artwork, text from a word processing application, or other objects onto a graph or report page: 1.



Open the application and file containing the desired artwork or text, and cut or copy the object.



2.



Switch to SigmaPlot and view the graph or report page.



3.



Click the location where you want the object to appear, then press Ctrl+V. The graphic is pasted to the page. If the object can be an OLE object, SigmaPlot always defaults to the OLE object.



4.



To paste the object as a specified file type, choose the Edit menu Paste Spe-
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 Graph Page Basics cial command. The Paste Special dialog box appears. Figure 4–21 Using the Paste Special Dialog Box to Paste an Object from Microsoft Word to SigmaPlot



Σ 5.



Note that the options available in the Paste Special dialog box depend on the type of file being pasted.



If you want the object displayed as an icon, click Display As Icon. Click the icon to view and edit the object in its source application. You can also specify a different icon to display the pasted object. Click Change Icon and select a different icon.



6.



Σ 7.



Placing Objects without the Clipboard



Click Paste to paste the object as a specified file type. Select Paste Link to paste the object as a linked file that can be updated in another application. The options in the As list change depending on your selection of either Paste or Paste Link, and the explanation in the Result box changes depending on your selection in the As list. Select the type of object to paste from the As box, then click OK. The object appears at the selected location.



You can select objects from applications that are installed on your system and to place them into a SigmaPlot graph or report with the Insert New Object command. The object types available on your system depend on the applications installed, and appear in the Object Type drop-down list of the Insert New Object dialog box. To insert an object using the Insert Object command: 1.



View the report or graph page, and click where you want the insertion point.



2.



On the Insert menu, click New Object. The Insert Object dialog box appears.
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If you want to display the new object as an icon, select Display As Icon. You can also specify a different icon to display the inserted object. Click the Icon button to open the Change Icon dialog box. Choose a different icon from the available options, or click the Browse button to search for alternative icons on your system.



4.



To create a new object to place on the report or graph page, select Create New, then choose the type of object from the Object Type list. Click OK to open the application associated with the selected object. Create the desired object, then use the application’s appropriate Exit command to close the application and return to SigmaPlot. The created object is displayed on the graph or report page as an embedded object.



5.



To insert an object from an existing file on the report or graph page, select Create from File, then type the path and file name of the desired file in



Figure 4–22 The Insert Object Dialog Box



the File edit box, or click the Browse button to open the Browse dialog box, from which you can select the appropriate path and file name of the object you want to place. 6.



Select the Link option to place the object on the page as a linked object. When a file is linked, it is modified in your graph or report page when it is modified in the original application. If the Link option is not selected, the
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 Graph Page Basics object is pasted as an embedded object. Figure 4–23 The Insert Object Dialog Box After Selecting Create From File, with the Display as Icon Option Checked



7.



Viewing and Modifying Object Links



Click OK.



You can view and modify links with the Links dialog box. The Links dialog box displays all links associated with the current graph or report page. To view and modify links: 1.



View the graph or report page by selecting it.



2.



On the Edit menu, click Links. The Links dialog box appears displaying the path, file name, type of file, and if it is a manually updated or automatically updated link, of all links on the page.



Figure 4–24 The Links Dialog Box



If you do not have any linked objects on the page, the Links box is empty. 3.



To change the updating to either Automatic or Manual, select the unse-
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 Graph Page Basics lected option. If Automatic updating is selected, the object changes automatically when the source file is changed. If Manual updating is selected, you must use the Update Now button to update the linked object with any changes made to the source file. 4.



To edit a linked object, select the object name in the Links dialog box, then click Open Source. The source file opens in the appropriate application where you can make changes, then exit the application and return to SigmaPlot. If Automatic updating is selected, the object reflects the changes; if Manual updating is selected, you must click the Update Now button to apply changes to the linked object.



5.



To change the source file for a linked object, click Change Source. Choose the new path and file name, then click OK. The link appears in the Links dialog box with the new path and file name. You may need to click the Update Now button to view this change in your document.



6.



To end the link between an object and its source file, click Break Link.



Figure 4–25 The Change Source Dialog Box



The object is no longer treated as a linked object. 7.



Click OK to close the Links dialog box.
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Dragging and Dropping Graphs



0



Using OLE you can drag objects between compatible applications within Windows. Additionally, you can drag and drop graphs from one graph page to another. To drag a graph into another application, you must be operating within Windows or Windows NT 4, and the other application must support OLE. 1.



Make sure the other application is open and visible from the desktop, with the location where you want to drop the graph also visible.



2.



Select the SigmaPlot graph you want placed in the other program, then drag the graph from the SigmaPlot page. If you want to drop a copy of the graph, press the Ctrl key while dragging.



3.



Move the mouse to the location you want the SigmaPlot graph to appear.



4.



Release the mouse; the graph appears at the drop location. You can now edit the graph with SigmaPlot in the future by double-clicking. Note that you can also drag and drop graphs onto your Windows desktop. Dropping a graph onto the desktop creates a scrap file that can be dragged into another document at a later date.



Dragging and Dropping Graphs Between Pages



You can drag a graph from one graph page to another. If you drag a graph from a different notebook section, it will insert its data into the destination section worksheet. To copy or move a graph from one graph page to another: 1.



Open the source and destination pages. The pages must still be within the same notebook, but can be in different sections.



2.



Select the graph and drag it from the original page to the new page. If you want to copy rather than move the graph, press the Ctrl key while dragging.



3.



Release the mouse where you want the graph to appear. The graph is placed on the new page. If the page is in a different section, the data plotted by the graph is copied to the current worksheet.
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Hiding and Deleting Objects from the Page



0



You can delete drawn and pasted page objects from the page, and graphs, automatic legends, automatically created graph titles, plots, and axes can be deleted and/or hidden from view. To learn about removing and hiding axes, see Hiding, Displaying, and Deleting Axes on page 370.



Hiding and Viewing Graphs on a Page



The quickest way to hide a graph on page is to select the graph page, then rightclick the graph you want to hide, and on the shortcut menu, click Hide. To control which graphs are displayed on the page: 1.



On the File menu, click Page Setup. The Page Setup dialog box appears.



Figure 4–26 Graph Layout Tab of the Page Setup Dialog Box



2.



Click the Page Layout tab. The graphs on the current page are listed in the Shown box.



3.



To hide a graph, select it from the list and click Hide. The selected graph is moved to the Hidden list. (To select multiple graphs, hold down the Shift or Ctrl key while making selections.)



Σ



4.



To view a hidden graph, select it from the Hidden list and click Show.



5.



Click OK to apply your selections and close the Page Setup dialog box.



Note that hidden graphs do not print. To learn about showing and hiding plots, see Showing, Hiding, and Deleting Plots on page 199.



Hiding and Deleting Objects from the Page 123



 Graph Page Basics



Hiding Graph Titles and Legends



You can hide automatically generated graph and axis titles and legends from view without being permanently removed from the graph page. To hide an automatic legend or automatically created graph title: 1.



Right-click the legend or title and on the shortcut menu, click Hide. The title or legend is not deleted, only hidden.



2.



You can also hide graph titles, axis title, and legends using the Graph Properties dialog box. Open the Graph Properties dialog box by double-clicking the graph. You can also right-click the graph, and on the shortcut menu, click Graph Properties.



3.



Click the Graph Tab.



4.



Under Settings for, select Legends.



5.



To hide the graph title, clear Show Title.



6.



To hide the automatic legend, under Legend properties, clear Show Legend.



7.



To hide axis titles, select the Axes tab, under Settings for click Labels, and clear the Show Axis Title option(s).



8.



Click OK to apply the changes and to close the Graph Properties dialog box.



Figure 4–27 Hiding Graph Tiltes and Automatic Legends Using the Graph Properties Dialog Box



The titles and automatic legend no longer appear on the graph page. Restore the title and legend by returning to the Graph Properties dialog box and checking the Show Title and Show Legend options.
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Removing Graphs, Plots, Titles, Legends, and Other Page Objects



Anything on the graph page can be removed from the page by selecting the object, then pressing the Delete key, or choosing the Edit menu Clear command. Deleting removes curves, plots and graphs entirely. You can use undo (Ctrl+Z) to retrieve these items. When a graph or plot is removed, worksheet data remains intact. Delete also completely removes drawn and pasted objects. Note that delete only hides titles and legends, and does not remove them permanently.



Drawing Objects on the Page



0



Use the Tools menu Draw Box, Draw Ellipse, Draw Line, and Draw Arrow commands to draw rectangles, ellipses, lines, and arrows, or use the Page toolbar.



Σ The Page Toolbar



Any drawn object or text is not attached to the graph until they are grouped with the graph, see Grouping and Ungrouping Objects on page 135 for more information. Use the Page toolbar to quickly and easily access Tools menu commands. To learn about viewing, hiding, and positioning toolbars, see Viewing Toolbars on page 16.



Figure 4–28 Drawing Objects on a Page
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 Graph Page Basics The drawing tools on the Page toolbar buttons are:



Select Object: Use the Select Object button to select objects on the graph page.



Draw Line: Click this button to draw a line on the graph page. Draw Arrow: Click this button to draw an arrow on the graph page. Draw Box: Use the Draw Box button to draw a box on the graph page. Draw Ellipse: Click this button to draw an ellipse on the graph page. Text: Click this button to add text, labels, or manually created legends to the graph page. Drawing Objects



To draw an object: 1.



Click a drawing tool on the Page toolbar, or choose a drawing command from the Tools menu.



2.



The pointer has a crosshair appearance when over the graph page. Place the pointer over the page where you want the object to begin, press and hold down the left mouse button, then drag the pointer to draw the object.



3.



Release the mouse button to finish drawing the object.
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 Modifying Object Colors and Lines



0



Use Format menu commands or double-click selected objects to modify line type, thickness, color, line end appearance (arrow heads, etc.), object fill color, pattern, and pattern color. You can make these modifications using the Object Properties dialog box. You can also use the Graph Properties dialog box to change fill patterns and colors. To find out more, see Changing Patterns and Fill Colors on page 216.



Changing Object Fills



Σ



Change fill patterns and colors of drawn rectangles and ellipses, and of graph symbols, bars, and boxes using the Object Properties dialog box. When you select multiple objects, fill options apply to all selected objects that can be filled, including lines. To learn how to customize the color, see Using Custom Colors on page 158. To change the background color of an object fill: 1.



Select the object(s) to modify on the graph page.



2.



On the Format menu, click Fill. The Object Properties dialog box appears.



Figure 4–29 Object Properties Dialog Box Fill Tab



3.



Click the Fills tab.



4.



From the Background Color drop-down list, choose a color.



5.



Click OK to apply your changes and to close the dialog box.



To change the fill pattern of the selected object:
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 1.



Select the object to modify on the graph page.



2.



On the Format menu, click Fill. The Object Properties dialog box appears



3.



Under Foreground, from the Pattern drop-down list, choose a pattern and pattern density.



4.



Click OK to apply your changes and to close the dialog box.



To change the color of the fill pattern lines and edge lines: 1.



Select the object to modify on the graph page.



2.



On the Format menu, click Fill. The Object Properties dialog box appears.



3.



Under Foreground, from Color drop-down list, choose a color. Choose none to create a transparent pattern and edge line.



4.



Click OK to apply your changes and to close the dialog box.



To set pattern and edge line thickness: 1.



Select the object to modify on the graph page.



2.



On the Format menu, click Fill. The Object Properties dialog box appears.



Changing Lines



3.



Under Foreground, move the Thickness slider or enter a value in the Thickness box to set pattern and edge line thickness.



4.



Click OK to apply your changes and to close the dialog box.



For drawn lines and graph lines, you can change line type, color, and thickness. You can also use the Object Properties dialog box to add arrowheads and other line endings to lines. To learn about using custom colors, see Using Custom Colors on page 158. To change line color: 1.



Select the object(s) to modify:



2.



On the Format menu, click Line.
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 The Object Properties dialog box appears. Figure 4–30 Object Properties Dialog Box Line Tab



3.



Click the Line tab.



4.



Under Line, select a color from the Color drop-down list. Choose None to create a transparent line.



5.



Click OK to apply your changes and to close the dialog box.



To change line type and thickness: 1.



Select the object(s) to modify:



2.



On the Format menu, click Line. The Object Properties dialog box appears.



3.



Click the Line tab.



4.



To set the line type, under Line, select a type from the Type drop-down list.



5.



To set the line thickness, use the Thickness slider. Clicking the slider causes the slider to move incrementally, while dragging it moves it more precisely.



Σ



To change the range of control of the slider, move the slider to one end of the selectable range, select the text in the corresponding edit box, and type a new numeric value.



6.



Click OK to apply your changes and to close the dialog box.
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 Changing Line Ending Attributes



Edit line ending attributes for existing lines and arrows, or set the default line endings for drawn arrows. Line ending attributes affect only plain lines and arrows, not graph lines. To change line ending attributes: 1.



Select the line(s) to modify:



2.



On the Format menu, click Line. The Object Properties dialog box appears.



Figure 4–31 The Line End tab of the Object Properties Dialog Box



3.



Click the Line End tab.



4.



Add or edit line ends at both the start and end of a line. The Start of Line options add or modify the beginning end of the line (where you start drawing the line). The End of Line options add or modify the line end at the end of the drawn line (where you stop drawing the line by releasing the mouse button).



5.



To change the type of line used, select a style from thee Style drop-down list.



6.



To change the arrowhead length and angle, move the Angle and Length slider. The angle is the angle between the arrowhead line and the main line. The Angle option is unavailable if the line Style is dotted or plain.



Σ 7.



Clicking the slider causes the slider to move incrementally, while dragging it moves it more precisely. To change the range of control of the slider, move the slider to one end of the selectable range, select the text in the corresponding edit box, and type a new numeric value. Click OK to apply your changes and to close the dialog box.
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 Changing Multiple Page Objects



When making changes to multiple objects with different properties, the Object Properties dialog box options are blank. Only options that are changed are applied to selected objects. To learn how to select multiple objects, see Selecting Page Objects on page 98.



Moving and Sizing Graphs and Objects



0



You can modify graph or object size and position either by using your mouse on the page, or by setting specific position, size, and scaling options in the Size and Position tab of the Object Properties dialog box.



Using Your Mouse to Move Graphs and Objects



When you use your mouse to move graphs, graph titles, axis labels, and automatic legends are automatically grouped with a graph and move with it. You can move graphs and objects to other page windows.



Figure 4–32 Moving a Graph



To move a graph or object with your mouse: 1.



Select the desired graph.



2.



Drag it to the desired position. A dotted outline of the graph follows the pointer indicating the location of the moved graph.



3.



Release the mouse button. The graph moves to the new position.
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 Using Your Mouse to Change Graph and Object Size



The easiest way to adjust the size and shape of a graph is to resize the graph using the mouse. You can also specify proportional scaling of graphs and objects so that the height and width ratios are maintained, and choose to rescale graph and axis titles and tick marks accordingly. To adjust graph or object size with the mouse: 1.



View the page window.



2.



Click the graph or desired objects to select them. Selected page objects are surrounded with small square handles.



3.



Place the pointer over a handle.



4.



Press and hold down the left mouse button to drag the handle to a new location. The shape of the pointer changes when you move it over a handle, indicating the direction you can stretch the graph or object. Drag a side handle to stretch or shrink an object horizontally, drag a top or bottom handle to stretch or shrink an object vertically, or drag a corner handle to stretch an object two-dimensionally. A dotted outline of the resized graph or object follows the pointer position.



Figure 4–33 Resizing a Graph



Dragging a corner handle preserves the aspect ratio (relative height and width) of objects by default. Also, graph text, symbols and tick marks are rescaled along with the graph. To disable these features, use the Tools menu Options command and change these Page option settings; see Setting Page Options on page 96. 5.



Release the mouse button when finished. The graph or object resizes to the indicated size.
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 Σ Setting a Specific Size and Location



Unlike graphs and drawn objects, you cannot stretch or shrink text labels manually. To resize text, change the font size. To learn how to resize text, see Formatting Text on page 146.



To move a graph or object to a specific location on the page, or to scale the graph or object to a specific size, use the Object Properties dialog box Size and Position tab. To set graph size and location with the Object Properties dialog box: 1.



Select the graph or object on the page by clicking it.



2.



Right-click the selected item, and on the shortcut menu, click Object Properties. The Object Properties dialog box appears.



Figure 4–34 Object Properties Dialog Box Size and Position Tab



Nudging Graphs and Objects



3.



Click the Size and Position tab.



4.



To set the distance of the selected object from the top and the left of the page, under Position, move the Top and Left sliders or type new values in the Top and Left boxes.



5.



To change the size of the selected object, under Size, move the Height and Width sliders to set the size to specific measurements, or scale the object to a new size by typing a percentage in the Height and Width boxes.



6.



Click OK.



You can use your keyboard arrow keys to move graphs and objects on a graph page. Select the object using your mouse, and then move the object by using the



Moving and Sizing Graphs and Objects 133



 arrow keys. You can also select objects by pressing the Tab key. Press Shift+Tab to scroll back. Press Shift+Arrow to select multiple objects. Pressing an arrow key moves the graph or object one one point, or .014in. You can change this default setting in the spw.ini file. If you have activated Snap-to grids, nudge will not work unless you set the nudge value to be greater than or equal to the Snap-to value. You cannot nudge computable objects, such as plots and all parts of plots, tick marks, and regression, reference, and grid lines.



Moving Objects to the Front or Back



0



You can move selected objects so that they appear in front of or behind other page objects. To move an object to the front or back: 1.



Select the object to move by clicking it.



2.



To move the selected object to the foreground, on the Page toolbar, click Bring to Front. The selected object is drawn in front of all other objects.



3.



To move the selected object to the background, on the Page toolbar, click Send to Back. The selected object is drawn behind all other objects.



Σ



If you select more than one object, the selected objects remain in their relative front to back positions. Grouped objects, including titles and legends with graphs, move as a single object.
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 Grouping and Ungrouping Objects



0



You can move and modify selected items on the page by grouping multiple objects as one object. To individually modify grouped objects, you must ungroup them first. Objects and text must be grouped with the graph for them to stay in place, and move with the graph if you shift the graph’s location. To group and ungroup objects: 1.



On the Page toolbar, click Select Object.



2.



Select the graph, by clicking it, if you wish to attach the graph to the objects or text.



3.



Select the objects and text to group by holding down the Shift key while selecting individual objects. Handles appear around the graph and each selected object.



4.



On the Page toolbar, click Group. The Group command and button are available only when more than one object is selected. All selected objects are grouped and can be selected, moved, sized, aligned, and positioned as a single object.



To ungroup objects on a graph page: 1.



Select the group.



2.



On the Page toolbar, click Ungroup. If you have grouped a group, you may need to ungroup the objects as many times as they have been grouped.



Aligning Page Objects



0



You can align labels and objects with each other as well as with graphs and axes. To align page objects: 1.



Select the labels, graphs or other object(s) you want to align by holding down the Shift key while selecting individual objects. (You must select more than one object to use the Align command.)
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 2.



On the Page toolbar, click Align. The Align dialog box appears.



Figure 4–35 Align Dialog Box



3.



Under Horizontal and Vertical, choose the appropriate options to align the selected objects vertically, horizontally, or both. Graphical feedback for your selections appears in the lower right corner of the dialog box.



4.



To align selected objects relative to each other, select Each Other. You must have multiple objects selected if you want to align selected objects relative to each other. Each Other moves aligned objects with respect to the last selected object, which remains in a fixed position. The last selected object can be distinguished from other selected objects by solid rather than hollow selection handles.



5.



To align objects relative to the page margins rather than the page edge, select Page Margins. If you select Page Margins, objects will not move with respect to each other. You can select Page Margins to place single objects. To set margins for each page, on the File menu, click Page Setup.



6.



Click OK.



Working with Grids and Rulers Use grids and rulers to quickly and easily align graphs and objects on the page. You can show or hide grids and rulers from the Tools menu Options dialog box, View menu, or you can right-click the graph page to open the shortcut menu. Although visible on the screen, they do not print with the page. Control the grid and ruler attributes using the Tools Menu Options dialog box.



136 Working with Grids and Rulers



0



 Using Rulers



Rulers are optionally displayed at the top and left hand side of all graph pages. They display the current units set in the Tools menu Options dialog box. You can choose between inches, centimeters, or points.



Using Snap-to



You can use Snap-to if the grids are displayed or hidden. Select Snap-to in the Tools menu Options dialog box, or right-click the graph page and on the shortcut menu, click Snap-to. Graphs and objects snap to the nearest grid.



Using Crosshairs



Use Crosshairs as an object alignment tool. To turn on crosshairs, click the Crosshairs button on the upper left hand corner of the graph page window. Crosshair lines extend from the pointer tip to the rulers and to the right and bottom of the window, and follow the pointer. To hide crosshairs, click the Crosshairs button again.



Arranging Graphs



0



Use layout templates to quickly arrange, resize, and set positions of graphs on a page. Layouts, like templates, use a .jnt extension and are stored in notebooks. To learn more about templates, see Using Graph Pages as Templates on page 105. A sample layout notebook, Layout.jnt, is provided with SigmaPlot and is set as the default layout source notebook. Using SigmaPlot’s Arrange Graph dialog box and General tab on the Options dialog box, you can: ➤



Apply an existing layout template to a graph page. ➤ Add new pages to Layout.jnt. ➤ Create your own custom layout template file. ➤ Change the default template file.



Applying Layout Templates to Arrange Graphs



Use the Arrange Graphs dialog box to apply existing layout templates to a graph page. To arrange graphs on a page: 1.



Select the graph page.



2.



On the Format menu, click Arrange Graphs.



Arranging Graphs 137



 The Arrange Graphs dialog box appears. Figure 4–36 Arrange Graph Dialog Box



3.



From the Layouts list, select a layout for the page. A preview of the layout appears in the Preview window.



Σ 4.



You must apply a layout to a page that has the same or fewer number of graphs. Click Apply. The graphs on the page match the layout you selected, and the Layout dialog box remains open.



5.



Adding New Pages to Layout.jnt



To arrange the graphs again, you can select another layout from the Layouts list, then click Apply, or click Close to close the dialog box.



You can add a previously created page to the Layout.jnt notebook. This is especially useful for saving layouts you create yourself. For example, you can add a layout created in one notebook, and copy and paste it into the layout.jnt notebook. .Jnt files are template files. To add a page: 1.
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On the File menu, click Open.



 The Open dialog box appears. Figure 4–37 Open Dialog Box



2.



Select Template Notebook from the Files of type drop-down list.



3.



Select Layout.jnt from the SPW7 folder.



4.



Click Open.



5.



The Layout.jnt notebook appears.



6.



Open or view the notebook file containing the page you want to add to Layout.jnt.



7.



Select the page you want to copy.



8.



Press Ctrl+C.



9.



Select the section of Layout.jnt where you want to add the new page.



Figure 4–38 Layout Notebook
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 10. Press Ctrl+V. The page appears in Layout.jnt and also at the bottom of the section. Figure 4–39 Layout Notebook with a New Layout



11. On the File menu, click Save to save the notebook.



Creating a Custom Layout Template File



You can create your own template file with a .jnt extension in which you can create and save your own custom layouts. To create your own layout template file:
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1.



Create a graph page and position the graphs as desired.



2.



On the File menu, click Save.



 The Save As dialog box appears. Figure 4–40 Save As Dialog Box



3.



Type the name of the new layout template notebook in File name box.



4.



Select SigmaPlot Template file from the Save as type drop-down list.



5.



Click Save. Now you can add future layouts to their own separate layout notebook.



Changing the Default Layout Template File



Set the default layout template file using the Options dialog box General tab. To change the source template file: 1.



On the Tools menu, click Options. The Options dialog box appears.
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 2.



Click the General tab.



3.



Type the path and file name of the desired layout file in the Layout File field.



4.



Click OK.



Figure 4–41 Options Dialog Box General Tab



The notebook becomes the default layout source.
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 Working with Text on the Page Editing Text



0



Use the Page toolbar to add and edit text labels and legends to the graph page, in addition to editing automatically created graph and axis titles. SigmaPlot automatically creates legends for every plot. You can modify the existing automatic legend by clicking the Text button on the Page toolbar, and then edit the text using the Formatting toolbar. To learn more about the Page toolbar, see The Page Toolbar on page 125. You can format tick and contour labels, but you cannot edit their content. To learn about formatting text, see Formatting Text on page 146. For information on modifying Automatic Legends using the Graph Properties dialog box, see Working with Automatic Legends on page 148.



Creating Text Labels



You can add an unlimited number of text labels and legends to any graph page. SigmaPlot for Windows supports: ➤ ➤ ➤ ➤ ➤ ➤



All TrueType®, PostScript®, and other fonts installed on your system. Multiple lines of text aligned left, right, or centered, with adjustable line heights. Mixed fonts and other attributes within a single label. Multiple levels of superscripting and subscripting. Rotation of text in single degree increments. Color using up to 16.7 million different combinations of red, green, and blue.



Figure 4–42 Examples of Text
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 To create text labels or legends on a page: 1.



Select and view the page window, then click the Page toolbar.



button on the



This places you into text mode until another mode or tool is selected. 2.



Click the page where you want the label to begin. A text box appears.



3.



Select the font, character size, and other starting character attributes from the Formatting toolbar.
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 The following table outlines the functions of each button. These buttons act on selected text, or set the format for following text. Control



Function Set Font Set Size Normal Format Bold Italic Underlined Superscript One Level Subscript One Level Toggle to Greek (Symbol) Font Left Align Center Align Right Align Line Spacing (Multiline Paragraph Only) Rotation Color



The Rotation, Alignment, and Line Spacing options affect the entire label, not just the selected text, and Line Spacing is a minimum spacing control, not fixed. If you change the height of characters by changing font sizes or by adding superscripts or subscripts, the line height adjusts automatically.



Σ Σ 4.



Using the Default Text Properties you can set default text label attributes by opening the Text Properties dialog box with no labels selected. For more information on using the Text Properties dialog box, see Formatting Text on page 146. In addition to using the Greek text button to add a Greek symbol to text, you can also select pre-existing text and choose Symbol as the font type in the Text Properties dialog box. Type your label.
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 ➤ To type additional lines, insert a line break by pressing Enter. ➤ To change the attributes of text already typed in the Edit Text dialog box,



drag the cursor over the text you want to change to highlight it, then click the appropriate button, such as normal font, bold, italics, underline, sub or superscript, or symbol. ➤ To switch back to normal text from greek, superscript, or subscript text, click the normal button. 5.



To add legend symbols to your text, click Symbols. The Symbol dialog box appears.



Figure 4–43 The Symbol Dialog Box



6.



Click Show Legend to activate manually created legend options. Select the Graph to apply the legend to from the Graph drop-down list, then choose to place the symbol before text or after text using the Placement drop-down list. Use the Style drop-down list to control the appearance of the legend you are creating, then choose the symbol to use for the legend from the Symbol window. Symbols and Style options vary depending on the graphs you have created. Legend symbols added to text using the Edit Text dialog box do not appear in the Edit Text dialog box; they appear with the text on the page. Click OK to place the symbol in the text and to close the Symbol dialog box.



7.



Click OK.



Editing Text and Individual Characters



To edit existing text, you can click the text if you are in text mode, or if you are in select mode, double-click the text.



Formatting Text



If you want only to change the attributes (the formatting) of selected text, use the Formatting toolbar. The Text Properties dialog box sets properties for all selected labels, and applies changes to all characters within selected labels.
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 Σ



If you have complex font and character changes within a label, take care not to overwrite these formats with Text Properties dialog box settings. Global Text Changes: The Text Properties is useful for formatting multiple labels as well as all text on a graph. Select the graph and choose Text Properties, then select the attributes you want applied to all graph labels and titles. Default Text Properties: The Text Properties dialog box is used to set the default character and paragraph properties for new labels. Open the Text Properties dialog box with nothing selected, and set the options you want applied to new text labels. To format text using the Text Properties dialog box: 1.



Select the text object you want to modify. If you want to modify several text objects, hold down the Shift key while clicking the objects, or drag a select window around all objects



2.



On the Format menu, click Text Properties. The Text Properties dialog box appears.



Figure 4–44 Text Properties Dialog Box Font Tab The Size option is blank, indicating that there are multiple text objects of different sizes.



3.



To change the font, style, character size, or color of text, or to underline text, click the Font tab. If you have multiple text objects with different text properties selected, the attributes that are not the same appear blank. Do not select an attribute for these options unless you want it to be applied to all selected objects.



4.



To change paragraph attributes, including line spacing, alignment, or rota-
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 tion, click the Paragraph tab. Figure 4–45 Text Properties Dialog Box Paragraph Tab



5.



Click OK to apply the changes and close the dialog box.



Working with Automatic Legends



0



Legends work as a key for your graph. They label what the different graph symbols, lines, or fills represent. SigmaPlot automatically creates legends for all graphs, always placing them below the graph on the left side. Legend entries are labeled using the titles of the columns plotted; if there are no column titles, column numbers are used instead. Move and modify legends as you would any other page object. They also have a special set of controls and features. This section describes how to modify and control these automatic legend features.
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 You can also add legend symbols to any text label or title. To learn how to add symbols to text, see Creating Text Labels on page 143. Figure 4–46 Example of a Graph Displaying an Automatic Legend
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Editing Individual Legend Entries



You can edit and format the text for individual legend entries using the Edit Text dialog box. For more information on using the Edit Text dialog box, see Editing Text on page 143. To edit legend entries: 1.



View the page.



2.



On the Page menu, click the Text button.



3.



Double-click the legend entry that you want to edit.



4.



Edit the text of the legend entry as desired using the Formatting toolbar. You can also change the legend symbol properties, including Symbol size, by clicking the Symbol button. To learn more, see Sizing Legend Symbols on page 150.



Working with Automatic Legends 149



 Increasing the Line Spacing for a Legend



You can increase the spacing between legend symbols by increasing the height of the legend box. Click the box to select it, then drag the top or bottom handle to increase the height.



Figure 4–47 Increasing Spacing Between Legend Entries



You cannot change the widths of automatic legends—these are determined automatically by the width of the text. You can edit individual labels and add multiple lines. You can also ungroup a legend and format it manually; see Ungrouping a Legend on page 153.



Sizing Legend Symbols



You can individually control legend symbol size using the Symbols dialog box. To resize legend symbols: 1.



Double-click the legend.



2.



On the Formatting toolbar, click the Symbol button. The Symbol dialog box appears.



Figure 4–48 Using the Symbol Dialog Box to Resize Legend Symbols



3.



Under Symbol, select the symbol to use for the label.
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 This list displays all symbols, lines and fills used by the selected graph source. 4.



Σ



Under Size, move the Width and Height sliders to increase symbol size, or enter a symbol size value. The Width value determines the space between symbols, while the Height value determines the actual symbol size. This means the larger the height, the larger the symbol size; the larger the width, the larger the space between the symbol and text. For line and scatter plots, the width can never be less than the height.



5.



Editing Automatic Legends



Click OK to close the dialog box and save the changes.



You can edit a legend as a single object. To edit an individual legend entry, see Editing Individual Legend Entries on page 149. To halt automatic legend updating, see Locking Legend Text on page 153. To edit an automatic legend: 1.



Double-click the graph to open the Graph Properties dialog box.



2.



Click the Graph tab.



3.



To show or hide an automatic legend, under Legend Properties, select or clear Show Legend.



Figure 4–49 Use the Graph tab of the Graph Properties dialog dox to Edit an Automatic Legend



Σ



To learn how to show or hide graphs for all subsequentially created graphs, see Permanently Displaying and Hiding Automatic Legends on page 153.



Working with Automatic Legends 151



 4.



To enclose the legend in a box, under Legend Properties, select Framed in Box.



5.



To hide a legend box, under Legend properties, clear Framed in Box.



6.



To modify the line thickness and fill of the legend box, under Legend Properties, click Box to open the Object Properties dialog box.



7.



To halt all automatic updating of the legend text for the whole legend, select Lock legend.



Σ



To learn more see Locking Legend Text on page 153.



8.



To show or hide individual legend entries for a specific plot or curve, under Legend appearance, from the For legend symbol list, select or clear a legend entry.



9.



To annotate from the For legend symbol drop-down list, enter the text for a legend symbol by selecting the symbol then select the Legend text box and type text. Do this for as many legend symbols as you want.



10. To move the legend symbols either to the right or to the left of text, select a position from the Symbol placement drop-down list. If you have no legend symbol selected, this operates on all legends. If you select a specific entry from the For Legend Symbol list, this option affects only that symbol. 11. To modify the appearance of the symbols for the current legend, select a symbol style from the Style drop-down list. The Style drop-down list only affects scatter and line plots. If you have no legend symbol selected, this operates on all symbols. If you select a specific entry from the For Symbol list, this option affects only that symbol. 12. To change the text size or style, under Legend properties, click Font. The Text Properties dialog box appears. For more information on using the Text Properties dialog box, see Formatting Text on page 146. 13. To restore all legend text and symbols to the default settings, under Legend properties, click Reset.



Σ



The Reset button also unlocks the legend, if locked. When you click Reset defaults, a Novice prompt appears which you can disable. To learn more about Novice Prompting, see Setting Program Options on page 18.



14. Click OK to apply the changes and close the Graph Properties dialog box. The legend is updated as specified.
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 Permanently Displaying and Hiding Automatic Legends



You can control the display of automatic legends either for all subsequently created graphs. To view or hide automatic legends for all subsequently created plots: 1.



On the Tools menu, click Options. The Options dialog box appears.



Ungrouping a Legend



2.



Click the General tab.



3.



Select Automatic legends to display the legend, or clear it to hide the legend.



4.



Click OK to close the dialog box and save the changes.



You can ungroup the legend entries and box by selecting the legend, then choosing the Format menu Ungroup command, or clicking the Page toolbar Ungroup button (see Grouping and Ungrouping Objects on page 135). You can then edit each object like an ordinary graphic object or label. You can also use your mouse to move any of the legend items to a new location, and the Format menu Align command, or arranging toolbar button to align them (see Aligning Page Objects on page 135).



Σ Locking Legend Text



Ungrouping a legend removes automatic legend features. Locking legends halts all automatic updating of the legend text for the whole legend. For example, if you lock the legend, you can change column titles and column data without resetting the legend label. The legend will automatically update, however, if you remove or add a curve. You can also lock a legend by simply editing it. If you do not lock the legend, either from the Graph Properties dialog box, or by editing the legend, the legend automatically updates itself when you change column titles and data. Locking the legend affects the entire legend, not just individual entries. To lock legend text:
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 1.



Double-click the graph to open the Graph Properties dialog box.



2.



Click the Graph tab.



3.



Under Settings for, click Legends.



4.



Under Legend properties, click Lock legend.



5.



Click OK to close the dialog box.



Figure 4–50 Use the Graph tab on the Graph Properties dialog box to lock legend text.



Changing Graph Page Format You can change graph page margins and size using the Page Setup dialog box. This dialog box also controls which graphs on a page are displayed or hidden from view, and the color of the page. To learn about displaying or hiding graphs
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 on the page, see Hiding and Deleting Objects from the Page on page 123. To learn about changing page color, see Changing Page Color on page 157. Figure 4–51 The Margins Tab of the Page Setup Dialog Box



Σ Changing and Displaying Graph Page Margins



The options in the Page Setup dialog box affect both the view of the page onscreen, and the printer settings for the page you are printing. To learn more about printing pages, see Printing Graph Pages on page 50. To change page margins, and to view or hide margins on the current page: 1.



On the File menu, click Page Setup. The Page Setup dialog box appears from which you can select the Margins tab, if necessary, to display the Margins tab of the Page Setup dialog box.



2.



Σ



Margins do not affect printing, they are only a guide. The Align dialog box uses margins when aligning the page.



3.



Clear or check the Show Margins option by selecting it. If this option is checked, margins are displayed on the page. To hide page margins, clear Show Margins.



4.



Click OK.



Σ Graph Page Size and Orientation



Use the Top, Bottom, Left, and Right options to specify the width or height of the corresponding page margin. You can type values in the edit boxes using any of the available units of measurement; the value is converted to the current measurement units specified in the Options dialog box. Type in for inches, mm for millimeters, and pts for points.



To learn about changing the unit of measurement used on the graph page, see Changing Page Units of Measurement on page 156.



To change the size or orientation of the graph page: 1.



On the File menu, click Page Setup.
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 The Page Setup dialog box appears. Figure 4–52 The Page Size Tab of the Page Setup Dialog Box



2.



Click the Page Size tab.



3.



From the Paper Size drop-down list choose the appropriate size for the page, or select unique page sizes from the Width and Height drop-down lists.



Σ 4.



To switch between portrait (normal) and landscape (sideways) orientation, select either the Portrait or Landscape option.



5.



Click OK to accept your changes and close the dialog box.



Σ Changing Page Units of Measurement



SigmaPlot does not support heights or widths greater than 32 inches.



If you change the page size and/or orientation, the page changes on the screen, but your graphs remain in the same relative position. You may have to move the graphs back into position.



Use the Page Options dialog box to change the units of measurement used on the page. Page units of measurement are important when specifying margins and object size and position. These settings apply to all pages and graph and object properties dialog boxes. To change the unit of measurement used: 1.



On the Tools menu, click Options.
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 The Options dialog box appears. Figure 4–53 Options Dialog Box Page Tab



Changing Page Color



2.



Click the Page tab.



3.



From the Units box, select the unit of measurement to use on the Page. You can choose to use inches, millimeters, or points.



4.



Click OK to accept the changes and close the dialog box.



You can change the color of a page using the Page Setup dialog box. This is especially useful when creating output for slides or for overhead projectors. To change the color of a page: 1.



Make the page active by selecting it, or by choosing its name from the Window menu. A check mark next to the name of the page indicates that the page is active.



2.



On the File menu, click Page Setup.



Changing Graph Page Format 157



 The Page Setup dialog box appears. Figure 4–54 The Graph Layout Tab of the Page Setup Dialog Box



Σ



3.



Click the Graph Layout tab.



4.



From the Color drop-down list, select the color to use for the page. Select (Custom) to use or create a custom color. To learn more, see Using Custom Colors on page 158.



5.



Click OK.



If you want no background color to show up for pasted graphs (e.g., pasting a graph into PowerPoint), set the page color to None. To learn about changing graph backplane color, see Modifying Grids and Planes on page 396.



Page Color Default Setting



You can set the default color for a new page by opening the template file and change the attributes for the Normal page using the Page Setup dialog box for that page. If there is no template file or Normal page present, page settings are derived from the settings stored in the SPW.INI file (see Troubleshooting on page 471).



Templates



You can overwrite the current page entirely by applying a template to it. This is not recommended as a means of reformatting the page unless you intend to discard all changes made to the page up to this point. For more information on the use of page templates, see Using Graph Pages as Templates on page 105.



Using Custom Colors Color drop-down lists have a (Custom) option that opens the Color dialog box, from which you can select a custom color from over 16.7 million possible
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 combinations of red, green, and blue (24-bit color). These color controls are available in the Graph Properties, Object Properties, Options, and Page Setup dialog boxes.



Configuring Your Display for Color



If you want the truest representation of what your colors will appear like when printed, you should always set you display to the highest color level possible. Most Windows systems support Hi Color (16-bit) or True Color (24-bit) modes. Right-click your desktop, choose Properties, select Settings, then set your Color palette to the highest possible level. To select a custom color: 1.



Open the dialog box that has the color option in it, and from the Color dropdown list, select Custom.



Figure 4–55 Selecting the Custom Color option from the Text Properties Dialog Box.



You have not already selected a custom color, the Color dialog box appears. Figure 4–56 The Color Dialog Box



If a custom color has already been defined for this option, the custom color is selected. For directions on how to select a different custom color,
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 see Re-defining Custom Colors on page 161. 2.



From the Basic Colors list, select a color, or click Define Custom Colors to define your own color. The dialog box expands to show a color palette.



Figure 4–57 The Color Dialog Box



Color Field



3.



Click the large color field, or drag your mouse across it to indicate the approximate color you want to use. If you know the numeric RGB (red, green, blue) values of the desired color, you can select each of the Red, Green, and Blue edit boxes and type the correct values. The selected color box appears.



4.



Move the slider next to the vertical color bar along the right of the dialog box to fine-tune the range of the Hue, Saturation, and Luminosity of the selected color, or type new values in the edit boxes. The current custom color appears in the Color|Solid box as a gradational color and a solid.



5.



To change the color assigned to a Custom Color box, select the box in the list, then specify the new color from the large color field.



6.



To select the gradational color, click Add to Custom Colors. The color appears in the first available box of the Custom Colors list.



7.



To select the solid version of the color, double-click the solid in the Color|Solid box, then click Add to Custom Colors. The color appears in the first available box of the Custom Colors list.



8.
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Select the color to use from the Custom Color list, then click OK.



 The Color dialog box closes, and you are returned to the dialog box from which you opened the Color dialog box. The color drop-down list that you are using now has the color you created as an option with the word (Custom) next to it. If the custom color you created is a duplicate of a pre-existing system color, the system color is selected instead of the (Custom) option in the drop-down list.



Re-defining Custom Colors



If you want to change a custom color, right-click the Color drop-down list (without opening it). On the shortcut menu, click Custom Color; the Colors dialog box appears. Select a new custom color to use as described above.



Figure 4–58 Choosing the Custom Color command from the shortcut menu for Text Color
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 Notes
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Creating and Modifying Graphs This chapter covers the basics of SigmaPlot graph creation and modification. These include: ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤



About SigmaPlot Graphs and Plots



Setting graph defaults (see page 164) SigmaPlot graph types (see page 165) and styles (see page 167) Creating a new graph (see page 177) Creating graphs using the Graph Style Gallery (see page 182) Creating and modifying embedded SigmaPlot graphs (see page 186) Creating SigmaPlot Graphs as Embedded Objects in SPSS (see page 188) Creating Graphs Using Excel (see page 189) Naming a plot (see page 192) and graphs (see page 194) Modifying an existing graph’s properties (see page 190) Hiding and showing graphs and plots on the page (see page 199) Plotting a restricted data range (see page 201) Handling missing and out-of-range data (see page 203) Changing scatter plot symbols (see page 204) Changing line plot lines (see page 213) Changing bar, box and pie chart fill colors and hatching (see page 216) Creating custom color, symbol, and line schemes (see page 220) Changing bar and box plot widths and spacing (see page 222) Adding and changing drop lines (see page 226) Plotting and solving equations (see page 228)



A graph is a representation of selected worksheet columns on a graph page. You select the representation, or graph type (for example, 3D scatter plot, vertical bar chart, and so on), when you create a plot or graph, but you can change it at any time. Most plot types can graph many worksheet columns, column pairs, or column triplets. Depending on the plot type, a separate curve or set of bars represents each column. A graph must have at least one plot, but most graphs can hold many more plots, each with a different type and style.
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 Creating and Modifying Graphs Use the Graph Wizard to create graphs. This chapter provides an overview of the graph creation process using the Graph Wizard, including descriptions of the different graph types and styles available, and common modifications.



Setting Graph Defaults



0



Changing graph defaults affects only new graphs created. To change existing graphs: 1.



Select the graph.



2.



Change its properties using the Graph Wizard or other dialog boxes and commands.



The graph default options are intentionally limited and simple. If you want to use more complex graph defaults, use the page templates or the Graph Style Gallery to create complex graphs that can be applied to data as a template, bypassing graph creation entirely. For more information on using page templates, see Using Graph Pages as Templates on page 105. For more information on using the Graph Style Gallery, see Creating Graphs Using the Graph Style Gallery on page 182. To change your Graph Defaults: 1.



On the Tools menu, click Options. The Options dialog box appears.



Figure 5–1 Options Dialog Box Graph Defaults Tab



2.
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Click the Graph Defaults tab.
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Change the graph defaults options as desired. The available options are:



Size: The default height of all new graphs is 3.5 inches, and the width is 5



inches. Position: The default position of the first new graph created on each graph page. Any subsequent graphs you create on the same graph page are positioned below the first graph, using default offset distances. The default initial location is 3.5 inches from the top and 1.75 inches from the left. Font: Select a font to be used to display all standard text labels, graph and axis titles, tick labels, and legends. Settings For Symbols: The default symbol types and colors for single and multiple curves on a graph. Single curves use Circle as the default symbol shape, and Black as the fill color. Multiple curves use Doubles as the default scheme, and Black and White as the color scheme. Settings For Lines: Default line styles and color for single and multiple curves on a graph. Single curves use Solid as the default line style, and multiple curves use Monochrome as the default line style. Both line colors default to black. Settings For Fills: The default bar color for both simple and grouped bar charts. Simple bar charts use light gray, and grouped bar charts use Grayscale as the default background color scheme. You can specify the thickness of each bar with the Bar Thickness drop-down list. The default bar thickness is 60%.



SigmaPlot Graph Types



0



There are more than a dozen graph types available in SigmaPlot. Choose a graph type using the Graph Wizard or the graph toolbar. To learn about making graphs, see Creating Graphs on page 177.



Graph Types



Scatter Plot



Plots data as XY points using symbols.
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Line Plot



Plots data as XY points connected with lines.



Line and Scatter Plot



Plots data as XY points using symbols connected with lines.



Area Plot



Plots data as XY points with regions below or between curves filled with a color or pattern.



Polar Plot



Plots data using angles and distance from center.



Ternary Plot



Plots data on a coordinate system based on three different components which always add up to 100%.



Vertical Bar Chart



Plots data as Y points with vertical bars.



Horizontal Bar Chart



Plots data as X points with horizontal bars.



Box Plot



Plots data as the median and percentiles.



Pie Chart



Plots data as a percent of the total.



Contour Plot



Plots data as XYZ values in 2D space. Format data columns as: many Z; single XY, many Z; or XYZ triplet. See Arranging Data for Contour Plots and 3D Graphs on page 289.



3D Scatter Plot



Plots data as XYZ data points in 3D space. Format data columns as: many Z; single XY, many Z; or XYZ triplet. See page 289.
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3D Line Plot



Plots data as XYZ data points connected with lines. Format data columns as: many Z; single XY, many Z; or XYZ triplet. See page 289.



3D Mesh Plot



Plots data as a 3D surface. Format data columns as: many Z; single XY, many Z; or XYZ triplet. See page 289.



3D Bar Chart



Plots data as Z values on an XY grid. Format data columns as: many Z; or single XY, many Z. See page 289.



SigmaPlot Graph Style



0



Many graph types have several styles to choose from. When you select a graph type, either from the graph toolbar or from the Graph Wizard, you are prompted to choose a graph style.



Scatter Plots Simple Scatter



Plots a single set of XY pairs. Format data columns as: XY pair; single X; or single Y.



Multiple Scatter



Plots multiple sets of XY pairs. Format data columns as: XY pairs; single Y, many X; single X, many Y; many X; or many Y.



Simple Regression



Plots a single set of XY pairs with a regression line. Format data columns as:



Multiple Regressions



XY pairs; single X; or single Y.



Plots multiple sets of XY pairs with regression lines. Format data columns as: XY pairs; single Y, many X; single X, many Y; many X; or many Y.
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Simple Error Bars



Plots a single set of XY pairs with error bars. If using worksheet columns or asymmetric error bar columns, format data columns as: XY Pair; or Single Y. If using columns means, the first column entry, or the last column entry as symbol values, format data columns as: single X, many Y; or many Y. If using row means, row



median, first row entry, or last row entry as symbol values, format data columns as: single X, single Y replicate; or Y replicate. Multiple Error Bars



Plots multiple sets of XY pairs with error bars. If using worksheet columns, asymmetric error bar columns, columns means, the first column entry, or the last column entry as symbol values, format data columns as: X many Y; or many Y. If



using row means, row median, first row entry, or last row entry as symbol values, format data columns as: single X, many Y replicates; or many Y replicates. Simple Error Bars & Regression



Plots a single set of XY pairs with error bars and a regression line. If using worksheet columns or asymmetric error bar columns, format data columns as: XY pair; or single Y. If using columns means, the first column entry, or the last column entry as symbol values, format data columns as: single X many Y; or many Y. If using row means, row



median, first row entry, or last row entry as symbol values, format data columns as: single X, single Y replicate; or Y replicate.
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Multiple Error Bars & Regressions



Plots multiple sets of XY pairs with error bars and regression lines. If using worksheet columns, asymmetric error bar columns, columns means, the first column entry, or the last column entry as symbol values, format data columns as: single X many Y; or many Y. If using row means,



row median, first row entry, or last row entry as symbol values, format data columns as: single X, many Y replicates; or many Y replicates. Simple Horizontal Error Bars



Plots XY pairs with horizontal error bars. If using worksheet columns or asymmetric error bar columns as the as symbol values, format as: XY pairs; single X; single Y, many X, or many X. If using column means, column median, the first column entry, or the last column entry as symbol values, format data as: single Y, many X; or many X. If using row means,



row median, the first row entry, or the last row entry as symbol values, format data columns as: single X replicate; single Y, single X replicate; many X replicates; or single Y, many X replicates. Bi-directional Error Bars Vertical Point Plot



Horizontal Point Plot



Plots XY pairs with both horizontal and vertical error bars. Format data columns as XY pairs.



Plots columns of data as Y values. Format data columns as: many Y; single X, many Y; many Y Replicates; or single X, many Y replicates.



Plots columns of data as X values. Format data columns as: many X; single Y, many X; many X replicates; or single Y, many X replicates.
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Vertical Dot Plot



Plots a column of data as Y values. Format data columns as: many Y; single X many Y; or XY pairs.



Horizontal Dot Plot



Plots a column of data as X values. Format data columns as: many X; single



Simple Straight Line



Plots a single set of XY pairs connecting the data points with straight lines.



Multiple Straight Lines



Plots multiple sets of XY pairs connecting the data points with straight lines. Format data columns as: XY pairs;



Y, many X; or YX pairs.



Line Plots



Simple Spline Curve



Format data columns as: XY pair; single X; or single Y.



many X; many Y; single X, many Y; or single Y, many X.



Plots a single set of XY pairs connecting the data points with a spline curve. Format data columns as: XY pair; single X; or single Y.



Multiple Spline Curves



Plots multiple sets of XY pairs connecting the data points with spline curves. Format data columns as: XY pairs;



Simple Vertical Step Plot



Plots a single set of XY pairs connecting the data points with vertical and horizontal lines, starting with vertical.



Multiple Vertical Step Plot



Plots multiple sets of XY pairs connecting the data points with vertical and horizontal lines, starting with vertical. Format data columns as: XY pairs;



many X; many Y; single X, many Y; or single Y, many X.



Format data columns as: XY pair; single X; or single Y.



many X; many Y; single X, many Y; or single Y, many X.
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Simple Horizontal Step Plot



Plots a single set of XY pairs connecting the data points with vertical and horizontal lines, starting with horizontal. Format data columns as: XY pair;



Multiple Horizontal Step Plot



Plots multiple sets of XY pairs connecting the data points with vertical and horizontal lines, starting with horizontal. Format data columns as: XY



Simple Straight Line



Plots a single set of XY pairs connecting symbols with straight lines. Format



single X; or single Y.



pairs; many X; many Y; single X, many Y; or single Y, many X.



Line & Scatter Plots



data columns as: XY pair; single X; or single Y.



Multiple Straight Lines



Plots multiple sets of XY pairs connecting symbols with straight lines.



Simple Spline Curve



Plots a single set of XY pairs connecting symbols with a spline curve. For-



Multiple Spline Curves



Plots multiple sets of XY pairs connecting symbols with spline curves.



Format data columns as: XY pairs; many X; many Y; single Y, many X; or single X, many Y.



mat data columns as: XY pair; single X; or single Y.



Format data columns as: XY pairs; many X; many Y; single Y, many X; or single X, many Y.
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Simple Error Bars



Plots a single set of XY pairs as symbols with error bars connected with straight lines. If using worksheet columns or asymmetric error bar columns, format data columns as: XY Pair; or Single Y. If using columns means, the first column entry, or the last column entry as symbol values, format data columns as: X Many Y; or Many Y. If using row means,



row median, first row entry, or last row entry as symbol values, format data columns as: X, Y Replicate; or Y Replicate. Multiple Error Bars



Plots multiple sets of XY pairs as symbols with error bars connected with straight lines. If using worksheet columns, asymmetric error bar columns, columns means, the first column entry, or the last column entry as symbol values, format data columns as: X Many Y; or Many Y. If



using row means, row median, first row entry, or last row entry as symbol values, format data columns as: X, Many Y Replicates; or Many Y Replicates.
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Simple Vertical Step Plot



Plots a single set of XY pairs connecting symbols with vertical and horizontal lines, starting with vertical.



Multiple Vertical Step Plot



Plots a multiple sets of XY pairs connecting symbols with vertical and horizontal lines, starting with vertical.



Simple Horizontal Step Plot



Plots a single set of XY pairs connecting symbols with vertical and horizontal lines, starting with horizontal.



Format data columns as: XY pair; single X; or single Y.



Format data columns as: XY pairs; many X; many Y; single Y, many X; or single X, many Y.



Format data columns as: XY pairs; single X; or single Y.
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Multiple Horizontal Step Plot



Plots a multiple sets of XY pairs connecting symbols with vertical and horizontal lines, starting with horizontal. Format data columns as: XY pairs; many X; many Y; single Y, many X; or single X, many Y.



Simple Area



Plots single set of XY pairs as a line plot with a downward fills.Format data columns as: XY pair; single X; or single Y.



Multiple Area



Plots multiple sets of XY pairs as line plots with downward fills. Format data columns as: XY pairs; many Y; single X, many Y; many X; or single Y, many X.



Vertical Area



Plots single set of YX pairs as a line plot with a left direction fill. Format data columns as: single X; or YX pair.



Multiple Vertical Area



Plots multiple sets of YX pairs as line plots with left direction fills. Format data columns as: many X; or single Y, many X.



Complex Area Plot



Plots multiple line plots with downward fills and intersections. Format data columns as: XY pairs; X many Y; Y many X; many X; many Y.



Scatter



Plots angle and distance data as symbols. Format data columns as: Theta, R



Area Plots



Polar Plots



pairs; XY pairs; many Theta; Many R; single Theta, many R; or R, many Theta.



Lines



Plots angle and distance data points connected with lines. Format data columns as: Theta, R pairs; XY pairs; many Theta; Many R; single Theta, many R; or R, many Theta.
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Scatter & Lines



Plots angle and distance data as symbols connected with lines. Format data columns as: Theta, R pairs; XY pairs; many Theta; Many R; single Theta, many R; or R, many Theta.



Ternary Plots Scatter



Plots ternary triplet data as symbols. Format data columns as: X,Y, and Z values; or XY, YZ, or XZ pair data.



Lines



Plots ternary triplet data as data points connected with lines. Format data columns as: X,Y, and Z values; or XY, YZ, or XZ pair data.



Scatter & Lines



Plots ternary triplet data as symbols connected with lines. Format data columns as X,Y, and Z values; or XY, YZ, or XZ pair data.



Simple Bar



Plots a single column of data as Y values. Format data columns as: XY pair; or



Vertical Bar Charts



single Y.



Grouped Bar



Plots multiple columns of data in a series of bars. Format data columns as: single X, many Y; many Y; many Y replicates; or single X, many Y replicates.



Simple Error Bars
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Plots data as Y values with error bars. If using worksheet columns or asymmetric error bar columns as the symbol value source, format data columns as: single Y; or XY pair. If using columns means, the first column entry, or the last column entry as symbol values, format data columns as: single X many Y; or many Y. If using row means, row median, the first row entry, or the last row entry, format data columns as: single Y replicate; or X, Y replicate.
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Grouped Error Bars



Plots data as multiple sets of Y values in a series of bars with error bars. If using worksheet columns or asymmetric error bar columns as the symbol value source, format data columns as: many Y; or single X, many Y. If using row means, row median, the first row entry, or the last row entry, format data columns as: many Y replicates; or single X, many Y replicates. Error bar values are from the



worksheet. Stacked Bars



Plots multiple columns of data as a series of stacks in bars. Format data columns as: single X, many Y; many Y; many Y replicates; or single X, many Y replicates.



Horizontal Bar Charts Simple Bar



Plots a single column of data as X values. Format data columns as: XY pairs; single X.



Grouped Bar



Plots multiple columns of data in a series of bars. Format data columns as: single Y, many X; many X, many X replicates; single Y, many X replicates.



Simple Error Bars



Plots data as X values with error bars. If using worksheet columns or asymmetric error bar columns as the symbol value source, format data columns as: single X; or YX pair. If using columns means, the first column entry, or the last column entry as symbol values, format data columns as: many X; or single Y, many X. If using row means, row median, the first row entry, or the last row entry, format data columns as: single X replicate; single Y, single X replicate; many X replicates; or single Y, many X replicates.
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Grouped Error Bars



Plots data as multiple sets of X values in a series of bars with error bars. If using worksheet columns or asymmetric error bar columns as the symbol value source, format data columns as: single Y, many X; or many X. If using row means, row median, the first row entry, or the last row entry, format data columns as: many X replicates; or single Y, many X replicates. Error bar values are from the



worksheet. Stacked Bars



Plots multiple columns of data as a series of stacks in bars. Format data columns as: single Y, many X; many X; single Y, many X replicates.



Box Plots Vertical



Plots the median, 10th, 25th, 75th, and 90th percentiles as vertical boxes with error bars. Format data columns as: many Y; or single X, many Y. Error bar values are column means.



Horizontal



Plots the median, 10th, 25th, 75th, and 90th percentiles as horizontal boxes with error bars. Format data columns as: many X; or single Y, many X. Error bar values are column means.



Contour Plots
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Contour



Plots data XYZ values in 2D space. Format data columns as: XYZ triplet; many Z; or XY, many Z.



Filled Contour



Plots data XYZ values in 2D space filling in the area between contour levels. Format data columns as: XYZ triplet; many Z; or XY, many Z.
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3D Line Plots 3D Trajectory



Plots data as XYZ data points connected with lines.



3D Waterfall



Plots data as XYZ data points, but only displays X or Y gridlines. Format data as: many Z; or single XY, many Z.



Creating Graphs



0



Create graphs using either the Graph Wizard, graph toolbar buttons, or the Graph Style Gallery. To learn how to create graphs using the Graph Style Gallery, see Creating Graphs Using the Graph Style Gallery on page 182. If you want to select the worksheet columns to plot before creating your graph, drag the pointer over your data. You do not have to select data before you start a graph; you can select the columns to plot during graph creation.



Using the Graph Toolbar to Create Graphs



To create a graph using the graph toolbar: 1.



Select the desired graph type from the graph toolbar. If you selected to create a graph type that has more than one style, a graph style toolbar appears.



Figure 5–2 2D Graph Style Toolbar



2.



Select a graph style. The Graph Wizard appears.



Create a Graph Using the Graph Wizard



To learn about modifying plots see SigmaPlot Graph Style on page 167 and SigmaPlot Graph Types on page 165. To learn about repicking data for an existing plot, see Picking Different Data for the Current Plot on page 194. To create a 2D graph using the Graph Wizard: 1.



On the Standard toolbar, click the Graph Wizard



button.
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 Creating and Modifying Graphs The Graph Wizard appears. Figure 5–3 Graph Wizard Graph Types



2.



Under Graph Types, select the type of graph you want to make.



3.



Click Next.



4.



Under Graph Styles, select the desired graph style. See SigmaPlot Graph Style on page 167 to learn about the different graph styles available for different graph types.



Figure 5–4 Graph Wizard



5.



Click Next.



6.



If the graph style you have chosen uses error bars, you are prompted to choose an error bar source and a value to use for the error bars.



Symbol Value: Choose either Column Means to use the column means as the error bar source, Replicate Row Means to use the row means as the error bar source, Worksheet Columns to use values you’ve entered in the worksheet, or 2 Worksheet Columns to read error bar end values from sets of two adjacent columns. You are prompted during data picking to specify the col-
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 Creating and Modifying Graphs umn to use as error bar source data. Figure 5–5 Specifying Error Bar Information



Error Calculation: If you choose any option besides Worksheet Columns as the symbol value, specify the error calculation method to use for upper and lower error bars.



Σ



To learn more about creating plots with error bars, see Creating 2D Scatter Plots with Error Bars on page 245.



7.



Click Next.



8.



Under Data format, select how your data is formatted, and click Next.



9.



From the Data for drop down list, select the worksheet columns that correspond to the axis or error bar of your plot.



Figure 5–6 Specifying the Data Format



You can also drag a range of data on the worksheet using the mouse.



Σ



When creating graphs using Microsoft Excel, you can only enter ranges manually. You can also select a range of data by entering the range manually into the Data for box. After entering the range, press Enter. The range appears in the Graph Wizard.
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 Creating and Modifying Graphs If you make a mistake while selecting data, double-click the mistaken column in the Selected Columns list to clear the selection. Figure 5–7 Selecting Columns to Plot



To learn more about entering data ranges, see Manually Entering Data Ranges into the Graph Wizard on page 180. To learn how to create graphs using Microsoft Excel, see Creating SigmaPlot Graphs Using MicroSoft Excel on page 189. 10. Click Finish to create the plot.



Manually Entering Data Ranges into the Graph Wizard



The simplest way to select a region of data is to drag the columns or range using the mouse. You can, however, manually enter the ranges into the Graph Wizard. This is necessary when creating graphs using Microsoft Excel where it is not possible to use the mouse to select a range of data. The Graph Wizard supports the following formats when specifying a region in the worksheet: ➤



rc Notation: Specify a cell using the letter “r” to denote the row, and the letter “c” to denote the column. For example, to specify the cell in the third row and twelfth column, you would enter r3c12. To specify a rectangular region, follow the upper left cell of the region by the lower right cell, separated by two periods. For example, if the upper left cell of the region is r2c1 (second row, first column), and the lower right cell of the region is r4c4 (fourth row, fourth column), you would enter r2c1..r4c4 into the Graph Wizard. You can also specify the column first. For example, both c2r2...c4r5 and
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 Creating and Modifying Graphs r2c2...r5c4 denote the same region in the worksheet. Figure 5–8 Selecting a Range of Data Using the rc Format



➤



Excel Notation: You can use Excel notation in the Graph Wizard. In Excel notation, the columns are alphabetized in lexicographic order and the rows are numbered. In this case, to specify a rectangular region you would again specify the upper left and lower right cells. For example, both A3:D9 and $A3;$D9 specify a region with the upper left cell in the first column, third row and the lower right cell as the fourth column, ninth row. Note that the separator is a colon. The letters are case insensitive.



Figure 5–9 Selecting a Range of Data Using the Excel Format
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Column Numbers Notation: You can make a selection of a consecutive group of entire columns by specifying the range of column indices. For example, to specify columns 1 through nine, type 1:9 or 1..9.



Figure 5–10 Selecting a Range of Data Using the Column Numbers Format



Using Templates, Layouts, and the Graph Style Gallery



0



Templates apply the contents of an entire page, which you can use as the source for new pages. This is useful if the graphs you use have a complex layout with multiple graphs and non-graph objects. Layouts are similar to templates, but do not overwrite existing pages. Instead, they use the size and position attributes of the pages in the layouts to modify your existing graph. Create your own layout to fully maximize the potential of this feature. Use the Graph Style Gallery to create individual graphs. When you create and define a graph in the Graph Style Gallery, you simultaneously set the graph defaults for future graphs. The Graph Style Gallery preserves all attributes of a graph, except for the data, which you select when you create a graph using the Graph Style Gallery.



Creating Graphs Using the Graph Style Gallery



0



Use the SigmaPlot Graph Style Gallery to create a graph from a predefined graph style. When creating a custom graph style, you save all graph, plot, and axes attributes, including graph size and position. Then you can quickly use these attributes to create future graphs. All you supply is the data, and the Graph Style Gallery formats the rest.
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 Creating and Modifying Graphs Each graph style that you create appears as a thumbnail preview in the Graph Style Gallery. You can create new graphs by choosing one of the styles from the window. You can either double-click a graph or click Create Graph to create a graph. The graph then appears in a location defined by the graph style.



Docking the Graph Style Gallery Applying Graph Styles to Pages



The SigmaPlot Graph Style Gallery is a resizable window that you can dock like a toolbar, or leave floating. Double-click the Graph Gallery title bar to dock or undock it, or drag it to the desired docked or undocked position. Use the Graph Style Gallery to quickly apply your own custom graph styles to data. To apply a graph style: 1.



On the Graph menu, click Graph Style Gallery. The Graph Style Gallery window appears.



Figure 5–11 Graph Style Gallery Box



2.



Double-click the graph style you want to use. The Graph Wizard - Create Graph panel appears. To learn how to use the Graph Wizard, see Create a Graph Using the Graph Wizard on page 177.



3.



Select the worksheet columns you want to use for the plot.



4.



Click Finish to create the plot.
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Adding Styles to the Graph Style Gallery



After creating and formatting a graph, you can save its style in the Graph Style Gallery, and later apply that style to future SigmaPlot graphs. To add a graph style or object to the Graph Style Gallery: 1.



Open the graph that you wish to add to the Graph Style Gallery.



2.



If the Graph Style Gallery is not visible on your SigmaPlot desktop, on the Graph menu, click Graph Style Gallery.



3.



From the graph page, select the graph and drag and drop it into the Graph Style Gallery window. A thumbnail of the graph appears in the Graph Style Gallery palette. The graph title appears as the graph style's name.



Alternative Methods There are two alternative methods to add graph styles to the Graph Style Gallery: ➤



If the Graph Style Gallery is docked, select the graph on the page, right-click and on the shortcut menu click Add Graph. The graph style appears in the Gallery.



➤



If the Graph Style Gallery is floating, select the graph on the page, and then on the Gallery click Add Graph. The graph style appears in the Gallery.



Figure 5–12 Using the RightClick Shortcut menu to Add a Graph to the Graph Style Gallery. Here, the Graph Style Gallery is docked.
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Creating Graph Style Gallery Graphs Using the Graph Wizard



You can use the Graph Wizard in conjunction with the Graph Style Gallery to create graphs by selecting Graph Gallery as a graph type in the Graph Wizard. To create a Graph Style Gallery graph from the Graph Wizard: 1.



On the Standard toolbar, click the Graph Wizard



button.



The Create Graph - Type panel of the Graph Wizard appears. Figure 5–13 Using the Graph Wizard to Create a Graph You can choose Graph Gallery as a Graph Type.



2.



Under Graph Types, select Graph Gallery, and click Next. The Create Graph - Gallery panel of the Graph Wizard appears. All graphs that appear in the Gallery graphs list are also in the Graph Styles Gallery.



Figure 5–14 Choosing a Graph Style Gallery Graph from the Graph Wizard All available Graph Style Gallery graphs appear in the list.



3.



Under Gallery graphs, select the graph type that you want to apply to your data, and click Next.
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 Creating and Modifying Graphs The Create Graph - Select Data panel of the Graph Wizard appears. Figure 5–15 Selecting Data in the Graph Wizard



4.



Under Data for, select the worksheet columns to plot.



Σ



If you make a mistake while selecting data, select the correct column in the



5.



Click Finish to create the graph.



Selected Columns list.



A graph appears on the page using the applied Gallery graph style.



Creating and Modifying Embedded SigmaPlot Graphs



0



When you insert a SigmaPlot graph into a document as a SigmaPlot object, some different menus and options are available than when viewing graphs inside SigmaPlot. The following describes the behavior of SigmaPlot features while editing a SigmaPlot graph. Note that you can also open embedded graphs inside SigmaPlot, gaining full SigmaPlot functionality. For learn more about modifying graphs, see Modifying Graphs on page 189.



Creating Embedded Graphs



You can create embedded graphs in any number of ways, including: ➤



Copying and pasting into an application that accepts embedded objects, like Word, Excel or PowerPoint. ➤ Using the Insert File or Object menu from an application that accepts embedded objects. ➤ Running any of the SigmaPlot integration routines (e.g., SPSS integration). For more information on SPSS integration and using category data, see Cre-
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 Creating and Modifying Graphs ating SigmaPlot Graphs Using SPSS on page 188. ➤



Using Embedded Graph Menus and Commands



Using the Paste to PowerPoint Slide or Insert Graphs into Word Toolbox macros.



The following SigmaPlot menu commands are available while editing embedded SigmaPlot graphs:



Edit



Undo/Redo, Cut, Copy, Paste, Paste Link, Insert New Object, Links, Object



View



Toolbar*, Stop, Refresh, Suspend Redraw



Format



Text Properties, Line, Fill, Size and Position, Bring to Front, Send to Back, Group, Ungroup, Align, Arrange Graphs



Tools



Select Object, Text, Draw Box, Draw Ellipse, Draw Line, Draw Arrow



Graph



Select Graph, Graph Properties, Add to Gallery*, Save as Web Page, Paste to PowerPoint Slide



Help



Contents and Index, Tip of the Day, SigmaPlot Tutorial, SigmaPlot Automation, SPSS Science on the Web, Publication Assistant, About SigmaPlot



*Denotes a command only available from the embedded graph menus.



Editing Embedded Graphs



You can choose to edit a SigmaPlot graph from inside the current program, or open the embedded graph inside SigmaPlot. Editing "in-place" To edit a graph in place, simply double-click it. You can also right click it and choose to Edit the SigmaPlot Graph Object. To modify the graph at this point, right-click or double-click the graph to access the different and settings. Opening graphs To open an embedded graph inside SigmaPlot, you can rightclick the inactive graph, and choose to Open the SigmaPlot Graph Object. The graph will open as a graph page and worksheet inside SigmaPlot as an Embedded Page. Note that no notebook window or file is associated with this graph. You can use the File menu to update the source document, or save a copy of the graph off as a new file.
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Viewing Data for an Embedded Graph



If you need to view or edit the data for an embedded graph, you must open that graph inside SigmaPlot.



Resizing Embedded Graphs



The sizing and scaling of the SigmaPlot graph is controlled by the "container" application, that is, the program for the document where the graph has been embedded. However, you can change the size of the page for the embedded graph itself. This is particularly useful if for some reason the graph has been clipped, or you need to rescale and resize the graph or other page objects. Resizing the Graph Page The embedded graph resides on a graph page that has been clipped to just contain the embedded content. You can resize this page if necessary using the Page Setup command from the page right-click menu, or from the Graph menu.



Creating SigmaPlot Graphs Using SPSS



0



If you have SPSS 11.0, you can create SigmaPlot graphs as embedded objects which you can view and edit inside the SPSS Viewer. To create a SigmaPlot graph as an embedded object in SPSS: 1.



In SPSS, on the Graphs menu, click SigmaPlot Graph. The Graph Wizard - Create Graph - Type dialog box appears.



2.



Use the Graph Wizard to create the graph. To learn more about creating SigmaPlot graphs using the Graph Wizard, see Create a Graph Using the Graph Wizard on page 177.



Modifying Embedded SigmaPlot Graphs in SPSS



When you create a SigmaPlot graph using SPSS, it appears as an embedded SigmaPlot object in the SPSS Viewer. To modify SigmaPlot graphs in SPSS: 1.



Double-click the graph. A box appears surrounding the graph.



2.



Double-click the graph again to open the Graph Properties dialog box. To learn more about creating and modifying embedded graphs, see Creating and Modifying Embedded SigmaPlot Graphs on page 186. To learn more about modifying graphs, see Modifying Graphs on page 189 and Modifying Error Bars on page 253.
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Creating SigmaPlot Graphs Using MicroSoft Excel



0



You can launch the Graph Wizard and subsequently create a SigmaPlot graph using Microsoft Excel. Just as you would using SigmaPlot, you can select data from the workseet. You can also select ranges of data. If you change your data in Excel, the SigmaPlot graph automatically updates. To create a graph using Microsoft Excel: 1.



On the Excel toolbar, click the SPW button, or on the Excel Insert menu, click SigmaPlot graph. The Graph Wizard appears.



2.



Σ



Select Excel data and create the graph using the Graph Wizard. For information on selecting ranges of data, see Manually Entering Data Ranges into the Graph Wizard on page 180.



Modifying Graphs



0



Use the Graph Properties dialog box to make most graph modifications. To display the Graph Properties dialog box, double-click the graph.



Modifying Plots and Axes



To modify a plot or the axes of a selected graph, click the Plots tab or the Axes tab. Use the Plot or Axis list to specify which plot or axis in the current graph you
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 Creating and Modifying Graphs are modifying. Use the Settings For lists in the Plots and Axes tabs to gain access to many different plot and axis modification options. Figure 5–16 Using the Graph Properties Dialog Box Plots Tab to modify a graph. You can select a plot to modify from the Plot drop-down list.



Modifying Grids and Planes, Titles and Legends



To modify grids or planes, open the Graph Properties dialog box, click the Graphs tab, and under Settings for, click Grid Lines or Backplanes. To hide or show graph titles and automatic legends, to hide or show plots, and to make modifications to automatic legends, click the Graph tab, and under Settings for, click Legends. To apply your changes, click Apply, or click OK to apply your changes and close the Graph Properties dialog box.
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Selecting a Graph or a Plot



0



To select a graph or plot: 1.



View the page window.



2.



On the Tools menu, click Select Object. A check mark appears next to the menu command.



Figure 5–17 On the Tools menu click Select Object to select objects on the graph page.



3.



Place the pointer over the desired graph or plot and click.



Figure 5–18 Small, square handles surround selected graphs.
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 Creating and Modifying Graphs A selected graph is surrounded by small square handles. A selected plot is indicated with handles at each deadpanning, or in the case of meshes, four handles surrounding the mesh. Alternative Method As an alternative method to select a graph, on the Graph menu, click Select graph, and then click the name of the graph. Figure 5–19 To select a graph on a page, on the Graph menu, click Select Graph, and then click the graph.



Using Special Shortcuts



To automatically open the Graph Properties dialog box, double-click the graph. For more information on using the Graph Properties dialog box, see Modifying Graphs on page 189. Your can also right-click a selected graph or plot display to view other available commands on the Shortcut menu.



Naming Plots



0 The default plot names are numeric; for example, Plot 1, Plot 2, etc. To assign a new name to a plot: 1.
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On the Standard toolbar, click the Graph Properties



button.



 Creating and Modifying Graphs The Graph Properties dialog box appears. Figure 5–20 Using the Graph Properties dialog box to rename a graph. Click Rename to open the Rename dialog box.



2.



Click the Plots tab.



3.



From the Plot drop-down list, select the plot to rename.



4.



Click Rename.



Figure 5–21 Type a new name for the plot in the Rename Item dialog box.



The Rename Item dialog box appears. 5.



Type a new name.



6.



Click OK. The Rename dialog box closes.



7.



Click OK to close the Graph Properties dialog box.
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Naming Graphs



0



The default graph names are numeric, and include the graph type; for example, 2D Graph 1, 2D Graph 2, and so on. To assign a new name to a graph: 1.



Double-click the graph title that appears above the graph to select it.



2.



Type the new name, making any font changes as necessary using the Format Text Toolbar.



3.



Click OK.



Picking Different Data for the Current Plot



0



To change data columns for an existing plot: 1.



Click the plot to modify. Square handles appear over the data points for the clicked curve. Do not click the graph, or you will add a plot to the graph.



2.



On the Standard toolbar, clicking the Graph Wizard



toolbar button.



3.



The Graph Wizard appears.



4.



Under Data Format, select a data format, and click Next.



5.



If you did not change the data format for your graph, your previous column choices appear under Selected Columns. To change column assignments, under Selected Columns, select the desired assignment, then under Data For, select the appropriate column from the worksheet or from the data



Figure 5–22 The Graph Wizard displays the available Data Formats for the current plot
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 Creating and Modifying Graphs list. Figure 5–23 You can change the column assignments using the Graph Wizard.



Σ 6.



To clear a column assignment by double-click it in the Selected Columns list.



If you did change the data format for your graph, a single data type is highlighted in the Selected Columns list. The highlighted data type indicates the data column to pick. To pick data, either click the corresponding column directly in the worksheet, or choose the appropriate column from the Data for list. Use this method to pick X, Y, or Z data, R and theta data, and error bar data, if applicable.



7.



If you make a mistake while picking data, click the mistaken entry in the Graph Wizard, then choose the correct column from the worksheet.



8.



Repeat the process for every data column. When you have chosen the data appropriate for your style of plot, click Back to repick data columns, or if applicable, click Next to pick data for additional plots.



9.



Click Finish to close the Graph Wizard and view the changed graph.



Changing Graph Type and Style



0



Change plots using the Graph Wizard; however, once you have defined a plot style and type, the styles and types available for you to apply to the created plot are limited. If the plot you’ve selected cannot be changed to the plot type or style that you want, use the Graph Wizard to create another plot using the desired style and type. To learn about creating new plots, see Creating Additional Plots on page 5-197. To change graph type and style: 1.



Click the plot to modify.
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 Creating and Modifying Graphs Square handles appear over the data points for the clicked curve. Do not click the graph, or you will add a plot to the graph. 2.



On the Standard toolbar, clicking the Graph Wizard Graph Wizard.



button to pen the



The Graph Wizard appears displaying the data format of the current plot. 3.



To change plot style, click Back to view the Graph Styles list. Choose from the list of available styles then click Next.



Figure 5–24 You can use Graph Wizard to change the type and style of the graph.



4. To change the plot type, click Back twice to view the Graph Types list. Choose from the list of available graph types, then click Next.



Σ



5.



Click next until you can select a data format again for the new plot type or style from the Data Format list, then click Next. You are prompted to specify which worksheet columns to plot.



6.



If necessary, repick the data columns to plot. Otherwise, click Finish to complete you plot type or style change.



If you are changing a 3D plot to a mesh plot, you may need to smooth your data. For more information on smoothing 3D data, see Smoothing 2D and 3D Data on page 420.



Adding New Plots



0



Graphs can have multiple plots and plot types. Although most 2D graphs with multiple curves do not require more than one plot, if you want to mix plot types on a single graph you will need to create multiple plots. If you want multiple sets of lines, symbols, or bars, just plot multiple columns of data for the same plot; see Creating Multiple Curves on page 244.
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 Creating and Modifying Graphs Use multiple plots per graph rather than a single plot with many curves only if different plot types or styles are required (i.e., placing a bar chart and a line plot, or a 3D scatter and mesh plot on a graph), if different data formats are required (such as XY and Y only for a scatter plot), or if a curve requires a different axis (scale, range, etc.). 2D graphs with multiple plots can also have multiple axes. For information on adding multiple axes to a 2D graph, see Creating Multiple 2D Axes on page 283.



Figure 5–25 Example of a Graph with Two Plots
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Creating Additional Plots



Use the Graph Wizard, the Add Plot command, or Graph Wizard button to add a plot to a selected graph.



toolbar



To add another plot to a graph: 1.



Σ 2.



Click the graph to modify. Small square handles surround the graph. Do not click a curve, or you will modify that curve instead. On the Graph menu, click Add Plot. The Graph Wizard appears displaying all the graph types. The available styles and types for a new plot are limited depending on the other plot types and styles in the current graph; for example, you cannot add a Polar plot to a 2D Cartesian plot, or vice versa.



Σ



If the selected graph cannot accommodate the plot type or style that you want to add, the plot will be created as a new graph. You can move the graph of the new plot over the original graph so that it appears to be in the same graph.
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 Creating and Modifying Graphs 3.



Under Graph Type, select a graph type, and click Next.



4.



Under Graph Styles, select the desired plot style, and click Next.



5.



Under Data Format, select a data format, and click Next.



6.



Pick data either by clicking the corresponding column directly in the worksheet, or choosing the appropriate column from the data list. Use this method to pick X, Y, or Z data, R and theta data, and error bar data.



Σ
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If you make a mistake while picking data, click the wrong entry in the Graph Wizard, then choose the correct column from the worksheet. You can also clear a column assignment by double-clicking it in the Selected Columns list.



7.



Repeat the process for every data column. When you have chosen the data appropriate for your style of plot, click Back to repick data columns, or if applicable, click Next to pick data for additional plots.



8.



Click Finish.



 Creating and Modifying Graphs



Showing, Hiding, and Deleting Plots



0



Occasionally, you may want to remove a plot from a graph without deleting it. You can hide plots from view without deleting them by using the right-click shortcut menu, or the Graph Properties dialog box.



Hiding Plots



To hide a plot: 1.



Right-click the plot.



2.



On the shortcut menu, click Hide. The plot is hidden, but not removed.



Figure 5–26 You can use the shorcut menu to hide graphs.



Showing Hidden Plots



To show a hidden plot: 1.



Double-click the graph.
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 Creating and Modifying Graphs The Graph Properties dialog box appears. Figure 5–27 Graph Properties Dialog Box Title and Legend Tab



2.



Click the Graph tab.



3.



Under Settings for, click Plots. All plots associated with the current graph are listed under Show/hide plots. A check mark in the check box next to the name of a plot indicates that the plot is displayed.



Deleting Plots



4.



Clear a check box to hide a plot from view, or select it to show the plot.



5.



Click OK.



Use the Delete command to delete plots from graphs, or select the plot and press Delete. The Delete Plot command is only available when there are multiple plots in a graph. To delete a plot: 1.



Select the graph.



2.



On the Graph menu, click Delete Plot.



3.



Choose the plot you want to delete.



To delete the individual curves of a plot, select a curve on a graph, then press the Delete key. If you delete a plot by mistake, press Ctrl+Z to restore the deleted plot.
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Sampling Fewer Data Points



0



If you have a graph with a large number of data points, you can plot only a portion of the column(s) and/or sample only a portion of the data from the column. This is useful if you are interested only in graphing part of the data, or if you want to increase drawing speed while working on the graph. To plot only a portion of your data: 1.



Double-click the graph. The Graph Properties dialog box appears.



2.



Click the Plots tab.



3.



Select the desired plot from the Plot drop-down list.



4.



To plot only a portion of your data, under Data sampling, select Only Rows, and then enter the range to plot.



5.



To sample the column rows by a specified increment, select by and type a number. Typing a “2” samples every other row and reduces the number of rows plotted by 50%, typing a “3” samples every third row, and so on. You can also use the By list to select a number of rows plotted.



6.



Click OK.



Figure 5–28 You can sample data using the Plots tab on the Graph Properties dialog box.
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 Plotting Missing and Out of Axis Range Data Points



0



You can choose to either plot or ignore bad points. Bad points are either missing values, or data that lie outside the axis ranges. Figure 5–29 Example of Graphs Plotting Bad Data Points The graph on the left plots both a missing data point and out-of-range data point. The graph on the right ignores both missing and out of range points.
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To ignore missing and out-of-range points: 1.



Double-click the graph. The Graph Properties dialog box appears.



Figure 5–30 Graph Properties Dialog Box Plots Tab Data Settings



2.



Click the Plots tab.



3.



Select Data from the Settings for list.



4.



Select the desired plot from the Plot drop-down list.



5.



To plot data without missing values, under Ignore, select Missing values.
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 To plot missing values, clear the option. 6.



To plot data without out of range values, under Ignore, select Out of Range Values. To plot out of range values, clear the option.



7.



Click OK.



Changing Symbol Type and Other Symbol Options



0



You can specify the symbol type used either for the symbols in a single curve, or for all the curves in a plot. The default is to use the same symbol for a single curve and increment symbols for multiple curves. You can only modify symbols. Plots that normally use symbols are scatter plots, line plots, line/scatter plots, bubble plots, polar plots, box plots, 3D scatter plots, 3D trajectory plots, and ternary plots.



Σ



Σ Changing Symbol Type, Size, and Color



Bubble plots use circles as the default symbol shape. If you choose a different symbol shape, you must change the transform function used to translate area to diameter. For more information, see Bubble Plots on page 279. To use different symbol types within a single curve, or for each curve, you can increment types automatically; see Automatically Incrementing Symbols on page 206. You can also choose to use your own order of symbols, or to use text as symbols. For more information, see Using Custom Symbol, Fill, Line, and Color Increments on page 220., and Using Characters and Text as Symbols on page 208. You cannot increment Symbols for single curves, unless there is only one curve within a plot. To change symbol attributes: 1.



Double-click the plot.
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 The Graph Properties dialog box appears. Figure 5–31 Graph Properties Dialog Box Plots Tab Symbols Setting



2.



Click the Plots tab.



3.



From the Settings for list, select Symbols.



4.



From the Plot drop-down list, select the plot to modify.



5.



To change the symbol type for the selected plot, from the Type drop-down list select a symbol type, or choose to increment symbols using the one of the symbol schemes. To create a plot that displays lines only, turn off symbols by choosing (None). To learn more about automatically incrementing symbols, see Automatically Incrementing Symbols on page 206. To learn about using custom symbol schemes, see Using Custom Symbol, Fill, Line, and Color Increments on page 220. For information on using text as symbols, see Using Characters and Text as Symbols on page 208..



6.



To change the size of the symbol, move the Size slider, or type a new value in the Size box. By default, all symbols in a plot are the same size. Use symbols of different sizes by entering symbol sizes in a worksheet column, then selecting the column from the Size list.



7.



To change the fill color of symbols for the selected plot, under Fill Color, select a color from the Color list, or choose to increment fill colors using the one of the incrementing schemes. To turn off symbol fills select (None). To learn more about automatically incrementing symbol fills, see Automatically Incrementing Symbols on page 206. To learn about using custom incre-
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 ment schemes, see Using Custom Symbol, Fill, Line, and Color Increments on page 220. Select (Custom) to open the Color dialog box to create or choose a custom color. For more information, see Using Custom Colors on page 158. S



Hollow Symbols are symbols that use (None) as the fill color. They are hollow, that is, they are composed of the edge lines only. Lines, error bars, and graph background colors all show through unfilled symbols. This is useful if you have many overlapping data points.



8.



To change the edge color of symbols, from the Edge Color drop-down list, select a color, or select to increment edge colors using the one of the incrementing schemes. To turn off symbol edge color, select (None). To learn more about automatically incrementing edge color, see Automatically Incrementing Symbols on page 206. To learn about using custom increment schemes, see Using Custom Symbol, Fill, Line, and Color Increments on page 220. Use the (Custom) option to open the Color dialog box from which you can create or choose a custom color. For more information on using custom colors, see Using Custom Colors on page 158.



9.



To control the color of symbol dots and crosshairs, or of text used as symbols (see page 208), use the Edge Color option. If a symbol is filled with black and has a black edge, then dots and crosshairs automatically default to white.



10. To change the thickness of the symbol edge, move the Thickness slider, or type a new value. 11. Click OK.



Automatically Incrementing Symbols



When incrementing symbols automatically, symbol types are assigned to curves (or points, if the plot has only one curve) in the same order as the column pairs
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 listed in the Graph Wizard. SigmaPlot increments symbols according to the selected scheme. Figure 5–32 Example of Symbol Schemes on Scatter Plots Both graphs use the Doubles symbol scheme and the Black and White color scheme. The first graph has only one curve; the second has four.
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Symbol types and colors appear on the curves of the plot in the same order as the symbol types and colors in the right-click popup menus of the incrementing option. To learn about using custom increment schemes, see Using Custom Symbol,



Fill, Line, and Color Increments on page 220. To use automatically incrementing symbol types: 1.



Double-click the plot. The Graph Properties dialog box appears.



Figure 5–33 Changing the Starting Symbol for an Incrementing Sequence Right-click the symbol type to select the first symbol of the incrementing scheme.
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 2.



Click the Plots tab.



3.



From the Settings for list, select Symbols.



4.



From the Plot drop-down list, select the desired plot.



5.



To increment symbol types and fill and edge colors automatically, under Symbols, from the Type, Fill Color, and Color lists, select a symbol scheme.



Σ



Using Characters and Text as Symbols



There are seven different incrementing color schemes to choose from for both fill and edge colors. Increment schemes do not include (None) as a symbol type.



6.



To change the first symbol type or color used in the incrementing sequence, from the Symbols Type, Fill Color, and Edge Color drop-down lists, select Incrementing. Right-click the selected Incrementing option, and from the shortcut menu, click First Symbol or First Color, then click the symbol type or color to start the incrementing sequence.



7.



Click OK.



You can use numbers, characters, and text as symbols by entering them in a worksheet column and specifying the column in the Graph Properties dialog box. 50



Figure 5–34 Using Text from a Worksheet Column as Plot Symbols
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For more information on using symbols from worksheet columns, see Using Custom Symbol, Fill, Line, and Color Increments on page 220. To specify characters as symbols: 1.



Enter the text you want to use as symbols in a worksheet column in the order you want the curve(s) to use them. To use numeric values as sym-
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 bols, add a space after each value in the worksheet. You can assign the numbers that appear aligned to the left as symbols. Figure 5–35 Example of Worksheet with Plot Symbol Text Entered in Column 3



Σ



You can use all the non-keyboard characters available for the default font. To view and access these characters, you can use the Windows Character Map utility. The Windows User's Guide also lists these special characters, along with the keystrokes required to enter them.



2.



On the Standard toolbar, click the View Page



button.



3.



Double-click the plot on which you want to use text symbols. The Graph Properties dialog box appears.



Figure 5–36 Using Text from a Worksheet Column as the Symbol Type for the Plot Change the font for text symbols by right-clicking the Type option and choosing Symbol Font.



4.



Click the Plots tab.



5.



From the Settings For list, click Symbols.



6.



Under Symbols, from the Type drop-down list select the column that con-
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 Σ 7.



tains the text or numeric values you want to use as symbols. The column option does not appear in the Type list unless text or symbols are entered in a worksheet column. Under Symbols, right-click the Type box, and from the shortcut menu, click Symbol Font. The Text Properties dialog box appears.



Figure 5–37 Using Text as a Symbol Font Select a new font from the Font drop-down list. This feature is especially useful if you wish to use Wingdings, Zapf Dingbats as symbols.



8.



Click the Font tab.



9.



Select another font from the Font drop-down list. This feature is especially useful if you wish to use Wingdings, Zapf Dingbats, or other iconic or symbolic fonts as a symbol. The Fill Color and Edge Thickness options do not apply to text and characters.



10. Click OK.



Using Different Symbol Sizes



By default, all symbols in a plot are the same size. To use symbols of varying sizes, enter symbol size values in a worksheet column, then set symbol size using the Graph Properties dialog box. For more information on using symbol attributes
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 from worksheet columns, see Using Custom Symbol, Fill, Line, and Color Increments on page 220. 18



Figure 5–38 Using Symbol Sizes from a Worksheet Column for Plot Symbols
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Symbol sizes are assigned to symbols and curves (or points, if the plot has only one curve) in the same order as the column pairs that form the curves are listed in Graph Wizard. To use worksheet values for symbol size: 1.



Select the first cell of an empty column in the worksheet containing data for the current plot.



2.



Type the size values to use in the order you want to use them. Since the symbol sizes correspond to symbol diameters or widths, make sure that the symbol sizes you enter are of a reasonable size, that is, small fractions of inches or only a few millimeters or points. If desired, you can also include the measurement unit for the value. For
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 example, for inches type in, for millimeters type mm, or for points type pt. Figure 5–39 Example of Worksheet with Symbol Sizes Entered in Column 3



Σ



If you omit the measurement unit, the numeric values in the symbol size column are assigned the measurement unit specified in the Options dialog box Page tab.



3.



Click the toolbar



button the view the graph page.



4.



Double-click the plot. The Graph Properties dialog box appears.



5.



Select the plot that contains the symbols to modify from the Plot drop-down list.



6.



Use the Size drop-down list to choose the worksheet column containing the
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 symbol size values. Figure 5–40 Using the Plots Tab to Select Symbol Size from a Worksheet Column



7.



Σ



Click OK. When creating a bubble plot, the Graph Wizard automatically prompts you to pick a column to specify bubble size. For more information, see Bubble Plots on page 279.



Changing Line Type and Other Line Options



0



You can change the line type, shape, thickness, and color for all lines in a plot. Because plots can also have multiple curves, you can also increment the line types and colors for any plot with multiple curves. Lines can only be modified in or added to plots that normally use lines, i.e., scatter plots, line plots, line/scatter plots, polar plots, 3D scatter plots, 3D trajectory plots, and ternary scatter, line, and line/scatter plots.



Changing Plot Line Attributes



To change the attributes of lines in a selected plot: 1.



Double-click the plot.
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 The Graph Properties dialog box appears. Figure 5–41 Graph Properties Dialog Box Plots Tab



2.



Click the Plots tab.



3.



Select Lines from the Settings for list.



4.



Under Line style, from the Type drop-down list, choose a line type.



Σ



To learn more about incrementing symbols, see Automatically Incrementing Symbols on page 206. To learn about using custom increment schemes, see Using Custom Symbol, Fill, Line, and Color Increments on page 220. To create a plot that displays symbols only, choose (None) to turn off lines.



5.



To change the thickness of the line, move the Thickness slider, or by type the new value in the Type box.



6.



Choose a line shape from the Shape drop-down list.



7.



To change the color of the lines in the selected plot, select a color from the Color drop-down list, or choose to increment line color using the one of the incrementing schemes. Select (None) to create transparent lines. Use (Custom) to create or choose a custom color. For more information on using custom colors, see Using Custom Colors on page 158.



8.



Σ 9.



To control the layering of plot lines, use the Layering drop-down list to place lines behind or in front of plot symbols. Hollow symbols (None) will always show plot lines. Click OK.
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 Automatically Incrementing Lines



Line types and colors appear on the curves of the plot in the same order as the line types and colors in the right-click popup menus of the incrementing option. There are two line type incrementing schemes: Incrementing and Monochrome. There are seven different incrementing color schemes to choose from for line colors.



Figure 5–42 Incremented Line Types for Line Plots with Multiple Curves
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For examples of these schemes, see Schemes on page 451. To learn about using custom line schemes, see Using Custom Symbol, Fill, Line, and Color Increments on page 220. To use automatically incrementing line types: 1.



Double-click the plot. The Graph Properties dialog box appears.



Figure 5–43 Graph Properties Dialog Box Plots Tab Right-click Menu



2.



Click the Plots tab.
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 3.



Select Lines from the Settings for list.



4.



Select a plot from the Plot drop-down list.



5.



From the Type and Color drop-down lists, choose a line scheme.



Σ



Windows is limited in its ability to supply the true colors for lines by the number of system colors available. For the best representation of true line colors, set your display to either HiColor (16-bit) or TrueColor (24-bit).



6.



Right-click the incrementing option selected in the Type and Color dropdown lists, and from the shortcut menu, select First Line or First Color.



7.



Choose First Line or First Color from the shortcut menu.



8.



Choose the line type or color to start the incrementing sequence.



9.



Use the Line Thickness, Shape, Line Color, and Layering options to modify the lines, if necessary. For more information on modifying lines, see Changing Plot Line Attributes on page 213.



10. Click OK.



Changing Patterns and Fill Colors



0



You can modify and increment the background colors, patterns, and pattern colors used for plots. You can only modify or add fill colors and patterns to plots that normally use fills, i.e., bar charts, box plots, pie charts, 3D bar charts, and ternary plots.
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 Changing Plot Fill Patterns and Colors



Modern laser printing and color slides have removed much of the need for using hatch marks and other line patterns for bar and pie charts. Use gray shades and colors whenever possible.



Figure 5–44 Example of a Bar Chart with a Gray Scale Fill Color Scheme
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To learn more about automatically incrementing fills, see page 218. To learn about using custom increment schemes, see Using Custom Symbol, Fill, Line, and Color Increments on page 220. For more information on using custom colors, see Using Custom Colors on page 158. To change plots’ fill attributes: 1.



Double-click the plot. The Graph Properties dialog box appears.



Figure 5–45 The Fills Settings of the Graph Properties Dialog Box Plots Tab
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 2.



Click the Plots tab.



3.



From the Plot drop-down list, select the plot that contains the fills to modify.



4.



From the Settings for list, select Fills.



5.



To change the background fill color, under Fill Color, from the Color list, select a color, or choose to increment fill colors using the one of the incrementing schemes to change the background fill color.



Σ



Automatically Incrementing Chart Fills



➤ To turn off background fills, select (None). ➤ To create a custom color, select (Custom).



To learn more about creating custom colors, see Using Custom Colors on page 158.



6.



To change the fill pattern and density for the selected plot, under Pattern and Edge, from the Pattern list, select a fill pattern, or select to increment fill patterns using one of the fill schemes. To turn off fill patterns, select (None).



7.



To change the thickness of the pattern lines and edges, move the Thickness slider.



8.



Click OK.



When incrementing fills automatically, different fill colors and patterns are assigned to each bar, box and pie chart slice in the plot. If you are incrementing fills for a grouped bar chart fill colors and patterns are assigned to each group in the plot in the same order the column pairs forming the groups are listed in the Graph Wizard. To learn about using custom increment schemes, see Using Custom Symbol, Fill, Line, and Color Increments on page 220. For examples of fill schemes, see Color, Symbol, Line, and Fill Schemes and Codes on page 451. For more information on modifying fills, see Changing Plot Fill Patterns and Colors on page 217. There are two line type incrementing schemes: Monochrome and Incrementing. There are seven different incrementing color schemes to choose from for line colors. To use automatically incrementing fills: 1.



Double-click the plot. The Graph Properties dialog box appears.



2.



Click the Plots tab.



3.



From the Plot drop-down list, select the plot that contains the fills to modify.
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 Figure 5–46 Graph Properties Dialog Box Plots Tab Right-click Menu



4.



From the Settings For list, select Fills.



5.



Select a scheme from the Color and Pattern drop-down lists. Colors and patterns appear in the bars, boxes, or pie chart slices of the plot in the same order as the right-click shortcut menu.



6.



Right-click the incrementing option and from the shortcut menu, select First Pattern or First Color, and then select the pattern or color to start the incrementing sequence.



7.



Click OK.
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 Using Custom Symbol, Fill, Line, and Color Increments When using a series of incremented symbols, fills, lines, or colors you have defined, the increment scheme is assigned to curves or points in the same order the columns plotted for the curves are listed in the Graph Wizard. Figure 5–47 Bar Chart using Colors From a Worksheet Column
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To define and apply a series of incremented symbols, fills, lines, or colors: 1.



View Worksheet.



2.



On the Insert menu, click Graphic Cells. The Insert Graphic Cells dialog box appears.



Figure 5–48 Using the Insert Graphic Cells Dialog Box to Specify a Custom Line Sequence



3.



Click the Colors, Lines, Symbols, or Patterns tab.
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0



 Σ



Custom Solid and Hollow Symbols Using symbol types from a column specifies the symbol shape only. If you want to change the symbol fills, create another color column and use it as the symbol fill colors. Typically, white is used for “hollow” symbols, and black for solid symbols.



4.



Select the first cell in an empty column in the worksheet.



5.



Double-click the color, line, symbol, or fill pattern in the Insert Graphic Cells dialog box you want to place in the cell.



Σ



Do not mix graphic cell types within the same column; for example, place colors in one column, symbols in a different column, fills in yet another column, and lines in a fourth column. However, you can use multiple columns to define several different increments of the same graphic cell type. For example, you can have several columns containing colors of differently ordered increments. The item appears in the worksheet cell.



6.



Continue adding to the column, in the order you want the curves to use the colors, lines, symbols, or patterns. The order of the curves is the order in which they appear in the Selected Columns drop-down list in the Graph Wizard.



7.



Close the Insert Graphic Cells dialog box.



8.



Click the View Page



9.



Double-click the plot.



button.



The Graph Properties dialog box appears. Figure 5–49 Assigning Custom Symbol Colors in a Worksheet Column to a Plot
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 10. From the Plot drop-down list, select the plot to modify. 11. From the Settings For list, select Fills, Area Fills, Symbols, or Lines, depending on what you have defined in the worksheet. 12. Choose the name of the column which contains the appropriate graphic cells from the Symbols Type, Fills Foreground Pattern, or Lines Type, or Color drop-down lists.



Σ



If you are applying a large number of colors or other property schemes, you may wish to turn off the automatic legend, which will attempt to display your first 25 different data points. Click the Titles and Legends tab, and clear Show Legend.



13. Click OK.



Entering Graphic Cells Manually



You can also add graphic cells to the worksheet by entering the code in the cell. If you want to enter symbols using codes, enter the code for the symbol type in the cell. See Color, Symbol, Line, and Fill Schemes and Codes on page 451 for a list of all these codes.



Generating Color Gradients with a Transform



You can also use the RGBCOLOR transform function to add colors to worksheet cells and columns. You can also use the RGB transform to transform a third or fourth variable to color and add another dimension to your graph. For more information on the use of this transform, see the Programming Guide.



Changing Bar and Box Widths and Spacing



0



Control the amount of space between bars and boxes, and between grouped 2D bars by adjusting the percent of the maximum possible widths of both the individual bars and the bar groups. Figure 5–50 From left to right: bar charts with a group spacing of 50% and relative thickness of 100%, group spacing and relative thickness both set to 66%, and both settings set to 100%.
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To control bar and box width and spacing for bar charts and box plots: 1.



Double-click the plot to modify.
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 The Graph Properties dialog box appears. Figure 5–51 Graph Properties Dialog Box Plots Tab Widths Settings



2.



Click the Plots tab.



3.



From the Settings For list, select Widths.



4.



To change the width and spacing between bars for all bar charts and box plots, move the Bar Thickness slider. The wider the bars or boxes, the less space between them. The narrower the bars or boxes, the more space between them.



5.



To change the width and spacing between groups of 2D and 3D bars, move the Group Spacing slider. This option is only available for grouped and 3D bar charts. SigmaPlot sets grouped bar widths and spacing to as wide or as narrow and as far or as close as possible given the corresponding spacing or width setting.



6.



To set a constant width for all bars or boxes, from the Width drop-down list, select Uniform. This is the default setting. If the bars are set to Uniform, the Bar Thickness setting has the same effect on all bars. For more information on using the Uniform and Variable width settings, see Uniform versus Variable Bar Widths on page 224.



7.



To set potentially uneven widths for bars and boxes, select from the Width drop-down list, select Variable. If the constant column values are uneven, the bars will vary in width according to the corresponding axis values. For more



information on using the Uniform and Variable width settings, see Uniform versus Variable Bar Widths on page 224. Change bar widths according to the percent of their total widths, if the bars
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 Σ



are set to Variable, so that wide bars are more affected than thin bars. Bars created with a single plot will not overlap. However, you can create bars using separate plots and overlap them; see Spacing Bars from Different



Plots on page 263. 8.



To create a needle plot, move the Bar Thickness slider to set bar widths to the narrowest possible widths.



Figure 5–52 An Example of a Histogram Needle Plot
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To make a needle plot, create a bar chart and set the Bar Thickness to Needle. Frequency



500



400



300



200



100



0 0



20



40



60



80



100



120



Bin



9.



Figure 5–53 From Left To Right: Bar Charts with Alignments to the Left of the X Points, to the Right of the X Points, and Centered over the X Data Points



To change bar alignment, from the Align drop-down list, select either Center, Left, or Right. By default, bar chart bars are centered around the data point. Use Align to alternately draw the bars right or left aligned with the data points. 10
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10. Click OK.



Uniform versus Variable Bar Widths



Uniform bar widths set all individual bars to the same width, using the width of the narrowest bar. If the values which the bars are plotted along are unevenly incremented, the bar widths still remain constant. Variable bar widths set the widths to be as wide as possible, as determined by the Bar Thickness and Group Spacing settings. If the values which the bars are
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 plotted along are evenly incremented, this option has no effect. However, if the values which the bars are plotted along are unevenly incremented, the bar widths will vary according to their corresponding values. Figure 5–54 The bar chart on the left is set to a uniform width; the bar chart on the right uses a variable width.
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 Adding and Modifying Drop Lines



0



Use drop lines to produce dot plots and other types of graphs which connect data points to their axis values. You can add drop lines from plotted data points to either or both axes in a 2D scatter, line, or line/scatter plot, or to any or all back planes in a 3D scatter or trajectory plot. Drop lines are drawn for every curve in a plot. Figure 5–55 Graphs with Drop Lines
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The graphs on the left are examples of 2D plots with drop lines to the Y and X axes. The graph on the right is an example of a 3D graph with drop lines to all axes.
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Drop lines always fall toward the minimum of a range; for example, if a Y axis range were reversed, a drop line to the X axis would fall to the top of the graph rather than the bottom. Use the Drop Lines settings in the Graph Properties dialog box Plots tab to create new drop lines, and to modify existing drop line type, thickness, and color. To add or modify drop lines for a selected plot: 1.



Double-click the plot to modify. The Graph Properties dialog box appears.



Figure 5–56 Graph Properties Dialog Box Plots Tab Drop Lines Setting for a 2D Scatter Plot
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 Drop Lines for a Single Point



Figure 5–57 Drop Lines Used to Indicate the Values of Points on a Graph



2.



Click the Plots tab.



3.



From the Plot drop-down list, select the plot that contains the drop lines to modify.



4.



From the Settings For list, select Drop Lines.



5.



Select the X or Y drop-line check box. Drop lines are added to any and all planes or axes that are selected.



6.



From the Type drop-down list specify the type of line to use for selected drop lines.



7.



To adjust line thickness, move the Thickness slider, or type the new value in the Thickness box.



8.



To set drop line color, select a color from the Color drop-down lists. Select any of the listed colors, or select (Custom) to select or define a custom color. To learn more, see Using Custom Colors on page 158.



9.



Click OK.



You can use drop lines to indicate the position of a single point. To show a single drop line, create a second plot which graphs only the desired data point, then add drop lines to the single-point plot. If you don’t want the symbol to show for the point, set the symbol type to (None). Spline Graph with Drop Lines Y axis 16
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 Plotting and Solving Equations



0



Use the Plot Equation dialog box to create and plot equations defined using the Transform language. You can use one of over 100 built-in equations, or create an equation of your own and save it to a notebook. To create and plot an equation and save it to a notebook: 1.



With the worksheet in view, on the Graph menu, click Plot Equation. The Plot Equations dialog box Equation tab appears, either with Untitled or the name of the last used equation in the Name field.



Figure 5–58 Plot Equation Dialog Box Equation Tab and Functions Palette



2.



To manually enter the equation, from the Name drop-down list, select Untitled.



3.



If necessary, delete the existing equation in the f = field, and then either type the equation, or click the Functions Palette button to open the Functions Palette. The Functions Palette provides immediate access to some of the most frequently used functions. You can also select one of the last ten used functions from the Name dropdown list. To learn more about plotting saved equations, see page 231.



4.



From the Variables group box, select either 2D or 3D.



5.



Set the independent variables using the Name, Minimum, Maximum, and Intervals boxes.
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 Name: Type the name of the independent variable(s). Minimum and Maximum: Type the extent of the range of values for the corresponding independent variables.



Σ 6.



Intervals: Set the number of intervals for sampling independent variables over a specified range. You can also select a column in the worksheet. The range of that column appears in the Minimum and Maximum edit boxes. To set the equation parameters, click the Options tab. To learn more about setting equation parameters, see Setting Equation Parameters on page 231.



7.



Click Add As. The Add As dialog box appears.



Figure 5–59 Add As Dialog Box



8.



Type the name of the equation in the Equation Name edit box.



9.



Click OK. The equation name appears in the Name drop-down list on the Equation tab.



Figure 5–60 Plot Equation Dialog Box Equation Tab



10. Click Plot. A graph page appears with the plotted equation, and the equation values appear in the worksheet. 11. Click Close to close the dialog box.
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 If desired, you can add plot an equation and add it to the existing graph, or plot a new equation on a new graph page.



Plotting Equations onto Existing Graphs



Use the Plot Equation dialog box to plot equations onto existing graphs. This is especially helpful if you want to see how the curves change by modifying the parameters. To plot the equation: 1.



Select the graph.



2.



On the Graph menu, click Plot Equation. The Plot Equation dialog box appears.



Figure 5–61 Plot Equation Dialog Box Equation Tab



3.



Either manually enter the equation in the f = edit box, or choose an existing equation, or use the same equation as used previously if you want to change the parameters.



4.



To set the equation parameters, click the Options tab. To learn more about setting parameters, see page 231.



5.



If you don't want to create a second graph page, select Add to current graph



Figure 5–62 Plot Equation Dialog Box Options Tab
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 and clear Create new graph. 6.



Click Plot. The plot appears on the current graph.



7.



Setting Equation Parameters



Click Close to close the Plot Equations dialog box.



All equations that you create or use from the Standard.jfl library have editable parameters. You can either enter the parameters or modify them using the Graph Equation dialog box Options tab. To set equation parameters: 1.



With the worksheet in view, on the Graph menu, click Plot Equation. The Plot Equation dialog box appears.



Figure 5–63 Plot Equation Dialog Box Options Tab



2.



Click the Options tab.



3.



In the Parameters box, enter or edit the parameters.



Σ



Plotting Saved Equations



Enter parameters with the name of the parameter first, followed by an = sign, and then the value, i.e. a=3 or b=7.231



4.



To assign a value to the next parameter, press Enter.



5.



Click Plot to plot the equation.



Each equation you create is saved in the Standard.jfl library. Select the equation to plot from the Library tab of the Plot Equation dialog box. You can also select one of the last ten equations plotted from the Name dropdown list of the Plot Equation dialog box Equations tab. To plot an equation using the Library tab: 1.



With the worksheet in view, on the Graph menu, click Plot Equation.
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 The Plot Equation dialog box appears. Figure 5–64 Plot Equation Dialog Box LIbrary Tab



2.



Click the Library Tab.



3.



Select an equation category from the Equation Category drop-down list. The items that appear in the Equation Category drop-down list are sections in the Standard.jfl library. Below, in the Equation Name list, are items that appear under that section name in the notebook.



4.



Select an equation from the Equation Name list.



5.



Click Select. The Equation tab appears with the selected equation displayed in the Name drop-down list.



Figure 5–65 Plot Equation Dialog Box Equation Tab



Σ



Some of the settings for SigmaPlot's built-in equations in the Standard.jfl library are read-only. To modify a built-in equation, click Add As to create an equation based on the built-in equation.
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 6.



Click Plot. A graph page appears with the plotted equation, and the equation values appear in the worksheet.



7.



Solving Equations



Click Close to close the Plot Equation dialog box.



Use the Equation Solver on the Plot Equations dialog box to evaluate mathematical expressions for functions and to solve equations. The Equation Solver uses the expression entered in the Equation tab on the Plot Equations dialog box as the basis for its results. This expression then appears on the Solve tab for evaluation. To solve an equation: 1.



On the Graph menu, click Plot Equation. The Plot Equation dialog box appears.



Figure 5–66 Plot Equation Dialog Box



2.



Click the Equation tab, and enter an equation in the f = box. You can also select one of the last ten used functions from the Name dropdown list, or you can choose any of the built-in parameterized equations used by the Regression Wizard. Select these equations from the Library, too. To learn more about plotting saved equations see Plotting Saved Equations on page 231. To learn more about entering equations in the Plot Equation dialog box, see Plotting and Solving Equations on page 228.



3.



Click the Solve tab.
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 The entered equation appears in the f = box on the Solve tab. Figure 5–67 Solve Tab of the Plot Equation Dialog Box



4.



Under Options, select the mode of operation. You can select from one of the following: ➤ Evaluate F at Enter a numerical value for each variable that occurs in the



expression in the boxes that appear at the bottom of the dialog box. ➤ Solve equation for x within range Enter a numerical value into the box



Σ 5.



which appears to the left of the expression (the default value is 0) to complete the definition of the equation. You must also enter limits for a range of values of the equation variable. The default range limits are taken from the values entered on the Equation tab. The Solver is only available for expressions containing a single independent variable, although any number of parameters can be present. Under Options, click Evaluate or Solve, depending on the selected mode of operation. The resulting value or the equation solutions that lie between the prescribed
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 range appear in the Results box. Figure 5–68



Results Box Tips and Tricks ➤



The Results box keeps a tally of all evaluation and solving results relative to the given expression. If you alter this expression on the Equation tab or select a new plot expression, the Results box appears with no text. Modifying the expression also clears the other boxes on the Solve tab. ➤ Click Copy to place the entire contents of the Results box onto the Clipboard. ➤ You can annotate the results in the Results box. All annotations are preserved when your perform further computations using the same expression. ➤ In addition to displaying the results of evaluating functions and solving equations, the Results box also displays estimates for any singularities found in the course of solving an equation. Singularities are values of the expression variable (in the given range) where the expression is undefined. When you perform a computation, a label precedes the values in the Results box to indicate the type of output displayed.



Equation Solving Guidelines



Sometimes the solutions to an equation 0 = f(x) are not obvious and the basic methods for solving it are unavailable. If this is the case, then the simplest way to estimate the location of solutions is to: 1.



Using the Plot Equations dialog box, graph the function equation y = f(x).



2.



Observe where the graph intersects the x-axis.



This technique aids in determining range limits for the independent variable in the Function Solver (Solve tab of the Plot Equation dialog box). If the distance between two solutions of an equation is small relative to the size of the range, then the Function Solver may not return both solutions. The resolution of the solutions is approximately two orders of magnitude less than the size of the
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 range. You can obtain higher resolution by adjusting the range limits to reduce the range size. There is particular difficulty, due to roundoff error, in determining solutions to 0 = f(x) at points where the graph of y = f(x) does not cross the x-axis, but lies on one side of it. And example of this situation is the graph of y = x^3+x^2 at x = 0. Although in many cases, as with the above equation, the Function Solver provides the solution, in some cases, however, the solution will not be found and recorded in the Results box. If you suspect that there is such a solution and the Function Solver does not find it, then try the following technique for approximating the solution: 1.



Alter the value for the left side of the equation by a small amount.



2.



Re-solve the equation.



This is equivalent to slightly shifting the graph of the equation up or down until it lies on both sides of the axis. In general, the Results edit box then reports two solutions that are very close together. As smaller amounts are used to adjust the left side of the equation, these two solutions are seen to converge to one solution. As an example, try solving the equation 0 = sin(2*x)*cos(3*x) over the range from x = 1 to x = 2. The Function Solver will indicate that there are no solutions. Using the above technique will yield solutions that are close to the true solution of PI/2. Spurious Solutions A less frequent problem involves the appearance of spurious solutions. Due to the limits of floating point numbers, the value of an expression f(x) at x = a might compute to zero even if x = a is not a true solution to 0 = f(x). This situation commonly arises when the graph of y = f(x) is very "flat" near a point where it intersects the x-axis. For example, consider the equation 0 = x^201. If you solve this equation over the range from x=0 to x=1, then the Function Solver will return 13 solutions even though the only true solution is x = 0. This is because each of 13 results raised to the 201st power is equal to zero in the machine's floating point representation.
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 6



Working with 2D Graphs This chapter describes two dimensional graphs and procedures specific to 2D graphs. To learn about making general graph modifications, like changing symbols, lines, or fills, see Creating and Modifying Graphs on page 163. Modifications to pie charts, polar plots, and ternary plots are discussed in Working with Pie, Polar, and Ternary Plots on page 317. For information on modifying axes, see Chapter 10, Modifying Axes, Tick Marks, and Grids. This chapter covers: ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤



About 2D Plots



Different 2D plot types and their attributes (see page 238). Creating a basic 2D plot (see page 243) Creating a graph that plots multiple lines, bar or data sets using the same style (see page 244) Creating a plot with error bars (see page 245) Creating plots with asymmetric error bars (see page 249) Creating error plots using category data (see page 252) Modifying and customizing error bar appearance (see page 253) Creating a grouped bar chart (see page 261) Spacing bars for overlapping bar charts (see page 263) Creating a grouped bar chart with error bars (see page 263). Changing box plot appearance (see page 267) Computing percentile methods for error bars and box plots (see page 268) Creating an area plot (see page 269) Creating a bubble plot (see page 282) Adding multiple axes (see page 283)



Create 2D Cartesian (XY) plots from many worksheet columns or column pairs. Each column is represented as a separate curve, set of bars, or box, depending on the plot type. 2D graphs must have at least one plot, but can display many more plots, each with a different type and style.
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 Working with 2D Graphs Linear or polynomial regressions with confidence and prediction intervals, and reference lines can be drawn for each curve. To learn about plotting with regressions, see Plotting and Modifying Regression Lines on page 407. For information on adding reference lines, see Adding Reference Lines on page 412.



2D Plot Types Scatter, Line, and Line/Scatter Plots



Figure 6–1 Examples of a Stepped Line Plot, a Scatter Plot, and a Line Scatter Plot



0 Scatter, line, and line/scatter plots graph data as symbols, as lines only with no symbols, or as symbols and lines. Line shapes can be straight segments, splines, or steps. Add drop lines to either axis to any of these plot types, and add error bars to plots with symbols. Draw linear or polynomial regressions with confidence and prediction intervals for each curve.
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For more information on adding drop lines, see Adding and Modifying Drop Lines on page 226. To learn more about creating scatter and line/scatter graphs with error bars, see Creating 2D Scatter Plots with Error Bars on page 245. Using area plots, you can fill an area under a curve with a color making the curve easier to see. You can orient the fill up, down, left, or right. If your curve is a closed polygon, you can also fill the polygon. You can have multiple curves (plots) on a page, so you can stack Area Plots. 80



Figure 6–2 Examples of Area Plots
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 Working with 2D Graphs



Bar Charts



Figure 6–3 Examples of a Simple Bar Chart, a Grouped Bar Chart, and a Stacked Bar Chart



Bar charts plot data either as vertical or horizontal bars. They originate from zero in either a positive or negative direction. Simple bar charts plot each row of data as a separate bar, and grouped bar charts plot multiple columns of data by grouping data in the same rows. Stacked bar charts plot data as segments of a bar; each data point is drawn as a bar segment starting where the previous data point ended.
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Use the Graph Properties dialog box to modify bar width, bar fill colors, and bar fill patterns. Add error bars to simple and grouped bar charts. To learn more about grouped bar charts, see Creating Grouped Bar Charts on page 261. To learn about using the Graph Properties dialog box to modify bar fills and colors, see Adding and Modifying Drop Lines on page 226.



Box Plots



Figure 6–4 Example of a Box Plot



Box plots graph data as a box representing statistical values. The boundary of the box closest to zero indicates the 25th percentile, a line within the box marks the median, and the boundary of the box farthest from zero indicates the 75th percentile. Whiskers (error bars) above and below the box indicate the 90th and 10th percentiles. In addition, you can graph the mean and outlying points. For information on modifying box plots, see Modifying Box Plot Fills, Widths, and Symbols on page 267. 35 30 25 20 15 10 5 0 10
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You need a minimum number of data points to compute each set of percentiles. At least three points are required to compute the 25th and 75th percentiles, five points to compute the 10th percentile, and six points to compute the 5th, 90th, and
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 Working with 2D Graphs 95th percentiles. If SigmaPlot is unable to compute a percentile point, that set of points is not drawn.



Arranging Data for a 2D Plot



0



Organize data for SigmaPlot graphs by columns. Place data for the X values of a graph in a single column, and place data for the corresponding Y values in another column.



Σ



For information on creating a graph, see Creating and Modifying Graphs on page 163. For information on creating another plot for an existing graph, see Adding New Plots on page 196.



Category Data



Use the Category Data format (indexed data) if your data is organized row wise by categories with corresponding data, as is often the default data organization for both statistics data tables and databases. Using this format, you can plot data files from other statistical packages, such as SigmaStat or SPSS, without having to divide the data into groups.



Figure 6–5 Example of Category Data



The Category Data format is available when creating all summary plots, such as: ➤



All error bar plots using a statistic to compute the error bars and/or datapoint Box plots ➤ Point plots ➤



XY Pair Format for a Single Curve



If the graph you are creating uses only one set of X and Y values, enter all X data in one column, and all corresponding Y data in another column. These columns
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 Working with 2D Graphs do not need to be adjacent or the same length (missing values are ignored). Figure 6–6 Data for a 2D Graph Arranged and Picked as XY



XY Pair Format for Multiple Curves



If the graph style you are creating plots more than one curve, place as many additional X and Y values in worksheet columns as you want to plot. Enter X and Y data in the worksheet in consecutive columns, or in any order you want.



Figure 6–7 Data for a 2D Graph Arranged and PIcked as Multiple XY Pairs



Using the Same Column for Multiple Curves (Single X or Y vs. Many Y or X)



SigmaPlot can graph many curves using the same X or Y data column. There is no need to duplicate a column that is used for more than one curve; for example,
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 Working with 2D Graphs enter the X data into only one column, and enter the corresponding Y data into as many columns as you have curves. Order and length of columns does not matter. Figure 6–8 Data for a 2D Graph Arranged and Picked as X Many Y



Using Row Numbers for X or Y Values (Single X; Single Y; Many X; or Many Y)



SigmaPlot can also graph data as only X or Y values, and use the row numbers of the columns as the corresponding Y or X coordinates. If you want to graph data as only X or Y values, enter the data for each plot into a column, and do not enter data for corresponding coordinates.



Figure 6–9 Data for a 2D Graph Arranged and Picked as Many Y Only



Column Averaged Error Bar Plots



Certain graph styles plot data by representing the mean of an entire column as a single data point. In these cases, place the values you want represented as a single X or Y value into one column.



Asymmetric Error Bar Plots



Asymmetric error bar plots use two columns as the error bar source from which you can independently control the values of error bars. Place the values you want to represent the error bars to the right of the plotted column.
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Column Means



Plots the average of an entire worksheet column as a single datapoint, then uses the column statistics to compute error bars, as specified by the Error Calculation.



Creating 2D Plots



0



For information on the available 2D data formats, see the description of graph styles in see SigmaPlot Graph Style on page 167. To create a 2D plot: 1.



Select the worksheet columns to plot before creating your graph by dragging the pointer over your data.



2.



Select the desired graph type and style from the graph toolbar. The Graph Wizard appears.



Figure 6–10 Using the Graph Wizard to Specify the Data Format



3.



From the Data Format list, choose the appropriate data format, and click Next.



4.



Specify which worksheet columns correspond to the data for your plot. Since you selected columns prior to opening the Graph Wizard, your choices automatically appear in the dialog box and you can click Finish to create the graph. If you have not already picked columns, note that a single data type is highlighted in the Selected Columns list. This shows the data type you are picking a column for. Begin picking data either by clicking the corresponding column directly in the worksheet, or choosing the appropriate column from the Data Columns list. Repeat this process for every column you are using to create your graph.



5.



If you make a mistake while picking data, select the wrong entry in the Graph
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 Working with 2D Graphs Wizard, then choose the correct column from the worksheet. You can also clear a column assignment by double-clicking it in the list. Figure 6–11 Using the Create Graph Dialog to Pick Columns to Plot



6.



When you have finished picking data, click Finish to create the plot and close the Graph Wizard.



Use the Graph Properties dialog box to modify the plot, or reopen the Graph Wizard to pick different data columns for your plot, or to add another plot to your graph. For more information on making general modifications to your plot, see Creating and Modifying Graphs on page 163.



Creating Multiple Curves



0



You do not have to create multiple plots to obtain multiple curves. To plot more than one curve, choose any of the plot styles described as Multiple and add additional columns, or column pairs to the list of curves in the Graph Wizard. Figure 6–12 Plot Styles that Include Multiple Curves
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The order of the curves is determined by the order of the column pairs in the Graph Wizard. To change the curve order, repick columns by selecting them in the Graph Wizard or by clicking the column in the worksheet.
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Creating 2D Scatter Plots with Error Bars



0



In a Line and Scatter Plot with Error Bars, plot the means of each column as the Y value, and represent the standard deviations with error bars. Use the Graph Wizard to create 2D plots with error bars. Scatter plots, line/scatter plots, or simple bar charts can be created with error bars. To learn about creating grouped bar charts with error bars, see Creating Grouped Bar Charts on page 261. For information on the available data formats for the graph you are making, see the description of the graph style in see SigmaPlot Graph Style on page 167. Figure 6–13 2D Plots with Error Bars



5



8



10



7



9



4



8



6



7



5



3



6 4 5



2



3



4



2



1



3



1 0



Σ



2



0 0



2



4



6



8



1 -40 -30 -20 -10



0



10



20



30



40



0



2



4



6



8



10 12 14 16 18



To add error bars to a pre-existing plot, you must change the plot type. For more information, see Changing Graph Type and Style on page 195. To create a scatter plot with error bars: 1.



Select the worksheet columns to plot before creating your graph by dragging the pointer over your data.



2.



On the 2D Graph Toolbar, click Scatter Plot, and then click Simple Scatter
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 Working with 2D Graphs Error Bars. Figure 6–14 Selecting Simple Scatter Error Bars from the 2D Graph Toolbar



The Graph Wizard appears. 3.



From the Symbol Value drop-down list, select the error bar source.



4.



From the Error Calculation - Upper and Error Calculation - Lower dropdown lists, specify the error calculation for the error bars.



Figure 6–15 Graph Wizard - Error Bars



Error Calculations are not applicable if you select Worksheet Columns or Asymmetrical Error Bars from the Symbol Value list.
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Click Next.



6.



From the Data Format list, select the appropriate data format.



Figure 6–16 Graph Wizard - Data Format



X column averaged plots require a constant Y column value, and Y column averaged plots require a constant X column value. 7.



Click Next.



8.



Specify which worksheet columns correspond to the data for your plot. Since you selected columns prior to opening the Graph Wizard, your choices automatically appear in the dialog box, and you can click Finish to create the graph.



Figure 6–17 Using the Graph Wizard Create Graph Dialog to Pick Columns for the First Plot in the Graph Notice the Next button is enabled so that you can create an additional plot for the graph.



To create a single plot graph, choose data for every column you are using to make the graph. To create a graph of multiple plots, choose data for the first plot, then click Next to pick data for the next plot. Repeat this process for as many plots as necessary. To make a graph with simple error bars or a graph with multiple error bars using worksheet columns as the Symbol Value for error bar data, you are prompted to choose columns for error bar data. Repeat the data picking process for every column you are using to create your plot.
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 Working with 2D Graphs To make a graph using any of the other sources for error bar data (i.e. Column Means, Column Median, Standard Error, etc.) with multiple error bars, you can create a graph using a single plot, or a graph with multiple plots. Use multiple plots if you want to use different symbols to distinguish between data sets (see Figure 6–13 on page 245).



Σ 9.



If you make a mistake while picking data, click the wrong entry in the Graph Wizard, then choose the correct column from the worksheet. You can also clear a column assignment by double-clicking it in the Selected Columns list. Use the Back button to access previous Graph Wizard panels. Click Finish when you have finished picking the data to create the plot.



To learn about modifying error bar information, Changing Error Bar Appearance on page 253 To learn about repicking data for an existing plot, see Picking Different Data for the Current Plot on page 194.



Creating a Range Plot



A range plot is an error plot that plots the highest and lowest values in a column or row of data as the range of the error bar, using the mean or median value as the data point. To create a range plot from columns of data: 1.



Select the worksheet columns to plot before creating your graph by dragging the pointer over your data.



2.



On the graph toolbar click Scatter Plot and then Simple Scatter - Error Bars. The Graph Wizard - Create Graph dialog box appears.



3.



Select Column Means or Column Median from the Symbol Value drop-down list.



4.



Select Maximum from the Error Calculation - Upper drop-down list.



5.



Select Minimum†from the Error Calculation - Lower drop-down list.



6.



Click Next. The Graph Wizard prompts you to select a data format.



7.



Select X Many Y from the Data Format list, and click Next. Since you've already selected the data columns to plot, the appropriate column titles appear in the Selected Columns list.



8.



Click Finish. A range plot appears.
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Creating 2D Plots with Asymmetric Error Bars



0



Create 2D scatter plots with error bars using two adjacent columns as the error bar source to independently control the error bar values. SigmaPlot computes the asymmetrical error bars by using the column value as the absolute value. The column to the right of the plotted data is the source for the bottom or left error bar; the column following is the source for the top or right error bar. Figure 6–18 2D Plots with Asymmetrical Error Bars
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To create a plot with asymmetric error bars: 1.



Drag the pointer over your worksheet data to select the data.



2.



On the 2D Graph Type Toolbar, click Scatter Plot, and then click either Simple Scatter - Vertical Asymmetrical Error Bars or Simple Scatter - Horizontal Asymmetrical Error Bars.



Figure 6–19 Selecting Horizontal Asymmetric Error Bars from the 2D Graph Toolbar
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 Working with 2D Graphs The Graph Wizard appears. 3.



From the Data Format list, select a data format, and click Next.



4.



Specify which worksheet columns correspond to the data for your plot. Since you selected columns prior to opening the Graph Wizard, your choices automatically appear in Selected Columns list.



5.



Click Finish to create the graph.



To learn about modifying error bar information, Changing Error Bar Appearance on page 253 To learn about repicking data for an existing plot, see Picking Different Data for the Current Plot on page 194.



Creating Quartile Plots



A quartile plot is an asymmetrical error bar plot that divides the total sample of a frequency distribution into four quarters. The median of the data is the data point, while the 75th and 25th percentiles of the data represent the upper and lower error bars.



Figure 6–20 Example of a Quartile Plot



To create a quartile plot: 1.



Select the worksheet columns to plot before creating your graph by dragging the pointer over your data.



2.



On the graph toolbar click Scatter Plot and then Multiple Scatter - Error Bars. The Graph Wizard - Create Graph dialog box appears.
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Select Column Median from the Symbol Value drop-down list.



4.



Select 75th Percentile from the Error Calculation - Upper drop-down list.



5.



Select 25th Percentile from the Error Calculation - Lower drop-down list.



6.



Click Next. The Graph Wizard prompts you to select a data format.



7.



Select X Many Y from the Data Format list, and click Next. Since you've already selected the data columns to plot, the appropriate column titles appear in the Selected Columns list.



8.



Creating Plots with Bi-Directional Asymmetrical Error Bars



Σ



Click Finish.



Bi-directional asymmetrical error bar plots plot the error bar values relative to the axis, and not the data point. SigmaPlot plots the first two column in the worksheet as the XY data values, then the adjacent two sets of columns as the left-to-right error bar values, and then the last two columns as the bottom-to-top error bar values. Because SigmaPlot automatically uses adjacent columns to calculate both the right and top error bar values, do not select the data before creating the graph. To create a bi-directional asymmetrical error bar plot: 1.



Click the Graph Wizard button



on the Standard toolbar.



The Graph Wizard appears. 2.



From the Graph Types list select Scatter Plot, and click Next.



3.



From the Graph Styles list, select Bidirectional Asymmetric Error Bars, and click Next.



Figure 6–21 Select Bidirectional Asymmetric from the Graph Styles list to make a bidirectional asymmetric error bar plot
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From the Data Format list, select XY pairs, and click Next.



5.



On the worksheet, click the column you wish to use as X1 and then click the column you wish to use as Y1.



6.



Click to select the column you wish to use as the left error bar values. SigmaPlot automatically uses the adjacent column as the right error bar values.



7.



Click to select the column you wish to use as the bottom error bar values. SigmaPlot automatically uses the adjacent column as the top error bar values.



8.



Click Finish to create the graph.



Creating Error Bar Plots Using Category Data



0



You can create SigmaPlot error bar plots using category data either entered into a SigmaPlot worksheet, imported from SPSS, or you can create graphs as embedded objects in SPSS. For a description of category data, see Category Data on page 240. To learn how to create graphs inside SPSS, see Creating SigmaPlot Graphs Using SPSS on page 188. You can also create scatter plots and bar charts using category data. To create a SigmaPlot error bar plot using category data: 1.



Open or import a worksheet using a category data format. For more information on importing worksheets, see Importing Files from Other Applications on page 58.



2.



On the Graph menu, click Create Graph. The Graph Wizard - Create Graph - Type dialog box appears.



3.



Select a graph type from Graph types list, and click Next. The Graph Wizard - Create Graph - Style dialog box appears.



4.



Select a graph style that uses error bars from the Graph styles list, and click Next. The Graph Wizard - Create Graph - Error Bars dialog box appears.



5.



Select either Category Mean or Category Median from the drop-down list.



6.



Select error calculations from the Error calculation - upper and Error calculation - lower drop-down lists, and click Next.
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 Working with 2D Graphs The Graph Wizard - Create Graph - Data Format dialog box appears. 7.



From the Data for Categories drop-down list, select a column that corresponds to the categorical data you wish to plot.



8.



From the Data for Y drop-down list, select the column that corresponds to the Y data you wish to plot, and click Finish. An error bar plot appears.



Modifying Error Bars



0



Compute error bars for scatter, line/scatter, and bar charts. Select error bar values when you pick the data for a plot and compute using values in a worksheet column or using column means (see Creating 2D Scatter Plots with Error Bars on page 245).



Σ Figure 6–22 Examples of Graphs with Error Bars



You cannot add error bars to existing plots. However, you can select the desired plot on the page and change its plot type and style so that it includes error bars. To learn about changing graph type and style, see Changing Graph Type and Style on page 195. 5 4 3
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Changing Error Bar Appearance
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Use the Graph Properties dialog box to change error bar color, cap width, line thickness, mean computation method, and direction. Note that you cannot select error bar values from this dialog box; the Graph Properties dialog box only affects the appearance of error bars. Determine error bar values when you pick data to plot. To change error bar appearance: 1.



Double-click the plot. The Graph Properties dialog box appears.
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 Working with 2D Graphs 2.



From the Settings For list, select Error Bars.



3.



To change the color of the error bars, from the Line Color list, select a line color.



4.



To change line thickness and error bar cap width, move the Thickness and Cap Width sliders.



5.



Click OK.



Figure 6–23 Graph Properties Dialog Plots Tab Error Bar Setting



Changing Error Bar Directions



Specify error bar direction using two different methods: absolute and relative. You can specify absolute error bars to point in either a positive or negative direction; specify relative error bars to point either towards or away from zero. To change error bar direction 1.
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Double-click the plot.



 Working with 2D Graphs The Graph Properties dialog box appears. Figure 6–24 Graph Properties Dialog Plots Tab Error Bar Setting You can change the direction of the error bars by selecting a direction from the Error Bar Direction drop-down list.



2.



Click the Plots tab.



3.



From the Plot drop-down list, select the plot with error bars to modify.



4.



From the Settings For drop-down list, select Error Bars.



5.



Under Error Bars, from the Direction drop-down list, select the direction of Y.



6.



Select either X or Y Positive or Negative.



Σ Figure 6–25 The bar chart on the left uses Y error bars with an absolute positive direction. The bar chart on the right uses a relative direction away from zero.



An X positive absolute direction always points right; a Y positive direction always point up. An X negative absolute direction always points left; a Y negative absolute direction always points down. 75
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To orient error bar directions relative to zero:
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 Working with 2D Graphs 1.



Double-click the plot. The Graph Properties dialog box appears.



2.



Click the Plots tab.



3.



From the Settings For list, select Error Bars.



4.



From the Error Bars Direction drop-down list, select X or Y From Zero or To Zero.



Σ



A relative to zero direction always points toward or away from zero. This option is useful for bar charts that have negative values.



Figure 6–26 The bar chart on the left uses X error bars with an absolute negative direction. The bar chart on the right uses a relative direction towards zero.
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 Working with 2D Graphs



Customizing Error Bar Directions



Control the error bar direction used for each data point by entering error bar directions into a worksheet column.



Figure 6–27 Error Bars Using Custom Directions from Worksheet Columns



To use custom error bar directions: 1.



Select the first cell in an empty worksheet column.



2.



Enter the codes for the error bar directions. The codes for the directions are: Direction



Code



Absolute Positive



Positive or P



Absolute Negative



Negative or N



Relative From Zero



From Zero or F



Relative To Zero



To Zero or T



Absolute or Relative, Both Directions



Both, PN or FT



Σ



Codes you type in the worksheet can be either upper or lower case.



3.



Double-click the plot.
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 Working with 2D Graphs The Graph Properties dialog box appears. Figure 6–28 Setting Error Bars



Changing the Mean Computation Method



4.



Click the Plots tab.



5.



From the Settings For list, select Error Bars.



6.



Under Error bars, from the Direction list, choose the name of the column which contains the error bar direction codes.



7.



Click OK to apply the changes and close the dialog box.



If you are using a log axis scale, you can choose between calculating the column means arithmetically (the default) or geometrically on a log scale. This option is only available for log axis scales. To change the mean computation method:
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1.



Double-click the plot with a log axis scale to open the Graph Properties dialog box.



2.



Click the Plots tab.



3.



From the Settings For list, select Error Bars.



 Working with 2D Graphs 4.



From the Mean Computation drop-down list, select Arithmetic or Geometric.



5.



Click OK.



Figure 6–29 Selecting Arithmetic or Geometric from the Mean Computation list



Changing Error Bar Source



Use this method to change the error bar source after you have created a graph. You can: ➤



Plot the means of worksheet columns as single data points and compute the error bars values from column statistics (column averaging). ➤ Use data in worksheet rows and columns as error bar values (see Creating 2D Scatter Plots with Error Bars on page 245). ➤ Use data in two adjacent worksheet columns as the absolute error bar values (see Creating 2D Plots with Asymmetric Error Bars on page 249). To change the error bar source after you have created the graph: 1.



Select the plot to modify by clicking it. Small, square, black handles surround the selected plot.



2.



On the Standard toolbar, click the Graph Wizard button



.
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 Working with 2D Graphs The Graph Wizard appears. Figure 6–30 Graph Wizard - Modify Plot



3.



Click Next.



4.



From the Data for Error drop-down list, select a column as a new error bar source.



5.



Click Finish.



Figure 6–31 Choose the new error bar source from the Data for Error drop-down list.



The graph appears with the new error bars.
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Grouped Bar Charts



0



Create grouped bars charts by picking multiple columns for a single plot. Data points within the same row appear within the same group, and each additional column adds another bar to each group. There are as many groups as there are rows of data. Figure 6–32 Examples of Grouped Bar Charts with and without Error Bars
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The order of the column pairs in the list determines the order of the bars for each group. To change the bar orders within groups, change the order the column pairs appear in the list by using the Graph Wizard to repick column data. For more information about repicking data, see Picking Different Data for the Current Plot on page 194. Use the Graph Wizard to create grouped bar charts with or without error bars. If creating a grouped bar chart with error bars, error bar values must be from worksheet column values entered prior to creating the plot. You are prompted during graph creation for error bar worksheet columns.



Creating Grouped Bar Charts



To create a grouped bar chart: 1.



Select the worksheet columns to plot before creating your graph by dragging the pointer over your data.



2.



On the 2D Graph Toolbar, click Horizontal or Vertical Bar Chart, and then click either Grouped Bar Chart, or Grouped Error Bars.
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 Working with 2D Graphs The Graph Wizard appears. Figure 6–33 Using the Graph Wizard to Specify the Data Format



3.



From the Data Format list, choose the appropriate data format to specify how your data is formatted. The data formats available depend on the graph type and style.



4.



Click Next. Since you selected columns prior to opening the Graph Wizard, your choices automatically appear in the in the Selected Columns list. To change the selected data, select the wrong entry in the Graph Wizard, then choose the correct column from the worksheet. You can also clear a column assignment by double-clicking it in the Selected Columns list.



Figure 6–34 Using the Create Graph Dialog to Pick Columns to Plot Notice that this dialog box also prompts you for the columns with the data to use as the error bar values.



5.



Click Finish.



To learn about modifying error bar information, Changing Error Bar Appearance on page 253 To learn about repicking data for an existing plot, see Picking Different Data for the Current Plot on page 194. For information on the available data formats for the graph you are making, see the description of the graph style in SigmaPlot Graph Style on page 167.
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Spacing Bars from Different Plots



If you need to create a bar chart with two or more different axes scales, or a chart with overlapping bars, use multiple plots. SigmaPlot does not automatically space bars from different plots. However, you can manually space bars by grouping your data column(s) with column(s) containing missing or empty data. This creates bar groups with null values and leaves room for other bars. When picking columns to plot, pick the missing columns in a different order for each plot, so that the bars do not overlap. To overlap bars, plot your bar values versus a column of evenly incremented values rather than by row numbers.



Figure 6–35 Bars graphed with different plots that both overlap and are spaced differently by using different x increments.



Grouping Column Averaged Bars



You cannot create a grouped bar chart with error bars using column averaging; the bars do not group or space correctly. However, you can copy the worksheet means and standard deviations from the statistics window, then plot this data as a grouped bar chart with error bars. To create a bar chart with grouped column averaged bars: 1.



On the View menu, click Statistics.
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 Working with 2D Graphs The statistics window for the worksheet appears. Figure 6–36 Column Statistics Worksheet



2.



Select the block of data in the statistics window that consists of the means and standard deviations of the first set of bars.



3.



Right-click, and on the shortcut menu click Copy.



4.



Select the first row of an empty column in the worksheet.



5.



On the Edit menu, click Transpose Paste. The first pasted column of data is the mean, and the next column is the standard deviations. For more information on using the transpose paste feature see Switching Rows to Columns on page 81.



Figure 6–37 Example of Transposed Pasted Data The data in columns 13 and 14 of the worksheet are transposed from the selected data in rows 1 and 2 of the Column Statistics window. Column 13 contains the means of the column data and column 14 contains the standard deviations of the data.



6.
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Repeat the copy and transpose paste procedure for the remaining sets of bars. Each pair of mean and standard deviation columns you create adds an additional bar to each group.



 Working with 2D Graphs 7.



To plot the results, on the 2D Graph Toolbar, select a vertical or horizontal bar chart graph type with grouped error bars, then select the desired data format. If you already have a graph, repick the plotted data by selecting the plot to modify, then clicking the toolbar



button.



8.



If you select X Many Y as the data format, pick your constant value column (either a row number or a single column), then pick the first column of means as your data column, and the first column of standard deviations as the associated error bar column.



9.



Continue picking the mean columns and error bars for each set.



10. Click Finish when done. Figure 6–38 Picking Data to Plot for a Grouped Bar Chart with Error Bars



Creating Box Plots



0



A box plot is a summary plot that plots graph data as a box representing statistical values. The boundary of the box closest to zero indicates the 25th percentile, a line within the box marks the median, and the boundary of the box farthest from zero indicates the 75th percentile. Whiskers (error bars) above and below the box indicate the 90th and 10th percentiles. In addition, you can graph the mean and outlying points. To create a box plot: 1.



Select the worksheet columns to plot by dragging the pointer over your data.
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On the 2D Graph Toolbar, click Box Plot and then click Horizontal Box or Vertical Box. The Graph Wizard appears.



Figure 6–39 Graph Wizard - Data Format



3.



From the Data Format list, choose the appropriate data format, and click Next.



Figure 6–40 Graph Wizard - Select Data



Since you already selected columns prior to opening the Graph Wizard, your choices automatically appear in the Selected Columns list.



Σ



You need a minimum number of data points to compute each set of percentiles. At least three points are required to compute the 25th and 75th percentiles, five points to compute the 10th percentile, and six points to compute the 5th, 90th, and 95th percentiles. If SigmaPlot is unable to compute a percentile point, that set of points is not drawn.



4.



Click Finish to create the graph. Use the Graph Properties dialog box to modify the plot, or reopen the Graph Wizard to pick different data columns for your plot, or to add another plot to your graph.



266 Creating Box Plots



 Working with 2D Graphs



Modifying Box Plot Fills, Widths, and Symbols



The fill, width, and symbol settings for the boxes can be modified using the appropriate Graph Properties Plot tab settings. For changing: ➤



Symbols used to display extreme data points, see Changing Symbol Type and Other Symbol Options on page 204. ➤ Box fill color and patterns (including edge and whisker color), see Changing Patterns and Fill Colors on page 216. ➤ Box widths, see Changing Bar and Box Widths and Spacing on page 222.



Changing Other Box Plot Attributes



To add a mean line, change which outliers are displayed, and change the 10th and 90th percentile whisker cap widths: 1.



Double-click the plot to open the Graph Properties dialog box. The Graph Properties dialog box appears.



Figure 6–41 Graph Properties Plots Tab



2.



Click the Plots tab.



3.



From the Settings For list, select Box Options.



4.



To display a mean line in addition to the median line, under Box Plot Mean Line, select Display Mean Line. If the check box is clear, the mean line is not displayed.



5.



To modify the mean line, under Box Plot Mean line, from the Line Type drop-down list, select a mean line type.



6.



Select a line thickness and color using the Thickness and Color options. Selecting (None) from the Line Type or Color lists creates a transparent mean line. Selecting (Custom) from the color list enables you to use a custom mean line color, or to create a new color.
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To change how outliers are handled, from the Handling Outliers dropdown list, select either Show Each Outlier (to plot outside the 10th and 90th percentiles), or Show 5th/10th Percentiles (to plot only the 5th and 95th percentiles as symbols).



Σ



At least six data points are required to compute the 5th and 95th percentiles, and that there may not be any points beyond the 10th and 90th percentiles.



8.



To modify whisker cap width, under Whisker Caps, move the Width slider, or type a new value in the Width box.



9.



Click OK.



Computing Percentile Methods When graphing error bars and creating box plots, you can select the method of computing percentiles. To change the percentile method: 1.



On the Tools menu, click Options. The Options dialog box appears.



Figure 6–42 Selecting a Percentile Method You can select either Cleveland or Standard.



2.



Click the System tab.
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0
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From the Percentile Method drop-down list, select either: ➤ Cleveland ➤ Standard



Both the Cleveland method and the Standard method use linear interpolation to determine the percentile value, but each uses a different method of rounding when determining the smallest data index used for the interpolation. The two methods give the same result when computing the 50th percentile (median). If the data in increasing order is x1, x2, ..., xN and the percentile is p, then the two methods compute the data percentile value v using the following formulas:



Σ 4.



Cleveland



Let k be the nearest integer to N*p/100, and let f = N*p/ 100 + .5 - k.



Standard



Let k be the largest integer less than or equal to (N+1)*p/100, and let f = (N+1)*p/100 - k.



To compute the percentile value, each of the above methods uses the formula: v=f*xk+1+(1-f)*xk Click OK.



Creating Area Plots



0



Area plots are 2D line plots with regions below or between curves filled with a color or pattern. Most commonly, an area plot is a line plot with shading that
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 Working with 2D Graphs descends to the axis. You can add shade below a curve and shade in different directions, and you can uniquely fill and identify intersecting regions. Figure 6–43 Example of an Area Plot This example is actually four plots: a simple straight line, simple scatter, vertical area, and multiple area. You can find this example in Samples.jnb.
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Creating Simple and Vertical Area Plots



Simple Area Plots plot a single line plot with a downward fill. Vertical Plots plot single YX line plots with a left direction fill.



Figure 6–44 Example of an Area Plot In this example, we see two vertical area plots, a simple area plot, and a simple scatter plot.



To create a simple straight line area plot: 1.



Select the worksheet columns to plot by dragging the pointer over your data.



2.



On the 2D Graph Toolbar, click Area Plot and then click Simple Area Plot. The Graph Wizard appears.



Figure 6–45 Graph Wizard - Data Format



3.



From the Data Format list, choose the appropriate data format, and click
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 Working with 2D Graphs Next. Figure 6–46 Graph Wizard - Select Data



Since you already selected columns prior to opening the Graph Wizard, your choices automatically appear in the Selected Columns list.



Σ



You can plot no more than 2500 data points per curve.



4.



Click Finish to create the graph.



Figure 6–47 Example of a Vertical Area Plot



Use the Graph Properties dialog box to modify the plot, or reopen the Graph Wizard to pick different data columns for your plot, or to add another plot to your graph.
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Creating Multiple Area and Multiple Vertical Area Plots



Multiple Area Plots plot multiple line plots with downward fills. Multiple Vertical Area Plots plot single YX line plots with left downward fills. To create a multiple area plot: 1.



Select the worksheet columns to plot by dragging the pointer over your data.



2.



On the 2D Graph Toolbar, click Area Plot, and then click Multiple Area plot. The Graph Wizard appears.



Figure 6–48 Graph Wizard - Data Format



3.



From the Data Format list, choose the appropriate data format, and click Next. Since you already selected columns prior to opening the Graph Wizard, your choices automatically appear in the Selected Columns list. To change the selected data, select the wrong entry in the Graph Wizard, then choose the correct column from the worksheet. You can also clear a column assignment by double-clicking it in the Selected Columns list.



Figure 6–49 Graph Wizard - Select Data



Σ



You can plot no more than 2500 data points per curve.
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Click Finish to create the graph.



Figure 6–50 Example of a Multiple Area Plot using a Y Many X data format.



Use the Graph Properties dialog box to modify the plot, or reopen the Graph Wizard to pick different data columns for your plot, or to add another plot to your graph. You can identify intersections either by using the Graph Properties dialog box or by creating a complex area plot. To learn more, see Creating Complex Area Plots on page 274 and Converting a Multiple Area Plot to a Complex Area Plot on page 276.



Creating Complex Area Plots



Complex Area Plots plot multiple line plots with downward fills and intersections. To create a complex area plot:



274 Creating Area Plots



1.



Select the worksheet columns to plot by dragging the pointer over your data.



2.



On the 2D Graph Toolbar, click Area Plot, and then click Complex Area Plot.



 Working with 2D Graphs The Graph Wizard appears. Figure 6–51 Graph Wizard - Data Format



From the Data Format list, choose the appropriate data format, and click Next. Since you already selected columns prior to opening the Graph Wizard, your choices automatically appear in the Selected Columns list. To change the selected data, select the wrong entry in the Graph Wizard, then choose the correct column from the worksheet. You can also clear a column assignment by double-clicking it in the Selected Columns list. Figure 6–52 Graph Wizard - Select Data



Σ



You can plot no more than 2500 data points per curve, and you cannot plot more than four curves.
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Click Finish to create the graph.



Figure 6–53 Example of a Complex Area Plot Intersections only appear for two our more curves, and a legend appears for each intersection.



Converting a Multiple Area Plot to a Complex Area Plot



You can uniquely identify intersecting areas of all curves of a multiple area plot with a separate fill by using the Graph Properties dialog box. Each possible intersection appears on the area plot, and each identifiable set of intersections uses the next color or pattern in the selected scheme. You can display intersections for a minimum of two curves and a maximum of four. Plots with two curves will have up to three different regions, one region for each tuple, and one region for the intersection. Three curves yield up to seven regions, and four curves up to fifteen. To change a multiple area plot to a complex area plot: 1.
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Double-click the multiple area plot.



 Working with 2D Graphs The Graph Properties dialog box appears. Figure 6–54 Using the Graph Properties Dialog Box to Identify Intersections



Shading in Different Directions



2.



Click the Plots tab.



3.



Select Area Fills from the Settings for list.



4.



Select Identify Intersections.



5.



Click OK to close the dialog box and accept the changes.



Use the Graph Properties dialog box to change the direction of fill colors in an area plot. To change the area fill direction: 1.



Create an area plot.



2.



Double-click the graph.
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 Working with 2D Graphs The Graph Properties dialog box appears. Figure 6–55 Using the Graph Properties Dialog Box to change the direction of the area fill



Changing Area Plot Fill Colors



Σ



3.



Click the Plots tab.



4.



From the Settings for list, select Area Fills.



5.



From the Direction drop-down list, select Up, Down, Left, or Right.



6.



Click OK.



Use the Graph Properties dialog box to change area plot fill colors.



SigmaPlot only supports system patterns. If you enter patterns into the worksheet, you should only use system patterns. To change the area plot fill color: 1.



278 Creating Area Plots



Double-click the area plot.



 Working with 2D Graphs The Graph Properties dialog box appears. Figure 6–56 Using the Graph Properties Dialog Box to change the area fill color and pattern



2.



Click the Plots tab.



3.



From the Settings for list, select Area Fills.



4.



From the Color drop-down list, select (None) to create a transparent fill color, (Custom) to create a custom color, or a color incrementing scheme to use a color array, or any one of many available colors.



5.



From the Pattern drop-down list, select a pattern.



6.



Click OK.



Σ Bubble Plots



To learn more about modifying fills, see Changing Patterns and Fill Colors on page 216.



0 Bubble plots are XY scatter plots that use symbols to represent not only XY locations, but also a third dimension represented by the size of the symbol. Use bubble plots to plot population density, epidemiological data, or other similar data sets where a third variable can be clearly illustrated by the size of the symbols.



Arranging Data for Bubble Plots



Data for bubble plots can either be X, Y data in two separate columns or single X or single Y data in one column. In both cases, an additional column is needed to
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 Working with 2D Graphs indicate bubble size values. Since the bubble size column corresponds to symbol diameter, you must convert the data for your third variable to diameters. Figure 6–57 Example of a Bubble Plot
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Bubble plots must have at least one plot, but can hold many more plots using different data formats if appropriate. The bubble plot type has available only the default scatter style. You can change the symbol type. However, if you use something other than a circle you will need a different equation to transform area to diameter.



Using X, Y Values for Bubble Plots Data for Bubble Size



Converting Area Data to Diameters



Bubble plot X, Y data is arranged in the same way as other 2D plot X, Y data, with all X values in one column and all Y values in another. SigmaPlot can graph bubble plots using XY pair, Single Y, Single X, and bubble size data. Bubble size values must be entered in a separate column. Each value corresponds to the diameter of the symbol, in whatever page units are being used. If you want bubble size to correspond to area data, you must convert your area data to diameters before creating the bubble plot. If you want your bubble plot to display area data, you must run this transform where area is the source column number and the diameter is the results column number. This transform is derived from the formula for the area of a circle. To convert your area data into diameters: 1.
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On the Transforms menu, click User-Defined.



 Working with 2D Graphs The User-Defined Transform dialog box appears. Figure 6–58 User-Defined Transform dialog box



2.



Type the transform function as follows: pi=3.14159265359 col(diameter)=sqrt(col(area)*factor/pi) where diameter is the column number for your diameter data, area is the column number for your original data to be represented by area, and factor is some number to increase or decrease the magnitude of your data to a reasonable range. It is very important to reduce the diameters of your symbols to a reasonable
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 Working with 2D Graphs size before plotting them. Figure 6–59 Transforming Area Data to Diameters



Σ Creating a Bubble Plot



3.



Click Run.



4.



Your new data appears in the worksheet.



If you change the symbol shape, you must use a different equation to transform area data. To create a bubble plot: 1.



Select the worksheet columns to plot before creating your graph by dragging the pointer over your data.



2.



Click the Graph Wizard



button.



The Graph Wizard appears. Figure 6–60 Graph Wizard Dialog Box
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From the Graph Types scroll-down list, select Bubble Plot, and



 Working with 2D Graphs click Next. 4.



From the Data Format list, select the appropriate format, and click Next.



5.



When you have selected all the columns to plot, including the Bubble Size column, click Finish.



Creating Multiple 2D Axes About Axes and Plots



0



You can only create new pairs of X or Y axes if you have more than one plot on a graph and you want to scale these plots differently. To learn about adding a plot to a graph, see Adding New Plots on page 196. More more information on working with grids and axes, see Modifying Axes, Tick Marks, and Grids on page 361.



Creating Additional Axes for Multiple Plots



If you have more than one plot on a graph and want to use multiple axes, use the following steps to add additional axes. To create an additional axis: 1.



Right-click the plot, and on the shortcut menu, click Add New Axis. The Graph Wizard appears.



Figure 6–61 Using the Graph Wizard Add Axis Dialog Box to Select the Plot for the New Axis



2.



Select to create either a new X axis or Y axis for the specified plot.
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Click Next.



4.



Select which side of the graph to add the new axis. You can add the new axis to the left, right, top, or bottom of the graph. Selecting an Offset location moves the new axis slightly to the side, top, or bottom of the original axis.



5.



Click Finish to add the new axis according to the specified settings.



Figure 6–62 Selecting to Create a New Y Axis for the Selected Plot



Figure 6–63 Specifying Where to Place the New Y Axis on the Graph



The New axis appears on the graph, and the plot re-scales to reflect the new axis. Figure 6–64 Example of a Second Y Axis Added to the Graph for a Line Plot
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Creating Multiple Axes for a Single Plot



If you want to use two or more X or Y axes for a single plot (for example, to show two different units of measurement), first create a plot which graphs empty columns, then add an axis to the empty plot. To add an axis to the second plot: 1.



Right-click the graph, and on the shortcut menu, click Add New Plot. The plot type does not matter, so long as it is a 2D Cartesian plot.



2.



Pick any data format.



3.



Pick empty columns when prompted to select the data to plot.



4.



On the Graph menu, click Add Axis to create multiple axes. Create an axis for this “dummy” plot at the desired location



5.



Select the new axis, then use manual scaling to set the appropriate range and tick interval for the new axis. This scale is often a linear transformation of the opposite axis scale, for example, a Celsius scale to a Fahrenheit scale.



Figure 6–65 The second temperature axis for the single plot was created by first creating a “dummy” plot, creating a Y axis for the dummy plot, then manually scaling the axis range.



To learn more about creating and modifying axes, see Modifying Axes, Tick Marks, and Grids on page 361.
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Notes
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Working with 3D and Contour Graphs This chapter describes 3D graphs and procedures specific to 3D graphs. This chapter covers: ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤



Basic 3D plot types and styles (see page 287) Arranging data for contour Plots and 3D graphs (see page 289) Creating 3D scatter and bar charts (see page 293) Creating trajectory plots (see page 294) Creating waterfall plots (see page 295) Creating mesh plots (see page 297) Changing mesh plot attributes (see page 298) Changing the rotation and lighting for 3D graphs (see page 299) Understanding 3D axis placement (see page 303) Modifying the frame lines for 3D graphs (see page 304) Generating more data for mesh plots (see page 306) Creating contour plots (see page 306) Modifying contour lines and labels (see page 308)



3D Plots



0 Create 3D (XYZ) plots from many worksheet columns or column triplets. XYZ plots must have at least one plot, but can display many more plots, each with a different type and style. Graphs can be rotated and shaded added to enhance the height and depth of mesh and bar charts. To learn about rotating graphs, see Changing Graph Perspective, Rotation, and Shading on page 299. For information on adding a light source to 3D graphs to produce shading, see Changing the View of a 3D Graph on page 299.
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3D Scatter and Line Plots



3D scatter and line plots graph data as symbols, as lines only with no symbols, or as symbols and lines. Use the Graph Properties dialog box Plots tab Symbols settings to add symbols to a 3D line plot, or the Lines settings to add lines to a scatter plot. To learn about modifying or adding symbols and lines, see Changing Symbol Type and Other Symbol Options on page 204, and Changing Line Type and Other Line Options on page 213.



Figure 7–1 Examples of a 3D Scatter Plot and a 3D Line Plot



Drop lines to any back plane can be added to either of these plot types. For more information on adding drop lines, see Adding and Modifying Drop Lines on page 226.



Mesh Plots



Figure 7–2 Mesh Plot with No Fill Color and with a Gradient of Colors
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Mesh plots graph 3D data as a continuous surface with a mesh. Use the Graph Properties dialog box to modify mesh lines, color, transparency, and to enable the light source for shading. To learn more about modifying meshes, see Modifying Mesh Lines and Fill Color on page 298 and to learn about using the light source, see Changing the View of a 3D Graph on page 299.
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3D Bar Charts



Create bar charts in 3D space using 3D data. Modify 3D bar charts by changing fill color and pattern, and adjusting bar width and spacing.



Figure 7–3 3D Bar Charts



For information on changing bar chart fill color and pattern, see Changing Patterns and Fill Colors on page 216. To learn about modifying bar width and spacing, see Changing Bar and Box Widths and Spacing on page 222.



Waterfall Plots



Waterfall plots graph 3D data as stacked line plots along the Y axis. Use the Graph Properties dialog box to modify plot lines, color, and transparency.



Figure 7–4 Waterfall Plots



Arranging Data for Contour Plots and 3D Graphs



0



Organize data for SigmaPlot graphs by column. Typically, data for contour plots and 3D graphs is composed of X, Y, and Z value columns, or one or more Z columns and optional X and Y columns. 3D bar charts, scatter plots, and line plots can use any three columns as XYZ data; however, contour and mesh plots require a strict arrangement of the data.



Σ



If multiple Z columns are plotted, they all must be next to each other. The X and Y columns can be located anywhere.
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Data for 3D Bar Charts, 3D Scatter Plots, and 3D Line Plots



Arrange data for 3D bar charts, scatter plots, and line plots either as XYZ triplet data, multiple columns of Z data, or as a single column for Y values, a single column for X values, and multiple columns for Z values. For each of these graph types, the data in each row is graphed as a data point. For bar charts, each column of Z data is plotted as a row parallel to either the X axis, with Y values as the constants. If you are formatting XYZ triplet data, you also can use one of the multiple Z column formats designed for 3D mesh plots. For more information, see Data for Contour and Mesh Plots on page 290.



Σ Data for Contour and Mesh Plots



3D bar charts cannot use XYZ triplet data. You can use the X, Y, and many Z format; however, you must have at least two columns of Z data. Data for a contour or mesh plot requires XYZ coordinates for each intersection of a rectangular mesh. Y1
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The arrangement of this data for the three possible methods of picking columns to plot are described in the following sections.



X, Y, and Z Data in Three Columns: To plot three columns as the X, Y, and Z values of a contour or mesh plot, the data must be in long form mesh format. This format assigns the proper Z value to each X and Y point in the mesh, in the required order. For example, for the table of X, Y, and Z values shown above, the three column mesh format must be arranged in the worksheet as:
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This arrangement places the XYZ data point coordinate values in the required order. The XYZ columns must be the same length. Figure 7–5 Data Arranged in Long Form Mesh Format



X and Y Columns vs. Many Z Columns: You can also place the X and Y data in single columns, then place the corresponding Z data in many continuous columns. This method may work best if you have XYZ data displayed in a table, or if you have irregularly incremented X or Y values. To use this option, you should have as many Z columns as you have Y rows, and the Z columns should be the same length as the X column. X data
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 Working with 3D and Contour Graphs The data in the first Z column is assigned to the first Y value, the data in the second Z column to the second Y value, etc. The data in each row of the X column is assigned as the X value for the data in the same row in the Z columns. Figure 7–6 XYZ Data Arranged as One X Column, One Y Column, and Many Z Columns



The X and Y data must be strictly ascending or descending. Note that in this case, you can use columns of uneven length. Extra X, Y, or Z values created by uneven columns are not plotted, as mesh plots cannot graph missing values.



Z Data vs. Row and Column Numbers: You can also plot columns as Z values versus the cell columns and row numbers as the X and Y values. This is the appropriate column assignment option to use: for mesh plots and 3D Bar Charts where X and Y values are evenly and equally spaced; for example, when graphing pixel intensity data for an image. All data is assigned as a Z value, and the Z columns must be contiguous. To use this format for a mesh plot, no special data arrangement is required other than
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 Working with 3D and Contour Graphs equal column length. The rows and columns of the cells can be used as either the X or Y values. Figure 7–7 Mesh Plot Data Arranged as Z Data Versus Row and Column Numbers



Creating 3D Scatter Plots and 3D Bar Charts



0



3D scatter plots can use any data format; however, 3D bar charts are limited to XY Many Z or Many Z only. For more information on the available data formats for the graph you are making, see the description of the graph type in SigmaPlot Graph Types on page 165. To create a 3D scatter plot or 3D bar chart: 1.



Select the worksheet columns to plot by dragging the pointer over your data.



2.



On the 3D Graph Toolbar, click 3D Scatter Plot or 3D Bar Chart. The Graph Wizard appears.



Figure 7–8 Specifying the Data Format



3.



From the Data Format list, specify how your data is formatted. The data formats available depend on the graph type you are making.
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Click Next.



Figure 7–9 Selecting Columns to Plot



Since you already selected columns prior to opening the Graph Wizard, your choices automatically appear in the dialog box. 5.



Click Finish.



Use the Graph Properties dialog box to modify the plot, or reopen the Graph Wizard to pick different data columns for your plot, or to add another plot to your graph. For more information on making general modifications to your plot, see Creating and Modifying Graphs on page 163.



Creating Trajectory Plots



0



Trajectory plots use an XYZ coordinate system to create a 3D line plot. To create a trajectory plot: 1.



Select the worksheet columns to plot by dragging the pointer over your data.



2.



On the 3D Graph Toolbar, click 3D Line Plot and then 3D Trajectory. The Graph Wizard appears. Since you already selected columns prior to opening the Graph Wizard, your choices automatically appear in the Selected
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 Working with 3D and Contour Graphs Columns list. Figure 7–10 Graph Wizard Select Columns Panel



3.



Click Finish.



Use the Graph Properties dialog box to modify the plot, or reopen the Graph Wizard to pick different data columns for your plot, or to add another plot to your graph. For more information on making general modifications to your plot, see Creating and Modifying Graphs on page 163.



Creating Waterfall Plots



0



3D waterfall plots are stacked line plots along the Y axis. Because hidden lines are eliminated, waterfall plots are useful for showing trends of line plots. Figure 7–11 Waterfall Plot



3D waterfall plots are limited to Many Z and XY Many Z data formats. For more information on the available data formats for the graph you are making, see the description of the graph type in SigmaPlot Graph Types on page 165. To create a waterfall plot:
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Select the worksheet columns to plot by dragging the pointer over your data.



2.



On the 3D Graph Toolbar, click 3D Line Plot and then click 3D Waterfall. The Graph Wizard appears.



Figure 7–12 Graph Wizard Data Format Panel



3.



From the Data Format list, choose the appropriate data format.



4.



Click Next.



Figure 7–13 Graph Wizard Select Columns Panel



Since you already selected columns prior to opening the Graph Wizard, your choices automatically appear in the Selected Columns list. 5.



Click Finish.



Use the Graph Properties dialog box to modify plot lines, color, and transparency. For more information on making general modifications to your plot, see Creating and Modifying Graphs on page 163.
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Creating Mesh Plots



0



When you create a mesh plot you can choose between solid and transparent mesh with discrete or gradient shading. Use a transparent mesh to highlight the relationship of one mesh plot to another on the same graph. 3D mesh plots use an XYZ coordinate system; the data points are graphed as intersections of a mesh grid. If you select Many Z as the data format, SigmaPlot uses column numbers as the X values, and row numbers as the Y values. If you are using XYZ triplet data, you need to reformat the data. For more information, see Smoothing 2D and 3D Data on page 420. To create a 3D mesh plot: 1.



Select the columns to plot by dragging the pointer over your data.



2.



On the 3D Graph Toolbar, click 3D Mesh Plot. The Graph Wizard appears.



Figure 7–14 Specifying the Data Format



3.



From the Data Format list, choose the appropriate data format, and click Next.



Figure 7–15 Using the Create Graph Dialog Box to Pick Columns to Plot



Since you already selected columns prior to opening the Graph Wizard, your choices automatically appear in the dialog box.
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Click Finish.



Use the Graph Properties dialog box to modify the plot, or reopen the Graph Wizard to pick different data columns for your plot, or to add another plot to your graph. For more information on making general modifications to your plot, see Creating and Modifying Graphs on page 163. For information on changing mesh attributes, see Modifying Mesh Lines and Fill Color on page 298.



Modifying Mesh Lines and Fill Color



0



To modify mesh lines and fill color: 1.



Double-click the plot. The Graph Properties dialog box appears.



Figure 7–16 Graph Properties Dialog Box Plots Tab Mesh Settings



2.



Click the Plots tab.



3.



From the Settings For list, select Mesh.



4.



To change the color of the mesh, under Fill Colors, from the Color dropdown list, select a color. Select (none) to create a transparent mesh, select (Custom) to create a custom color (see Using Custom Colors on page 158), and select one of the color schemes or color columns to increment the mesh from bottom to top using a color array. For information on using custom colors from a column, Using Custom Symbol, Fill, Line, and Color Increments on page 220.



5.



To make your mesh translucent, under Fill Colors, select Transparent. Objects behind it will be visible. Use this option to more clearly show the intersections between two or more 3D meshes.
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Σ 6.



Σ



Set your display to High Color (16 bit) or True Color (24 bit) for this feature to work properly. Check your system’s color capabilities under the Windows Display Properties Settings. If you are using a color scheme, under Fill Colors, from the Transition dropdown list, specify how the colors flow across the grid. Select Discrete to use an increment with a clear shift between colors, or select Gradient to use an increment with a gradual shift between colors.



The Transition drop-down list is available only when using a fill color scheme.



7.



To change mesh lines, from the Settings For list, select Lines Use the Color drop-down list to change line color. Selecting (None) creates transparent mesh lines, and selecting (Custom) enables you to use or create a custom color. For more information on using custom colors, see Using Custom Colors on page 158.



8.



To change line thickness, move the Thickness slider, or type a new value in the Thickness box.



9.



Click OK.



Changing Graph Perspective, Rotation, and Shading



0



Modify the view of the 3D graph by changing perspective and rotation of the graph, and by enabling a light source to add shading.



Changing the View of a 3D Graph



To change the perspective of a 3D graph, rotate a graph, and enable the light source: 1.



Double-click the plot.
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 Working with 3D and Contour Graphs The Graph Properties dialog box appears. Figure 7–17 Graph Properties Dialog Box 3D View Tab Rotation Settings



2.



Click the Graph tab.



3.



From the Settings For list, select Rotation. This tab displays a Preview that shows how the current settings affect the selected graph.



4.



Σ



To rotate the graph, move the Horizontal View and Vertical View sliders, or type horizontal or vertical values into the boxes. Horizontal and vertical values are in degrees. Rotate the graph horizontally from 0° to 360°, or vertically from −90° to +90°. The recommended Horizontal View is 205°, and the Vertical View is 25° The three solid red axes displayed in the Preview box of the 3D View tab are the origin axes for the rotation, and are used as reference when determining the angles of rotation. The rotation is displayed in the axes degrees from 0°. The origin used to determine the degree from the horizontal or vertical is the intersection of the three axes. When both rotation angles are set to 0°, the origin as you see the graph, is the left bottom rear corner.
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Σ



The origin axes are not related to the axes marked with ticks and tick labels, but act as the zero point for tick labels and data.



Figure 7–18 A 3D graph with a horizontal rotation of 0°, a vertical rotation of 0°, and a perspective of 20.



Figure 7–19 A 3D graph with a horizontal rotation of 0°, a vertical rotation of 45°, and a perspective of 20.



Figure 7–20 A 3D graph with a horizontal rotation of 45°, a vertical rotation of 45°, and a perspective of 20.



5.



To change the perspective of the graph, move the Perspective slider, or type a new value into Perspective box.
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Σ



The Perspective value is based on the “depth” of the graph. A perspective of 0% means that the graph has no depth; 100% means that the graph has maximum depth. The recommended perspective is 20%.



Figure 7–21 A 3D graph with a perspective of 0.



Figure 7–22 A 3D graph with a perspective of 50.



Figure 7–23 A 3D graph with a perspective of 100.



6.



To enable the light source and create shading on your graph, select Enable Light Source. If the check box is cleared, the light source is not applied to the graph.
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Σ



Set your display to High Color (16 bit) or True Color (24 bit) for this feature to work properly. You may check your system’s color capabilities under the Windows Display Properties Settings.



Figure 7–24 The graph on the right has the light source option selected.



Σ



3D line and scatter plots are not affected by the light source option.



7.



To return to the 3D View settings you had before applying any changes, click Revert to original settings.



8.



Click OK.



3D Graph Axis Placement



0



3D axes are always at the following positions: ➤



X: bottom right front Y: bottom left front ➤ Z: left front ➤



Axis Placement During Graph Rotation



When you rotate the view of a 3D graph, SigmaPlot automatically repositions the visible axes to the front of the graph so that the axes do not become positioned behind the graph. For more information on rotating 3D graphs, see Changing Graph Perspective,



Rotation, and Shading on page 299.
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Frame Lines for a 3D Graph Drawing, Modifying, and Hiding Frame Lines



0



Drawing a 3D graph frame completes the “cube” surrounding the plotted data. Normally, these lines are hidden. You can use a frame to mark the origin axes, or to mark the 3D extent of the graph. Frame lines are unrelated to the lines used to draw axes and planes, and are controlled independently of those lines. Frame lines are drawn over the axes. To add frame lines, modify frame lines, or hide frame lines from view: 1.



Double-click the plot. The Graph Properties dialog box appears.



Figure 7–25 Graph Properties Dialog Box 3D View Tab Frame Lines Settings



2.



Click the Graph tab.



3.



From the Settings For list, select Frame Lines.



4.



From the Frame Lines drop-down list, select either:. ➤ Relative to Viewer: If the frame is oriented from your perspective, one



set of lines is composed of the three cube edges closest to you, and the other lines are the remaining sides of the cube. The position of these lines is independent of the graph's rotation. This is the default position. ➤ Relative to Graph Origin: If the frame is drawn according to the origin, one set of the lines is drawn over the origin axes (see page 300), and the
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 Working with 3D and Contour Graphs other lines draw the remainder of the cube. The position of these lines is dependent on the graph's rotation. Figure 7–26 These graphs use the Viewer as the point of reference. The graph on the left draws only the “front” lines, and the right graph draws only the “back” lines



Figure 7–27 These graphs use the Origin as the point of reference. The graph on the left draws only the origin lines, and the right graph draws only the non-origin lines



5.



Hide frame lines, or add frame lines to your graph by selecting or clearing the appropriate Show check box. Selected frame lines are drawn. A graph cannot display frame lines for both the Relative To Viewer and Relative To Graph Origin perspectives. If Relative To Graph Origin is selected from the Frame Lines drop-down list, the Show check boxes for Relative To Viewer are cleared automatically, and vice versa.



6.



To change the frame line type, under Front lines, from the Line Type dropdown list, select a line type.



7.



To change a frame line color, under Front Lines, from the Color drop-down list, select a frame line color.



Σ



Choose (None) from either list to create transparent frame lines. Choose (Custom) from the Color drop-down list to use or create a custom color. For more information on using custom colors, see Using Custom Colors on page 158.
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To the modify frame line thickness, move the Thickness slider, or type a new thickness value into the thickness field.



9.



Click OK.



Creating Contour Plots



0



Contour graphs and filled contour graphs plot 3D data on an XYZ coordinate system with the Z data (vertical) indicated with lines at specified Z intervals. If you select Many Z as the data format, SigmaPlot uses column numbers as the X values, and row numbers as the Y values. If you are using XYZ triplet data, it needs to be reformatted as mesh data. For more information on using the XYZ triplet format, see Smoothing 3D Data on page 425. Figure 7–28 Contour Plots



To create a contour plot: 1.



Select the worksheet columns to plot by dragging the pointer over your data.



2.



On the 3D Graph Toolbar, click Contour Plot and then Contour.
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The Graph Wizard appears.



4.



From the Data Format list, select the appropriate data format, and click Next.



Figure 7–29 Graph Wizard Data Format Panel



The Graph Wizard prompts you to specify which worksheet columns correspond to the data for your plot. Since you selected columns prior to opening the Graph Wizard, your choices automatically appear in the Selected Columns list. Figure 7–30 Graph Wizard Select Columns Panel



Σ



5.



If you made a mistake picking data, click the wrong entry in the Selected Columns list, then select the correct column from the worksheet. You can also clear a column assignment by double-clicking it in the Selected Columns list. Click Finish.



To create a filled contour plot: 1.



Select the worksheet columns to plot by dragging the pointer over your data.



2.



On the 3D Graph Toolbar, click Contour Plot and then Filled Contour.
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The Graph Wizard appears.



4.



From the Data Format list, select the appropriate data format and click Next.



Figure 7–31 Graph Wizard Data Format Panel



The Graph Wizard prompts you to specify which worksheet columns correspond to the data for your plot. Since you selected columns prior to opening the Graph Wizard, your choices automatically appear in the Selected Columns list. Figure 7–32 Graph Properties Select Columns Panel



5.



Click Finish.



Modifying Contour Plots



0



Modifying contour plots involves: ➤



Picking new data for the plot (see Picking Different Data for the Current Plot on page 194). ➤ Changing contour line attributes, and hiding or displaying lines (see Displaying and Changing Contour Lines on page 309).
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Modifying back plane color and grid lines (see Modifying Grids and Planes on page 396). Changing the vertical (Z data) range and scale (see Changing Contour Vertical (Z Data) Range and Scale on page 311). Changing X and Y axis and tick attributes (see Modifying Grids and Planes, Titles and Legends on page 190). Adding colors to contour fills (see Adding Fills to Contour Plots on page 310). Turning on or off interpolated fills (see Modifying Interpolated Filled Contours on page 311). Changing and displaying contour labels (see Displaying and Modifying Contour Labels on page 313).



To modify a contour plot, select the graph and open the Graph Properties dialog box. To learn about selecting graphs and using the Graph Properties dialog box, see Modifying Graphs on page 189, and Selecting a Graph or a Plot on page 191.



Displaying and Changing Contour Lines



To hide, display, and modify contour plot lines: 1.



Double-click the plot. The Graph Properties dialog box appears.



Figure 7–33 Graph Properties Dialog Box Plots Tab Contours Settings



2.



Click the Plots tab.



3.



From the Settings For list, select Contours.



4.



To modify contour lines, from the Contours drop-down list, select Major or Minor. The Line Styles reflect the contour you select in the Contour dropdown list. Select Major to change the Line Styles for major contours. Select Minor to change the Line Styles for minor contours.



5.



To specify the line type of major and minor contour lines, from the Modifying Contour Plots 309



 Working with 3D and Contour Graphs Type drop-down list, select a line type. Select one of the incrementing schemes to increment contour line types, or select (None) to create transparent lines.



Σ 6.



To learn about using custom increment schemes, see Using Custom Symbol, Fill, Line, and Color Increments on page 48. To select the color of the contour lines, from the Line Style Color dropdown list, select a color. You can choose from several predefined color schemes, or select (None) to create transparent lines. Select the (Custom) option to create a custom color. For more information see Using Custom Colors on page 158.



7.



To set the thickness of the contour lines, move the Thickness slider, or type a new value in the Thickness box.



8.



Adding Fills to Contour Plots



Click OK.



To fill intervals between contour lines with colors: 1.



Double-click the plot. The Graph Properties dialog box appears.



Figure 7–34 Graph Properties Dialog Box Plots Tab Contours Settings



2.



Click the Plots tab.



3.



From the Settings For list, select Contours.



4.



From the Contours drop-down list, select Major.



5.



From the Color drop-down list, select from several predefined color schemes.



6.



From the Fill Start drop-down list, set the direction of the contour fills. The
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 Working with 3D and Contour Graphs default direction is bottom. That is, the fill starts from the lowest z value. You can also create filled contour plots automatically when you first create the graph. You can either select the Filled Contour Plot style from the graph toolbar, or choose Filled Contours from the Graph Wizard.



Modifying Interpolated Filled Contours



When you create a filled contour plot from the toolbar, its fill colors are automatically interpolated and stretched to fit the number of z-intervals. To turn off interpolated fills: 1.



Double-click the graph. The Graph Properties dialog box appears.



Figure 7–35 Graph Properties Plots Tab Contour Settings



Changing Contour Vertical (Z Data) Range and Scale



2.



Click the Plots tab.



3.



From the Settings For list, select Contours.



4.



From the Contours drop-down list, select Minor.



5.



Under Fills, from the Color drop-down list, select (None).



6.



Click OK.



Use the Graph Properties Range settings to select the scale type and set the vertical range used by the contour lines. To set the scale and range used by contour lines: 1.



Double-click the plot.
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 Working with 3D and Contour Graphs The Graph Properties dialog box appears. Figure 7–36 Graph Properties Plots Tab Scale Settings



Changing Contour Line Intervals



2.



Click the Plots tab.



3.



From the Settings For list, select Scale.



4.



From the Scale Type list, select Linear or Log (Common) scale. The linear scale uses a standard base 10 numeric scale, and the log scale uses a base 10 logarithmic scale.



5.



To manually set the Z axis range, in the Start and End boxes, enter beginning and ending range values.



6.



To automatically set the Z axis range, from the Calculation drop-down lists, select Data Range. SigmaPlot automatically determines the vertical range based on the Z data plotted.



7.



To add padding to both ends of the axis, select Pad 5%.



8.



To extend the range to the nearest major tick mark, select Nearest Tick.



9.



Click OK.



Use the Graph Properties Line Interval settings to select line intervals for Major and Minor contours. To set line intervals: 1.
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Double-click the plot.



 Working with 3D and Contour Graphs The Graph Properties dialog box appears. Figure 7–37 Graph Properties Plots Tab Scale Settings



2.



Click the Plots tab.



3.



From the Settings For list, select Scale.



4.



From the Apply to drop-down list, select the Major or Minor lines to modify.



5.



Under Line intervals, from the Lines drop-down list, select one of the following intervals: ➤ Automatic: SigmaPlot automatically determines the interval at which



contour lines are drawn. ➤ Manually: Manually set the number of contour lines are drawn. Enter the



z interval in the Every field, and the value at which the first interval is drawn in the From field. ➤ Columns: Select the column used to determine major contour line z values. Note that when major contour lines are plotted from a column, no minor lines are drawn. 6.



Displaying and Modifying Contour Labels



Click OK.



Use the Graph Properties dialog box Label settings to switch contour line labels on and off, add prefixes or suffixes to labels, and rotate labels relative to the contour line. For information on modifying contour X and Y axis tick labels, Changing Tick Labels on page 387. To add, hide, or modify contour line labels:
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Double-click the contour plot. The Graph Properties dialog box appears.



Figure 7–38 Graph Properties Dialog Box Plots Tab Labels Settings



2.



Click the Plots tab.



3.



From the Settings For list, select Labels.



4.



To display or hide contour labels, under Contour Labels, select or clear Major Contour Labels and Minor Contour Labels. Selected options display labels, and cleared options hide labels.



5.



To align contour labels parallel to the contour line, under Label Appearance, elect Align With Contour Line. Clear the option to align the contour labels parallel to the X axis.



6.



To control how many labels appear for the contour lines, move the Label Frequency slider. Move the slider toward Fewer to reduce the number of contour labels, or move the slider toward More to increase the number of contour labels.



7.



To add to the contour labels, under Add to Major Labels and Add to Minor Labels, in the Prefix and Suffix boxes, type the prefix or suffix.



8.



To separate a suffix or prefix from the tick label, type a space before a suffix or after a prefix.



9.



Click OK.
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Changing Contour Label Text Attributes



Changing the text attributes for both major and minor contour labels involves changing the font, style, size, and color of the text. To open the Text Properties dialog box: 1.



Double-click the contour plot. The Graph Properties dialog box appears.



2.



Click the Plots tab.



3.



From the Settings For list, select Details.



4.



Click Font. The Text Properties dialog box appears. To learn about using the Text Properties dialog box, see Formatting Text on page 146.



Changing Numeric Contour Label Settings



Use the Graph Properties Detail settings to modify numeric contour labels. To change numeric contour labels: 1.



Double-click the plot. The Graph Properties dialog box appears.



2.



Click the Plots tab.



3.



From the Settings For list, select Details. The numeric contour settings appear.



4.



To use a numeric type of contour label, from the Type list, select Numeric, then use the Label Notation options.



5.



From the Use list, specify which type of numeric display to use. The Scientific Notation and Engineering Notation options always use scientific notation or engineering notation to display numbers. For large numbers options, use scientific or engineering notation only when numbers exceed a specified range. Use the Above and Below lists to specify the range beyond which scientific notation or engineering notation is used. For log scale, you can select to display number, only the Exponent, or both the Base and Exponent. For linear scale, you can always use scientific notation, or only when needed. If you use scientific notation only when needed, set the range to by typing values in the Lower and Upper ranges in the edit boxes. These values are expressed in log units.
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Use the Precision options to specify the number of places used to display numeric tick labels. Select Automatic to let SigmaPlot automatically determine precision, or select Manual, then select the number of decimal places to use from the Places drop-down list.



7.



To use a series type of contour label, from the Type drop-down list, select Series then from the Series list, select the type of series.



8.



From the Length drop-down list, select the number of characters to use for the labels.



9.



From the Start At drop-down list, select the series item to begin labeling tick marks with, then from the Step By drop-down list, select the frequency or increment for the series.



Figure 7–39 The Series Labels Settings for Contour Labels



10. To restart tick labeling from a specified point, use the After and Repeat From drop-down lists. 11. To use values or text from a worksheet column, enter the values or text in a worksheet column, then from the Series list, select the column containing tick labels. 12. To change the font size, style, or color of text labels, click Font to open the Text Properties dialog box. To learn about using the Text Properties dialog box to format text, see Formatting Text on page 146. 13. Click OK.
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Working with Pie, Polar, and Ternary Plots This chapter describes procedures specific to pie charts, polar plots, and ternary plots. To learn about making general graph modifications, like changing symbols, lines, or fills, see Creating and Modifying Graphs on page 163. This chapter covers: ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤



Creating pie charts (see page 318) Changing pie chart slice settings (see page 319) Creating polar plots (see page 323) Basic polar plot attributes (see page 325) Changing polar plot angular axis (see page 327) Changing plot radial axes (see page 330) Modifying polar plot radial axis tick marks and tick labels (see page 332) Creating ternary graphs (see page 334) Basic ternary graphs attributes (see page 338) Moving ternary plot axis titles (see page 339) Changing ternary plot axes ranges and scaling (see page 340) Modifying ternary plot tick marks and tick labels (see page 345)
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 Working with Pie, Polar, and Ternary Plots



Pie Charts



0 Pie charts plot a single worksheet column by representing each data point in the column as a pie slice. Each data point in the column is graphed as a slice size equivalent to the data point's percent of the sum of all the data.



Figure 8–1 Pie Charts
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The first pie slice starts at 0° (3 o'clock) by default. Additional slices are added counterclockwise, in the order the data points occur in the column.



Arranging Data for a Pie Chart



To organize data for a pie chart, place data in a single worksheet column.



Figure 8–2 Arranging Data for a Pie Chart All data is placed into a single column.



Making a Pie Chart



0 To make a pie chart:
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1.



Select worksheet data before creating the graph.



2.



On the 2D Graph Toolbar, click Pie Chart.



 Working with Pie, Polar, and Ternary Plots The Graph Wizard appears. Figure 8–3 Using the Create Graph Dialog Box to Pick Columns to Plot



3.



Specify which worksheet column corresponds to data for your plot. Since you selected a column prior to opening the Graph Wizard, your choice automatically appears in the dialog box and you can click Finish to create the pie chart.



4.



If you selected the incorrect columns to plot, select a column either by clicking the corresponding column directly in the worksheet, or selecting the appropriate column from the Data for Pie list.



Σ 5.



If you make a mistake while picking data, click the wrong entry in the Graph Wizard, then select the correct column from the worksheet. Click OK.



Use the Graph Properties dialog box to modify the pie chart, or reopen the Graph Wizard to pick a different data column for your plot. For more information on making general modifications to your plot, see Creating and Modifying Graphs on page 163.



Σ Modifying Pie Charts



You cannot add plots or axes to pie charts. Modifying pie charts includes: ➤



Picking new data for the graph (see Picking Different Data for the Current Plot on page 194). ➤ Changing fill color and patterns of pie chart slices (see Changing Patterns and Fill Colors on page 216). ➤ Rotating the pie chart (see the following section). ➤ Adding exploded pie slices to the pie chart (see the following section). To modify a pie chart, select the graph and open the Graph Properties dialog box. To learn about selecting graphs and using the Graph Properties dialog box, see Modifying Graphs on page 189, and Selecting a Graph or a Plot on page 191.
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Rotating the Pie



Use the Graph Properties dialog box to rotate pie charts or add single or multiple exploding slices. To rotate the pie: 1.



Double-click the pie chart. The Graph Properties dialog box appears.



Figure 8–4 Graph Properties Dialog Box Plots Tab Pie Slices Settings



Adding Exploding Slices



2.



Click the Plots tab.



3.



Select Pie Slices from the Settings For list.



4.



Move the Counterclockwise from slider to change the starting angle. Increasing the starting angle for the first slice moves the starting slice counterclockwise. The default is 0° (3 o’clock).



5.



Click OK.



Use the Graph Properties dialog box to add single or multiple exploding slices. To explode one slice: 1.
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Double-click the pie chart.



 Working with Pie, Polar, and Ternary Plots The Graph Properties dialog box appears. Figure 8–5 Graph Properties Dialog Box Plots Tab Pie Slices Settings



2.



Click the Plots tab.



3.



Select Pie Slices from the Settings For list.



4.



Select Single Slice from the Exploded Slices drop-down list.



5.



Select the number of the slice to explode from the Slice drop-down list. By default, the first slice begins at 0° and proceeds counterclockwise. If you have not rotated the pie chart, the slice number corresponds to the worksheet row number.



6.



Σ



Click OK.



Choosing No Exploded Slices from the Exploded Slices drop-down lists replaces any exploded pie slices.



To explode multiple slices: 1.



Select an empty column.



2.



Type a 1 in the same row as the data point for each row you want to emphasize with an exploding slice.



3.



Double-click the pie chart.
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 Working with Pie, Polar, and Ternary Plots The Graph Properties dialog box appears. Figure 8–6 Graph Properties Dialog Box Plots Tab Pie Slices Settings



Figure 8–7 Pie Chart with Many Exploding Slices



322 Pie Charts



4.



Click the Plots tab.



5.



Select Pie Slices from the Settings For list.



6.



Select the column containing exploding slice data from the Exploded Slices drop-down list.



7.



Click OK.
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Polar Plots



0 Polar plots display data in the coordinate system ( r, θ ) format where r is the distance from the origin of the graph, and theta (θ) is the angle between the positive horizontal axis and the radius vector extending from the origin to the plotted data point. Polar plots are useful for showing data where one value (θ) is periodic in nature, like a clock. An example of this is a graph that shows average temperatures of differing geographical regions during the days of a month, or months of a year. 90



90



Figure 8–8 Polar Plots
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Arranging Data for Polar Plots



0



Data for polar plots can be entered in either one of two ways: ➤ ➤



R, θ values X,Y coordinates



Data for Radial and Angular Values (R, Theta)



To arrange data using θ (angular) and R (radial) values, enter all θ values in one column, and enter the corresponding R values in another column. Data is plotted as θ versus R, which is similar to X,Y plots in organization, but differs from X,Y plots in that R is usually the dependent variable.



Using X,Y Values for Polar Plots



Polar plot X,Y data is arranged the same as 2D plot X,Y data, with all X values in one column, and all Y values in another column; however, polar plots are plotted as R,θ pairs defined as:



R =



y x 2 + y 2 and θ = atan  -  x



where R is the radius, and θ is the angle of the data point from the origin.
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Data for Multiple Curves Using Data from One Column for Multiple Curves



Since SigmaPlot can graph more than one curve per plot, place as many additional θ, R values, or X,Y coordinates, as you want to plot in worksheet columns. SigmaPlot can also graph many curves using the same column as the θ or R data (or, X or Y data). There is no need to duplicate a column that is used for more than one plot; for example, enter the θ data into only one column, and enter the corresponding R or dependent data into as many columns as needed.



Making Polar Plots



0 To create a polar plot: 1.



Select the worksheet columns to plot by dragging the pointer over your data.



2.



On the 2D Graph Toolbar, click Polar Plot, and then click the style of polar plot you want to create. The Graph Wizard appears.



Figure 8–9 Choosing an Angular Axis Unit from the Angular Axis Unit list



3.



Choose a unit type from the Angular Axis Unit list. The Range Lower Bound and Range Upper Bound options change depending on your selection from the list. For more information on polar axes, see Modifying Polar Axes on page 326.



Σ 4.
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If you don’t see the axis units you want to use for your polar plot listed in the list, you can type the desired values in the Range Lower Bound and Range Upper Bound fields. Click Next.
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Select the appropriate data format from the Data Format list.



6.



Click Next.



7.



Click Finish.



Figure 8–10 Using the Graph Wizard to Specify the Data Format



Use the Graph Properties dialog box to modify the plot, or reopen the Graph Wizard to pick different data columns for your plot. For more information on making general modifications to your plot, see Creating and Modifying Graphs on page 163.



Modifying Polar Plots



0



Modifying polar plots involves: ➤



Picking new data for the plot (see Picking Different Data for the Current Plot on page 194). ➤ Changing line and symbol type, size, and color (see Changing Symbol Type and Other Symbol Options on page 204 and Changing Line Type and Other Line Options on page 213). ➤ Modifying back plane color and grid lines (see Modifying Grids and Planes on page 396). ➤ Modifying angular and radial axes (see Modifying Polar Axes on page 326). To modify a polar plot, select the graph and open the Graph Properties dialog box.
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Modifying Polar Axes



0



Polar plots have a radial axis and an angular axis. The angular axis describes a circle and can use radians, degrees, or other units as the scale. There are both outer and inner angular axes. The radial axes are “spokes” of the circle and scale the distance from the center of the circle (the radius, or R). There are four radial axes, referred to as spokes 1-4. Figure 8–11 A Diagram of the Axes of a Polar Plot



90



Radial Axis



80



120



60



60 40



Inner Angular Axis



150



30 20



Angular Axis



Angular Data



0 120 80



60



40



20



180



0



90



60



150



30



180



0



210



330 240



270



300



0 0



20



40



60



80



Radial Data



0



Radial 20 330



210 40 60 80



240



300



270



Σ Angular Axes



Axis breaks cannot be created for either radial or angular axes. The angular axes can be drawn along the inner and outer circumferences of the graph. By default, the inner axis is not displayed. Angular axes can be modified by: ➤



Changing axis titles (see Working with Axis Titles and Tick Labels on page 375). ➤ Displaying or hiding either axis (see Hiding, Displaying, and Deleting Axes on page 370). ➤ Changing axis lines (see Changing Axis Line, Color, and Thickness on page 372). ➤ Changing axis scaling, range, and rotation (see Changing Angular Axis Scaling and Position on page 327).
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Changing the amount of polar arc displayed (see Changing Angular Axis Scaling and Position on page 327). ➤ Changing tick marks (see Changing Tick Mark Intervals on page 378). ➤ Changing axis tick labels (see Changing Tick Labels on page 387).



Radial Axes



The radial axes are drawn along the radius of the graph, and by default are displayed as four axes extending from the center of the graph to the outer edge of the graph. Each of the radial axes is a representation of the same data, so the range and scale must be the same for each radial axis; however, you can modify the color, tick marks, labels, location, and display of each radial axis independently. Radial axes can be modified by: ➤



Displaying or hiding any axis (see Modifying Radial Axes Lines and Position



on page 330). ➤ ➤ ➤ ➤ ➤



Changing display of axis and tick label titles (see Displaying and Changing Radial Axis Ticks and Labels on page 332). Changing axis lines (see Modifying Radial Axes Lines and Position on page 330). Changing axis scaling (see Changing Axis Scales on page 363). Changing tick marks (see Changing Tick Mark Intervals on page 378). Changing axis tick label type (see Changing Tick Labels on page 387).



Changing Angular Axis Scaling and Position Angular Axis Scaling



0



Polar plot angular axis scale and range settings control the axis units and increments used to plot data. You can modify axis scale, range, units, and rotation using the Scaling settings of the Graph Properties dialog box Axes tab. To change an axis scale, range, units, and rotation: 1.



Double-click the plot.
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 Working with Pie, Polar, and Ternary Plots The Graph Properties dialog box appears. Figure 8–12 Graph Properties Dialog Box Axes Tab Scaling Settings



2. Click the Axes tab. 3.



Select Scaling from the Settings For list.



4.



To change the axis scale used, choose the desired axis scale type from the Scale Type list. For descriptions of the different scale types available, see Axis Scale Types on page 363, and Using a Custom Axis Scale on page 369.



5.



To change the measurement units of the angular axis, select measurement units from the Angular Axis Units drop-down list. If you don’t see the axis units you want to use for your polar plot listed in the list, select Other, then type new axis range values in the Range Lower Bound and Range Upper Bound fields. If using a predefined measurement unit, the Range Lower Bound and Range Upper Bound box values are entered automatically.



Σ 6.



The only effect of changing units is to change the pre-defined axis range. This range can be manually changed regardless of the current units. To change the size of the displayed arc of the polar plot, move the Arc slider. A setting of 360° displays the entire circle, 270° displays three-quarters of the circle, and 90° displays half of the circle.



Σ



If you change the arc of the angular axis, the axis range remains the same. The current axis range appears along the new distance of the arc.
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Figure 8–13 Polar plots with: Starting angle of 315 ° and arc of 270 °; start angle of 0 ° and arc of 180 °; and start angle of 135 ° and arc of 22.5 °.



To change the start angle for the displayed arc, move the Start Angle slider. The default is 0° (3 o’clock). Rotation is counterclockwise. 180 210
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Click OK.



You can drag both inner and outer angular axes closer or further from the center of the graph. Select the axis, and move it using the mouse. To set exact locations for angular axes: 1.



Double-click an angular axis. The Graph Properties dialog box appears.



Figure 8–14 Graph Properties Dialog Box Axes Tab Lines Settings



2.



Click the Axes tab.



3.



Select Lines from the Settings For list.



4.



To change the percentage in the Outer and Inner axes, under Show/Place Axes, move the Outer and Inner slider controls. Locations are described as the percentage of the distance the axes lie from the
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 Working with Pie, Polar, and Ternary Plots center of the graph. To move an axis out, increase the percent. To move an axis in, decrease the percent. 5.



Click OK.



Modifying Radial Axes Lines and Position



0



Control polar plot radial axes line settings using the Lines settings of the Graph Properties dialog box Axes tab.



Moving and Positioning Radial Axes



To move a radial axis: 1.



Select the axis on the page.



2.



Use the mouse to drag it to a new location. Radial axes rotate about the center of the graph like the spokes of a wheel.



To set radial axis positions to exact degree positions: 1.



Double-click a radial axis. The Graph Properties dialog box appears.



Figure 8–15 Graph Properties Dialog Box Axes Tab Lines Settings



2.



Click the Axes tab.



3.



Select Lines from the Settings For list.



4.



To move a radial axis, under Show/Place Axes, move the sliders to set a new location. The axis location is in degrees from 0° (3 o’clock). The
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 Working with Pie, Polar, and Ternary Plots defaults are 0°, 90°, 180°, and 270°.



To offset an axis from the center of the graph, move the Axes Start



5.



slider to change the length of the radial axes.



Σ



Setting the slider to 0% draws the axis from the center of the graph outward, 25% draws the axis beginning a quarter of the distance from the center, 50% draws it half the distance from the center, and so on.



Figure 8–16 Radial Axes in the Default Positions, and Offset by 45 ° with an Axes Start of 30%.
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Changing Radial Axes Lines



300 270



Click OK.



To display and modify radial axes lines: 1.



Double-click a radial axis. The Graph Properties dialog box appears.



Figure 8–17 Graph Properties Dialog Box Axes Tab Lines Settings



2.



Click the Axes tab.
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Select Lines from the Settings For list.



4.



To view or hide a radial axis, select Spoke 1, 2, 3, or 4. The Show/Place Axes boxes display the axis location on the graph.



5.



To change line color and thickness, under Line Properties, select a color and thickness from the Color and Thickness drop-down lists.



6.



Click OK.



Displaying and Changing Radial Axis Ticks and Labels Use the Graph Properties dialog box Axes tab Labels settings to display polar radial axis labels, and modify tick labels. Angular axes labels are analogous to standard Cartesian graph titles and labels. However, radial tick marks and labels have additional positioning options. Other than display and position, polar plot tick marks and labels have the same options as Cartesian graph tick marks and labels.



Changing Axis Title and Tick Labels Display



To view, hide, or move titles and tick labels on the radial axes: 1.



Double-click a radial axis. The Graph Properties dialog box appears.



Figure 8–18 Graph Properties Dialog Box Axes Tab Labels Settings



2.



Click the Axes tab.
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0
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Select Labels from the Settings For list.



4.



Select either Minor Ticks or Major Ticks from the Apply To drop-down list.



5.



To move or hide the major or minor tick labels on the radial axes, use the Major (or Minor) Tick Labels options.



6.



Select (None) to hide the labels.



7.



Select clockwise or counterclockwise to move the label from one side of the axis to the other.



8.



Click OK.



Hiding Tick Marks



Hide tick marks by clicking the ticks and pressing the Delete key. You can also right-click the labels and choose Hide.



Radial Axis Tick Mark Direction



To specify the direction for radial axis tick marks for each pair of radial axes: 1.



Double-click any radial axis tick mark. The Graph Properties dialog box appears.



Figure 8–19 Graph Properties Dialog Box Axes Tab Ticks Settings



2.



Click the Axes tab.



3.



Select Ticks from the Settings For list.



4.



Select either Minor Ticks or Major Ticks from the Apply To drop-down list.



5.



Use Direction options to change the tick directions on the radial axes. You can only change the directions for Spokes 1 and 3 together, and for 2 and 4



Displaying and Changing Radial Axis Ticks and Labels 333



 Working with Pie, Polar, and Ternary Plots together.



Σ



Spoke 2



Spoke 2



Spoke 1



Spoke 1



Spoke 1 Spoke 3



Spoke 3



Spoke 4



Spoke 4



Spoke 3



Spoke 4



Figure 8–20 Polar Plots with All Ticks Pointing Inward, Spokes 1, 3 Inward and2,4 Outward, and All Ticks Pointing in Both Directions



Spoke 2



Selecting Inward orients the ticks clockwise, and Outward points the ticks counterclockwise.



6.



Selecting Both directions draws ticks both clockwise and counterclockwise, and selecting (None) hides the tick marks.



7.



Click OK.



Ternary Graphs



0



Ternary graphs plot data on an XYZ coordinate system in the form of three variables that add up to 100% or 1. These variables are typically the normalized proportions of three substances and are plotted on three axes generally arranged as an equilateral triangle. These graphs are also commonly referred to as triangle plots. Figure 8–21 Examples of a Ternary Line Plot, Scatter Plot, and Scatter and Line Plot
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You can create ternary scatter, line, and scatter and line plots. These graph data as symbols, as lines only with no symbols, or as symbols and lines, respectively. Line shapes can be straight segments or spline. Data for ternary plots can be XYZ data in three separate columns or SigmaPlot can extrapolate a third column from data pairs in two columns. Ternary graphs



 Working with Pie, Polar, and Ternary Plots must have at least one single or multiple curve plot, but can hold many more plots, each with a different style and data format. If your raw values do not add up to 100% or 1, SigmaPlot can convert them to normalized ternary data. If you have XY, YZ, or YZ pair data, SigmaPlot can compute the third-column values shown in the resulting graph.



Σ



For more information on creating another plot for an existing ternary graph, see Adding New Plots on page 196.



Data for a Single Curve Plot (Ternary Triplets)



If you are creating a graph with a single curve plot using only one set of XYZ values whose sum is 100% or 1, enter all X data in one column, all Y data in another column, and the corresponding Z data in another column. The columns do not have to be adjacent to one another, but they must be the same length. Ternary triplet data should always add up to 100% or 1. For information how to convert data whose sum is not 100% or 1, see Normalizing Ternary Data on page 335.



Data for a Multiple Curve Plot (Ternary Triplets)



If you are creating a graph with a multiple-curve plot using multiple sets of XYZ values where the sum of each set is 100% or 1, enter into worksheet columns as many additional ternary triplet data sets as you want to plot. Each set of ternary triplet data is a separate plot-curve. All ternary triplet data sets should add up to 100% or 1. For information how to convert data whose sum is not 100% or 1, see Normalizing Ternary Data on page 335.



Figure 8–22 Multiple Columns of Triplet Percentage Data for a Ternary Plot



Data for a Single or Multiple-Curve Plot (Ternary XY, YZ, or XZ Pairs)



Σ Normalizing Ternary Data



If you are creating a graph with a single or multiple curve plot using XY, YZ, or XZ pairs, enter all X, Y, or Z data in one column, and the corresponding X, Y, or Z pair values in another column. As long as all data pairs use a percentage or unitary scale, SigmaPlot will compute the third-column data shown in the resulting graph. SigmaPlot computes third column data for plotting only. Computed third-column data is not displayed in the worksheet. To create a ternary graph using data whose sum is not 100% or 1, first convert the raw XYZ data into normalized ternary triplet data by using the Normalize Ternary Data transform.
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 Working with Pie, Polar, and Ternary Plots To normalize ternary data: 1.



On the Transforms menu, click Normalize Ternary Data. The Normalize Ternary Data Column Picker dialog box appears.



Figure 8–23 Selecting the Data Columns to Normalize from the Normalize Ternary Data Column Picker Dialog Box



2.



Select the column with the original X data from the worksheet or the Data Source list. The selected column is assigned as the X Source in the Selected Columns list.



3.



Select the Y data source.



4.



Select the columns from the worksheet data.



5.



Select the X, Y, and Z data destination columns in the worksheet.



6.



Click Next.



7.



Select the type of scale from the Scale Type drop-down list.



8.



Click Finish.



Figure 8–24 Selecting the Scale Type from the Normalize Ternary Data Column Picker Dialog Box



Creating Ternary Graphs
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Ternary plot data set (triplet or pair) must be based on a percentage or unitary scale with the sum of all values being 100% or 1. If your data does not add up to 100% or 1, use the Normalize Ternary Data transform. For more information, see Normalizing Ternary Data on page 335.



 Working with Pie, Polar, and Ternary Plots To create a ternary plot: 1.



Drag the pointer over your data to select the worksheet columns to plot.



2.



On the 2D Graph Toolbar, click Ternary Plot, and then click the style of ternary plot you want to create. The Graph Wizard appears.



Figure 8–25 Selecting a Ternary Graph Data Format from the Graph Wizard



3.



Select the appropriate format, and click Next.



Figure 8–26 Selecting Columns to Plot Using the Graph Wizard



Since you selected columns prior to opening the Graph Wizard, your choices automatically appear in the dialog box.



Σ 4.



If you made a mistake picking columns, highlight the wrong entry in the Graph Wizard, then choose the correct column either in the worksheet or from the column list. Click Finish.



Use the Graph Properties dialog box to modify the plot or to open the Graph Wizard to pick different data columns to plot or to add another plot to your graph. For more information on making general modifications to ternary plots, see Creating and Modifying Graphs on page 163. For detailed information on modifying ternary axes, see Modifying Ternary Axes on page 338.
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Modifying Ternary Graphs



Modifying ternary graphs involves: ➤



Picking new data for the plot (see Picking Different Data for the Current Plot on page 194). ➤ Changing line and symbol type, size, and color (see Changing Symbol Type and Other Symbol Options on page 204 and Changing Line Type and Other Line Options on page 213). ➤ Modifying backplane color and grid lines (see Modifying Grids and Planes on page 396). ➤ Changing axis properties, including range and direction (see Modifying Ternary Axes on page 338). To modify a ternary graph, select the graph and open the Graph Properties dialog box. To learn about selecting graphs and using the Graph Properties dialog box, see Modifying Graphs on page 189, and Selecting a Graph or a Plot on page 191.



Modifying Ternary Axes



0



Ternary axes are drawn to represent increases in data value in a counterclockwise direction by default. Axis direction can be reversed, indicated by a reversal of tick labels, and the tick direction changes accordingly. Because ternary axes are interdependent, any modification in the scale type or range of one of the axes is reflected in the other axes, and may alter the shape and size of the graph. You can modify the color and thickness of axis lines, the appearance of tick marks and tick labels, location and rotation of axis titles, and display of each ternary axis independently. Ternary axes can be modified similarly to other graph axes. The following sections cover: ➤



Changing display of axis titles (Modifying Ternary Axis Title Location on page 339). ➤ Changing axis range, scale, and direction (see Changing Ternary Axis Range, Scale, and Direction on page 340). ➤ Changing axis tick labels (see Modifying Tick Label Display on page 349). ➤ Changing axis tick marks (see Modifying Ternary Tick Mark Line Appearance on page 348). To learn more about displaying or hiding any axis see Hiding, Displaying, and Deleting Axes on page 370. For more information on changing axis lines, see Changing Axis Line, Color, and Thickness on page 372.
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Σ



Axis breaks cannot be created for ternary axes.



Modifying Ternary Axis Title Location



0



You can position axis titles of ternary graphs either at the apex or along the length of the axis. You can also rotate them to a position parallel to the axis. To reposition a ternary graph axis title: 1.



Double-click the axis. The Graph Properties dialog box appears.



Figure 8–27 Graph Properties Dialog Box Axes Tab Labels Settings



2.



Click the Axes tab.



3.



Select Labels from the Settings For list.



Σ



To identify which axis is associated with and axis title, keep in mind that the title at the apex is always at the 100% point or maximum for that axis.



4.



Under Show Axis Title, select the desired Axis title location from the At drop-down list.



5.



Select Axis Title in the Rotate with Axis group box to rotate the axis title parallel to the axis.



6.



Click Apply.
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Continue to modify the titles of the other axes. Specify the axis title you want to change using the Axis list, then make the desired changes.



8.



When you have finished click OK.



Figure 8–28 Axis Titles at the Apexes and Along the Axes



Y Data 0 10



0



20



90



20



90



80



30



80



30



70



ata ZD



60



50



50



60



70



40



60



50



50



60



ata



40



YD



The titles along the axes are also rotated with the axes.
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Changing Ternary Axis Range, Scale, and Direction



0



Ternary axis scale type and range settings control the units and increments used to plot the data. Axis scale, range, and direction are modified using the Scaling settings displayed in the Graph Properties dialog box Axes tab. Axis range can also be modified by dragging a selected axis. Modifying a ternary axis range can alter the size and even the shape of the graph.



Modifying Axis Range by Dragging



You can modify axis range by dragging a selected axis or apex. Because ternary axes are interdependent, dragging an axis to modify its range can change the ranges of the other axes. Dragging an apex modifies the ranges of the two axes which form the apex; reducing the maximum of an axis range introduces a fourth axis, creating a trapezoid graph. Dragging a selected axis toward or away from the center of the graph modifies all three axis ranges by the same increment, maintaining the original shape of the graph. To modify ternary axis ranges: 1.



View the ternary graph.



2.



Select either an apex or an axis to modify.



3.



A selected apex displays a black, square selection handle and is surrounded by a dotted line; a selected axis displays a selection handle at the center point
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 Working with Pie, Polar, and Ternary Plots of its range and is surrounded by a dotted line. Figure 8–29 Dragging an Axis to Rescale a Ternary Plot Range



4.



Drag either the apex or the axis toward or away from the center of the graph. The axis ranges adjust accordingly.



Σ



Modifying axis ranges of ternary graphs often introduces additional axes. These axes are the second axes of each “pair” of axis lines. An axis which appears as a result of moving an apex is paired with the axis opposite the apex which moved. Additional axes can be modified and are controlled in the same way as the three original ternary axes using the Axes tab of the Graph Properties dialog box. 50
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Figure 8–30 The Results of Different Range Changes on Ternary Plots
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Modify ternary graph ranges using the Graph Properties dialog box: 1.



Double-click the angular axis.
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 Working with Pie, Polar, and Ternary Plots The Graph Properties dialog box appears. Figure 8–31 Graph Properties Dialog Box Axes Tab Scaling Settings



2.



Click the Axes tab.



3.



Select Scaling from the Settings For list.



4.



Use the slider controls for X Range, Y Range, and Z Range to change individual axis ranges.



Σ 5.



Σ Ternary Scale Type



Note that when you change the Minimum for any axis, the maximums for the other axes adjust automatically. Changing the Maximum for any axis does not require changing the ranges for other axes. Click OK.



Increasing an axis range minimum reduces the size of the ternary graph because it is always reduces the other axis range maximums. Reducing the maximum of a ternary axis range changes the graph shape.



All ternary axes on a single graph use either the default Percentage (0-100) scale or the Unitary (0.0-1.0) scale. Data used by each scale should be within the required ranges for each scale.
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 Working with Pie, Polar, and Ternary Plots Graph creation determines the graph scale. There should be no need to change the scale unless a mistake was made during graph creation. Changing the scaling from Percentage to Unitary can also hide out-of-range data. 60



Figure 8–32 Ternary Graphs Using Percentage and Unitary Axis Scales
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To change ternary axis scale type: 1.



Double-click the angular axis. The Graph Properties dialog box appears.



Figure 8–33 Graph Properties Dialog Box Axes Tab Scaling Settings



Σ



2.



Click the Axes tab.



3.



Select Scaling from the Settings for list.



4.



Select the new axis scale type from the Scale Type drop-down list.



5.



Click OK.



When you change the axis scale type for one axis, it is changed for all axes.
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Changing Ternary Axis Direction



Ternary graph axes show data increasing in either a clockwise or counterclockwise direction. Modifying axis direction changes all three axes; ternary axes are interdependent. Ternary graph axes have interdependent axis ranges from 0 to 100, where 0 to 100 is the default setting. The axis range and scale control the axis units and increments used to plot data. To modify the axis direction: 1.



Double-click the plot. The Graph Properties dialog box appears.



Figure 8–34 Graph Properties Dialog Box Axes Tab Scaling Settings



2.



Click the Axes tab.



3.



Select Scaling from the Settings for list.



4.



Select the axis you wish to modify from the Axis drop-down list.



5.



Select the axis direction from the Direction drop-down list.



6.



Click OK. The tick directions change on all three axes and the axis ranges reverse. Changing the axis directions inverts the 0-100 direction of the labels and changes the direction of the tick marks. However, axis titles only move if they are positioned along an axis, not at an apex. Apex position for each vari-
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 Working with Pie, Polar, and Ternary Plots able remain constant regardless of axis direction. Figure 8–35 Ternary Graphs Displaying Counterclockwise (Left) and Clockwise (Right) Axis Directions
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Changing Ternary Axis Tick Marks and Tick Labels



0



0



Ternary axes tick marks indicate the precise location of each value at specific intervals determined by the axis range. Tick marks and tick labels along ternary axes have both direction and origin. Every tick location can have tick marks and labels pointing in clockwise, counterclockwise, both clockwise and counterclockwise, and perpendicular directions, independent of the actual direction of the data.



Tick and Tick Label Directions and Ownership



Tick marks and labels indicate which values correspond to the plotted data points by the direction they lean in. The direction also indicates which axis the tick is actually controlled by. This can be a different axis than the tick mark is actually drawn on. For example, the default ticks for the X axis are drawn leaning in a clockwise direction on the bottom axis. These tick marks also correspond to the counterclockwise tick marks on the Y axis. If you change the tick mark attributes for X axis ticks, you can affect tick marks that are actually drawn on a different axis.
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 Working with Pie, Polar, and Ternary Plots The following figure best illustrates tick mark and label ownership. Figure 8–36 A Ternary Graph with All Tick Labels and Marks Drawn
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The X Axis ticks and labels are drawn in light gray, the Y Axis ticks and labels are drawn in black, and the Z Axis ticks and labels are drawn in dark gray.
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Modifying Ternary Tick Marks Direction and Intervals



Use the Graph Properties dialog box to modify tick appearance including tick length and color. You can also specify to view or hide tick marks, which side of the axis they extend from, and the tick interval. To modify tick marks: 1.



Double-click the tick marks.
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 Working with Pie, Polar, and Ternary Plots The Graph Properties dialog box appears. Figure 8–37 Graph Properties Dialog Box Axes Tab Ticks Settings



2.



Click the Axes tab.



3.



Select Ticks from the Settings For list.



4.



Select either Major Ticks or Minor Ticks from the Apply to drop-down list.



5.



To turn tick drawing on and off and to select tick directions for both sides of an axis line, use the Direction lists. The second list is only available if a ternary plot range change has created a secondary axis. Select Out, In, or In and Out to display tick marks on the selected axis out from the center of the graph, in toward the center of the graph, or both outward and inward. Select a clockwise, counterclockwise, both, or 900 option to select the tick mark direction along the axis. Select (none) to hide tick marks.



Figure 8–38 Graph Examples of Tick Marks Pointing, counterclockwise, Clockwise, Both, and 90 °



6.



To change major tick intervals, move the Major Tick Intervals slider.



7.



To change minor tick intervals, under Tick Intervals, select a new
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 Working with Pie, Polar, and Ternary Plots value from the Minor Tick Intervals drop-down list. Figure 8–39 Ternary Graphs with Tick Intervals of 15 and 30
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8.



Click Apply.



9.



Use the Axis drop-down list to modify tick marks on a different axis, or use the Apply To drop-down list to switch to modifying major or minor tick marks.



10. Click OK.



Modifying Ternary Tick Mark Line Appearance
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To change tick mark display, length, color, and interval: 1.



Double-click the tick marks you want to change. The Graph Properties dialog box appears.



Figure 8–40 Graph Properties Dialog Box Axes Tab Ticks Settings



2.



Click the Axes tab.



3.



Select Ticks from the Settings for list.
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Select either Major Ticks or Minor Ticks from the Apply to drop-down list.



5.



To change tick length and thickness, under Tick Line, move the Length and Thickness sliders. Drag the slider control with the mouse or set the tick length and thickness to specific values by typing directly in the Length and Thickness boxes.



6. To change tick color, under Tick Line, select a color from the Color drop-down list. Choose from any of the listed colors, or select (Custom) to use a pre-defined custom color or create your own color. Select (None) to create transparent tick marks.



Modifying Tick Label Display



7.



Click Apply.



8.



Use the Axis drop-down list to modify tick marks on a different axis, or use the Apply To drop-down list to switch to modifying major or minor tick marks.



9.



Click OK.



Tick labels are drawn using directions clockwise, counterclockwise, and both clockwise and counterclockwise. Tick label direction is controlled independently of the data direction. Tick labels can also be turned off, have a prefix or suffix added, and be rotated along the angle of the axis line. The tick label text can also be modified. For more information, see Formatting



Numeric Tick Labels on page 389. To modify tick label display along an axis: 1.



Double-click the axis you want to change.
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 The Graph Properties dialog box appears. Figure 8–41 Graph Properties Dialog Box Axes Tab Labels Settings



2.



Click the Axes tab.



3.



Select Labels from the Settings For list.



4.



Select the Major (or Minor) tick Labels check boxes. Depending on the selected axis, the check boxes are Top, Bottom, Left, or Right.



5.



To change the direction of the axis tick labels, select the Clockwise and counterclockwise (CCW) check boxes. You can draw in both directions at once. To draw tick labels at the 90 ° tick position, clear both direction options .



Figure 8–42 Ternary Graph Axes with Tick Labels counterclockwise, Both Clockwise and CounterClockwise, and Neither (90 °)



50 50



50



60



70 30



70



70



80 20



80



80



90 10



90 100 0



50



60 40



60



10



20



30



40



50



100 0 0 100 10 90



90 100 20 80



30 70



40 60



50 50



0



10



20



30



40



50



6.



To add a suffix or prefix to the major or minor tick labels on ternary axes, select either Major Ticks or Minor Ticks from the Apply To drop-down list, then use the Add To Major (or Minor) Tick Labels options to type a prefix or suffix to the major or minor tick labels.



7.



To rotate major or minor tick labels parallel to their axis, select either Major Ticks or Minor Ticks from the Apply To drop-down list, then under Rotate with Axis, select Tick Labels.



 Working with Pie, Polar, and Ternary Plots 8.



Click Apply.



9.



Use the Axis list to modify tick labels on a different axis, or use the Apply To drop-down list to switch to modifying major or minor tick labels.



10. Click OK.



Σ



Tick labels and tick marks are controlled by their axis of origin, but may be drawn on axes other than their own.



Changing Ternary Axis Tick Marks and Tick Labels 351



 Working with Pie, Polar, and Ternary Plots
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Publishing Graphs You can use SigmaPlot to publish graphs on the World Wide Web, and to create publication quality graphs for submission to journals and other printed forms. This chapter covers: ➤



Publishing graphs on the World Wide Web (see below) ➤ Submitting graphs to journals (see page 356) ➤ Publication tips and tricks (see page 359)



Publishing Graphs on the World Wide Web



0



Using SigmaPlot's latest web publishing technology, you can save your graphs in high resolution, and then later publish them on the Web (Internet or your Intranet). Saving your graphs as a web page creates HTML code that you can later import into any HTML editor. You can then view SigmaPlot graphs on the Web even if SigmaPlot is not installed using the SigmaPlot WebViewer.



About the SigmaPlot WebViewer



Σ



The SigmaPlot WebViewer is an ActiveX control freely distributed from the SPSS Science Web site. If this control is not installed the first time a SigmaPlot graph is viewed on a web page, the WebViewer is automatically installed. Then you can view the graphs in high resolution on the Intranet or Internet. Currently 3D graphs only appear as JPEG files, not as Web Graphs. Using the SigmaPlot WebViewer, you can: ➤



View the graphs in high resolution. ➤ Pan, and zoom the graph without losing resolution. ➤ Print in high resolution (printer resolution) as opposed to typical Web graphics (GIFs, JPEGs, etc.) that are printed in low resolution. ➤ View the data used to create the graph.



Publishing Graphs on the World Wide Web 353



 Publishing Graphs



Exporting Graphs into HTML Format



When you export a graph to the Web, SigmaPlot automatically creates three files: ➤



A notebook .JNB file which contains the SigmaPlot graph and data worksheet. ➤ A .JPG of the graph, viewable by those who do not have the SigmaPlot WebViewer. ➤ An .HTM file which references a .JPG of the graph and the .JNB file. You can export an entire graph page or other pasted objects. To export a SigmaPlot graph into HTML format: 1.



Open a graph page.



2.



Select the page objects you want to publish.



3.



On the File menu, click Save As Web Page. The Export File dialog box appears.



4.



Enter a name of the file in the File name box. HTML (SigmaPlot Web Graph) already appears in the Save as type box.



5.



Click Export. The Export Web Graph dialog box appears.



Figure 9–1 Export Web Graph Dialog Box



6.



Σ



To set the size of the figure, select desired measurements from the Height and Width drop-down lists. Note that one inch is 96 pixels, and the Export Web Graph dialog box uses a fixed aspect ratio.



7.



To export the currently selected graph or objects, select Export Selected Only.



8.



To export the entire graph page, clear Export Selected Only.



9.



To password protect the file, click Set Password.
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 Publishing Graphs



Σ



For detailed instructions for setting passwords, see Password Protecting Data on the Web below.



10. Click OK. Three files are created: an .HTM file which references a saved .JPG file and a .JNB file. You can later insert this .HTM file into any HTML editor.



Σ Password Protecting Data on the Web



Microsoft Word is not designed to handle HTML containing ActiveX references, including graphs saved using HTML. Do not edit HTML files in Microsoft Word.



You can secure your data for a graph you export to an HTML file by setting a password for viewers to enter when viewing this graph on the Internet. Setting a password also prevents the opening and downloading of this file. To set a password: 1.



On the Export Web Graph dialog box, click Set Password. The Set Password dialog box appears.



Figure 9–2 Set Password Dialog Box



Exporting Data Associated with the Graph



When you export a graph to a web page, you not only export the data for the graph but the entire worksheet as well. This can be useful if you want to associate or display additional data for the graph. However, it can also increase the size of the .JNB file, which can slow viewing. To export just the data associated with the graph: 1.



Select the graph on the page, and copy it.



2.



On the Standard Toolbar, click the New Page button. The Graph Page dialog box appears asking if you would like to create a graph.



Figure 9–3 Graph Page Dialog Box



3.



Click No.



Publishing Graphs on the World Wide Web 355



 Publishing Graphs 4.



Paste the graph to the new page. Now when you export this graph, you will also only export the data associated with the graph.



Inserting a Graph into FrontPage



After you've exported a graph into HTML format, you can import the graph into most HTML editors. The following example describes importing a SigmaPlot graph into FrontPage. To insert the graph into FrontPage: 1.



Export a graph into HTML format.



2.



In FrontPage, place the cursor on the page where you want to insert the WebViewer graph.



3.



On the Insert menu, click File. The Select File dialog box appears.



4.



Select the HTML file you created in SigmaPlot to import into your FrontPage project, and click Open. A Javascript object containing WebViewer graph information appears at the insertion point on the page.



Σ



The graph is not visible on the page until viewed using Internet Explorer.



Submitting Graphs for Publication



0



The following are some guidelines for preparing graphs for submission to journals or other printed form. This process is not necessarily simple, and requires understanding both the figure requirements of the publication as well as graphic file formats and terminology.



Figure Submission Requirements



The ultimate destination for most SigmaPlot graphs is a publication, and most publishers are now equipped for digital pre-press. This requires graphic files with specific formats and properties. Keep in mind the requirements of the different journals and other publications. These tend to vary, but are usually available at the web site for the journal submission requirements. Some URLs (as of the writing of this document) for requirements for some major publications are: ➤ ➤



Nature: http://www.nature.com/nature/submit/gta/index.html - 4.8 Science: http://www.submit2science.org/mtsweb/directions.html
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The Proceedings of the National Academy of Sciences: http://intl.pnas.org/ misc/iforc.shtml - Submitting Manuscripts ➤ Journal of the American Chemical Society: http://pubs.acs.org/instruct/ illus.html and http://pubs.acs.org/cgi-bin/submission_gen/sifiletypes.pl?Journal=jacsat Many journals also use the Cadmus electronic prepress service. Their requirements can be found at: http://cjs.cadmus.com/da/pages/guidelines.html.



Creating Files for Figure Submission



The steps to producing a file for publication can vary from publisher to publisher. For more information regarding publication requirements, see Figure Submission Requirements on page 356. When preparing a figure for file export, first determine: ➤



The final size of the figure, including the size of text (usually inches or millimeters). ➤ The required line weights. ➤ Acceptable typefaces (especially important for EPS - Encapsulated Postscript - files). ➤ The desired final dpi (the dots-per-inch resolution), if necessary. To produce a file for publication: 1.



Determine the final size of the figure, the heights of text and thicknesses of lines and whether the figure will be color, grayscale, or black and white.



2.



Determine what file formats are acceptable, and choose the best one. The ranking in which you should choose your format is: ➤ SigmaPlot ➤ EPS ➤ TIFF ➤ Printed hardcopy (not really a file, but some publications actually still



prefer this). These formats are regardless of whether the graph is color or not. Some publishers will directly accept SigmaPlot files. Most others accept EPS, TIFF, or both. 3.



Determine how much the figure is going to be scaled using the size of your current figure. For example, if your graph is 5 inches wide, but the figures are printed at 3.25
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 Publishing Graphs inches wide, then scale your graph by a factor of 3.25/5, or .65. 4.



Increase text labels and line widths accordingly on your SigmaPlot graph. For example, if you reduce your graph to .65 of the original size, and text must be 10pt in height, increase your labels to at least 15.5pt. Alternately, you can reduce the graph itself to the final publication size.



5.



Make any other changes to your graph to meet the publisher's requirements, such as typeface, labeling, and so on.



6.



Once you have your graph formatted, produce the selected file. Make sure that you select the figure (click it) before choosing export-this will automatically crop your figure for you. If you are producing an EPS file, you don't need to pay attention to dpi at all. If you must use TIFF format, make sure you use the CMYK-compressed TIFF format. Uncompressed TIFF files are too big to easily handle. Also, you will now have to do some dpi calculations. For example, if you are producing a file that requires a final printed dpi of 600, and the graph is being reduced by a .65 ratio, do not set the file dpi to 600. Instead, use a dpi of 390 (600*.65). When this file shrinks to the final printed size, the final dpi will also be 600.



Why Use EPS?



Most publishers request either EPS or TIFF formats. When given a choice, choose EPS. Why? Because EPS is known as a vector format. This means that the image is not made up of pixels, but instead graphic descriptions of lines, fills, text, and so on. A vector format has no "size." It is dimensionless. This means you can shrink it as small as you want, or grow it as big as you want, with no change in resolution. dpi has no meaning for a vector file. This format is ideal for a graph figure since there is no degradation of the quality of the figure as it re-scales. It is also means that when you place a vector format file in a document, it often first appears at an arbitrary size, and then you can scale it to the final desired size. This can often startle, annoy or confuse someone not familiar with the behavior of vector files. The other vector format supported by SigmaPlot is the Windows Metafile format.



Post-Processing TIFF Files



If you must use TIFF files and you have access to Photoshop, use it to optimize the file. SigmaPlot does not have access to the expensive, proprietary compression formats available in Photoshop. This means that SigmaPlot files will always be much larger than Photoshop files saved with the LZW compression
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 Publishing Graphs algorithm. Also, SigmaPlot does not support Monochrome or Grayscale TIFF, which are also proprietary export formats. Opening and re-saving a SigmaPlot file using LZW compression and the correct color mode can create dramatic differences in file size. A 100-fold reduction in size is typical. ➤



For color figures, leave the figure as a CMYK TIFF, but save it using LZW compression. ➤ For grayscale figures, change the Image Mode to Grayscale. ➤ For black and white figures, change the Image Mode to Duotone.



About dpi



dpi (dots per inch) is a printer term, and is often misleading. dpi determines how many pixels are used to create the figure. A more accurate term would be resolution. You can increase the final dpi of a raster figure by shrinking it. This creates more pixels within a smaller space, increasing the dpi. Most printed figures do not require a dpi higher than 600 for grayscale figures, and 300 dpi for color figures. The 1200 dpi number is for black and white figures only that have no half toning. If you must produce a 1200 dpi figure, you will have to do some post-processing on your file in order make it palatable to the printer. This can be beneficial if you must use TIFF file and have Photoshop.



Publication Tips and Tricks Making Global Changes



0



Use the Line and Text Properties dialog boxes to make global changes to your graphs before publishing. To make global changes to text and lines: 1.



Select the graph.



2.



From the Format menu, click Line or Text Properties. The Object or Text Properties dialog box appears from which you can make graph format changes.



Resizing Graphs



If you need to resize you graph for publication, set your fonts and line widths first, then turn the automatic re-scaling of these objects off before resizing your graph. To resize your graph for publication: 1.



From the Tools menu, click Options. The Options dialog box appears.
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Click the Page tab.



3.



Clear Graph Objects Resize with Graph.



To re-scale the graph precisely: ➤ From the Format menu, click Size and Position.



Before You Export



Select the graph before you export; otherwise, you will export the entire page including unnecessary white space surrounding the graph.



Disk Space and Memory



Make sure you have enough disk space and memory before trying to export a large graphic file. For a large file, you need at least 200 megabytes or more free on both your system drive (for swap and temp file space) as well as the same on your destination drive. You can also increase your Virtual Memory to a very large size, but this isn't necessary if you have sufficient hard drive space available. Note that it can take awhile to generate these files, depending on your system's speed and available RAM.
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Modifying Axes, Tick Marks, and Grids Axes are the scales or rulers along which data is plotted. 2D Cartesian graphs have an X (horizontal) axis, and a Y (vertical) axis. For 3D graphs, the X and Y axes form the base of the graph, and the Z axis is the vertical axis. Polar plots use an angular axis to draw the circumference of the plot and the radial axes to draw the radius of the plot. An axis is always associated with at least one plot on a graph, and determines the scaling of the plot. Each axis consists of pairs of lines that you can move and modify independently. Tick marks are short lines along the axis that represent scale intervals. You can display and modify tick marks for each axis. Grid lines are attached to the graph planes, and can be drawn at tick intervals for all axes. Make most axis modifications using the Axes tab of the Graph Properties dialog box. This chapter describes how to: ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤



Change an axis range (see page 362) Change an axis scale (see page 363) Hide, display, and delete axes (see page 370) Move axes (see page 371) Modify axis line, color, and thickness (see page 372) Set an axis break (see page 374) Add and edit axis titles (see page 375) View and hide axis titles and tick labels (see page 376) Change tick mark intervals(see page 378) Modify tick mark appearance (see page 383) Hide tick marks (see page 384) Customize tick intervals (see page 385) Change tick labels (see page 387) Display grid lines and backplanes (see page 396)
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Changing Axis Range



0



Axis range includes the values of the starting and ending points of an axis. Choose to set axis range automatically or manually. To change the axis range: 1.



Double-click the axis to modify. The Graph Properties dialog box appears.



Figure 10–1 Graph Properties Dialog Box Axes Tab Scaling Settings



2.



Click the Axes tab.



3.



From the Axis drop-down list, select the axis you wish to modify.



4.



From the Settings for list, select Scaling.



5.



To automatically set the axis range, select Data Range from the Calculation list. SigmaPlot automatically determines the axis range based on the data plotted. For log axes, or axes that forbid zero or negative numbers, the minimum is set to the nearest major tick mark beyond the smallest value.



6.



To manually set the axis range, select Constant then type beginning and ending axis range values in the Start and End edit boxes. Note that Date/Time axes display the ranges in date and time units.



7.
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Select Pad 5% to add padding to both ends of the axis.
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Select Nearest Tick to extend the range to the nearest major tick mark.



9.



Click OK.



Changing Axis Scales



0



You can control the axis units and increments used in representing your data. Axis scale and range are modified with the Scaling settings of the Graph Properties dialog box Axes tab. You can also use transforms and tick labels and intervals from worksheet columns to create your own custom axis scales; see Using a Custom Axis Scale on page 369.



Axis Scale Types



Linear: A standard base 10 numeric scale. (This scale is recommended for a date axis when an exact representation of spacing depicted by dates is not required. Otherwise, use the date/time scale.) Common Log: A base 10 logarithmic scale. Natural Log: A base e logarithmic scale.



Figure 10–2 Graphs of the Same Data Using Linear, Common Log, and Natural Log Scales



10000



5000



e8 e7



4000 1000



e6 e5



3000 100



2000



e4 e3



1000 10



e2 e1



0 1 0



2



4



6



8



10



12



0



2



4



6



8



10



12



0



2



4



6



8



10



12



Probability: The inverse of the Gaussian cumulative distribution function. The graph of the sigmoidally shaped Gaussian cumulative distribution function on a probability scale is a straight line. Probabilities are expressed as percentages with the minimum range value set at 0.001 and the maximum range value set at 99.999. The default range depends on the range of the actual data. Probit: A scale similar to the probability scale; the Gaussian cumulative distribution function plots as a straight line on a probit scale. The scale is linear, however, with major tick marks at each Normal Equivalent Deviation (N.E.D. = X − µ)/σ) plus 5.0. At the mean (X = µ) the probit = 5.0; at the mean plus one
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 Modifying Axes, Tick Marks, and Grids standard deviation (X = µ + σ) the probit = 6.0, etc. The default range is from 3 to 7. The range limit for a probit axis scale is 1 to 9. Figure 10–3 Graphs of the Same Data Using Linear, Probability, and Probit Scales
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Logit: Uses the transformation



y λογ it = λν  -----------  a – y where a = 100 and 0 ≤ y ≤ 100 . The default range is 7 to 97. Like the probability and probit scales, the logit scale “straightens” a sigmoidal curve. Category: A scale which uses numerical values or text from a worksheet column used to generate a plot. Each distinct entry in the column is a separate category against which the corresponding data values are plotted. This scale is commonly used for bar charts or other plots used to graph different categories of data. Figure 10–4 A Graph Showing the Category Scale
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Any plot generated by plotting a column containing any text versus a column containing data will use a category axis automatically. For more information on plotting data versus categories, see Using a Category Scale on page 366. You can select a category scale for numeric data, and each unique value will be treated as its own category.
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Σ



If a column contains more than one instance of the same category, the category appears only once, and all corresponding data is plotted within that category. Date/Time: Date and time formatted data are automatically plotted using a Date/ Time axis scale. This scale is specifically designed to handle true calendar date and time units, labeling and spacing.



Figure 10–5 A Graph Showing the Date/Time Scale
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For directions on plotting date and time data, see Using a Date and Time Scale on page 368. ➤ For directions on changing date and time labels, see Changing Date and Time Tick Labels on page 392. ➤ For directions on changing data and time intervals, see Tick Intervals for Date/Time Axes on page 382. Although you can plot numeric data as date and time, you should first view these numbers as dates and times in the worksheet to make sure they are sensible values. For more information on displaying numbers as dates or times, see Switching



Between Date and Time and Numeric Display on page 73. If a worksheet cell is a label, it won’t plot as a date and time value. In this case, you may want to reenter the label as a date and time value; see Entering Dates and Times on page 57.
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Changing Scale Type



0



To change an axis scale type: 1.



Select the axis to modify.



2.



On the Properties toolbar, click the Axis Scale



button.



The Graph Properties dialog box appears. Figure 10–6 Using the Scale Type list from the Axes Tab of the Graph Properties Dialog Box



Using a Category Scale



366 Changing Scale Type



3.



From the Settings for list, select Scaling.



4.



From the Scale Type list, select the desired axis scale type. The default axis scale is Linear for all numeric data, Category for text data, and Date/Time for date and time data.



5.



Click OK.



Use the category scale type by plotting a column containing categories against other columns of data values, or modify an already existing plot to use a category



 Modifying Axes, Tick Marks, and Grids scale by changing the axis scale type to Category, then using the Graph Wizard to repick the data and assign your category column as the X or Y coordinate values. Figure 10–7 Plotting Category Data Using a Category Scale



To plot a column of text as a category scale: 1.



Enter your category data (text) into a worksheet column, and corresponding data into adjacent worksheet columns.



2.



On the Graph tool bar, click the graph type and style you want to create. The Graph Wizard appears.



3.



Select the data format, and click Next.



4.



Since you have not already selected your data from the worksheet, click the worksheet columns to assign them under Selected Columns. Plot your category column as the category axis data type, and pick your other column(s) as the corresponding data type.



5.



Click Finish to create the graph.



To modify a plot to use a category scale: 1.



Double-click the axis you want to modify. The Graph Properties dialog box Axes tab appears.



2.



Select Scaling from the Settings For list.



3.



Select Category from the Scale Type drop-down list.



4.



Click Apply to change the scale type without closing the dialog box.
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 Modifying Axes, Tick Marks, and Grids 5.



Click the Plots tab, and then click Graph Wizard. The Graph Wizard - Modify Plot dialog box appears.



Using a Date and Time Scale



6.



Under Data Format, select the data format you want to use, and click Next.



7.



Click the columns in the worksheet to choose the worksheet columns to assign to plotted data under Selected Columns. Plot your category column as the data type you want to use as the category axis, and pick you other columns(s) as the corresponding data type.



8.



Click Finish to create the graph with the newly assigned worksheet data and modified axis.



SigmaPlot graphs date and time data from worksheet columns as specific calendar dates and times against which corresponding data values in other columns are plotted. For more information on entering date and time data, see Entering Dates and Times on page 57. To create a plot using a date/time scale: 1.



Enter dates or times into a column of a worksheet. For example, enter 1/1, 2/ 1, 3/1, etc., indicating months and days.



2.



Enter corresponding data into a separate worksheet column or columns.



3.



Drag the pointer over both the category and data columns.



4.



Create the graph using the graph toolbar or the Graph Wizard.



Figure 10–8 A Worksheet With Dates in Column 1
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Using a Custom Axis Scale



5.



Plot your date and time column as the date/time axis.



6.



Pick your other column(s) as the corresponding axis.



7.



Click Finish to create the graph.



Use the transform language to transform your data for a new axis scale, then use tick intervals from a column to the place correct ticks marks and labels. For example, to use an Extreme Value Distribution scale, apply the transform: f(y)=ln(ln(100/(100-y))) and for the Arrhenius scale, use the transform: f(y)=1-273/(T+273) Apply the transform to both your original interval values and data, then plot the transformed data using the transformed intervals as the tick mark values, and the original interval data as tick labels.



Figure 10–9 A Graph Using the Arrhenius Scale You can skip labeling tick intervals by using empty cells in the tick label column.



To learn how to run transforms, see the Programming Guide. For more information on using tick intervals from a column, see Customizing Tick Intervals on page 385. For more information on using tick labels from a column, see Using Custom Tick Labels on page 394. For an example of an Extreme Value Distribution axis scale, refer to the Programming Guide.
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Hiding, Displaying, and Deleting Axes



0



Control the display of axes using the Lines settings of the Graph Properties dialog box Axes tab.



Hiding and Displaying Axes



The easiest way to hide an axis is to select it, then press Delete. The axis is hidden rather than deleted. You can also hide an axis by right-clicking the axis, then choosing Hide. To view, hide or modify the display of an axis: 1.



Double-click the axis (you can double-click hidden axes as well).



2.



The Graph Properties dialog box appears.



3.



Click the Axes tab.



4.



From the Settings for list, select Lines.



5.



Under Show/Place Axes, select an axis to display that axis, or clear an axis to hide it. Hidden axes hide all ticks and labels associated with that axis.



6.



Click OK.



Figure 10–10 Graph Properties Dialog Box Axes Tab Line Settings



Σ



You can hide 3D axes, but if frame lines are active, or if the graph has grid lines, a line will remain present. To learn about working with frame lines, see Frame Lines for a 3D Graph on page 304. For more information on grid lines, see Displaying Grid Lines and Backplanes on page 396.
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Moving Axes



0 You can move 2D axes with your mouse, or to a precise location with the Graph properties dialog box. You cannot move 3D axes, but you can hide them from view. For information on hiding 3D axes, see Hiding, Displaying, and Deleting Axes on page 370.



Moving 2D Axes Manually



To move a 2D axis with the mouse, select the axis and drag it to a new position. Y axes move only horizontally and X axes only vertically. Moving ternary graph axes changes the axis range and scale, along with the size and shape of the graph. Axis titles move with the axis.



Figure 10–11 Moving an Axis by Dragging



Moving Axes to a Precise Location



Use the Lines settings in the Graph Properties dialog box Axes tab to position axes a precise distance from the graph origin. For ternary plots see Modifying Ternary Axes on page 338. To move an axis: 1.



Double-click the axis you want to move.
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 Modifying Axes, Tick Marks, and Grids The Graph Properties dialog box appears. Figure 10–12 Graph Properties Dialog Box Axes Tab



2.



Click the Axes tab.



3.



From the Settings For list, select Lines.



4.



Under Show/Place Axes, move the sliders to change the percentage in the Top and Bottom boxes for X axes or Y axes, or type the value in the fields. Locations are described as the percentage of the graph dimension the axes lie from the original position. To move an axis up or right, enter a percent greater than 0% (positive). To move an axis down or left, enter a percent less than 0% (negative). The defaults are 0.0%, and Normal.



5.



Click OK.



Changing Axis Line, Color, and Thickness Use the Axes tab of the Graph Properties dialog box to change axis color and thickness. To change the color and thickness of an axis: 1.



Double-click the axis. The Graph Properties dialog box appears.



2.



Click the Axes tab.



3.



Select Lines from the Settings For list.
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Σ Using the Object Properties Dialog Box



4.



Select the axis you want to modify from the Axis drop-down list.



5.



To change the color of the axis, under Line Properties, select a color from the Color drop-down list. Choose (None) to make the axis transparent, and choose (Custom) to open the Custom Color dialog box. For more information on custom colors, see Using Custom Colors on page 158.



6.



To change the thickness of the axis, under Line Properties, move the Thickness slider or type a thickness in the Thickness box.



7.



Click OK to apply the changes and close the dialog box.



3D graph frame lines are drawn over axes lines and may obscure 3D axes modifications. For more information on frame lines, see Frame Lines for a 3D Graph on page 304. You can also change axis line attributes by right-clicking the axis and choosing Object Properties. You can also select the axis, and then on the Format, click Line, or on the Properties toolbar, click the Line Properties button.



Figure 10–13 The Line Tab of the Object Properties Dialog Box Note that the Type option is unavailable for axes.



To learn more about using the Object Properties dialog box to change line appearance, see Changing Lines on page 128.
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Setting Axis Breaks



0



You can set axis breaks for 2D Cartesian graphs over specific ranges, at a specific location along the axis, and you can change the major tick intervals that occur after the break. You can also use several different break symbols. Figure 10–14 A Graph Before and After the Addition of a Y Axis Break
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To create an axis break: 1.



Double-click the axis where you want to add the break. The Graph Properties dialog box appears.



Figure 10–15 Graph Properties Dialog Box Axes Tab Breaks Settings



374 Setting Axis Breaks



2.



Click the Axes tab.



3.



From the Settings for list, select Breaks.



4.



From the Break Range group box, select Show Break.



5.



In the Omit boxes, enter the Break to omit.
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 Modifying Axes, Tick Marks, and Grids 6.



To specify the break position, move the Position slider. The location of the break is determined as a percent of the total axis length, from the origin.



7.



To set the width of the space between break lines, move the Gap Width slider.



8.



To set a post break interval, type a value in the Post Break Interval box. The default value is the interval specified for the axis range.



Σ 9.



Tick values from a column are not applied to the post break interval. To set axis break properties, under Break Properties, from the Symbol drop-down list, select a break symbol type then use the Length, Color, and Thickness options.



10. Click OK.



Working with Axis Titles and Tick Labels



0



SigmaPlot automatically labels graph axes with titles and tick labels. Axis titles can be modified like any other text label. For information on how to edit tick labels, see Changing Tick Labels on page 387.



Editing an Axis Title



To edit an axis title: 1.



On the graph page, double-click the axis title.
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 Modifying Axes, Tick Marks, and Grids The Edit Text dialog box appears. Figure 10–16 Editing an Axis Title



2.



Make your changes to the title.



3.



Click OK.



For more information on how to use the Edit Text dialog box, see Working with Text on the Page on page 143.



Σ Rotating Axis Titles



You can also rename an axis title from within the Axis tab of the Graph Properties dialog box. Double-click the axis, then click Rename. The Edit Text dialog box opens. To rotate an axis title: 1.



Double-click the axis title. Edit Text dialog box appears.



2.



Viewing and Hiding Axis Titles and Tick Labels



Select a degree of rotation for the selected label from the Rotation drop-down list.



The easiest way to hide a graph axis title or tick label is to click it and press delete. You can also use the Graph Properties dialog box. To view or hide axis titles: 1.



Double-click the desired axis.
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 Modifying Axes, Tick Marks, and Grids The Graph Properties dialog box appears. Figure 10–17 Graph Properties Dialog Box Axes Tab Labels Settings



2.



Select Labels from the Settings For list.



3.



To view or hide the axis title, under Show Axis Title select or clear Bottom or Top to specify the position of the axis label.



To view or hide Major Tick labels, from the Apply to list, select Major Ticks, then under Major Tick Labels, then select or clear Bottom or Top to specify the position of the tick label.



To view or hide Minor Tick labels, from the Apply to list, select Minor Ticks, then under Minor Tick Labels select or clear Bottom or Top to specify the position of the tick label. 4.



Moving an Axis Title



Σ



Click OK.



To move an axis title, drag it with the mouse, just like any other text label, or on the Format menu, click Size and Position. To learn more about moving labels and other page objects, see Using Your Mouse to Change Graph and Object Size on page 132. Axis title position, relative to the axis, remains constant when the axis or graph is moved.
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Changing Tick Mark Intervals



0



Use the Graph Properties dialog box to modify tick intervals. For information on changing tick marks for polar plots, see Working with Axis Titles and Tick Labels on page 375. For information on changing tick marks for ternary graphs, see Changing Ternary Axis Tick Marks and Tick Labels on page 345.



Σ Changing Linear and Probit Scale Tick Mark Intervals



Tick Intervals options vary depending upon the axis scale used. For example, there are no tick interval options for category axes. To change the tick intervals for linear and probit axis scales: 1.



Double-click the tick marks you want to change. The Graph Properties dialog box appears.



Figure 10–18 The Axes Major Tick Intervals Options for a Linear Axis



2.



Click the Axes tab.



3.



From the Settings for list, select Ticks.



4. To change tick intervals, select from the Ticks and Every drop-down lists in the Tick Intervals group box. 5.



If you select Manual, enter interval values by typing into the Every and From fields. The value in the Every field specifies how often major tick marks appear, and the From value specifies where on the axes major tick marks begin appearing.
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Σ



6.



Tick Intervals for Log Axes



Custom Tick Intervals: You can also choose major tick interval values from



the worksheet from the Major Tick Intervals list. Custom tick intervals are not available for minor ticks. For more information on how to specify custom tick intervals, see Customizing Tick Intervals on page 385. Click OK.



You an only specify log axis major tick marks automatically or from a column. However, you can select specific intervals for log scale minor ticks.



Figure 10–19 A View of a Graph with Log Y Axis Minor Ticks



To change log scale minor tick intervals: 1.



Change the axis scale to a log axis. For directions on changing axis scales, see Changing Axis Scales on page 363.



2.



Double-click the tick marks.
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 Modifying Axes, Tick Marks, and Grids The Graph Properties dialog box appears. Figure 10–20 The Axes Minor Tick Intervals Options for a Log Axis



Natural Log and Logit Scales



3.



Click the Axes tab.



4.



From the Settings for list, select Ticks.



5.



From the Apply to drop-down list, select Minor Ticks.



6.



Select all minor tick intervals you want to appear, and clear those you want hidden.



7.



Click OK.



Natural log and logit scales have only Automatic and from column Tick Intervals.
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 Modifying Axes, Tick Marks, and Grids Natural log intervals occur at every factor of e. Logit ticks occur at 7, 10, then every ten until 90, then 95 and 97. Figure 10–21 Tick Intervals for Natural Log and Logit Scales
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Tick Intervals for Probability Scales Figure 10–22 Coarse, Medium and Fine Tick Intervals for Probability Scales
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Probability scale axes have no minor ticks, but have three different settings for major tick intervals, coarse, medium, and fine, as well as the option to set tick intervals from a worksheet column. 99
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To specify the tick mark density for probability scales: 1.



Double-click the tick marks.
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 Modifying Axes, Tick Marks, and Grids The Graph Properties dialog box appears. Figure 10–23 Axes Tick Intervals Options for a Probability Axis



Tick Intervals for Date/Time Axes



2.



Click the Axes tab.



3.



From the Settings for list, select Ticks.



4.



Under Tick Intervals, from the Density drop-down list, select a tick mark density.



5.



Click OK.



SigmaPlot automatically sets both major and minor tick intervals that are computed from the data range. You can also manually set Major Ticks and Minor Ticks. To set tick intervals for a date/time axis: 1.



Double-click the tick marks. The Graph Properties dialog box appears.



2.



Click the Axes tab.



3.



From the Settings For drop-down list, select Ticks.



4.



Under Tick Intervals, from the Type drop-down list, select a tick interval type. Tick intervals are defined by the unit Type used and the selected Count. Dates fall at 12:00 AM of the first day for that period. The major tick interval options available are limited by the data range. You are prevented from
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 Modifying Axes, Tick Marks, and Grids selecting time units that would create too many tick marks. 5.



To increase the period between tick occurrences, change the Count. For example, set ticks to occur every other Type date by changing the Count to 2, or every fifth by changing the count to 5. Counts must be positive integers.



6.



To set minor tick intervals, from the Apply to drop-down list, select Minor Ticks.



7.



Select the minor tick Type and Count. Any time unit equal to or smaller than the Major interval type can be used as the Minor interval type.



Σ



Do not select a minor interval that creates hundreds or even many thousands of minor tick marks.



Changing Tick Mark Appearance



0



Use the Graph Properties dialog box to modify tick appearance including tick length and color. You can also specify tick mark direction, or hide tick marks altogether. For information on changing tick marks for polar plots, see Working with Axis



Titles and Tick Labels on page 375. For information on changing tick marks for ternary graphs, see Changing Ternary Axis Tick Marks and Tick Labels on page 345.



Tick Mark Direction



To turn tick drawing on and off and to select tick directions for both sides of an axis: 1.



Double-click the tick marks.
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 Modifying Axes, Tick Marks, and Grids The Graph Properties dialog box appears. Figure 10–24 The Axes Tick Direction Options



2.



Click the Axes tab.



3.



From the Settings for list, select Ticks.



4.



From the Direction list for either axis: ➤ Select Outward, to point tick marks away from the graph. ➤ Select Inward to point tick marks toward the inside of the graph. ➤ Select Both to point tick marks in both directions. ➤ Select (none) to hide tick marks.



Directions for tick marks are independent for either side of the axis.



Hiding Tick Marks



Changing Tick Mark Line Attributes



To hide tick marks: 1.



Click the tick marks on the page.



2.



Press Delete, or right-click and from the shortcut menu, click Hide.



To change tick mark length, color, and thickness: 1.



Double-click the tick mark.
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 Modifying Axes, Tick Marks, and Grids The Graph Properties dialog box appears. Figure 10–25 Graph Properties Dialog Box Axes Tab Ticks Settings



2.



From the Settings For list, select Ticks.



3. From the Apply to drop-down list, select Major Ticks for Minor Ticks. 4. To change tick length an thickness, under Tick Line, move the Length and Thickness sliders. 5. Select a color from the Color drop-down list. Choose from any of the listed colors, or select (Custom) to use a pre-defined custom color or create your own color. Select (None) to create transparent tick marks. 6.



Click OK.



For more information on using custom colors, see Using Custom Colors on page 158.



Customizing Tick Intervals



0



You can specify major tick locations by entering major tick values into a worksheet column, then selecting that column from the Graph Properties dialog box.
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 Modifying Axes, Tick Marks, and Grids Custom tick intervals are not available for minor ticks. Figure 10–26 A Graph with Custom Tick Intervals from Column 3



To use worksheet columns to customize tick intervals: 1.



Enter the desired tick marks into an empty worksheet column.



2.



Double-click the tick marks. The Graph Properties dialog box appears.



Figure 10–27 Selecting a Column for Tick Label Intervals
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3.



Click the Axes tab.



4.



From the Settings For drop-down list, select Ticks.



5.



From the Apply To drop-down list, select Major Tick Intervals.



6.



Under Major Tick Intervals, from the Ticks drop-down list, select the column number or title of the column you want to use for major tick marks.



7.



Click OK.



The numeric values of the intervals are automatically used for tick labels, that you can modify them like any other tick labels.



Changing Tick Labels



0



SigmaPlot can display tick labels in a variety of ways: for both major and minor tick marks, standard numeric labels, time and series labels, or values and text from a worksheet column. You can also add a suffix or prefix to all major or minor tick labels on a selected axis, and modify the calculation and precision of numeric labels, view different dates and times, select among many different series labels, and change the font and other text attributes.



Changing Tick Label Font and Other Text Attributes



To learn more about using the Text Properties dialog box, see Formatting Text on page 146. To change the font size, style, or color of tick labels: 1.



Right-click the tick labels, and from the shortcut menu, click
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 Modifying Axes, Tick Marks, and Grids Text Properties. Figure 10–28 Selecting a Column for Tick Label Intervals



The Text Properties dialog box appears. 2.



Click the Font tab.



3.



Change text attributes for tick labels the same way you would for any text label. You can also use the Rotation drop-down list on the Paragraph tab to rotate tick labels, but no other Paragraph settings are applied to tick labels.



Changing Tick Label Type



You can change the type of tick label used for all axis types except for category axes. For date/time tick labels, see Changing Date and Time Tick Labels on page 392. To change all other tick label types for all other axes: 1.



388 Changing Tick Labels



Double-click the tick labels you want to change.



 Modifying Axes, Tick Marks, and Grids The Graph Properties dialog box appears. Figure 10–29 Changing the Tick Label Type



2.



Click the Axes tab.



3.



From the Settings for list, select Tick Labels.



4.



From the Apply To drop-down list, select either Major Ticks or Minor Ticks.



5.



To use a numeric type of tick label, from the Type list, select Numeric, then use the Label Notation options.



6.



To use a series type of tick label, from the Type list, select Series.



7.



Click OK.



Σ Formatting Numeric Tick Labels



If you want to plot data versus true calendar dates, you should have entered date and time data in the worksheet, and use a date/time axis scale.



To format numeric tick labels: 1.



Double-click the tick labels of the axis you want to change.
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 Modifying Axes, Tick Marks, and Grids The Graph Properties dialog box appears. Figure 10–30 Selecting Numeric Tick Label Notation



2.



Click the Axes tab.



3.



From the Settings for list, select Tick Labels.



4.



From the Apply To drop-down list, select either Major Ticks or Minor Ticks.



5.



Under Label Notation, from the Use drop-down list, select the type of label notation to use. Scientific Notation or Engineering Notation for large numbers use scientific or engineering notation only when numbers exceed a specified range. Use the Below and Above drop-down lists to specify the range beyond which scientific notation or engineering notation is used. For log axes, you can select to display number, only the Exponent, or both the Base and Exponent.



Figure 10–31 Log Scale Y Axes Using Numbers, Exponent Only, and Base and Exponent
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For linear axes, you can Always Use Scientific Notation, or use it only When
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 Modifying Axes, Tick Marks, and Grids Needed for large numbers. To specify when scientific notation is needed, enter the Lower and Upper ranges in the fields, expressed as log units.



6. To divide numeric tick label values by a specific number, enter a divisor in the Factor Out drop-down list. A value of 2 divides label values in half, a factor of 0.5 doubles the tick label values, etc. 7. To specify the number of places used to display numeric tick labels, under Precision, select Automatic to let SigmaPlot automatically determine precision, or select Manual, then select the number of decimal places to use from the Places drop-down list. 8.



Formatting Series Tick Labels



Click OK.



To format series tick labels: 1.



Double-click the tick labels of the axis you want to change. The Graph Properties dialog box appears.



Figure 10–32 Selecting Series Tick Label Format



2.



From the Settings for list, select Tick Label.



3.



From the Apply To drop-down list, select either Major Ticks or Minor Ticks.



4.



From the Type drop-down list, select Series.



5.



From the Series drop-down list, select a series.



6.



From the Length drop-down list, set the number of characters to use for the
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 Modifying Axes, Tick Marks, and Grids tick label. 7.



From the Start At drop-down list, specify which series item to begin labeling tick marks with.



8.



From the Step By list, set the frequency, or increment, of series items to use. For example, if you are using a Days of the Week series, you might choose to start with Monday, and to step labeling by 2 days at a time. Tick labels appear as Monday, Wednesday, Friday, Sunday, Tuesday, etc.



9.



To re-start tick labeling from a specified point, use the After and Repeat From drop-down lists. For example, if you were using a Days of the Week series, and were stepping by 2 days at a time, you might use the After and Repeat From lists to specify that after Friday, repeat the series from Monday. Tick labels appear as Monday, Wednesday, Friday, Monday, Wednesday, Friday, etc.



10. Click OK.



Adding a Prefix or Suffix to Tick Labels



To add a suffix or prefix to the major or minor tick labels on a selected axis: 1.



Double-click the axis you want to change. The Graph Properties dialog box appears.



2.



Click the Axes tab.



3.



From the Settings For list, select Labels.



4.



From the Apply To drop-down list, select either Major Ticks or Minor Ticks.



5.



To add a prefix or suffix to the major or minor tick labels, type the prefix or suffix into the appropriate Add to Tick Labels Prefix or Suffix boxes. All labels on the selected axis appear with the specified suffix or prefix. You can use any keyboard or extended characters. Use the Windows Character map accessory program, or Alt+Numeric keypad combinations to enter extended characters like degrees symbols (Alt+0176).



6.



Changing Date and Time Tick Labels
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Click OK.



To change the format of date/time tick labels, use the Graph Properties dialog box. Entering values in these boxes is similar to entering date/time values in the worksheet.



 Modifying Axes, Tick Marks, and Grids To change date and time tick label format: 1.



Double-click the tick labels of the axis you want to change. The Graph Properties dialog box appears.



Figure 10–33 Changing Date/Time Tick Labels



2.



From the Settings For list, select Tick Label.



3.



From the Apply To drop-down list, select either Major Ticks or Minor Ticks.



4.



To change the display Date format, select a format from the list, or use the following table to enter a new label, using any additional characters as delimiters (i.e., slashes, commas, spaces, etc.). As you enter a different format, the Sample window shows an example of the label.



Typing:



Displays:



M/d/yy



No leading 0 for single digit month, day or year



MM/dd/yy



Leading 0 for single digit month, day or year



MMMM



Complete month



dddd



Complete day



yyy or yyyy



Complete year



MMM



Three-letter month



ddd



Three-letter day
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5.



6.



Using Custom Tick Labels



Typing:



Displays:



gg



Era (AD or BC)



To change the display Time format, select a format from the list, or use the following table to enter a new label, using any additional characters as delimiters (i.e., colons, spaces, etc.). As you enter a different format, the Sample window shows an example of the label.



Typing:



Displays:



hh or h



12 hour clock



HH or H



Military hours



mm or m



Minutes



ss or s



Seconds



uu or u



Milliseconds



H: h: m: s: or u



No leading zeroes for single digits



HH: hh: mm: ss: uu



Leading zero for single digits



tt



Double letter AM or PM



t



Single letter AM or PM



Click OK.



You can enter text and numbers into worksheet columns and use them as major tick labels. To customize tick labels using worksheet columns: 1.
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Enter the labels you want to use in a worksheet column in the order you want



 Modifying Axes, Tick Marks, and Grids them to appear. Enter minor labels in the right adjacent column. Figure 10–34 Tick Labels from a Column using the Symbol Font



Σ 2.



To skip specific labels, leave an empty cell for that tick mark when entering the labels into the worksheet column. Double-click the axis tick labels you want to modify. The Graph Properties dialog box appears.



Figure 10–35 Selecting a Columns as the Source for the Tick Labels



3.



Click the Axes tab.
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From the Settings for list, select Tick Labels.



5.



From the Type drop-down list, select the column to use for major labels. Labels for minor contours are automatically taken from the column to the right of the major tick labels.



6.



To change the font used for the tick labels, click Font. The Text Properties dialog box appears. You can use the Symbols font for Greek characters, and the Wingdings and other symbol fonts for iconic labels.



7.



Click OK.



Displaying Grid Lines and Backplanes



0



Display and modify grids for each graph plane using the Graph Properties dialog box. Grid lines are associated with both a backplane and one of the two axes which form the plane. If a graph has multiple axes, the axes used are the original pair. You can choose to turn on and modify grid lines for both major and minor tick intervals. Tick intervals are controlled using the Graph Properties dialog box Axes tab Scaling settings. For more information, see Changing Axis Scales on page 363.



Modifying Grids and Planes



To change major or minor grid lines: 1.



Double-click the graph to modify.
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 Modifying Axes, Tick Marks, and Grids The Graph Properties dialog box appears. Figure 10–36 Selecting the Backplane



2.



Click the Graph tab.



3.



Under Settings for, select Backplanes.



4.



If your graph is a 3D graph, from the Plane list, select the plane to modify.



Σ



When modifying a 2D graph, only one plane is available.



5. To select a background color for the selected plane, under Background, select a color from the Color drop-down list. Select any of the listed colors, or select (Custom) to use or create a custom color. To learn about using custom colors, see Using Custom Colors on page 158. Select (None) to create a transparent plane. Transparent planes are especially useful when superimposing graphs over one another. 6. To select a grid to modify or display, under Settings for, select Grid Lines, and then under Grid Lines, select a plane from the from the Plane dropdown list. You can modify major or minor grid lines for any axis of the selected plane.
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 Modifying Axes, Tick Marks, and Grids The grid lines available for Cartesian plots are X, Y, and Z for 3D plots. The Figure 10–37 Selecting the Grid Lines



grid lines for polar plots are for the Angular and Radial axes. Ternary plots have X, Y and Z direction grid lines. 7.



To change grid line style, under Line properties, from the Style drop-down list, select a style.



8.



To change grid line thickness, under Gridlines, move the Thickness slider type a thickness value in the Thickness box.



9.



To change grid line color, under Grid Lines, from the Color dropdown list, select a color. Choose any of the listed colors, or choose (Custom) to use or create a custom color. Choose (None) to create transparent grid lines. To learn about using custom colors, see Using Custom Colors on page 158.



10. To move the grid behind or in front of the plot, from the Layering dropdown list, select to move either the plot or grid to the front. This feature is
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 Modifying Axes, Tick Marks, and Grids especially useful for bar charts, and is not available for 3D plots. Figure 10–38 A Bar Chart with a White Backplane and White Grid Lines Placed in Front of the Plot
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11. Click OK.



Hiding and Viewing Grid Lines



To view hidden grid lines, or hide visible grid lines: 1.



Open the Graph Properties dialog box.



2.



Click the Grids and Planes tab.



3.



To hide grid lines, under Grid Lines, from the Style drop-down list, select (None).



4.



To display grid lines, change the style to a style other than (None).



5.



Click OK.
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 Modifying Axes, Tick Marks, and Grids
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Statistics This chapter covers many of the features available on the Statistics menu, including: ➤



Running t-tests (see page 401) ➤ Computing a histogram (see page 403) ➤ Plotting and modifying linear regression lines (see page 407) ➤ Adding and modifying reference lines (see page 412)



Running Paired and Independent t-Tests



0



A t-test determines if the mean values of two data columns are significantly different by testing the hypothesis that the means of the two columns are equal. SigmaPlot can perform both paired and unpaired t-tests. A paired t-test requires columns of equal length, since the data is assumed to be before and after data on the same subjects. An independent t-test can be performed on differently sized columns, since no relationship is assumed between the groups. To perform a t-test: 1.



On the Statistics menu, click t-test or Paired t-test.



Running Paired and Independent t-Tests 401



 Statistics The t-test Column Picker dialog box appears. Figure 11–1 t-test Column Picker Dialog Box



2.



Select the columns from the Selected Columns list or click the columns in the worksheet to pick the columns you want to compare. Selected columns are assigned to the highlighted group in the Selected Columns list.



3.



Click Finish. SigmaPlot displays results for the t-test.



Figure 11–2 t-test Results Dialog Box



4.



To save the t-test results, copy and paste the data to the worksheet, page, or another application.



For each test these values are displayed: ➤



T, the Student's t statistic P, the probability that you are incorrect in stating that the two means are different ➤ The Degrees of Freedom, a measure of the sample size ➤



Calculation of t



When performing t-tests, t is defined differently for paired t-tests than for unpaired tests. Paired Test: For a paired t-test on data sets {x1, x2, xn} and {y1, y2, , yn}
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 Statistics



D- where D = x – y and t = ----SD



2



( ΣD i ) ΣD i – ----------------n where D i = x i – y i -----------------------------------n(n – 1) 2



SD =



Unpaired Test: For an independent t-test on data sets {x1, x2, , xn1} and {y1, y2, , yn2}



t =
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Creating Histograms



0



Histograms are step, needle, or bar charts that represent counts of the datapoints that fall within specified ranges. The Histogram Wizard guides you through the steps in creating a histogram: generating frequency data, specifying the number of buckets or intervals, and selecting a graph style. The Histogram Wizard allows you to specify an even bucket size into which to partition the source data. The range of each interval is identical; the total range is the data minimum to the data maximum. The number of bars, steps, or needles displayed is generally equal to the number of buckets.
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 Statistics To create a histogram with an uneven bucket size, see The Histogram Transform Function on page 406. For a more detailed explanation of the histogram transform function, see the Programming Guide.



Using the Histogram Wizard



To use the Histogram Wizard: 1.



Enter the data you want to analyze in an empty column of the active worksheet.



2.



On the Statistics, click Histogram. The Histogram Wizard appears.



Figure 11–3 Histogram Wizard – Pick Data Dialog Panel



404 Creating Histograms



3.



Select the data for the histogram by choosing the appropriate column from the Source for Histogram drop-down list.



4.



Select the column for your output data by choosing the column from the Output for Histogram drop-down list.



5.



Click Next.



 Statistics 6.



The Histogram buckets panel appears.



7.



Specify the number of buckets you want to use. Enter values from 1 to 1000.



8.



Click Next.



9.



Select the graph style from the Graph Styles list.



Figure 11–4 The Histogram Wizard – Buckets Dialog Box



A preview of the graph appears. Figure 11–5 The Histogram Wizard – Graph Style Dialog Box



10. Click Finish. The graph appears on the active graph page, or a new page if the worksheet has no associated graph pages. The X axis representing the buckets is titled Bin.The Y axis representing the frequency or the number of data points in each bin, is titled Frequency. Both use a linear scale.
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 Statistics



Σ



If you choose None, SigmaPlot displays the worksheet with the output column containing the histogram frequency data.



Figure 11–6 Example of a Histogram Created Using the Histogram Wizard



For more information about modifying axes, see Modifying Axes, Tick Marks, and Grids on page 361.



The Histogram Transform Function



If you need to use uneven bucket sizes for a histogram, use SigmaPlot’s built-in



histogram transform function. To use the histogram transform function: 1.



Enter the data to analyze in column 1 the bucket values in column 2 of the worksheet. Bucket values are used as the upper bounds (inclusive) of the histogram interval ranges. The number of data points that fall within each specified range is counted. The number of histogram bars is equal to the number of interval upper bounds entered. The number of values that fall beyond the largest upper bound is also counted.



2.



On the Transforms menu, click User-Defined. The User-Defined Transform dialog box appears.



3.



406 Creating Histograms



Enter the following transform into the Edit Transform box:



 Statistics col(3)=histogram(col(1),col(2)) Figure 11–7 Graphing the results of the HISTOGRM.XFM transform as a bar chart



4.



Click Run. The histogram data appears in column 3.



5.



To graph the data, plot column 3 as a bar chart.



Plotting and Modifying Regression Lines



0



You can automatically compute and draw linear and polynomial regressions with confidence and prediction intervals. The regression equation can be computed using all the data in a plot, or individually for each curve in a multiple-curve plot. Polynomial curves can be fitted up to the 10th order. Regressions for column averaged data are computed using all the data from the columns, not just from the mean value. Regressions are computed and drawn linearly on nonlinear (e.g., log, probability, etc.) axis scales.



Regression equation coefficients, R2 values, and predicted values can be viewed and copied to the Clipboard. To perform nonlinear regressions and curve fits, such as sigmoidal, exponential, and peak functions use SigmaPlot’s Regression Wizard. The Regression Wizard provides an extensive set of equations for curve fitting. Creating a Graph with a Regression Line



Add a first order regression to a graph by selecting one of the graph styles that has a regression.
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 Statistics



Modifying and Adding Linear Regression Lines



To modify or add a regression to a plot: 1.



Click the plot to select it.



2.



On the Statistics menu, click Linear Regression. The Linear Regression dialog box appears.



Figure 11–8 Regression Line Tab



3.



Click the Regression Line tab.



4.



Select either Each Curve to draw a regression for the data in each curve of the selected plot, or All Data In Plot to draw a single regression for all of the data in the selected plot from the Regressions group box.



Σ



If neither box is selected a regression is not drawn. If both boxes are selected, regressions are drawn for each curve and for all the data in the plot.



5.



Under Line, choose the desired regression order Order drop-down list.



6.



Select the regression line type from Type drop-down list.



7.



Select line color from the Color drop-down list.



8.



To change line thickness, move the Thickness slider.



9.



To set the extent of regression line(s) all the way across the graph, under Options, select Extend to Axes.



10. Click OK.



Viewing and Saving Regression Equation Results



If you want to view and save the coefficients of the regression(s), select the Results tab of the Linear Regression dialog box. The Results panel appears displaying regression equation results.
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 Statistics The regression equation coefficients, correlation coefficient R2, and function results are displayed for each regression curve computed. If you computed confidence and prediction intervals, these values are also displayed. Figure 11–9 The Results Panel of the Linear Regression Dialog Box



Click Copy to copy the results and paste them into the worksheet, a report, or any other Windows application. For a description of the calculation of confidence and prediction intervals, see Linear Regression, Confidence, and Prediction Calculation on page 410.



Adding Confidence and Prediction Intervals



SigmaPlot can draw lines which describe either the 95% or 99% confidence and prediction intervals around a regression line. Confidence intervals, also called the confidence interval for a regression, describe the range where the regression line values will fall a percentage of the time for repeated measurements. Prediction intervals, also called the confidence interval for the population, describe the range where the data values will fall a percentage of the time for repeated measurements.



Σ



You must compute a regression in order to compute confidence and prediction lines. To add prediction and confidence lines: 1.



On the Statistics menu, click Linear Regression.
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 Statistics The Linear Regression dialog box appears. Figure 11–10 The Confidence Intervals Panel of the Linear Regression Dialog Box



2.



Click the Confidence Intervals tab.



3.



Choose the method of prediction to use from the Method drop-down list. Select either 95% or 99% for confidence and prediction intervals.



4.



Select the Confidence Interval and/or Prediction Interval option and select a line type and color, then move the Thickness slider or enter a value in the Thickness box to set line thickness. Line color, type, and thickness options work identically to the regression line type, color, and thickness options.



5.



Click OK.



For information on viewing confidence and prediction interval results, see Viewing and Saving Regression Equation Results on page 408.



Linear Regression, Confidence, and Prediction Calculation



Regression Calculation: SigmaPlot linear regression uses the least squares method to construct a fit a set of data points (xi, yi) i = 1, ..., n by a polynomial of degree p where:



y = β 0 + β 1 x + β 2 x 2 + ... + β p x p In vector-matrix notation this problem is formulated as:



Y = Xβ + ε where the n * 1 vector containing the yn data is:



Y = y 1 y 2 …y n and the n * (p +1) design matrix is: X = 410 Plotting and Modifying Regression Lines



1 x 1 x 12 … x 1p 1 x 2 x 22 … x 2p … … … … … 1 x n x n2 … x np



 Statistics



β is a (p + 1) * 1 vector of parameters to be estimated: β = β0 β1… βp ε is an n x 1 vector of residuals. The solution for the least squares estimates of the parameters β is:



b = ( X′X ) – 1 X′Y where X1 denotes the transpose of X. SigmaPlot uses the Cholesky decomposition to invert the X′Y matrix (see Dongarra, J.J., Bunch, J.R., Moler, C.B., and Stewart, G.W., Linpack User's Guide, SIAM, Philadelphia, 1979). This produces the regression curve



y = b 0 + b 1 x 0 + b 2 x 02 + … + b p x 0p For further details on matrix linear regression, refer to chapter 2 of Draper, Norman, and Smith, Harry, Applied Regression Analysis, Second Edition, John Wiley & Sons, Inc., New York, 1981.



Confidence Interval Calculation



Given a set of n data points (xi, yi) from two columns in the worksheet, SigmaPlot computes the pth order polynomial regression:



y 0 = b 0 + b 1 x 0 + b 2 x 02 + … + b p x 0p = where (b0, b1, ..., bp) are the p + 1 estimated parameters and y 0 is the Y value predicted for any x0. The confidence interval for this calculated regression is defined by the two confidence limits:



y 0 ± t ( n – p – 1 )s X′ 0 ( X′X ) – 1 X 0
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 Statistics where X0 is the (p +1) * 1 vector defined by:



X 0 = 1 x 0 x 02 … x 0p X is the n * (p +1) design matrix:



1 x 1 x 12 … x 1p X =



1 x 2 x 22 … x 2p … … … … … 1 x n x n2 … x np



s is obtained from the variance about the regression:



n



s2



=



(y i – y i)2 --------------------(n – 2) i=1



∑



and the t value for n − p − 1 degrees of freedom and the standard normal percentile equivalent z (z = 1.96 or 2.576 for 95% and 99% confidence intervals respectively) is computed from a six term rational polynomial approximation taken from Sahai, H. and Thompson, W., “Comparisons of Approximation to the Percentile of t, χ2 , and F Distributions,” Journal of Statistical Computation and Simulation, 1974, Vol. 3, pp. 81-93.



Prediction Interval Calculation



The prediction interval is calculated using the following equation:



y 0 ± t ( n – p – 1 )s 1 + X ′ 0 ( X ′X ) – 1 X 0



Adding Reference Lines



Σ



You can add horizontal or vertical lines at specific locations using the Graph Properties Plots tab Reference settings. Reference lines can be used to draw lines at specific values, to set quality control limits, and specify other reference values. Bar and stacked bar charts automatically place a reference line at the zero value.
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 Statistics Up to five reference lines can be added. All lines can be drawn only horizontally or vertically as a set. The Reference settings display the current calculation, line type, label, and color for each line. One set of five reference lines, either horizontal or vertical, can be drawn for each plot. If you need more than five lines or need both horizontal and vertical lines, you must create an additional plot. For information on creating multiple plots, see Adding New Plots on page 196. Figure 11–11 Graphs Using Reference Lines
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To draw reference lines: 1.



Double-click the plot to open the Graph Properties dialog box.



2.



Click the Plots tab.



3.



Select Reference from the Settings For list.



4.



Select a reference line to draw by selecting its check box. You can add up to five lines for each plot. The default names and calculations are the names commonly used when employing reference lines for quality



Figure 11–12 Graph Properties Dialog Plots Tab
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 control charts. 5.



To change the reference line name, select the line from the list, then edit the Label box for that line.



6.



To display the label next to the reference line, select Left or Right for horizontal reference lines, or Top or Bottom for vertical reference lines.



7.



To change the value or statistic used for the line, select an option from the Calc drop-down list. If you are not using a mean as the calculation, type a value to multiply the statistic by, or a value to use as a constant, in the box next to the Calc dropdown list. The calculation options apply only to the reference line highlighted in the Graph Properties dialog box list of reference lines. To set the reference line value to a specific value, select the Constant Calc option, and enter the value to the right. Automatically calculated statistics are derived from the plot data. All data points graphed, including multiple columns of data, are used for reference line calculations.



8.



Use the Appearance options to set a line type, thickness, and color for the highlighted reference line. Each reference line can have separate line attributes.



9.



Use the Direction drop-down list to draw reference lines horizontally or vertically.



10. Use the Layering drop-down list to draw reference lines either Behind or In Front of the selected plot. 11. Click Apply when finished modifying the current reference line, then highlight another reference line to continue modifying reference lines, or click OK.



 Statistics
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 Statistics
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Transform Basics This chapter covers: ➤



Using transforms and regressions to generate data (see page 417) ➤ Performing Quick Transforms (see page 419) ➤ Smoothing 2D and 3D Data (see page 420) For an in-depth discussion of transforms and regression, refer to the Programming Guide. It contains descriptions and examples of all transform functions and the regression wizard, as well as many complete transform and curve fitting examples and results.



Using the Transform Language



Modify and manipulate worksheet data using SigmaPlot’s extensive mathematical transformation language. Use transforms to create new data by performing functions on existing data, or generate calculated or random data, which can then be placed in worksheet columns. To create a user-defined transform: 1.



View the worksheet.



2.



On the Transforms menu, click User-Defined.



417



 Transform Basics The User-Defined Transform dialog box appears. Figure 12–1 User-Defined Transform Dialog Box



3.



Type transform instructions into the Edit Transform field. You can enter up to 32,000 characters in the Edit Transform field.



4.



Click Run.



You can save the contents of the transform window to a file. Since this is a text file, you can view or print these files using any word processor. You can open previously saved transforms in the transform window for execution or modification. A library of sample transforms is named Xfms.jnb in the Transforms folder. To view these files, click the Open button in the User-Defined Transforms dialog box and open a transform file. These transform examples also include a sample SigmaPlot graph file displaying the results of the transform.



Regression Wizard



Figure 12–2 Regression Wizard



418



The Regression Wizard provides access to the over 100 built-in curve-fitting equations and to your own regression models, and steps you through the regression process. The Regression Wizard produces plots of your fitted curves as well as statistical reports.



 Transform Basics



Performing Quick Transforms



0



Use the Quick Transform dialog box to enter and execute simple, one-line mathematical functions to modify one or more columns of data. This can save you time, as the Functions palette which appears directly below the Quick Transforms dialog box provides immediate access to frequently used transforms. No knowledge of complex programming is required. Note that you cannot run transforms on date and time columns. To use date and time data, you must first convert the data to numeric data, run the transform, and then convert the column back to date and time data. To learn more, see Switching Between Date and Time and Numeric Display on page 73. To perform a Quick Transform: 1.



With the worksheet in view, on the Transforms menu, click Quick Transform. The Quick Transform dialog box appears with two Equation drop-down lists. The Functions palette also appears directly below it, and contains many of the most commonly used functions.



Figure 12–3 Quick Transform Dialog Box and Functions Palette



You can either manually type the equation into the Quick Transform dialog box, or use the Function palette. 2.



Click the col or cell button in the Function palette. The Equation group box left drop-down list displays either col[?], or cell[?,?].



3.



Click the cell or column in the worksheet to replace the question mark in the Equation group box left drop-down list.



4.



Under Equation, place the cursor in the right drop-down list.



5.



Click a function button on the Functions palette.
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 Transform Basics



Σ



Close the Functions Palette by clicking the Functions Palette button open the Functions Palette, click it again.



. To



The function appears under Equation in the right drop-down list of the Quick Transform dialog box. 6.



Click the specific column, cell, or row in the worksheet to replace the question mark in the function argument with worksheet coordinates.



7.



Click Trig Units. The Trig Units dialog box appears.



Figure 12–4 Trig Units Dialog Box



8.



Select the appropriate trig units if calculating trig functions.



9.



Click OK.



10. Click Run.



Smoothing 2D and 3D Data



0



SigmaPlot smoothers are algorithms for smoothing sharp variations in dependent variable values within 2D and 3D data sets. You can also use smoothers to resample data to a rectangular grid of independent variable values. Each smoothing method weights the data contained in a window surrounding the smoothing location. The radius of this window is called the bandwidth radius. A linear or non-linear technique is then applied to the weighted data to compute each smoothed value. The weight assigned to each data value in the window is determined by its normalized distance (u) from the smoothing location.
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 Transform Basics Choose one of the following smoothing methods:



Σ Smoothing 2D Data



Smoothing Method



Description



Loess



Applies the tricube weight function ( 1 – u ) to weight the data. The smoother is polynomial of degree 1, 2, or 3. Use with 2D or 3D data.



Running Average



Computes the average of the dependent values. Use with 2D or 3D data.



Running Median



Computes the median of the dependent variable. Use with 2D or 3D data.



Negative Exponential



Applies a Gaussian weight function e to weight the data and a quadratic fit. Use with 2D or 3D data.



Bisquare



Applies a bisquare weight function ( 1 – u ) . Use with 2D or 3D data.



Inverse Square



Applies a Cauchy weight function 2D or 3D data.



Inverse Distance



Applies the weight function with 3D data only.



3 3



–u



2



2 2



1----p u



1 --------------2 1+u .



Use with



to the (x,y) data. Use



You can find smoother method guidelines in the 2D and 3D Smoothers sections of Samples.jnb. Use the Smooth 2D Data dialog box to remove undesired high-frequency data components. This data contains rapid variation such as noise contamination.



Figure 12–5 An example of “noisy data” and then its conversion to “quiet data.” Note that the original noisy data points appear on the graph.



To select the data source: 1.



Select the worksheet columns by dragging the pointer over your data.



Smoothing 2D and 3D Data 421



 Transform Basics 2.



On the Transforms, click Smooth 2D Data. The Smoother 2D - Select Data dialog box appears.



Figure 12–6 Selecting the Data Columns to Smooth from the Smoother 2D Dialog Box



3.



Click Next.



Figure 12–7 Selecting the Data Columns to Smooth from the Smoother 2D Dialog Box



To select columns for results: 1.



Select Predicted: First Empty from the Results list to compute a smoothed value for each data point.



2.



Select Residuals: First Empty to differentiate between the smoothed value and the original Y value.



3.



Accept First Empty as the standard default column in the Columns dropdown list.



4.



Select Plot Results to create a grid of the computed smoothed values on the worksheet.



5.



Click Next.



To select columns to graph:
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 Transform Basics 1.



Accept First Empty as the default in the Curve Data Column list.



2.



Select Create a new graph to create a line plot using the grid of data which appears on the worksheet.



Figure 12–8 Selecting columns to display a grid of smoothed data on the worksheet.



Σ 3.



To create another plot type and style, clear Create new graph, and create the plot manually. For information on creating 2D plots, see Creating 2D Plots on page 243. Click Finish. The Smooth 2D Data dialog box appears.



Figure 12–9 Selecting Smoothers from the Smooth 3D Data drop-down list



To define smoothing parameters: 1.



Select a smoother type from the Smoothers drop-down list.



2.



Set the Sampling Proportion to determine a fraction of the total number of data points used to compute each smoothed value.



Σ



The interpretation of the Sampling Proportion depends on the Bandwidth Method. To learn more about choosing a Bandwidth Method, see page 424.



3.



Set the polynomial degree from the Polynomial Degree list, if applicable.



4.



Select Reject Outliers to reduce the effects of outlier points on the
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 Transform Basics smoothed values. To set smoothing options: 1.



Click Options. The Smoothed Curve Options dialog box appears.



Figure 12–10 The Smooth Curve Options Dialog Box



2.



Σ 3.



Change the Minimum and Maximum for the X values to new beginning and ending values for the X ranges. For 2D smoothing, the Y values are the smoothed values, and therefore unavailable in the Smoothed Curve Options dialog box. Set the bandwidth method to either Fixed or Nearest Neighbors. Fixed: Sets the same bandwidth radius the same at every smoothing location. The radius is computed by multiplying the Sampling Proportion value times half of the difference between the set Minimum and Maximum independent variables (X values). Select Fixed if the density of the observed data is relatively constant over the extent of its defined region. Nearest Neighbors: Here the bandwidth radius depends on the smoothing location. The radius is equal to the maximum distance between the smoothing location and its nearest neighbors, as determined by the Sampling Proportion value. Select Nearest Neighbors for data that is clustered in some areas and sparse in others. For example, if there are 100 data points, enter .1 to choose ten data points nearest the smoothing location.



4.



Click OK.



To preview and create the graph:
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 Transform Basics 1.



Click Preview to see a preview of the graph. If the preview is not satisfactory, adjust the Smoother settings and options and click Preview again. Each time you preview, the settings are stored for subsequent review by clicking the right and left arrows.



2.



Click OK to accept the preview. The the graph appears with a line graph representing the smoothed data points. The original noisy data points also remain. The worksheet now contains the results of all selected computations. Click the Stop stop the process.



Smoothing 3D Data



button at the bottom of the Smooth 2D Data dialog box to



To resample 3D scatter plot data to rectangular grid locations necessary for creating mesh plots and 2D contour plots, first smooth the data, and then use the Smooth 3D Data dialog box to create the graph. To select the data source: 1.



Select the worksheet columns by dragging the pointer over your data.



2.



On the Transforms menu, click Smooth 3D Data. The Smoother 3D - Select Data dialog box appears.



Figure 12–11 Selecting the Data Columns to Smooth from the Smoother 3D Dialog Box
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 Transform Basics 3.



Click Next.



Figure 12–12 Selecting the Data Columns to Smooth from the Smoother 3D Dialog Box



To select worksheet columns for your results: 1.



Select Predicted: First Empty from the Results list to compute a smoothed value at each data point.



2.



Select Residuals: First Empty to differentiate between the smoothed value and the original Y value.



3.



Accept First Empty as the standard default column in the Columns drop-down list.



4.



Select Plot Results to create a grid of the computed data on the worksheet.



5.



Click Next.



To select columns to graph: 1.



Accept First Empty as the default in the Columns drop-down list.



2.



Select Create a new graph to create a mesh plot using the grid of data which appears on the worksheet.



Figure 12–13 Selecting columns to display the grid of smoothed data



If you are creating a contour plot, clear Create new graph, and create the contour plot manually. For information on creating contour plots, see Creating
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 Transform Basics Contour Plots on page 306. 3.



Select a smoother type from the Smoother drop-down list.



4.



Set the Sampling Proportion, a fraction of a total number of data points used to compute each smoothed value.



Figure 12–14 Selecting Smoothers from the Smooth 3D Data drop-down list



Σ



The Sampling Proportion depends on the Bandwidth Method. To learn more about choosing a Bandwidth Method, see page 427.



5.



Set the Polynomial Degree from the Polynomial Degree list, if applicable.



6.



Select Reject Outliers to reduce the effects of outlier points on the smoothed values.



To set smoothing options: 1.



Click Options. The Smoothed Curve Options dialog box appears.



Figure 12–15 The Smooth Curve Options Dialog Box



2.



Change the Minimum and Maximum for the X and Y values to new beginning and ending values for the X and Y ranges.



3.



Set the bandwidth method to either Fixed or Nearest Neighbors.
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 Transform Basics Fixed: The bandwidth radius is the same at every smoothing location. The radius is computed by multiplying the Sampling Proportion value times half of the difference between the set Minimum and Maximum independent variables (X and Y values). Select Fixed if the density of the observed data is relatively constant over the extent of its defined region. Nearest Neighbors: Here the bandwidth radius depends on the smoothing location. The radius is equal to the maximum distance between the smoothing location and its nearest neighbors, as determined by the Sampling Proportion value. Select Nearest Neighbors for data that is clustered in some areas and sparse in others. 4.



Click OK.



To preview and then create the graph: 1.



Click Preview to see a preview of the graph. If the preview is not satisfactory, adjust the Smoother settings and options, and click Preview again. Each time you preview, the settings are stored for subsequent review by clicking the right and left arrows.



2.



Click OK to accept the preview. The the graph appears, and the worksheet now contains the results of all selected computations. Click the red Stop button at the bottom of the Smooth 3D Data dialog box to stop the process.
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Using the Report Editor The SigmaPlot Report Editor is a text processor for annotating and documenting your graphs and data. The Report Editor features a complete text editor and OLE2 insertion and editing. It is also used by the Regression Wizard to report regression results. This chapter covers: ➤ ➤ ➤ ➤ ➤ ➤ ➤ ➤



Creating new reports (see page 429) Setting report view, toolbar and ruler options (see page 430) Setting the margins and paper size for a printed report (see page 430) Using the ruler (see page 432) Setting tab stops (see page 432) Indenting paragraphs (see page 434) Changing text appearance and paragraph alignment (see page 435) Inserting the current date and time (see page 436)



Creating Reports



0



Create reports using the New command (see Modified Notebook Items on page 38), or the Regression Wizard. To create a new report: ➤



Right-click the section in the notebook where you want to create the report, and on the shortcut menu click New, and then click Report. A report window opens and a new report is added to the selected section.



Creating Reports 429



 Using the Report Editor



Setting Report Options



0



To set report options, on the View menu, click Report Options to open the Options dialog box.



Σ Setting Ruler Units



These settings apply to the current report, but not to other open reports. To have these settings apply to subsequently opened or created reports, make your changes, then close the page. Newly opened or created reports will use these settings. Click the Units tab on the Options dialog box to select the ruler units and enable or disable automatic word selection. To open the report Options dialog box: 1.



Select the report window.



2.



On the View menu, click Report Options. The Options dialog box appears.



3.



Click the Options tab.



4.



To set the Measurement units to Inches or Centimeters, select the appropriate option.



Ruler Display



The View tab on the Options dialog box controls the ruler display. To view the ruler: 1.



Select the report window.



2.



On the View menu, click Report Options. The Options dialog box appears.



3.



Click the View tab.



4.



Under Show, select or clear Ruler options.



Setting Report Page Size and Margins Use the report Page Setup dialog box to set report margins, paper orientation, paper size, and paper source.



Σ



These settings apply to the current report, but not to other open reports. To have these settings apply to subsequently opened or created reports, make your
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 Using the Report Editor changes, then close the page. Newly opened or created reports will use all of these settings. To open the Page Setup dialog box: 1.



Select the report window.



2.



On the File menu, click Page Setup. The Page Setup dialog box appears.



Figure 13–1 Page Setup Dialog Box



The page sample at the top of the dialog box reflects changes. 3.



Select the paper size and source from the Size and Source drop-down lists.



4.



To select the printer, click Printer. The Page Setup dialog box appears on which you can select and setup any printer configured for your system.



5.



To change the paper orientation, under Orientation, select either Portrait or Landscape.



6.



To change the margins, under Margins (inches), type the desired values into the four boxes. The current ruler units appear in the Margins title.
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Using the Report Editor Ruler



0



Use the Report Editor ruler to view margins and to both view and modify report page tabs and paragraph indents. Figure 13–2 The Report Editor Ruler



First Line



Left Indent



Manual Tab



Default Tab Stop



Right Indent



The ruler indicates: ➤



Usable page column width Default tabs ➤ User-defined tabs ➤ Left and right paragraph indents ➤ First line indent ➤



You also use the ruler to specify tabs and indents. See Setting Tabs on page 432 and Setting Paragraph Indents on page 434.



Setting Ruler Units



Showing and Hiding the Ruler



Set ruler units using the Report Options dialog box (see Setting Ruler Units on page 13-430). These settings apply to the current report as well as to subsequently created reports. You can toggle ruler display by choosing View/Report Ruler. This command hides or shows the rulers for individual reports.



Setting Tabs



0 All tab stops appear on the report ruler. The default tab stop is 0.25" regardless of the current units. Tab stops made for individual and selected paragraphs, and are saved with reports. To set a tab: 1.



Select the paragraph(s) to change the tab stops.



2.



Click the ruler where you want to place a tab. A tab marker appears at the clicked location.



432 Using the Report Editor Ruler



 Using the Report Editor 3.



To move a tab, drag the tab marker to another location on the ruler. To delete



Figure 13–3 Setting a Tab Stop From the Ruler



a tab, drag the tab marker off the ruler. You can also set tabs from the Tabs dialog box: 1.



On the Format menu, click Tabs.



Σ



This command is only available while viewing a report window. The Set Tab dialog box appears.



Figure 13–4 Set Tab Dialog Box



2.



Enter tab stops in the Tab stop position in inches box. Enter Tab locations using the current ruler units.



3.



Click OK to add the tab setting to the list. Click Clear to remove a selected setting. Click Clear All to remove all tab settings.
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Setting Paragraph Indents



0



You can set left, right, and first line indents for individual paragraphs. These settings are saved with the report. To set paragraph indents: 1.



Select the paragraph(s) to change the indents.



2.



To change the first line indent, drag the marker at the top left of the ruler.



3.



To change the left indent, drag the marker on the bottom left of the ruler.



4.



To move both the left and first line indents, drag each marker separately.



5.



To change the right indent, drag the marker on the bottom right side of the ruler.



Figure 13–5 Report Editor Ruler
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 Using the Report Editor



Σ



To create an indented line, drag the marker to the right of the left indent. To create a hanging indent, drag the marker to the left of the left indent.



Figure 13–6 Paragraph Indent Formatting



Formatting Text And Paragraphs



0



The Formatting Toolbar appears at the top of the Report Editor. Using it, you can change report text attributes such as font, font size, color, and style of selected text. Figure 13–7 Formatting Toolbar



To modify text with the Formatting Toolbar: 1.



Select the text you want to modify. You can select individual characters, words, paragraphs, or the entire report.



2.



To format character font, size, weight, angle, underlining, or color, use the formatting toolbar buttons.



3.



To set paragraph alignment, use the Formatting Toolbar buttons for left, center, and right paragraph justification.



4.



To add bullets a to selected paragraph, click the Bullets button



. To



remove bullets, click the Bullets button again. You can also right-click the report page and on the shortcut menu click Bullet Style. Bullets are applied to the selected text.
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Inserting the Current Date and Time into a Report To insert the current date and time into reports: 1.



Select the report and click where you want to insert the Date or Time.



2.



On the Edit menu, click Insert Date and Time.



3.



Select the date and time format from the Available Formats list.



4.



Click OK. The current date and time appear as text at the specified location.



Figure 13–8 Date and Time Dialog Box



The list of available date and time formats depends on your Regional Settings. You can view or modify the Regional Settings directly from your Windows control panel.
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Sample Graphs Many of the following sample graphs can be found in the SAMPLES.JNB notebook, in the SigmaPlot program folder. This is a scatter graph of symbols with error bars and a line plot draw through the symbols. If you don’t have your fitted line data, you can use SigmaPlot’s Regression Wizard to create the data for curves. Scatter Plot with Error Bars and Fitted Curves 6
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 Sample Graphs



Grouped Bar Chart with Error Bars



This bar chart plots two data columns along with two error bar data columns, and uses a Y axis break.



Grouped Bar Chart with Error Bars 300 Data 1 Data 2
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Population Pyramid



A population pyramid created by using a stacked bar chart and tick labels from a column. Population Pyramid
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Bar and Line Chart with Two Y Axes



This graph plots a line and bar chart on the same graph with different Y axes. The bar chart has a width of 100% and the same color for both fill and edge.
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This is a Tukey box plot with varying box widths, taken from a worksheet column. The X axis is a category axis. Box Plots with Variable Widths 30
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 Sample Graphs



Bubble Plot



This is a bubble chart of two sets of xy data. Each bubble plot is a separate plot, since symbol sizes apply to entire plots, as opposed to individual curves.
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The legend is created using legend symbols for a dummy plot that graphs area data transformed to reasonable symbol sizes.



Fan Plot



This is a polar plot with a restricted angular axis arc and radial axis length. The radial axis positions are moved to the stop and start angles of the graph.
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 Sample Graphs



3D Mesh and Scatter



This is a graph of up to two 3D scatter plots and a mesh plot on a single graph.
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This is a set of four line graphs, each with one set of x and two sets of y data plotted as a line and a step plot, respectively. Graph 1
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 Sample Graphs



Ribbon Plot



A ribbon plot is created by a series of one interval wide meshes. You can use the RIBBON.XFM transform file to convert columns of data into mesh ribbons.



Ribbon Plot
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This graph is actually composed of three separate ternary graphs with different axis ranges and directions.
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Filled Contour Plot



This is a filled contour plot with the lines turned on. Both major and minor contours are set to use an incremented color scheme. Notice how the legend reflects what each color on the graph represents. Contour Graph 480
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This is a waterfall plot using an incremented color scheme. Waterfall plots are line plots placed along the Y axis in a 3D line plot. The “hidden” lines are eliminated by line fills. Waterfall Plot
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Printing Tips SigmaPlot relies entirely on Windows font and printer drivers for all of its output. These drivers were installed with Windows, or came with the printer and were installed separately. The precise options and settings available for each driver vary. Options available for the drivers provided with Windows are described in the Windows User’s Guide. Your printer vendor should have provided documentation for any drivers shipped with your printer.



Screen and Printer Fonts



All TrueType and PostScript fonts are fully supported using the Windows Fonts control panel and Adobe Type Manager. Some tips on using both TrueType and PostScript fonts are provided below. For more information on the Windows Fonts control panel, see the Windows User’s Guide. For more information on Adobe Type Manager, see the documentation provided by the program supplier.



Using TrueType Fonts



0



TrueType fonts are recommended if you are printing to printer(s) connected directly to your computer and are using a Windows compatible driver (provided either with Windows or by the printer vendor). Windows automatically renders TrueType fonts correctly in SigmaPlot both on your screen and printer. Control TrueType fonts from the Windows Control Panel. Use the Fonts control panel to add, remove, and enable or disable use of TrueType fonts. Additional TrueType fonts are provided with many other applications and can also be purchased as separate packages. SigmaPlot can use any correctly installed TrueType font.



Substituting Printer Fonts



For printers with their own built-in fonts, such as PostScript printers and later models of Hewlett Packard LaserJet printers, the printer setup dialog box option



Using TrueType Fonts 441



 Printing Tips allows automatic substitution of the built-in fonts for TrueType fonts. These options are found in the advanced options of the style options log for that printer.



Σ



Many high resolution typesetters and slidemakers still only support PostScript fonts, and not TrueType fonts. If you plan to take or send a printer file to a service bureau to output on a typesetter, color printer, or slidemaker, you should contact them and make sure they support the kind of fonts you want to use. If you must use non-TrueType fonts, you can disable TrueType fonts using the Fonts control in the Windows Control Panel.



Using PostScript Fonts



0



You can only use PostScript fonts when printing to PostScript or PostScript emulating printers. If you installed a PostScript printer driver, the PostScript fonts appear as printer fonts in the different font lists. PostScript fonts are only available if you installed a Windows PostScript printer driver when you installed Windows or by using the Windows Setup program, or if you are using Adobe Type Manager. You do not have to actually have a PostScript printer to install a PostScript printer driver. You will need to install the driver if you plan to use an outside service to print graphs on their PostScript compatible device.



When is PostScript Required?



Many high resolution typesetters and slidemakers still only support PostScript fonts, and not TrueType fonts. If you plan to take or send a printer file to a service bureau to output on a typesetter, color printer, or slidemaker, you should contact them and make sure they support the kind of fonts you want to use.



About Adobe Type Manager



PostScript fonts are not accurately rendered on your screen unless you have Adobe Type Manager installed. Windows will substitute similar fonts and display the widths correctly on the screen, and the fonts will print correctly. However, you can only install additional PostScript fonts using Adobe Type Manager. Adobe Type Manager was included in earlier versions of Windows and can also be purchased independently or bundled with many other applications.
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Optimizing Printer Output



0



Use Maximum Resolution



Some printers have a draft or lower resolution mode; if you are printing to a printer with variable resolution settings, make sure that the resolution is set to the highest level.



Use TrueType Fonts



Windows comes with TrueType fonts automatically installed. With TrueType fonts, you can access a wide range of typefaces. For more information about using TrueType fonts, see page 445.



Σ Thicken Lines



Use Halftoning



Note that some printing and slidemaking services do not yet support TrueType fonts; substituting printer fonts or using Adobe Type Manager generally solves this problem. For full sized graphs, the default line thicknesses may be too thin. Thicker lines will be easier to read. You can use set default line options by choosing Format/ Line to change line widths all at once. For more details, see Changing Multiple Page Objects on page 131.. If you are printing colors to a black and white printer, or are using different levels of gray, you can often improve the “dither” pattern using halftoning settings, available under the Advanced Options, for most laser printers. Laser printers default to a halftone screen of only 60, but can often handle up to 100. If you are producing high resolution at 1200 dpi, a halftone of 120 is possible, and at 2400 dpi, you can use a screen frequency of 150 (magazine quality).



Printing to High Resolution Typesetters and Slide Makers



0



There are a few points you should keep in mind when producing graphs for image setters and slide makers. Many of these are general design and layout principles that can be applied to any graph. ➤



Don’t use hairline line widths. Although hairline may appear fine on laser printed output, it will be too thin for image setters and slide makers. You can use set default line options by choosing Format/Line to change line widths all at once (see Changing Multiple Page Objects on page 131). ➤ Many journals and magazines don’t accept color, so consider using a gray scale for fill colors. If you are producing slides, color generally achieves a better effect. Avoid the use of fill patterns (hatching) whenever possible, and never mix patterns and colors; this tends to be confusing. ➤ Don’t use too many different fonts type faces (no more than two) on one page. Also, many publications accept only san serif fonts (such as Helvetica
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 Printing Tips



➤ ➤



➤



➤



or Arial). You can format text labels and set default text options by choosing Format/Text Properties (see Formatting Text on page 146). Don’t use small point sizes. For a full page graph, you don’t want to use point sizes smaller than 24 points. Don’t use too many different colors, and watch your color combinations. Don’t use red and green together, since many people are red-green color blind, and don’t use red and blue together, because the human eye has difficulty focusing on both (unless you are trying to achieve a “3D” effect). For slides, a dark background, such as black, dark gray or dark blue, creates the best effect. Use light colored lines and text when you have a dark background. For changing the background color, choose File/Page Setup (see Changing Page Color on page 157). For publications that accept color graphs, a light graph background color sets off the graph from the page. For changing the background color, choose File/ Page Setup; for more information, see Changing Page Color on page 157.



For other principles of graphing, you can refer to the resources listed under References on page 34.



Printing to Files



0



SigmaPlot can print pages to a disk file using any available Windows printer drivers, including PostScript using a PostScript printer driver, and HPGL using any Hewlett Packard plotter driver. PostScript files are required by many digital typesetters and slidemakers, and HPGL files can be imported into many word processors, desktop publishing, and drawing applications. You can also create any other kind of printer file, that can be printed at a later date by sending the file to the printer. The kind of file created is entirely dependent on the printer driver used. To print to a file rather than a printer: 1.



On the File menu, click Print. The Print dialog box appears.



2.



Select Print to File in the Print dialog box, and click OK. The Print to File dialog box appears.



3.



448 Printing to Files



Enter the file name for the output file, and click OK.



 Printing Tips



Types of Files



PostScript: PostScript files are created when you use a PostScript printer driver to print file. PostScript files can be “dumped” to another printer or high-resolution output device later. Use PostScript files if you want to take graph pages to a typesetting or slide-making service.



Σ



You do not need to have a PostScript printer connected to install and use a PostScript printer driver.



EPS: Encapsulated PostScript files are scalable line art graphic files. You can export graphs and pages to EPS files by choosing File/Export; see Exporting Graphs and Pages on page 47..



Σ



Note that EPS files contain no scaling information and are not designed to be sent to a printer. If you attempt to print an EPS file directly to a printer, you may receive unpredictable results.



HPGL: Hewlett Packard Graphics Language files use the Hewlett Packard pen plotter language. HPGL files are created when you use a Hewlett Packard plotter driver to print to a file. Many applications are able to read these files, some with great sophistication. Although HPGL files contain all color and line width information, not all applications will import this information correctly. If possible, avoid using thick lines in HPGL files; increasing line thickness increases the size of the HPGL file dramatically. Labels also add to file size. If you are directing HPGL output to a file for later “dumping” to a plotter, make sure that you have selected Hardware Handshaking in the Settings dialog box. Some programs, such as Ventura Publisher, are designed to handle and interpret large and complex HPGL files.
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Color, Symbol, Line, and Fill Schemes and Codes



Schemes Color Schemes



0 The colors used along with the equivalent graphic cell code is provided for each color scheme. Color



Graphic Cell Code



Black & White



@rgb(0,0,0) @rgb(255,255,255)



Gray Scale



@rgb(0,0,0) @rgb(192,192,192) @rgb(64,64,64) @rgb(224,224,224) @rgb(32,32,32) @rgb(128,128,128)



Earth Tones



@rgb(128,0,0) @rgb(192,192,0) @rgb(96,0,0) @rgb(255,128,0) @rgb(128,64,0) @rgb(128,128,0)



Schemes 447



 Color, Symbol, Line, and Fill Schemes and Codes Ocean



@rgb(0,0,128) @rgb(0,128,255) @rgb(0,0,96) @rgb(0,128,128) @rgb(0,64,128) @rgb(0,224,224)



Forest



@rgb(0,64,0) @rgb(0,255,0) @rgb(0,128,0) @rgb(192,255,0) @rgb(64,192,0) @rgb(255,255,0)



Muted Rainbow



@rgb(128,0,0) @rgb(255,128,0) @rgb(192,192,0) @rgb(0,128,0) @rgb(0,128,128) @rgb(0,64,128) @rgb(128,0,128)



Incremented



@rgb(0,0,0) @rgb(255,255,255) @rgb(255,0,0) @rgb(0,255,0) @rgb(255,255,0) @rgb(0,0,255) @rgb(255,0,255) @rgb(0,255,255)



452 Schemes



 Color, Symbol, Line, and Fill Schemes and Codes @rgb(128,128,128) @rgb(192,192,192) @rgb(128,0,0) @rgb(0,128,0) @rgb(128,128,0) @rgb(0,0,128) @rgb(128,0,128) @rgb(0,128,128) Incremented



@rgb(0,0,0) @rgb(255,255,255) @rgb(255,0,0) @rgb(0,255,0) @rgb(255,255,0) @rgb(0,0,255) @rgb(255,0,255) @rgb(0,255,255) @rgb(128,128,128) @rgb(192,192,192) @rgb(128,0,0) @rgb(0,128,0) @rgb(128,128,0) @rgb(0,0,128) @rgb(128,0,128) @rgb(0,128,128)



Symbol Schemes



Doubles: Circle, Circle, Down Triangle, Down Triangle, Square, Square, Diamond, Diamond, Up Triangle, Up Triangle, Hexagon, Hexagon Monochrome: Circle, + (cross), Down Triangle, Square, Up Triangle Dotted Doubles: Circle, Dotted Circle, Down Triangle, Dotted Down Triangle, Square, Dotted Square, Diamond, Dotted Diamond, Up Triangle, Dotted Up Triangle, Hexagon, Dotted Hexagon
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 Color, Symbol, Line, and Fill Schemes and Codes Incrementing: Circle, Square, Up Triangle, Down Triangle, Diamond, Hexagon



Line Schemes



Monochrome: Solid, Dotted, Short Dash, Dot-Dot-Dash, Long Dash, Dot-Dash, Medium Dash Incrementing: Solid, Long Dash, Medium Dash, Short Dash, Dotted, Dot-dash, Dot-dot-dash



Fill Pattern Schemes



Monochrome: Solid, None, Right-rising Fine, Cross Hatched Fine, Left-rising Fine, Horizontal Fine Incrementing: None, Right-rising Fine, Right-falling Fine, Cross Hatched Fine, Horizontal Fine, Vertical Fine, Grid Fine



Graphic Cell Codes



0



You can sequence plot lines, symbols, and fill patterns from an order that appears in a column. These sequences can be placed into a column by choosing Edit/Insert Graphic Cells. You can also directly type the “@” code for these symbols into a cell. Correctly typed codes appear as a graphic in worksheet cells. The codes for the symbols, lines, and patterns are shown below.



Symbol Codes



Codes for filled and unfilled (a fill color of none) symbols, as well as dotted and crossed symbols, are available. Use the (none) symbol type when you want to create curves which alternate between lines only and symbols only.



454 Graphic Cell Codes



Code



Symbol Type



@symbol(1,0)



(none)



@symbol(1,3)



dot only



@symbol(1,5)



crosshair only



@symbol(2,0)



hollow circle



@symbol(2,1)



solid circle



@symbol(2,3)



dotted solid circle



@symbol(2,2)



hollow circle with crosshair



@symbol(2,5)



solid circle with crosshair



 Color, Symbol, Line, and Fill Schemes and Codes @symbol(2,6)



hollow circle with crosshair



@symbol(3,0)



hollow square



@symbol(3,1)



filled square



@symbol(3,2)



dotted hollow square



@symbol(3,3)



dotted filled square



@symbol(3,4)



hollow square with crosshair



@symbol(3,5)



filled square with crosshair



@symbol(4,0)



hollow triangle up



@symbol(4,1)



filled triangle up



@symbol(4,2)



dotted hollow triangle up



@symbol(4,3)



dotted filled triangle up



@symbol(4,4)



hollow triangle up with crosshair



@symbol(4,5)



filled triangle up with crosshair



@symbol(5,0)



hollow triangle down



@symbol(5,1)



filled triangle down



@symbol(5,2)



dotted hollow triangle down



@symbol(5,3)



dotted filled triangle down



@symbol(5,4)



hollow triangle down with crosshair



@symbol(5,5)



filled triangle down with crosshair



@symbol(6,0)



hollow diamond



@symbol(6,1)



filled diamond



@symbol(6,2)



dotted hollow diamond



@symbol(6,3)



dotted filled diamond



@symbol(6,4)



hollow diamond with crosshair



@symbol(6,5)



filled diamond with crosshair



@symbol(7,0)



hollow hexagon



@symbol(7,1)



filled hexagon
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 Color, Symbol, Line, and Fill Schemes and Codes @symbol(7,2)



dotted hollow hexagon



@symbol(7,3)



dotted filled hexagon



@symbol(7,4)



hollow hexagon with crosshair



@symbol(7,5)



filled hexagon with crosshair



Line Codes



0 Codes for all available line types are provided. Use the (none) line type when you want to create curves which alternate between lines only and symbols only. Code



Line Type



@line(1)



(none)



@line(2)



solid



@line(3)



long dash



@line(4)



medium dash



@line(5)



short dash



@line(6)



dot



@line(7)



dash-dot



@line(8)



dash-dot-dot



Fill Pattern Codes



0



Codes for pattern types using the Windows default pattern density are provided. Use the (none) pattern when you want unfilled bars or boxes. The fill color of bars and boxes is controlled by the Fill dialog box Background Color options.
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Code



Fill Pattern



@pattern(1)



(none)



@pattern(2)



solid



 Color, Symbol, Line, and Fill Schemes and Codes @pattern(3)



rising right



@pattern(5)



rising left



@pattern(6)



diagonal cross hatch



@pattern(7)



horizontal lines



@pattern(8)



vertical lines



@pattern(9)



horizontal cross hatch



Fill Pattern Codes 457



 Notes



0



 17



The SPW.INI File Many system and option settings for SigmaPlot are saved in the SPW.INI file, which can be found in your Windows directory. You can modify some of the settings in SPW.INI directly by editing the file with the Windows Wordpad or another text editor; however, make sure you create a backup file before editing SPW.INI. Take great care in modifying this file. SPW.INI is used to handle the files that SigmaPlot shares with other programs, and changing these settings can lead to unpredictable results. Note that only those entries that are considered useful are discussed below.



Last Opened File Types



[Application] Last Open Filter=1 Last Import Filter=1 Last Export Filter=8 These setting under the [Application] heading determine the default open, import and export file types. Note that these are reset when new file types are selected from the Open, Import and Export dialog boxes. The number corresponds to Last used type from the [Open Filter], [Import Filter] and [Export Filter] lists. See Changing the File Type Orders on page 17-456.



Regression Wizard



[Nonlinear Regression] OneEditWindow=0 LastSection="3D" LastEquation="Lorentzian" The OneEditWindow setting can be used to display the Regression (edit code) dialog box as a single window in the style of previous versions of SigmaPlot. To set display to a single text window, set OneEditWindow=1. A setting of 0 creates multiple edit windows. The LastSection and LastEquation settings determine the default category and equation opened upon startup of the Regression Wizard. These are saved each time an equation is both selected and run on data.
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SigmaPlot Program Window Size and Position



[Settings] WindowPos=0,1,-1,-1,-4,-4,168,22,930,669 The WindowPos settings determine the SigmaPlot application window state, size and location upon opening. The first two settings determine the state of the window on startup: 0,1 = in window 0,2 = minimized 2,3 = maximized The next two settings can be ignored. This setting does not apply to Windows 95. The next pair of settings are unused. The last four settings determine the Window size and position. They are the pixel screen coordinates for the top left x, top left y, lower right x, lower right y of the window, respectively. When the SigmaPlot window is closed, the size and position on close is saved to this setting.



Changing the File Type Orders



File types listed in all of the SigmaPlot file dialog boxes (e.g. Open, Export, Import, etc.) are listed under the following headings. The name as it appears in order in the list is followed by the extension of the file type. You can change the order that these files appear in your file dialog boxes by changing the order they appear in these lists. If an import filter is required, the DLL used as the filter is specified before the file extension(s); do not change the import filter assigned to the file type.



Σ



Do not modify the [Export Page] heading; it is required to support export of SigmaPlot 1.0 and 2.0 files. The [Export Page Info] heading is used to support graphic file export. [Open Filters] SigmaPlot Notebook=,*.JNB Template Notebook=,*.JNT Regression Library=,*.JFL SigmaPlot 1.0, 2.0=JS~IJXFF|JD~IJXFF,*.SPW SigmaPlot Curve Fit=FIT,*.FIT SigmaPlot Macintosh 4=JS~ISPGF|JD~ISPGF,*.*
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 The SPW.INI File SigmaStat 1.0=JS~IJXFF|JD~IJXFF,*.SPW SigmaPlot DOS=JS~ISPGF|JD~ISPGF,*.SP5;*.SPG SigmaStat DOS=JS~ISPGF|JD~ISPGF,*.SP5 MS Excel=JS~WKW_F|JD~WKW_F,*.XLS Lotus 1-2-3=ImpOpenX|ImpOpenX,*.WKS;*.WK1;*.WK3;*.WK4 DBase=ImpOpenX|ImpOpenX,*.DB2;*.DB3;*.DBF Quattro Pro=ImpOpenX|ImpOpenX,*.WQ1;*.WKQ Paradox=ImpOpenX|ImpOpenX,*.DB Symphony=ImpOpenX|ImpOpenX,*.WK1;*.WR1;*.W RK;*.WKS Systat=ImpSystat|ImpSystat,*.SYS Plain Text=JS~IASCF|JD~IASCF,*.TXT;*.PRN;*.DAT;*.ASC Comma Delimited=JS~IASCF|JD~IASCF,*.CSV SigmaScan, SigmaScan Pro Worksheets=JS~IJXFF|JD~IJXFF,*.SPW Mocha, SigmaScan Image Worksheets=JS~IJXFF|JD~IJXFF,*.MOC DIF=JS~IDIFF|JD~IDIFF,*.DIF



[Open Excel Filters] EXCEL SigmaPlot Notebook=,*.JNB Template Notebook=,*.JNT Regression Library=,*.JFL SigmaPlot 1.0, 2.0=JS~IJXFF|JD~IJXFF,*.SPW SigmaPlot Curve Fit=FIT,*.FIT SigmaPlot Macintosh 4=JS~ISPGF|JD~ISPGF,*.* SigmaStat 1.0=JS~IJXFF|JD~IJXFF,*.SPW
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 The SPW.INI File SigmaPlot DOS=JS~ISPGF|JD~ISPGF,*.SP5;*.SPG SigmaStat DOS=JS~ISPGF|JD~ISPGF,*.SP5 MS Excel=EXCEL,*.XL* Lotus 1-2-3=EXCEL,*.WK* Quattro PRO/DOS=EXCEL,*.WQ* dBase=EXCEL,*.DBF Plain Text=EXCEL,*.TXT;*.PRN;*.CSV SYLK=EXCEL,*.SLK SigmaScan, SigmaScan Pro Worksheets=JS~IJXFF|JD~IJXFF,*.SPW Mocha, SigmaScan Image Worksheets=JS~IJXFF|JD~IJXFF,*.MOC DIF=JS~IDIFF|JD~IDIFF,*.DIF



[Import Filters] SigmaPlot 1.0, 2.0 Worksheet=JS~IJXFF|JD~IJXFF,*.SPW SigmaPlot Macintosh 4 Worksheet=JS~ISPGF|JD~ISPGF,*.* SigmaPlot Macintosh 5 Worksheet=JS~IJXFF|JD~IJXFF,*.* SigmaStat 1.0 Worksheet=JS~IJXFF|JD~IJXFF,*.SPW SigmaPlot DOS Worksheet=JS~ISPGF|JD~ISPGF,*.SP5;*.SPG SigmaStat DOS Worksheet=JS~ISPGF|JD~ISPGF,*.SP5 MS Excel=JS~WKW_F|JD~WKW_F,*.XLS Lotus 1-2-3=ImpOpenX|ImpOpenX,*.WKS;*.WK1;*.WK3;*.WK4 DBase=ImpOpenX|ImpOpenX,*.DB2;*.DB3;*.DBF Quattro Pro=ImpOpenX|ImpOpenX,*.WQ1;*.WKQ Paradox=ImpOpenX|ImpOpenX,*.DB Symphony=ImpOpenX|ImpOpenX,*.WK1;*.WR1;*.WRK;*.WKS
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 The SPW.INI File Systat=ImpSystat|ImpSystat,*.SYS Plain Text=JS~IASCF|JD~IASCF,*.TXT;*.PRN;*.DAT;*.ASC Comma Delimited=JS~IASCF|JD~IASCF,*.CSV SigmaScan, SigmaScan Pro Worksheets=JS~IJXFF|JD~IJXFF,*.SPW Mocha, SigmaScan Image Worksheets=JS~IJXFF|JD~IJXFF,*.MOC DIF=JS~WKW_F|JD~WKW_F,*.DIF Axon Binary=JS~AXF_F|JD~AXF_F,*.ABF;*.DAT Axon Text=JS~AXF_F|JD~AXF_F,*.ATF



[Export Notebook] SigmaPlot 3.0 Notebook=,,*.JNB SigmaStat 2.0 Notebook=,,*.SNB [Export Worksheet] SigmaPlot 3.0 Notebook=,,*.JNB SigmaStat 2.0 Notebook=,,*.SNB SigmaPlot 2.0=JS~EJXFF|JD~EJXFF,SPW,*.SPW SigmaPlot 1.0=JS~EJXFF|JD~EJXFF,SPW,*.SPW SigmaPlot Macintosh 5 Worksheet=JS~EJXFF|JD~EJXFF,SPW,*.SPW Excel 4=JS~WKW_F|JD~WKW_F,XLS4,*.XLS Excel 3=JS~WKW_F|JD~WKW_F,XLS3,*.XLS Lotus 1-2-3 v1.0=ExpOpenX|ExpOpenX,WKS,*.wks DBase II=ExpOpenX|ExpOpenX,DB2,*.dbf DBase III=ExpOpenX|ExpOpenX,DB3,*.dbf Quattro Pro v1.0=ExpOpenX|ExpOpenX,WQ1,*.wq1
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 The SPW.INI File Paradox v3.0=ExpOpenX|ExpOpenX,DB,*.db Symphony v1.0=ExpOpenX|ExpOpenX,WRK,*.wrk Systat=ExpSystat|ExpSystat,SYS,*.sys Comma Delimited=JS~WKW_F|JD~WKW_F,CSV,*.CSV Tab Delimited=JS~WKW_F|JD~WKW_F,TAB,*.TAB Plain Text=JS~WKW_F|JD~WKW_F,TXT,*.TXT SigmaScan, SigmaScan Pro=JS~EJXFF|JD~EJXFF,SPW,*.SPW Mocha, SigmaScan Image=JS~EJXFF|JD~EJXFF,MOC,*.MOC DIF=JS~WKW_F|JD~WKW_F,DIF,*.DIF



[Export Page] SigmaPlot 3.0 Notebook=,,*.JNB SigmaStat 2.0 Notebook=,,*.SNB SigmaPlot 2.0=JS~EJXFF|JD~EJXFF,SPW,*.SPW SigmaPlot 1.0=JS~EJXFF|JD~EJXFF,SPW,*.SPW



[Export Page INSO] SigmaPlot 3.0 Notebook=,,*.JNB SigmaStat 2.0 Notebook=,,*.SNB SigmaPlot 2.0=JS~EJXFF|JD~EJXFF,SPW,*.SPW SigmaPlot 1.0=JS~EJXFF|JD~EJXFF,SPW,*.SPW Bitmap=EBBMP2.FLT,BMP,*.BMP TIFF=EBTIF2.FLT,TIF,*.TIF MetaFile=EMWMF2.FLT,WMF,*.WMF Encapsulated PostScript=EMPS_2.FLT,EPS,*.EPS JPEG=EBJPG2.FLT,JPG,*.JPG
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Paper Size Definitions



These are the paper size settings for the Page Setup dialog box for printed graph pages, given in 1/254". [Paper Names and Sizes]; US Letter=, 2159, 2794 US Legal=, 2159, 3556 US Letter Small=, 2159, 2794 US Legal Small=, 2159, 2970 A4=, 2099, 2970



Text Defaults



These are the default options for newly created text, as set in the Text Options dialog box. These are reset each time the Text Options dialog box is opened and changed with no text selected. [Text Options] Name=Arial Italic=0 Weight=400 Underline=0 Size=20 Color=0l LineSpacing=139 Alignment=2 Rotation=0 Default Worksheet Option You can choose to have the Date and Time worksheet options appear by default instead of the Number defaults. Set SHOWNNUMERIC=1 if you want numbers to appear first, or set it to 0 if you want Date and Time to appear first. [DWWPREFINIT] SHOWNUMERICS=1
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Recent Equation Libraries



List of all Equation Libraries selected from the library panel of the Regression Wizard. You can change this list by editing the files under this heading. [Recent Equation Library List] Library1=C:\PROGRA~1\SPW\Standard.jfl Library2=C:\MYDOCU~1\Custom.jfl



Macro Preferences



These are the default options for macros, as set in the Tools/Options dialog box. [Macro Preferences] FontSize=10 FontName=Courier New HighlightBuiltin=0x00808000 HighlightComment=0x00008000 HighlightError=0x000000FF HighlightExtension=0x00800000 HighlightReserved=0x00FF0000 HighlightBreak=0x00000080 HighlightExec=0x0000FFFF MacroDefaultNotebook=C:\Program Files\SPW\SigmaPlot Macro Library.jnb Toolbar=1 RequireDefinitions=1



Last Saved Files



List of the last four saved files. You can change this list by editing the files under this heading. [Recent File List] File1=C:\WIN95\Desktop\samples.jnb File2=C:\SPW\SAMPLES.JNB File3=C:\My Documents\Example.JNB
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 The SPW.INI File File4=C:\SPW\TEMPLATE.JNT



Graph Page Size



[PageW] DefaultPageWidth=8500 DefaultPageHeight=11000 These are the page heights and widths used for new pages in the absence of a template file or if there is no page named Normal in the template file.



Metafile Bitmap Use for 3D Files



[PageW] hmetares=300 MetaBitmap=1 By default SigmaPlot generates 3D plots using a bitmap rather than a metafile. The hmetares setting determines the default resolution of that bitmap. This setting is changed to match the resolution of exported graphic files. The MetaBitmap setting determines whether a bitmap or metafile is used to render the 3D plot; 1=use a bitmap, 0=use a metafile. A bitmap is recommended if any gradient, lighting, and transparency is used. If you never use these setting, you can change MetaBitmap=0.



Grids, Rulers, Snapto and Crosshair Settings



[pagew] CrossHairsEnabled=0 GridShown=1 GridSpacing=250 GridDots=0 GridColor=0xffff80 RulersShown=1 GridSnap=0 These settings under the [pagew] heading determine the default grids, rulers, snap-to, and crosshair features; 1=show, 0=don’t show.



Default Zoom



[pagew] DefaultZoomLevel=5



467



 The SPW.INI File This setting under the [pagew] heading determines the default zoom; 5=50%, 1=10%, and 10=100%, and so on.



Edit Text Dialog Box Position



[Dialog Positions] Edit Text=302,349 These setting control the location where the Edit Text dialog box for graph page appears when opened. When the dialog box is moved and OK is clicked, this setting is updated.



Graph Properties Dialog Box Automatic Apply



[PageDialogs] AlwaysApply=1 When switching between the certain panels of Graph Properties dialog box, a prompt dialog box appears asking if you want to apply the changes before switching panels. If you click the Don’t show this again; always Apply check box, this prompt is removed.



Figure 16–1 The Apply Changes Prompt



You can re-activate this prompt by changing AlwaysApply=0.



Graph Default Settings



The settings for the graph defaults are provided as a reference in the event you would like to restore the settings to the original values using the SPW.INI file. [Graph Defaults] Graph Height In MilliInches=3500 Graph Width In MilliInches=5000 Graph Position Left In MilliInches=1750 Graph Position Top In MilliInches=3500 Font=Arial Page Color=16777215
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 The SPW.INI File Single Curve Symbol Color=0 Single Curve Symbol Color Repeat=2 Multi Symbol Color=0 Multi Symbol Color Repeat=61696 Single Curve Symbol Type=2 Single Curve Symbol Type Repeat=2 Single Curve Symbol Type Adornment=0 Multi Curve Symbol Type=2 Multi Curve Symbol Type Repeat=61952 Multi Curve Symbol Type Adornment=512 Single Curve Line Color=0 Single Curve Line Color Repeat=2 Multi Curve Line Color=0 Multi Curve Line Color Repeat=2 Single Curve Line Type=2 Single Curve Line Type Repeat=2 Multi Curve Line Type=2 Multi Curve Line Type Repeat=62464 Single Curve Bar Color=12632256 Single Curve Bar Color Repeat=2 Multi Curve Bar Color=0 Multi Curve Bar Color Repeat=61697 Bar Width=600
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Notes



470
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Troubleshooting This appendix provides you with tips for resolving common problems and gives advice for improving SigmaPlot performance on your system. It includes: ➤ ➤ ➤ ➤ ➤ ➤



Installation suggestions Ways to reduce or eliminate memory and other errors Solutions to common printing problems Tips on improving printing speed Inserting special characters Inserting SigmaPlot graphs into WordPerfect



Troubleshooting Installation Problems



0



Certain conditions in your Windows Setup may interfere with the installation of your new version of SigmaPlot. This section describes how to resolve most common difficulties.



General Advice for Windows 95 Users



Install in SafeMode SAFEMODE is a mode of running Windows 95 that is designed specifically for troubleshooting problems and for the installation of new applications. In this mode, all Terminate and Stay Resident (TSR) programs will not be run, and the video display will be set to a generic VGA mode. To install SAFEMODE, restart your computer, and when the words “Starting Windows 95" appear on the screen, press F8. Select SafeMode from the Microsoft Windows95 Startup Menu. When the Windows95 screen appears, begin installation.



Common Questions, Explanations, and Solutions



Question: My installation stalls and gives this message: “Cannot copy file THREED.VBX to \WINDOWS\SYSTEM, file already in use,” followed by, “THREED.VBX is out of date, installation procedure cannot continue....”
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 Troubleshooting Explanation: This problem may occur if you attempt to install while other Windows applications are running in the background. For instance, Microsoft Office makes use of the system-wide file VBRUN300.DLL. This means that this file cannot be copied to \WINDOWS\SYSTEM if you are running Microsoft Office while attempting to install SigmaPlot. Solution: In this case, follow these steps: 1.



Quit the installation procedure. Check to see which applications are currently running in the background by bringing up the Windows Task List on screen (Press CTRL+ESC on your keyboard). See Install in SafeMode on page 17-471.



2.



Keep a backup copy of the file on your system while preventing the Setup program from identifying it. Choose the File Manager Search command to examine files in your \WINDOWS\SYSTEM directory and to find the file THREED.VBX. The Search Results windows should show the file, THREED.VBX. Then choose the File menu Rename command to rename the file THREED.VBX as THREED.OLD and close the File Manager. Copy the file from the SigmaPlot installation disk to your \WINDOWS\SYSTEM directory.



Σ



If you are prevented from renaming the file in Windows, you can instead rename the file in DOS. Exit Windows, then use the DOS RENAME command by typing: C:\WINDOWS\SYSTEM>REN THREED.VBX THREED.OLD



3.



You are now ready to try the installation again. The Setup program should install successfully.



Question: My installation stalls and gives this message: “Cannot copy file VBRUN300.DLL to \WINDOWS\SYSTEM, file already in use. The installation procedure cannot be continued,” or, “Visual Basic Applications running, close applications.” Explanation: This problem may occur if you attempt to install while other Windows applications are running in the background. For instance, Visual Basic applications make use of the system-wide file VBRUN300.DLL. This means that this file cannot be copied to \WINDOWS\SYSTEM if you are running a Visual Basic application while attempting to install SigmaPlot. Solution: In this case, follow these steps: 1.



Quit the installation procedure. Check to see which applications are currently
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 Troubleshooting running in the background by bringing up the Windows Task List on screen (Press CTRL+ESC on your keyboard). Quit ALL applications other than Program Manager. 2.



Keep a backup copy of the file on your system while preventing the Setup program from identifying it. Choose the File Manager Search command to examine files in your \WINDOWS\SYSTEM directory and to find the file VBRUN300.DLL. The Search Results windows should show the file. Then choose the File menu Rename command to rename the file VBRUN300.DLL as VBRUN300.OLD and close the File Manager. Copy the file from the SigmaPlot installation disk to your \WINDOWS\SYSTEM directory.



Σ



If you are prevented from renaming the file in Windows, you can instead rename the file in DOS. Exit Windows, then use the DOS RENAME command by typing: C:\WINDOWS\SYSTEM>REN VBRUN300.DLL VBRUN300.OLD



3.



You are now ready to try the installation again. The Setup program should install successfully.



Question: The installation starts fine, but as soon as “Initializing Setup” appears on the screen, my computer crashes. Explanation: Problems like this are usually linked to a video driver conflict. Switching the video driver you are currently using to a standard Microsoft VGA or SVGA driver will probably solve the conflict. Solution: Here are the steps to make the setup changes: 1.



Quit the attempted installation and double-click the Windows Setup icon (usually located in the Main group of the Windows Program Manager). Under the setting Display, you will see the name and resolution details (if any) of the video driver you are currently using. Write down the full details of the current settings so that you can return to those settings later.



2.



Choose the Options menu Change System Settings command, scroll the list of video display options and choose either VGA or SVGA from the list. You will be prompted to install the “Current” or newer driver; choose “Current”, then restart Windows for the change to take effect.



3.



Attempt to reinstall once you are back in Windows. If you are unsuccessful, you may need to contact the manufacturer of your graphics card to update the driver.
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 Troubleshooting



SigmaPlot Errors



0



After installation, if you double-click the SigmaPlot icon and get an error message such as the one shown below, there are a number of possible solutions. Figure 17–1 The Too Many Users Warning



Important Network Information



As of SigmaPlot version 3.02, ALL workstations running SigmaPlot from a network must have FULL access to the application directory. Each time SigmaPlot is launched, it creates small files in the network application directory, and deletes them when it closes. If SigmaPlot cannot write to and erase from the application directory, it will not be able to run its counting routine and will not launch correctly. Look in your SigmaPlot application directory for LOCKFILE.SYS. Delete the LOCKFILE.SYS file and then attempt to restart SigmaPlot. Make sure that you have not exceeded the number of seats allocated on your network site license. If you have questions about the number of users allowed on your site, you can contact SPSS at: Telephone: (510) 412-2900 Fax: (510) 412-2909



Single-User Solution



To resolve the error when NOT running from a network: 1.



Check to see if you have another instance of SigmaPlot running on your system by viewing the windows task list. In Windows NT press Ctrl+Esc, and on Windows 95 press Ctrl+Alt+Del.



2.



Check to make sure that you filled in the registration information because SigmaPlot will not run if you have not entered your registration number. Instead, an error message like, “unable to initialize properly...too many users or SigmaPlot is not properly registered,” will appear. If you have entered the registration information, but somehow the file got corrupted or tampered with, you can delete the file USERDATA.TXT from the application directory, and then double-click on the SigmaPlot Registration icon to re-enter the data.



3.
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Exit and Restart Windows.
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Resolving Printing Problems Common Printing Problems



0



Problem: My Hewlett Packard Deskjet 600c prints text characters too far apart, with a space between each pair of characters. Explanation: This printer driver uses 2-cartridges, one for black and the other for color. The black cartridge supports three different resolutions: Best (600x600), Normal (600x300), and Econo (300x300). The color cartridge always prints at Econo (300x300) independent of the black settings. Solution: Change the default setting from Normal (600x300) to either of the 2 selections, 600x600 or 300x300, to avoid getting any of the spacing problems for text characters. Problem: While printing from SigmaPlot, objects on the screen look fine, but one of the following errors shows up: “Printer Busy,” “Memory Overflow Error,” “Printer Overrun”, or it prints no text, a blank page, or won’t print at all. Solution: Try the following steps: 1.



Update the printer driver to the latest version by obtaining the available printer driver from either the printer company or the SPSS Technical Support Department. To determine the current version of your driver go to the printer control panel (Settings/Printers from the Start bar in Win95) and select the desired printer by clicking it.



2.



If you are using a Hewlett Packard Laserjet IV or above, or a compatible printer, select Raster as Graphics Mode. In Win95, this can be found under Settings / Printers / Properties / Graphics.



If the above does not work, try using a different printer driver. For example, the Apple Laserwriter II driver is a Postscript driver, and using this when printing to a Postscript printer will often yield good results.



Improving Printing Speed in SigmaPlot



0



Printing speed is influenced by your system’s configurations and not by SigmaPlot. When printing, the “Updating Page” message appears and indicates that SigmaPlot is sending a “map” of the page through Windows. SigmaPlot waits for the Printer Driver within Windows to give the “go ahead” messages after each page segment is sent. The following are some configuration variables to check.
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 Troubleshooting The Spooler Make sure that the Windows spooler is up and running. In Windows95, it is selected in the START/Settings/Printers/Properties/Details/ Spool Settings. Printer Memory and Hard-Disk Space These are also factors in printing speed. The more printer memory and hard-disk space available, the faster the printing occurs. Graphics Mode Choosing the correct graphics mode for a type of graph can make a difference for HP Laserjet IV or above, or any compatible printer. Printing on HPGL/2 (vector type) mode is faster than Raster (bitmap type), unless you are printing a graph with error bars, in which case it is the other way around.



Pasting Special Characters



0



From time to time, you may need to put some characters or symbols onto your graphs or presentations. These symbols can be found in the Character Map dialog box. In Windows 95, the Character Map is located in the Accessories group. Figure 17–2 Character Map Dialog Box



Once a symbol is selected, the appropriate keystrokes that are necessary for this particular symbol shows in the bottom right corner. For example, if you select the heart symbol, the bottom right corner shows “Keystroke: Alt+0169.” To insert the heart symbol into your graph, press the Alt key and then the numbers 0, 1, 6, and 9, while keeping the Alt key depressed. Release the Alt key and the heart will appear. For better appearance, make sure the font selected in SigmaPlot matches the font selected in the Character Map dialog box. If using the key pad, make certain that the Num Lock is set on.



476 Pasting Special Characters



 Troubleshooting



Inserting SigmaPlot Graphs into WordPerfect



0



There are two basic ways to get a SigmaPlot graph into a WordPerfect document. One is to copy and paste the graph and the other is to insert the graph as a picture.



Copy and Paste or Paste Special



In SigmaPlot, select the object you would like copied into your WordPerfect document. Choose the Edit menu Copy command to place the object on the Clipboard. Now open your WordPerfect document and place the cursor where you want the Clipboard contents copied. Choose the Edit menu Paste command. You can also choose the Edit menu Paste Special command to paste a picture of a graph. For more information about inserting page objects, see Cutting, Copying and Pasting Graphs and other Page Objects on page 4-111.



Insert the Graph as a Picture



To insert your SigmaPlot for Windows graph as a picture, first convert your SigmaPlot file into a graphical format that WordPerfect can read. The graphical formats available to output a SigmaPlot graph are EPS (Encapsulated PostScript), WMF (Windows MetaFile), BMP (Windows Bitmap), TIFF, and JPEG. For direction on exporting graphs and pages to files, see Exporting Graphs and Pages on page 2-47. Once your graph is saved in a format that WordPerfect will accept, open your WordPerfect document and choose the File menu Insert command, then select File from the list. In the Insert File dialog box, set the List Files of Type to All Files, then select the file you want to insert into WordPerfect and click OK.
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 Notes



0



 Glossary 95% or 99% Confidence Lines See Confidence Line. Angular Axes The angular axes of polar plot are drawn along the inner (if applicable) and outer circumferences of the graph. By default, the inner axis is not displayed, but if your radial axes are offset from the center of the graph, you can choose to display the inner angular axis. See also Polar Plot, Radial Axes. Apex The maximum/minimum or tip of the triangle for ternary plot axes. ASCII File See text file. (ASCII stands for American Standard Code for Information Interchange.) Aspect Ratio The Aspect Ratio option allows for resizing of graphs and objects without distortion. To maintain the aspect ratio (the ratio of length to height) of a graph or object during manual resizing, make sure the Stretch Maintains Aspect Ratio option is checked in the Options. AUTOEXEC.BAT A DOS file that automatically executes a series of commands when DOS is booted. Axis In a Cartesian graph, an axis indicates the direction and range of X, Y, or Z values. In SigmaPlot, axes define the origin and scaling of a plot, and include tick and label definitions. Multiple axes for 2D graphs can be created using the Graph menu Add Axis command. Because each 2D Cartesian plot can be associated with only one set of X and Y axes, you can only create new axes if your graph contains multiple plots. However, since a graph can contain an unlimited number of plots, you can create an unlimited number of X and Y axes for a graph.



Σ



Note that an unlimited number of plots can share a single axis.



Axis Break A range along the axis where portions of a plot are omitted. If there is a large empty range between two sets of data, you can use an axis break to omit the empty range. Axis Direction For ternary axes, the direction that the data increases. This can be counter-clockwise (by default) or clockwise. Axis Label Axis titles and tick labels. Axis titles can be automatically taken from the Axis name (as shown in the Axis panel of the Graph Properties dialog box) or manually typed using the Tools menu Text command. Tick labels can be numeric, time series, or taken from a worksheet column. See also Tick Labels.
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 Glossary Axis Pair The top and bottom or left and right pairs in an axis. Each axis in the pair can be moved or turned on or off independently using the Lines settings of the Axes panel in the Graph Properties dialog box. Axis Range The minimum and maximum values of an axis, controlling the scale and extent of the plotted data. SigmaPlot uses default axis ranges unless you specify the range manually in the Scaling settings of the Axes panel in the Graph Properties dialog box. Major tick intervals are also controlled by the axis range. Axis Placement The position of an axis relative to the origin and “extent” of the graph. The graph extent is the size of the graph as indicated in the Object Properties dialog box. Use the Lines settings of the Axes panel in the Graph Properties dialog box to change axis positions. Placement is described as a percentage of the axis distance from the original position with respect to the graph extent, where 0% is the original position. Axis position can also be changed by selecting an axis and dragging it. Axis Title See Axis Label. Axon File The format produced by an Axon Instruments data acquisition device. This file format can be read into SigmaPlot worksheets using the Import command. Backplane The plane at the back of a graph formed by the axes. Grid lines are attached to backplanes. Backplanes are selected and modified using the Grid and Planes panel of the Graph Properties dialog box. Bad Points Any of three types of data points: 1) data that fall outside the range specified for the axes; 2) empty, missing, or non-data cells; 3) data outside the legal range for an axis, for example, a non-positive value on a logarithmic scale. You can ignore bad points using the Data settings of the Plots panel in the Graph Properties dialog box. Bar Chart A plot which graphs data as vertical or horizontal bars with bar lengths equal to the data values. If you plot more than one column of data, the data is plotted as groups of bars. Select a plot, then use the Graph Wizard – Modify Plot dialog box to change a plot to a bar chart. See also Plot Type and Stacked Bar Chart. Base (of an exponent) The number that is raised to the exponential power (for example, 10 or e). Bitmap A general description for an image composed of individual bits, or pixels. Also a term for the Window bitmap graphic file format. The resolution of a bitmap is dependent on the dpi, or dots per inch, it is created with. Because the number of pixels that compose a bitmap is constant, making a bitmap appear smaller increases its relative resolution by increasing its dpi. Conversely, making a bitmap larger reduces the dpi and its resolution.
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 Glossary Block 1) A selected, rectangular region of worksheet cells. Blocks can be copied, deleted, pasted, transposed, sorted, printed, and exported. 2) A transform language function that operates on worksheet blocks. BMP See Bitmap Box Plot A plot type that displays the 10th, 25th, 50th, 75th, and 90th percentiles as lines on a bar centered about the mean, and the 5th and 95th percentiles as error bars. The mean line and data points beyond the 5th and 95th percentiles can also be displayed. See also Plot Type. Bubble Plots A special case of scatter plot where a third dimension is graphed using the areas of the symbols. Cartesian A graph using a rectangular XY (or XYZ) coordinate system. SigmaPlot can create both 2D and 3D Cartesian graphs. See also Coordinate System. Category Scale A scale which uses numerical values or text from a worksheet column used to generate a plot. Each distinct entry in the column is a separate category against which the corresponding data values are plotted. Cell 1) A location on the worksheet that holds a single data value or label, described by its column and row number. 2) A transform language function that specifies the coordinates and contents of a worksheet cell. Clipboard The Windows data buffer where cut or copied data and graphics are stored. Press Ctrl+V or use the Edit menu Paste command to paste Clipboard contents to the worksheet or page. Note that data and graphics are stored in the same Clipboard, so cutting additional data or objects overwrites current Clipboard contents. Cleared (deleted) data or graphics bypasses the Clipboard and leaves the current contents intact. Codes (graphic cell) Graphic cell codes can be typed into a worksheet column to sequence different types for plot lines, symbols, and fill patterns. You can also use the Edit menu Insert Graphic Cells command to sequence lines, colors, symbols, and fill patterns. Coefficient A real number that multiplies a variable in an algebraic expression. See also Correlation Coefficient and R Value. Column Averaging Plotting the mean value of each column. This is most often used as a means of creating error bars. Standard deviation, standard error, or 95% or 99% confidence values can be used as error bar values. Column The SigmaPlot worksheet consists of columns and rows. A column generally holds a range of numbers to be plotted as a set. This set can be X, Y, or Z values, plotted against another column or against their row numbers. Columns can also be plotted as pie chart slices, or averaged and plotted as a single data point. See also Pie Chart and Column Averaging.
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 Glossary Columns can also hold labels, and sequences of custom symbol or line types, fill patterns, error bar directions, and colors. Column Statistics A collection of statistics computed for each column. Open the Column Statistics window by choosing the View menu Column Statistics command. Common Log Scale An axis type that plots data along a logarithmic scale with base 10. See also Natural Log Scale. Confidence Line For a regression line, there is a probability that any given data point will fall within a certain distance from the line. A confidence interval is the region where a data point will fall with a specific degree of probability. SigmaPlot can calculate 95% and 99% confidence intervals. Contour Plot Contour plots are a rendering of three dimensional data in two dimensions. The z, or vertical, dimension is represented by drawing lines that follow the XY coordinates of specific z intervals. Topographic maps are an example of contour plots. CONFIG.SYS A DOS file that installs device drivers and sets system parameters when you turn on or restart your computer. Coordinate System A system that defines the method of defining data point placement on a graph. SigmaPlot supports 2D and 3D Cartesian graphs, polar plots, ternary plots, and pie charts. ➤



Cartesian graphs use two or three rectangular axes to describe data point location. ➤ A polar plot describes data using angle and radius within a circular region. ➤ Ternary graphs plot data along three axis ranges that have a sum of 100%. ➤ A pie chart uses polar coordinates to assign slice sizes to data point values. A graph's coordinate system is fixed when you create the graph and cannot be changed. See also Plot. Copy Place selected worksheet data or graphic objects in the Windows Clipboard without removing the data or objects. The Clipboard contents can be placed elsewhere on the worksheet or page by pressing Ctrl+V or selecting the Edit menu Paste command or Edit menu Paste Special command. Correlation Coefficient (R) R, or the measure of closeness of a regression to the data. Specifically, it is the covariance divided by the product of the sample standard deviations. SigmaPlot calculates the correlation coefficient for linear regressions. Cubic Spline Interpolation A mathematical formula connecting data points with a smooth curve. It can be roughly described as a running interpolation of cubic polynomials.
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 Glossary Cursor Specifically, the blinking vertical entry bar for text, or the current cell highlight on the worksheet. See also Pointer. Curve The graphical display of a single data set, either a line/scatter curve or a set of bars or boxes. SigmaPlot data sets are the data in a single worksheet column or in a set of XY or XYZ columns. A plot can consist of multiple curves where more than one set of data columns are plotted. See also Plot. Curve Fit See Nonlinear Regression. Cut Remove selected data or graphics and place them in the Windows Clipboard. Press Ctrl+X or use the Edit menu Cut command to cut data or graphics. Cut displaces any current Clipboard contents. Only the last cut item can be pasted. Note that data and graphics use the same Clipboard. The Clipboard contents can be placed at any selected worksheet or page location by pressing Ctrl+V or choosing the Edit menu Paste command or Edit menu Paste Special command. Clipboard contents can also be pasted into other Windows applications. See also Paste. Data Set A column or set of worksheet columns that have been picked to plot. Column assignment labels at the bottom of the worksheet indicate the data sets for the currently selected plot. See also Plot and Curve. Date/Time Scale An axis that plots true calendar dates and times using real time increments. Delimiter A symbol or character used to separate data fields within a data file format; for example, white space, commas, semicolons, or colons. Dialog Boxes Windows of commands and options that appear on the screen. Use dialog box options to view and change graph and program settings. DOS Shell Used to access the DOS prompt from within Windows to run DOS commands. The DOS window mays not contain enough memory to run large applications. Drag Move the mouse while holding down the left mouse button. Dragging is used to move objects, stretch objects, or select regions. Drop Lines



Lines which can be added to 2D and 3D plots which use symbols.



Edges This term refers to the outline of bar chart bars, symbols, box plot boxes, pie chart slices, and the lines in a 3D graph mesh grid. Edge color is determined by the color of the fill pattern. Edge thickness can be modified using the Fills settings of the Plots panel in the Graph Properties dialog box. Edit Text Dialog Box A dialog box used to enter or edit text labels or symbols on the graph page. Embed Use the Edit menu Paste Special to embed an object on a graph page. Embedding an object on the page places a copy of the object on the graph page 483



 Glossary and enables you to edit the object by activating the object’s source application when you double-click it, but does not change the original file from which the object was pasted. Encapsulated Postscript File (EPS) Encapsulated PostScript files are scalable line art graphic files. Use this file format to export SigmaPlot graphs to other word processor and graphic applications. To create an EPS file, you must have a correctly installed Postscript printer driver supported by Windows. Error Bar A graphical display of the data variability. Error bar values can be automatically calculated through column averaging, or they can be entered in the worksheet columns. Error Bar Column A data column containing error bar values. Error Bar Direction The error bar direction can be specified for each curve or for each data point within a curve. These directions can be absolute (always up or down), relative (toward or away from zero), or both. Excel Workbook The file format for Microsoft Excel, which can be opened and used in its native format by SigmaPlot. Exploding Pie Slice A slice in a pie chart that is separated from the rest of the chart for emphasis. Exponent The power to which the base is raised. See Base. Export Save worksheet data or a graph page from SigmaPlot to a file, for use with other programs. Choose the File menu Export command to export files. Fills Fills include pattern of lines and colors that fill bar chart bars, pie chart slices, 3D graph mesh grids, 3D bar fills, and drawn objects. Fill patterns affect the color of bar, box, and slice edges and mesh grid lines. Fills and edges are specified using the Fills settings of the Plots panel in the Graph Properties dialog box. Use the Format menu Fill command for drawn objects. Film Recorder A hardcopy device used to print SigmaPlot graphs on a slide or photo for presentation. Slidemakers are a type of film recorder. Font A style or type of character. TrueType fonts are available from the Windows system. Other fonts, such as PostScript and Hewlett Packard fonts, are only available if the printer drivers are installed. Frame Lines Lines which are drawn to complete the “cube” outlining a 3D Cartesian graph. Frame lines can be drawn using either the viewer or the origin as the reference. Use the Frame Lines settings in the 3D View panel of the Graph Properties dialog box to turn on/off frame lines. Gaussian 1) A continuous probability distribution defined by two parameters, mean, and variance. Also called the normal distribution. 2) A transform language function used to generate random normally distributed data.
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 Glossary Geometric Mean The mean obtained by taking the antilog of the mean of the logarithm of the original variable. Error bars created using the logarithm of the variable are equidistant from the geometric mean when displayed on a logarithmic scale. This option is only available when using logarithmic axes. You can use the geometric mean instead of the arithmetic mean when using error bars. See Error Bar and Column Averaging. Graph In SigmaPlot, a graph is an object on the page of specific size and location, associated with a coordinate system. Back planes, plots, and axes are attached to graphs. Graphs can contain multiple sets of plots. 2D graphs can have multiple axes. Graphs are created with the Graph Wizard or Graph menu Create Graph command. See also Back Plane, Coordinate System, Page, and Plot. Graph Defaults A limited set of graph attributes that can be set to apply to newly created graphs. Graph defaults do not affect existing graphs. Set graph defaults using the Tools menu Options command. Graph Style The style of a graph determines the appearance of data on the graph. The style you can assign to a graph depends on the graph type. The Graph Wizard lists the available graph styles once you have selected a graph type. Graph Type The kind of representation for graphed data. SigmaPlot can produce 2D line and/or scatter plots, bar and stacked bar charts, Tukey box plots, line and/ or scatter polar plots, contour plots, and 3D line and/or scatter, bar charts, and mesh plots. Pie charts do not have different plot types. Graphic Object See also Object. Any object appearing on the page and capable of being moved; for example, text, lines, boxes, ellipses, and graphs. Grid Horizontal or vertical lines incremented according to the tick mark intervals of the associated Cartesian axes. Grid lines are modified using the Grids and Planes panel of the Graph Properties dialog box. Grid lines are attached to graph back planes. See also Back Plane and Tick Marks. Grouped Bar Chart See Bar Chart. Help System A system of indexed screens linked by hypertext providing on-line information about SigmaPlot commands and operations. Press F1 to view the Contents screen of the help system, or choose one of the Help menu commands to get additional help information. Related topics are linked through highlighted words on the screen; selecting these brings up the entry for that topic.
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 Glossary Histogram A representation of frequency distribution showing the number of occurrences within specified intervals, usually displayed as a bar or step chart. The histogram of a worksheet column can be generated and plotted by choosing the Statistics menu Histogram command, or by using the histogram transform function. Hot Key A quick method of selecting menu commands and dialog box options. A letter in the command or option appears highlighted; pressing that letter selects the command or option. See also Keyboard Shortcut. Import Transfer data from a file to the SigmaPlot worksheet for plotting or other operations. SigmaPlot recognizes text, .DIF, .Lotus 123, Quattro, Excel, SigmaPlot (*.SPW, *.SP5, and *.SPG), Mocha worksheets, and other file formats. Choose the File menu Import command to select files to import. Increment See Scheme Insert A data entry mode where existing data is moved aside to make room for entered data. When typing text labels on the page, you are always in insert mode. To switch between insert and overwrite modes on the worksheet, press Insert or choose the Edit menu Insertion Mode command. Worksheet data is moved down one row. When entering text, press the Insert key to toggle between insert and overwrite modes. In insert mode, characters are moved to the right to make room for the new characters. See also Overwrite. Inverse Distance Interpolation Inverse distance interpolation is a method of generating an evenly spaced XY mesh from XYZ data points. The Z value for each interpolated data point is calculated using the Z values of all original data points. The weight given the value of the nearer original data points versus the farther data points can be modified. JPEG A compressed bitmap graphic file format commonly used on the World Wide Web. See also Bitmap. Label Any text string, including tick labels, axis titles, and text entered using the Tools menu Text command. Tick labels are modified using the Tick Labels settings of the Axes panel in the Graph Properties dialog box. Text labels manually placed on the page can be modified by double-clicking them or using the Format menu Text Properties command. See also Axis Label, Rotation, Label Size, Font, and Tick Labels. Label Size The size of text label characters, specified in points (one point = 1 ⁄ 72 inch). Landscape Orientation of a page so that page width is greater than page height. Page orientation is controlled using the File menu Page Setup command or Printer 486



 Glossary Properties options in the Print dialog box. See also Orientation (Page) and Portrait. Legend An explanation of the symbols on a graph. Legends are inserted by choosing the Tools menu Text command, selecting a location on the page, then selecting the Symbols button to specify the graph, placement of symbols, and legend style to use for the legend. Line Graph A plot type in which data points are connected by lines. Line graphs and trajectory graphs are 2D Cartesian graphs or 3D Cartesian graphs using a line plot type. Use the Graph Wizard – Modify Plot dialog box to change a plot type and style. See also Scatter Plot and Plot Type. Linear Curve Fit or Linear Regression A linear regression of plotted data performed to a specified order. SigmaPlot can calculate 1st to 10th order regressions, and save the coefficients and R values to the worksheet. Use the Statistics menu Regressions command to perform regressions. See also Confidence Interval and Regression. Linear Axis Scale An axis scale in which values along the axis increment arithmetically. Link Use the Edit menu Paste Special command to place a linked object on the graph page. Linking the object appears to place a copy of the object on the page, but actually only places a reference to the original object file, and modifies the object every time the original file is changed. Logarithmic Scale See Common Log and Natural Log. Logit Scale An axis scale based on the logit equation



y Logit = ln  ----------------- 100 – y Menu Bar A list of menus appearing at the top of the SigmaPlot screen. These menus can be selected with a mouse, or by pressing Alt and the first letter of the menu name. When one menu appears, the adjacent menu can be pulled down by pressing → or ←. Mesh Plot A mesh plot is a 3D Cartesian plot of an even XY grid from XYZ data points, generating a surface. The worksheet data for mesh plots must be in a specific order to create the mesh. Mesh data can be generated from scatter data using inverse distance interpolation. See also “Inverse Distance Interpolation”. Metafile A standard Windows graphic file format, also known as a Windows picture file. Metafiles are a vector, or line-based file format, as opposed to a bitmap format. Metafile graphics are printed at the highest resolution a printer is capable of, no matter what size they are scaled to.
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 Glossary Natural Log Scale An axis type that plots data along a logarithmic scale using base e. Normalize Ternary Data Raw data must be converted to unitary data (0-1) or percentage data (0-100) in order to be plotted on a ternary graph. The Transforms menu Normalize Ternary Data command does this conversion for you. Notebook File SigmaPlot notebook files are files that contain worksheets, graph pages, reports, and regression equations. Notebook files are provided as a means for automatic file organization, enabling you to keep separate notebooks for separate groups of data. Novice Prompting Messages alerting you to certain situations or which double check some choices (for example, telling you that data contains missing values or asking for confirmation before clearing data). Novice prompting can be disabled using the Tools menu Options command. OLE2 Objects pasted from the Clipboard to a graph page can be linked, embedded, or placed on the page as a generic object without any kind of file reference. Linked and embedded objects use OLE2, Object Linking and Embedding version 2. Open Load a file into SigmaPlot, either a .JNB (notebook) file,.JNT (template notebook) file, or any other file format supported by SigmaPlot. Options Settings used to customize SigmaPlot behavior and to set program defaults. Use the Tools menu Options command to access the Options dialog box. Orientation (page) Describes the orientation of a page. Page orientation can be either portrait (right-side up) or landscape (sideways). Page orientation is controlled using the File menu Page Setup command or Printer Properties options in the Print dialog box. See also Portrait and Landscape. Orientation (text) Describes the rotation of a text label around an axis so the text reads left to right, top to bottom, or bottom to top. The orientation is entered as the number of degrees the label is to be rotated from the left-to-right. Also called rotation. Origin Axes For 3D Cartesian graphs, the axes intersecting at the X,Y, and Z coordinates closest to zero. The origin axes are used as a point of reference when rotating the view of a 3D graph, and appear as red lines in the 3D View panel of the Graph Properties dialog box. See also Rotation (3D Graph). Overwrite A data or text entry mode in which newly typed characters replace characters already on the screen. See Insert. Page (graph) A SigmaPlot item where graphs, labels, and graphic objects are drawn. The page displays the current graph(s) and other objects as they appear when printed.
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 Glossary You can use Tools menu drawing commands and the Edit menu and Format menu commands to directly edit, move, resize, delete, and paste graphs and objects on the page. Paste Place the contents of the Clipboard at the selected location. On the worksheet, the upper left corner of the Clipboard data block appears at the highlighted cell. On the Page, the Clipboard contents are offset from the original object’s position. Press the Ctrl+V, Shift+Ins, click the Paste toolbar button, or choose the Edit menu Paste command to paste data or graphics. Paste Special Place the contents of the Clipboard as an object of specified file type, as an embedded object, or as a linked file object. Percentage Scale A scale ranging from 0-100 as the absolute minimum and maximum, used for ternary graphs. Perspective A 3D graph view option, controlling the apparent “depth” of the graph. Use the Rotation settings of the 3D View panel in the Graph Properties dialog box to change a 3D graph's perspective. Pie Chart A graph where each data point in a column is represented as a pie slice equivalent to its percentage of the total. Plane See Backplane. Plot The graphed results of paired sets of data columns. 2D and 3D Cartesian plots can contain multiple curves, and 2D and 3D Cartesian graphs can contain multiple plots. Plots are created when you create a graph using the Graph menu Create Graph command, or added to an existing graph using the Graph menu Add Plot command. Each plot is also associated with a set axes. All curves in a plot must use the same plot type. See also Axis, Curve, Graph, and Plot Type. Note that 2D Cartesian, 3D Cartesian, polar, ternary, and pie charts are considered different coordinate systems. See also Cartesian, Polar Plot, Ternary Plot, Pie Chart, and Coordinate System. Point (pt) A unit of measure used in typesetting. Seventy-two points equal one inch. Pointer The tool controlled by the mouse used to choose commands, select dialog box options, select data on the worksheet, and select and modify page objects. Sometimes called the cursor. The pointer is usually arrow shaped. On the page, the shape of the pointer changes according to its current function. Polar Plot Polar plots show data in an r = f ( θ ) format where r is the distance from the origin of the graph, and theta (θ) is the angle described by a line passing 489



 Glossary through the center of the graph and the plotted data point, and another line passing through the center of the graph horizontally on the page. Portrait Orientation of the page so that the height is greater than the width. Page orientation is controlled using the File menu Page Setup command or Printer Properties options in the Print dialog box. See also Landscape and Orientation. Position Defines the position of a graph on a page. Graph position is displayed in the Size and Position panel of the Object Properties dialog box, accessed by rightclicking a selected graph, and choosing Properties from the popdown menu. You can also use the Format menu Size and Position command to center and align selected graphs and objects with respect to the page. Preferences See Options. Probability Scale An axis scale in which a sigmoidally shaped curve identical to the Gaussian cumulative distribution function appears as a straight line. Probit Scale An axis scale identical to the probability scale, except that it is expressed in terms of standard normal deviates increased by five. A probability of 0.5 (50%) corresponds to 0 standard normal deviates, or five probits. One standard normal deviate on either side of zero encompasses 68.2% of the area under the normal curve. A probit of 6 (1+5) corresponds to the 84.1% probability and a probit of 4 (-1+5) corresponds to the 15.9% probability (68.2% = 84.1% 15.9%). Quality Control Lines See Reference Lines. R Value The correlation coefficient, or square root of R2. R2 is sometimes called the coefficient of determination and is a measure of the closeness of fit of a scatter graph to its regression line where R2 = 1 is a perfect fit. SigmaPlot calculates R when performing all regressions. See also Correlation Coefficient and Regression. Radial Axes The radial axes of a polar plot are drawn along the radius of the graph, and by default are displayed as four axes extending from the center of the graph to the outer edge of the graph. Reference Lines Horizontal or vertical lines on a Cartesian graph drawn at specific values. The value can be computed as either the mean of the data, a specified multiple of a specific statistic above or below the mean, or a specific number. The statistics available are standard deviation, standard error of the mean, and 95% or 99% confidence intervals. Regression Regression is most often used by scientists and engineers to visualize and plot the curve that best describes the shape and behavior of their data. Regression procedures find an association between independent and dependent variables that, when graphed on a Cartesian coordinate system, produces a straight line, plane or curve. This is also commonly known as curve fitting. 490



 Glossary SigmaPlot uses a least squares method to curve fit your data. Choose the Statistics menu Regression Wizard command to pick an equation and run the curve fitter. You can also define any equation using the SigmaPlot transform language. See also Transform. Regression Coefficients The coefficients a0,...,a10 calculated for polynomial (linear) regressions. SigmaPlot can save these regression coefficients to the worksheet. See Regression. Regression Equation (Library Notebook) A notebook file which stores sets of regression equations, which can be viewed, browsed, open and run by the Regression Wizard. Regression Order The exponent of x in the polynomial regression y = a0 + a1x + a2x2 +...+ a10x10. SigmaPlot can calculate up to 10th order regressions. See also Regression. Regression Wizard A graphical wizard interface used to guide you trough nonlinear regression (curve fitting) procedures. See Regression. Report A text document that supports text and paragraph formatting and object pasting. Reports are saved to notebooks. Reports are also produced by running the Regression Wizard. Rich Text Format (RTF) A text file format that supports complex text and paragraph attribute formatting. The SigmaPlot report is stored in RTF. Rotation (3D Graph) The vertical and horizontal angles of rotation for a 3D Cartesian graph. These indicate the number of degrees the origin axes are from the absolute 0,0,0 origin. Use the Rotation settings in the 3D View panel of the Graph Properties dialog box to change the rotation of a 3D graph. See also Origin Axes. Rotation (Text) See Orientation (Text). Scatter Plots A plot type where a symbol represents each data point. Scatter plots are 2D or 3D Cartesian graphs using a scatter plot type. Select the plot, then use the Graph Wizard – Modify Plot dialog box to change a plot to a scatter plot. See also Line Graph and Plot Type. Scheme Symbols, lines, colors, and fill patterns can be sequenced by using schemes. Schemes can be customized by right-clicking the property options list, then selecting First from the popdown menu to specify the order of the sequence. Schemes can also be created by entering graphic cell codes into a worksheet column. Scientific Notation A form for expressing numbers using the letter e to represent 1 the power of 10. For example, the scientific notation for 10.0 is 1 × 10 .
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 Glossary Scroll Box A dialog box option containing a list of items. You can scroll up or down to reveal more selections. Selected scroll boxes have a scroll bar appearing along the right side. You can use the mouse to drag the scroll bar up or down, or click the up and down arrow buttons. Section Sections are a subdivision of the notebook file which is a compound file used to save all data and graphs in SigmaPlot. Notebook sections are individual “folders” that contain notebook items. Notebook items are worksheets and graph pages you have created using SigmaPlot. Each notebook section may contain only one worksheet, but can contain unlimited pages. Within sections, notebook items are indicated as worksheets or graph pages by icons that appear next to item names. Select (object) To choose an object on the page in order to perform an operation (such as move or delete) on it. Graphs, axes, text labels, and drawn objects can be selected. Items can only be selected when the Tools menu Select Object command is checked. To select an object, click while the pointer is over the object. Selected objects are surrounded by square handles or a dotted line. You can select multiple objects by dragging a dotted-line box completely around the objects, or by holding down the Shift key while selecting individual objects. Series Labels Tick labels that are automatically incremented in time units (days, months, or years), or in an alphabetic or numeric sequence. Series tick labels are selected using the Tick Labels settings of the Axes panel in the Graph Properties dialog box. Sort To arrange items in an ascending or descending order. Selected blocks of worksheet data can be sorted using the Transforms menu Sort Selection command. If you sort more than one column, all columns are sorted according to the selected key column. Spline Curve A smooth curve passing through all the data points of a scatter graph. SigmaPlot uses a cubic spline interpolation to generate the curve. Use the Plot menu Lines/Options command to change a line to a spline shape. Stacked Bar Chart A bar chart plot type where each bar is divided to represent each category. SigmaPlot plots each row in the selected columns as a stack in a bar. Standard Deviation (Std Dev) A measure of the spread of the data about the mean. The sample standard deviation is the square root of the ratio of the sum of
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 Glossary the squares of the residuals divided by degrees of freedom (the number of data points, minus one). n



s =



1 ----------n–1



∑ ( xi – x )2 i=1



Standard Error (of the Mean) The standard deviation of the mean, computed by dividing the sample standard deviation by the square root of the sample size.



s Std Err = ------n Swap File Windows makes use of virtual memory swapping temporary buffers and information to a swap file specified in the Virtual Memory settings in the Control Panel. You can use a swap file to optimize the performance of SigmaPlot on your system. Symbol The figure (such as a circle or triangle) used to represent a data point in a line or scatter plot. Plot symbols are modified using the Symbols settings of the Plots panel in the Graph Properties dialog box. Template All of the settings for a page except for the data. Use templates to create complicated sets graphs from existing pages. SigmaPlot includes a template notebook file containing several page templates you can use to create new pages with specific attributes. You can also create your own page templates and save them in a Template Notebook file (*.JNT), or use a graph page as a template by copying it into a different section. The SigmaPlot Notebook Template file, TEMPLATE.JNT, is located in the program directory. Use the File menu New command to create pages from these templates. Ternary Plot A graph that plots the proportions of three values on using three axes. The proportion that each value is equal to its percentage of the whole, and coordinates for each data point on the graph add up to 100%. t-Test A statistical test used to determine if there is a difference between the means of two samples. Also called Student's t-test. Use the Statistics menu t-test and Paired t-test commands to perform a t-test for two worksheet columns. Text Box A dialog box option used to enter text information, such as file names or values.
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 Glossary Text File A “plain text” file format widely used by word processing, desktop publishing, and spreadsheet programs. SigmaPlot can import and export text files. Tick Labels Labels (usually numeric) which appear next to axis tick marks, indicating the value of each tick. Alphabetic characters can be added as prefixes or suffixes to the numbers. You can also use date and time, category, or series labels. Choose the Tick Labels settings of the Axes panel in the Graph Properties dialog box to modify tick labels. See also Axis Range. Tick Marks Marks along an axis indicating the precise location of each value at specific intervals. Major tick mark intervals are determined by the axis range. Minor tick marks create a specified number of intervals between major tick marks. Tick mark intervals are also used as grid line intervals. See also Axis Range and Grid. Use the Ticks settings of the Axes panel in the Graph Properties dialog box to specify major and minor tick intervals. Tick Origin The value used to compute the starting tick mark locations along an axis (usually zero). The actual starting value is determined by the range and major tick increment. If the origin is less than the beginning of the axis range, the tick increment is added to the tick origin until the axis range is reached. The tick origin is specified in the Ticks settings of the Axes panel in the Graph Properties dialog box. See also Axis Range. TIFF Tagged Image Format File. This is one of the most common bitmap graphic formats used by both PCs and Macintoshes, and is the native file format for many graphic programs, such as Adobe Photoshop. See also Bitmap. Toolbar Toolbars are floating palettes containing buttons to execute many common File, Edit, View, Format, Tools, and Graph menu commands and to select a graph type and style with a single click. These include selecting text, line, box, and ellipse drawing modes, inserting legends, grouping objects, and moving objects to the front or back of the page. You can view the function of a toolbar button using Tool Tips. Move the mouse pointer over the button, and leave it there for a moment without clicking to view the Tool Tip. Transform A mathematical equation that generates data, either by performing calculations on columns of data in the worksheet, or by producing series of random or automatically incremented numbers. Transforms are created using the Transforms menu User-defined Transform command. See the Programming Guide for a complete description of transform functions.
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 Glossary Transparent Meshes Turning a 3D mesh plot transparent enables you to more clearly show the intersections between two or more 3D meshes. You must have a High Color (10 bit) or True Color (24 bit) video card for this feature to work properly. You may check your system’s color capabilities under the Windows Display Properties Settings. Transpose Paste Switches the orientation of worksheet data so that columns become rows and rows become columns. Use the Edit menu Transpose Paste command to paste Clipboard data with rows and columns transposed. Unitary Scale An axis scale with an absolute range of 0-1, used by ternary plots. Whiskers Indicate the 10th and 90th percentiles of a box plot. Whisker cap width can be modified and color can also be applied to whiskers. Error bars are sometimes referred to as whiskers. Worksheet Worksheets are the containers for the data you analyze and graph. They are spreadsheet-like in appearance but are much more limited in function, and are column rather than cell oriented. A worksheet opens automatically every time a SigmaPlot notebook is open. You can also open a worksheet any time you are using SigmaPlot. You can enter worksheet data manually, import it, or, in some cases, data is automatically placed in worksheet columns by SigmaPlot. Some functions are available for displaying and manipulating worksheet data. Zoom Enlarge or shrink the view of the current page. Click the toolbar zoom button, then click and drag to specify an area of the page to zoom, use the dropdown list in the toolbar to use pre-set zoom levels, or choose the View menu Zoom command to change the zoom level. You can view a page at 50%, 100%, 200%, 400%, full screen, or fit the page in the current window.
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 Notes



0



 Index . 161 .ASC files opening 44 .CVS files opening 44 .DBF files opening 44 .DIF files opening 44 .EPS files creating 448–449 producing files for publication 357 .HPGL files creating 448–449 importing 449 .INI file editing 459–467 .JNB files exporting as non-notebook files 46–48 saving 46 .JNT files creating 493 defined 11 saving 493 .MOC files opening 44 .PRN files opening 44 .SMB files importing 59 .SP5 files opening 44 .SPG files opening 44 .SPW files opening 44 .TIFF files post-processing 358 producing files for publication 357 .TXT files opening 44 .WK* files opening 44



10th/90th percentiles



box plots 267 2D graphs adding plots 198 Area plots 238 area plots 269–279 arranging data 240, 242 asymmetric error bar plots 242 asymmetric error bars 249 bar charts 239 bi-directional asymmetric error bars 251 box plots 239, 268 column averaged error bar plots 242 creating 243, 244 creating multiple axes for single plot 285 creating plots with asymmetric error bars 249 creating plots with bi-directional asymmetric error bars 251 creating plots with error bars 248 error bars 245 examples 23–27 grouped bar charts 261, 262 grouped bar charts with error bars 261 line/scatter 491 linear regression lines 407–410 modifying plots 407–414 multiple axes 285 multiple plots 198 plotting data 238, 240, 242, 266 plotting multiple curves 241 plotting mutiple curves, same X or Y 241 plotting X or Y using row numbers 242 polar axes 333 quartile plots plots 250 range plots plots 248 reference lines 268 same X or Y for multiple curves 240 single curve plots 240 3D bar charts data format 167 fills 219 3D function generating mesh data 306 3D graphs adding plots 198 axes placement during rotation 303
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 Index bar chart data format 167 bar charts 289 changing view 299 creating 293, 294, 295, 296 creating mesh 298 data format 167 examples 28–30 generating mesh data 11 light source 303 lighting 303 line data format 167 mesh 288 mesh data format 167 mesh lines/fills 299 mesh plots 298 modifying 287–306 modifying mesh lines and fill color 298 multiple plots 198 origin axes 300 perspective 303 plotting data 287, 293 positioning axes 303 rotation 303 scatter 491 Scatter and line 288 scatter data format 166 smoothing mesh data 11 trajectory 294 waterfall plots 289, 295 3D mesh plots data format 167 3D plots see 3D graphs 3D scatter plots adding drop lines 226–227 data format 166 lines 216 symbols 204–213



A Accessing SigmaPlot user information 33 Adding axes 285 axis breaks 374–375 contour fills 310 contour labels 313–316 exploding slices to pie charts 320–322 frame lines 304 graphs to pages 102–103 labels to page 143–146 multiple axes for single plot 285 new plots 198
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plots to graphs 197–198 prefix/suffix to tick labels 392 reference lines 268 sections to notebook files 41 styles to Graph Style Gallery 184 suffixes/prefixes 314 text to page 143–146 worksheets to notebook files 41 Aligning axis titles 377 legends 153 objects/graphs/labels 12, 135–136 snap-to grids 137 text 143 using crosshairs 137 using snap-to 137 with grids 136 with rulers 136 Alphanumeric symbols 208 Angular axes about 326 arc 327–329 defined 479 modifying 333 range 327–329 rotation 327–329 scale 327–329 Angular values 323 Apex dragging to modify ternary axis ranges 340 Applying data transforms 12 graph page layouts 137 graph styles using the Graph Style Gallery 183 templates 42 Arc, axis angular 327–329 Area plot creating vertical area plots 271 Area plot data formats multiple area plot 173 multiple vertical area plot 173 simple area plot 173 vertical area plot 173 Area plots 269–279 changing area fill direction 277 changing fill color 278 converting multiple into complex 276 creating multiple and multiple vertical area plots 273 creating simple straight line area plots 271 examples 238 identifying regions 276 Arithmetic mean see mean



 Index Arranging data for 2D graphs 240, 242 data for 3D graphs 293 data for a single curve 240 data for bubble plots 279 data for contour plots 293 data for polar plots 323–324 graphs 137–142 radial and angular values for polar plots 323 XY data for polar plots 323 Arrhenius scale 369 Arrow keys moving graphs and objects using 134 Arrows drawing 125 modifying arrow heads 130 ASCII files defined 479 see text files Aspect ratio defined 479 Options 97 Asymmetric error bar plots 242 Asymmetric error bars creating 2D plots with 249 Asymmetrical error bars quartile plots 250 Attributes 108 changing line 372–373 text formatting 146–147 Author information Options 20 AUTOEXEC.BAT defined 479 automatic legend updating 153 Automatic legends 11 displaying 151, 153 editing 151 locking 153 Options 19 restoring to default settings 152 see also legends Available statistics 63 Averaging see mean Axes 370 displaying 370 hiding 370 modifying 370 Axis 3D placement during rotation 303 about 283 adding 285 additional for multiple plots 283



angular 333 breaks 11, 374–375 category scale 364 changing range 363 changing scale 365 changing scale types 366–369 common log 363 contour range values 312 creating multiple for single plot 285 Date/Time 365 defined 479 dragging to modify ternary ranges 340 Extreme Value Distribution axis scale 369 labels 377 labels, defined 479 line attributes 372–373 linear 363 linear scale 363, 487 logarithmic scale 363, 487, 488 logit scale 364, 487 modifying 303 modifying range by dragging 340 moving 2D 372 multiple 11 multiple pairs 285 natural log 363 natural log scale 363, 488 origin axes 300, 488 pair, defined 480 placement, defined 480 polar 333 positioning 3D 303 positioning using Graph Properties dialog 371 probability scale 363, 490 probit scale 364, 490 radial 333 radial tick labels 333 range values 362 range, changing 362 range, defined 480 scale types 363, 365, 366–369 scale values 392 scale, category 366 scale, custom 369 tick labels 392 tick marks 349, 387 titles 377, 479 turning on/off 370 using drawing tools, using formatting commands 12 using Object Properties dialog 373 X and Y 11 Axis breaks creating 374–375 defined 479
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 Index Axis scale Arrhenius 369 Extreme Value Distribution 369 types 363–365 Axis titles editing 375 hiding 376–377 moving 377 rotating 376 viewing 376–377 Axis, range contour plots 311–312 Axis, scale switching to category 366 switching to custom 369 Axon files importing 62



B Back planes color 397 defined 480 grid lines 399 Background colors modifying 219 Backup files Options 19 Bad points defined 480 Bar charts automatic reference lines 412 bar widths 224 creating 243, 244 defined 480 edges 127 error bars 258 examples 239 fills 127, 219 grouped bars with error bars 263 histograms 403–407 horizontal data format 166 needle 403 needle plot 224 spacing bars 223–225, 263 stacked 492 step 403 vertical data format 166 Bar charts, 3D creating 293, 294, 295, 296 examples 289 Bar widths variable 224 Bars
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edges 127 fills 127, 219 spacing 223–225, 263 stacked 492 widths 224 Base



using as tick labels 315, 390 Base and exponent defined 480 Bi-directional asymmetric error bars creating 2D plots with 251 Bidirectional error bars data format 169 Blocks defined 481 Blocks, data deleting 80–81 inserting 78–80 sorting 77 Body Log Axis Scale 363 Box plots 10th/90th percentiles 267 box fills/color 267 box widths 267 creating 243, 244 data format 166 defined 481 edges 127 examples 239 fills 127, 219 mean lines 267 modifying 268 outliers 267 symbols 204–213, 267 whisker cap widths 267 Boxes drawing 125 edges 127 fills 127, 219 Breaking links 121 Breaks see axis breaks Bubble plots 204 2D 283 applications 279 arranging data 279 arranging data for size 280 converting area data to diameters 280 plotting data 279 transforms dialog 280 X, Y values 280 Bucket values



 Index histograms 405



C Calculating confidence intervals 410–412 error bar mean 258 error bars 258 linear regressions 410–412 prediction intervals 410–412 Cap width see Error bars Cartesian defined 481 Category axis scale 364 Category data using to create plots 252 Category scale creating 366 defined 481 modifying 367 Cells defined 481 moving to 56 using as column or row titles 87 Centering axis titles 377 Changing 3D graph view 299 area plot fill color 278 axis color 373 axis range 362, 363 axis scale 365 axis scale types 366–369 axis thickness 373 bar/box fills 127 color of fill pattern lines and edge lines 128 colors 217 column width 66–68 contour labels 313–316 contour plots 308–316 contour range values 311–312 default layout template file 141 fill patterns 127 fills 217 grids 396 inserted object icons 119 line end attributes 130 line types 129, 213 multiple selected objects 131 object background fills 127 objects fills 127 page color 157–158 pasted object icons 118



pattern and edge line thickness 128 pattern density of plot fills 218 patterns 217 pie charts 322 polar plots 325–326 radial axes 330–333 radial axes tick labels 333 range direction 344 scale direction 344 slice fills 127 source files for links 121 symbol fills 127 ternary axis direction 344 ternary graphs 338 ternary range 344 ternary scale type 342–343 text formatting 146–147 tick label text 389 tick values 392 units of measurement 156–157 see also Modifying Chapters outline 33 Characters non-keyboard 145 using as symbols 208 Chart fills color incrementing 218 Charts creating pie charts 318–319 Cholesky decomposition 411 Clearing graph titles 125 graphs/objects 125 legends 125 see also deleting Clipboard 78 cutting and copying data 74, 78, 111 defined 481 placing contents 482 using 111 Codes assigning to worksheet 451–457 defined 481 fill pattern codes 456–457 line type codes 456 symbol codes 454–456 Coefficients defined 481 regression 491 Color 219 assigning to worksheet 220 axis lines 372–373 bars 219
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 Index box plots 219, 267 changing 217 contour fills 310 contour lines 310 custom incrementing schemes 220–222 custom, using 158–161 error bars 253 frame lines 304 graph back planes 397 grids 397 incrementing chart fills 218 line 128 lines 214 mesh lines/fills 299 page 157–158 radial axes 332 reference lines 414 tick marks 349, 385 Color incrementing customizing 220–225 symbols 206 Column averaging defined 481 grouped bar chart 263 Column picker dialog normalizing ternary data 336 Column picker dialog box Graph Wizard 195 Column statistics defined 482 maximum value 64 minimum positive value 64 minimum value 64 missing values 65 other values 65 printing 49 setting Options 18–21 size of sample 64 standard deviation 64 standard error 64 sum of sample 64 viewing 12, 63 Column width changing 66–68 Columns asymmetric error bar plots 242 averaging 63 column and row titles dialog box 85 column averaged error bar plots 242 defined 481 deleting 80–81 inserting empty 78–80 inserting graphic cells 220 inserting symbol size values 210
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key 77 multiple Z 289 picking different data for current plot 195 plotting multiple curves, same X or Y 241 plotting X or Y using row numbers 242 plotting XYZ 293 same X or Y for multiple curves 240 selecting 76 Sizing 66 sizing 74 sorting data 77 statistics 63 switching from rows to columns 81 tick labels 316, 394 titles 85–88 type labels 394 using as row titles 86 Commands embedded graphs 187 Common log axis scale 363 Common logarithmic axis scale 363 defined 482 Compression formats post-processing .TIFF files 358 Computing see calculating Confidence intervals adding to 2D graphs 409–410 calculating 410–412 linear regressions 409–410 Confidence lines 95% and 99% confidence interval 64 defined 411–412, 482 CONFIG.SYS file defined 482 Configuring printer settings 50 Contour fills color 310 modifying 311 Contour labels changing frequency 314 numeric 315–316 rotating 314 skipping 395 suffixes/prefixes 314 text attributes 315 turning on/off 314 Contour lines color 310 line types 310 modifying 309–310 showing/hiding 309 thickness 310



 Index Contour plots adding fills 310 adding labels 313–316 creating 306 data format 166 defined 482 editing contour labels 315 example 27 frequency of contour labels 314 line types 310 modifying 308–316 modifying contour lines 309–310 modifying fills 311 modifying labels 313–316 modifying Z data range/scale 311–312 plotting data 290–293, 306, 307 sample graph 27 setting line intervals 312 setting the direction of fills 310 X,Y,Z values 290 Conventions manual 33 Converting area data to diameters for bubble plots 280 numeric and date and time data



Date and time data converting to numeric 73 Coordinate system defined 482 Copy and Paste 61 Copy shortcut 56 Copying data 78 defined 482 graphs 103 notebook items between notebooks 45 objects/graphs 111 Correlation coefficient (R) defined 482 Creating additional axes for multiple plots 283 additional plots 197–198 axis breaks 374–375 category scale 366 contour plots 306, 307 custom graph page layout 140 custom scale 369 embedded graphs 186 EPS files 449 equations to plot 228 Excel worksheets 41 files for figure submission 357 filled contour plots 307



graphs 163–194 graphs using Excel worksheets 92 graphs using SPSS 188 graphs using the Graph Style Gallery 182–184 graphs with Graph Toolbar 177 graphs with Graph Wizard 177 graphs with Graph Wizardr 177 histograms 403–407 JNT files 493 labels 143–148 legends 143–148 multiple area plots 273 multiple axes for single plot 285 multiple curves 241 new equations 42 new graph for current page 102 new graph pages 42 new object to insert 119 new reports 42 page templates 108–123 pie charts 318–319 plots using category data 252 plots with date and time scale 368 polar plots 325 reports 429 sections 41 simple straight line area plots 271 single curve plots 240 ternary graphs 336–337 text labels, legends 143 vertical area plots 271 worksheets 41 Crosshairs 137 Cubic spline interpolation defined 482 Curves asymmetric error bar plots 242 column averaged error bar plots 242 defined 483 multiple for polar plots 324 multiple in graph 244 multiple, same X or Y 241 plotting multiple 241, 244 plotting X or Y using row numbers 242 same X or Y for multiple curves 240 single 240 spline curve 492 Custom color 158–161 right-clicking 161 Custom scale creating 369 Custom tick mark intervals 385 Customer Service 32 Customizing
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 Index color increments 220–225 error bar directions 257 fill increments 220–225 fill sequences in worksheet 451–457 line increments 220–225 line sequences in worksheet 451–457 symbol increments 220–225 symbol sequences in worksheet 451–457 tick labels 316, 394 tick mark intervals 387 customizing graph styles 182–184 Cut shortcut 56 Cutting data 78 defined 483 notebook items between notebooks 45 objects/graphs 111



D Data
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2D graphs 238, 240, 266 3D graphs 287 applying transforms 12 arranging for 2D graphs 240, 242 arranging for 3D graphs 293 arranging for bubble plots 279 arranging for contour plots 293 arranging for polar plots 323–324 column statistics 63 contour plots 293, 306, 307 converting bubble plot area 280 converting data to diameters for bubble plots 280 converting to mesh format 11 copying 78 cutting 78 deleting 78 entering 53–94 exporting 62, 484 generating mesh 306 generating random data 417 Graph Properties dialog 201 highlighting outliers 83 importing 58–61, 81, 486 inserting 58 long form mesh format 290 mesh, converting to 11 moving 78 multiple-curve plots (ternary triplets) 335 normalizing for ternary graphs 335–336 one column for multiple curves in polar plot 324 password protecting 355 pasting 78



pie charts 318–319 plotting additional 198 plotting different data for current plot 195 plotting portion of 201 plotting X or Y using row numbers 242 polar plots 323–324, 325 printing 49–50 radial and angular values 323 rearranging 81 regression 12 removing outlying data 81–84 sampling 201 saving 46 selecting 75–76 selecting for ternary graphs 337 single-curve plot (ternary triplets) 335 smoothing 11 smoothing 2D high-frequency data 421–425 smoothing 3D mesh data 425–428 sorting 77 ternary graphs 337 transposing 81 using transform language 417 viewing for embedded graphs 187, 188 viewing in embedded graphs 187 X,Y, many Z for contour and mesh plots 291 XY pairs 240 XY values for polar plots 323 Data brushing 81–84 Data feedback changing colors on worksheet 67 set colors on worksheet 67 Data format 3D graphs 166 box plots 166 contour plot 166 graph styles 167–177 graph types 165 horizontal bar chart 166 horizontal dot plot 170 line and scatter plot 166 line plot 166 long form mesh 290 multiple area plot 173 multiple horizontal step plot 171 multiple regressions 167 multiple scatter plot 167 multiple spline curves 170 multiple straight line 171 multiple vertical area plot 173 multiple vertical step plot 170, 171 pie chart 166 polar plot 166 scatter plot 165



 Index simple area plot 173 simple regression 167 simple scatter plot 167 simple spline curve 171 simple straight line 171 simple vertical plot 170 ternary graphs 166 vertical bar chart 166 vertical dot plot 170 verticle area plot 173 Data set defined 483 Date and Time Options 18 tick intervals 382 Date and Time axis scale tick labels 394 tick labels for contour plots 316 tick marks 382 Date and Time format Date delimiters 57 date delimiters 73 entering 57 regional settings 72 time delimiters 58 using with Excel 74 worksheet display 70–74 Date and time scales creating pltos with 368 Date delimiters Date and Time format 57 Date and Time formats 73 Date/Time axis scale 365 Decimal places setting in worksheets 67 Defaults setting graph 165 Degrees of freedom 402 Delete Cells... command shortcut 56 Delete shortcut 56 Deleting columns and rows 80–81 data 78 graph titles 125 legends 125 objects 125 plots 200 undoing delete 200 see also clearing Delimiter defined 483 Density changing pattern of plot fills 218



Design graphing references 34 principles of graphing 34 suggested reading 34 Digital pre-press preparing graphs 356 Direction customized error bars 257 error bars 254 reference lines 414 Display formats Date and Time format 70–74 numbers 68–69 Displaying automatic legends 152, 153 axes 370 contour fills 310 contour labels 313–316 contour lines 309 grid lines 399 outlying data 83 page margins 155 plots 200 reference lines 413 toolbars 15–17 Docking Graph Style Gallery 183 DOS shell, defined 483 Dot plot horizontal data format 170 vertical data format 170 Double-clicking opening Graph Properties dialog 192 dpi 359 Dragging 2D axes 371 defined 483 objects 131 radial axes 330 ternary axes 340 Drawing arrows 125 ellipses 125 lines 125 objects 12, 125 Page toolbar 125 Drop lines adding to plots 226–227 attributes 227 defined 483 for single point 227 modifying 226
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 Index



E E Notation Always display 68 E Notation When Needed display 68 Edge lines setting the color 128 setting thickness 128 Edges bar/box 127 defined 483 plot line thickness 218 slice 127 Edit menu commands Copy 78 Cut 78 Delete Cells... 78 Insert New Object 119 Paste 78 Transpose Paste 81 Edit text defined 483 Editing automatic legends 151 axis tick labels 387 axis titles 375, 377 contour labels 314, 315 embedded graphs 186, 187 graph titles 194 notebook items 43 notebook sections 43 object links 121 page format 154 pasted graphs in other applications using OLE2 112– 121 plot name 192–193 radial axes tick labels 332 SPW32.INI file 459–467 text 146–147 tick labels 389 editing 43 Ellipses drawing 125 Embedded graphs available menus and command 187 creating in SPSS 188 editing 186, 187 opening inside SigmaPlot 187 resizing 188 viewind data 187 viewing data 188 Embedding defined 483
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objects 113–122 Reports 113 Encapsulated PostScript see EPS files Entering column titles 85–88 data 53–94 equations 228 Greek symbols 145 labels 143–146 row titles 85–88 symbols in legends 146 text 143–148 EPS files 358 creating 448–449 defined 484 importing 449 Vector formatssee EPS files Equations confidence intervals 411–412 creating 42, 228 linear regression 410–411 manually entering 228 plotting 228–236 prediction intervals 412 setting parameters 229, 231 solving 233–236 solving guidelines 235–236 Error bars asymmetric 249 bi-directional asymmetric 251 bidirectional data format 169 calculating 258 cap width 253 color 253 creating 2D plots with 248 creating grouped bar charts with 261 custom directions 257 defined 484 direction 254, 484 generating 258 grouped bar charts 263 horizontal data format 169 line thickness 253 mean computation method 258 methods for generating 259 modifying 253 modifying appearance 253 multiple and regressions data format 169 multiple data format 168 plot types 245 quartile plots 250 range plots 248 relative direction 255



 Index simple and regression data format 168 simple data format 168 European address and phone number 32 Evaluating F at 234 mathematical expresions 233–236 Examples 2D graphs 23–27 3D graphs 28–30 contour plot 27 mesh plot 29 pie chart 23 polar plot 26 Excel worksheets creating graphs 92 limitations 91 new 41 opening 89 opening data files 90 regression 93 statistics 91 system requirements 13 toolbars 92 transforms 93 Unprotecting workbooks 89 using 88–94 using Date and Time format 74 using Excel Export commands 91 using Excel print commands 91 workbooks 12 Executing one-line functions 419 Exploding pie chart slices 320–322 defined 484 Exponents defined 484 numeric tick labels 315, 391 Exporting data 484 defined 484 Excel worksheets 91 into HTML 354 to Systat 63 worksheet data 49–50, 62, 484 worksheets as text files 62 Extreme Value Distribution scale 369



F Factor axis tick labels 391 File formats .HPGL 448 import Comma Delimited (.CSV) 59



import dBase (.DBF) 59 import DOS files 59 import Lotus 1-2-3 (WK*) 59 import Microsoft Excel (.XLS) 59 import Mocha Worksheets 59 import Plain Text (.TXT, .PRN,.DAT,.ASC) 59 import Quattro/DOS (.WK*) 59 import SigmaPlot 1.0 and 2.0 (.SPW) 58 import SigmaPlot Macintosh 4 and 5 Worksheet 58 import SigmaScan (.SPW) 59 import SigmaStat 1.0 (.SMB) 59 File menu commands Page Setup 155 File types 90 Files as objects to insert 119 breaking links between source and object 121 changing source for linked objects 121 embedding objects 113–122 EPS files 448–449 exporting as non-notebook files 46–48 HPGL 449 HPGL files 448–449 importing data from 58–61, 81 JNT files 493 linking objects 113–122 notebook templates 108–123 opening non-notebook 44 PostScript 449 printing to 448–449 saving 46 saving notebook 46 SPW32.INI 459–467 text 61–62 updating links 120 Fill color modifying 298 Filled contour plots creating 307 modifying 311 Fills area plots 277–279 bar chart 127 box plot 127 box plots 267 change color of pattern lines and edge lines 128 change object fill background color 127 change object fill pattern 127 changing 217 contour plots 311 custom incrementing schemes 220–222 defined 484 increment customizing 220–225 mesh plots 299



507



 Index modifying 219 object 127 pattern codes 456–457 pie chart 127 set pattern and edge line thickness 128 symbol 127 Film recorder defined 484 Fixed Decimal display 69 Fonts defined 484 Greek 145 PostScript 143, 449 printing tips 445–449 screen and printer 445 symbols 145 TrueType 143, 445–446 Format menu commands Align 135–136 line 128 Formats submitting graphs for publication 356 Formatting Date and Time tick labels 394 labels 12 text 146–147 Frame lines color 304 defined 484 line type 304 modifying 304 relative to origin 305 relative to viewer 305 Frequency contour labels 314 FrontPage inserting graphs 356 Functions one-line 419 solving 233–236



G Gaussian transform defined 484 Generating error bars 258 linear regression lines 407–410 mesh data 11 random data 417 Geometric mean defined 485 Global
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changing multiple page objects 131 Global text changes 147 Glossary 479–495 Go to... worksheet cell 56 Graph defined 485 Graph Defaults Setting 164 Graph defaults 11, 21 Options 165 setting 165 Graph dialogs Graph Properties 97 Graph Wizard 97 Graph page see page setting options 96–97 Graph page command creating files 448–449 printing to file 448–449 Graph pages creating 42 printing 50 selecting objects 98 Graph Properties dialog bar widths 224 customizing tick labels 395 data sampling 201 modifying graphs 189–190 modifying grids and planes 190 modifying tick appearance 378 modifying titles and legends 190 moving axes 371 pie charts 319 positioning 2D axes 371 radial axes 330 viewing/hiding axis 370 Graph Properties dialog box 100 modifying tick appearance 383 Graph style multiple straight lines 170 simple straight line 170 Graph style data format bidirectional error bars 169 Horizontal dot plot 170 horizontal point plot 169 hortizontal error bars 169 multiple area plot 173 multiple error bars 168 multiple error bars and regressions 169 multiple horizontal step plot 171 multiple regressions 167 multiple scatter plot 167



 Index multiple spline curves 170 multiple straight line 171 multiple vertical area plot 173 multiple vertical step plot 170 simple area plot 173 simple error bars 168 simple error bars and regression 168 simple horizontal step plot 171 simple regression 167 simple scatter plot 167 simple spline curve 170, 171 simple straight line 171 simple vertical step plot format 170 vertical area plot 173 vertical dot plot 170 vertical point plot 169 Graph Style Gallery adding styles 184 applying graph styles 183 creating graphs 182–184 define 182 docking 183 Graph styles 3D graph display 11 cubic spline interpolation 11 error bars 11 regression 11 selecting with Graph Wizard 11 graph styles using the Graph Style Gallery 182–184 Graph titles deleting 125 Graph Toolbar 177 Graph toolbars 2D, 3D 102 Graph type data format 3D bar chart 167 3D line plot 167 3D mesh plot 167 3D scatter plot 166 box plots 166 contour plot 166 horizontal bar chart 166 line and scatter plot 166 pie chart 166 polar plot 166 ternary 166 vertical bar chart 166 Graph types defined 485 Graph Wizard 177 additional axes 283



area plots 266, 271 bubble plots 282 changing graph type/style 195–196 creating 3D graphs 293, 296 creating mesh plots 297 multiple plots 283 selecting graph styles 11 Graphic file formats see file formats Graphs 2D example 23–27 3D example 28–30 adding drop lines 226–227 adding plots 197–198 adding to page 102–103 aligning 135–136 anatomy of 22–28 arranging 137–142 asymmetric error bar plots 242 automatic legends 148–153 axes 303 box plots 268 centering 135–136 column averaged error bar plots 242 contour plots 27, 317–338 copying 111 creating 163–194 cutting 111 data format for graph styles 167–177 data format for graph types 165 defaults, setting 165 displaying automatic legends 151, 153 editing in other applications using OLE2 112–121 grid lines 399 grouped bar charts 261, 262 grouping/ungrouping objects/text 135 hiding 123 hiding automatic legend 151, 153 hiding graph titles 124 hiding on page 123–124 hiding using shortcut menu 123 hiding/displaying plots 200 legends 143 line/scatter 487, 491 modifying 163–194 modifying 2D plots 407–414 modifying 3D plots 287–306 modifying type/style 195–196 modifying using Graph Properties dialog 189–190 moving 131–133 multiple curves, same X or Y 241 multiple plots 198 naming plots 192–193 pasting without data 115
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 Index picking different data for current plot 194–195 pie charts 23, 317–338, 484 plotting data 240, 242 plotting multiple curves 241 plotting X or Y using row numbers 242 polar plots 26, 317–338 references for design 34 resizing for publication 359 resizing labels/legends automatically 97 same X or Y for multiple curves 240 saving 46 scaling 131–133 scatter, 3D 290, 491 selecting 191–192 selecting style 167–177 selecting type 165 shortcuts to modify 192 single curve plots 240 sizing 131–133 stacked bar charts 492 styles 167–177, 485 symbols 204–213 ternary 317–338 titles 194 types 11, 165 types and styles 11 using Paste Special 112–115 viewing on page 123–124 working on pages 122, 127–131, 158–161 zooming in/out 103–104 Graphs, 2D see 2D graphs Graphs, 3D see 3D graphs Greek symbols 145 entering 145 Grids 399 aligning graphs and objects 136 color 397 defined 485 displaying in front/behind 399 graph back planes 399 hiding 399 line types 398 mesh graphs 11 modifying 303 snap-to 137 turning on/off 399 Grouped bar charts column averages 263 creating 261, 262 creating with error bars 261 error bars 263 examples 261
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spacing bars 223–225 Grouping objects/text 135 Guidelines equation solving 235–236



H Halftones printing 447 Halting 153 Hardware system requirements 13 Help system defined 485 using 32 Hiding automatic legends 151, 152, 153 axes 370 axis titles 376–377 contour lines 309 graph titles 124 graphs on page 123–124 graphs using shortcut menu 123 grid lines 399 legends 124 plots 200 plots using shortcut menu 200 radial axis labels 332 statistics 65 tick marks 376–377 toolbars 15–17 High-frequency data smoothing 421–425 Highlighting outliers 83 Histogram Wizard using 404–406 Histograms bucket values 405 creating 403–407 defined 486 histogram transform function 404 Histogram Wizard 403–407 HISTOGRM.XFM transform 406–407 Horizontal bar chart data format 166 Horizontal dot plot data format 170 Horizontal error bars data format 169 Horizontal point plot data format 169 Hot key



 Index defined 486



I Icons changing display for inserted objects 119 changing display for pasted objects 118 displaying inserted objects as 119 displaying pasted objects as 118 Identifying area plot intersections 276 Ignoring outliers 81–84 Important note flag used in manual 33 Importing 60 Axon files 62 data 486 data files 58–61, 81 defined 486 DIF files 60 EPS files 449 HPGL files 449 SigmaPlot files 60 SigmaScan files 60 SigmaStat files 60 SPSS files 59 text files 61–62 In 32 Inches page units 156–157 Incrementing lines 215 symbol color 206 Incrementing colors chart fills 218 Incrementing schemes customized 220–222 defined 491 Independent graph pages 45 Independent t-test 403 performing 402 Information using this manual 33 Insert Cells shortcut 56 Insert Date and Time command for reports 436 Insert Graphic Cells command 220 Insert New Object command 119 Inserting columns and rows 78–80 data 58 defined 486 displaying inserted objects as icons 119



graphs into FrontPage 356 linked objects 120 modifying inserted object icons 119 new object 119 objects from file 119 Insertion mode turning on/off 58 Installing SigmaPlot 12–13 serial numbers 13 Interpolating data setting mesh range values 427 Intersections idenitying in area plots 276 Intervals confidence/prediction 64, 409–410 setting for contour plots 312 tick mark values assigned to a worksheet 387 Inverse distance interpolation defined 486



J JNT files 137 Journals preparing graphs for publication 356–359



K Key column 77 Keyboard moving around worksheet 55 moving graphs and objects using arrow keys 134 Keystrokes functions 55



L Labels adding to page 143–146 aligning 12, 135–136 automatic scaling with graphs 97 axis titles 377, 479 axis values 392 column titles 85–88 column type 394 contour 313–316 creating 143–148 defined 486 editing tick 389 entering non-keyboard characters 145 formatting 12 frequency of contour 314 graph titles 194 grouping/ungrouping 135 numeric tick 315
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 Index radial axes 333 reference lines 414 rotating 145 rotating contour 314 row titles 85–88 size, defined 486 sizing 486 suffixes/prefixes 314 tick mark 392, 494 using column and row title dialog box 85 using for column titles 86 using for row titles 86 Landscape defined 486 page orientation 155 Layering in front/behind grid lines 399 reference lines 414 Layout graph design references 34 Layout templates defined 182 Legends adding symbols 146 adding to page 143–146 aligning 153 automatic 11, 19, 148–153 automatic scaling with graphs 97 creating 143, 143–148 defined 487 deleting 125 editing 151 locking 153 restoring to default settings 152 ungrouping 153 see also Automatic legends Light source 3D graphs 303 Line and scatter plot multiple straight line data format 171 simple straight line data format 171 Line and scatter plots adding drop lines 226–227 creating 243, 244 data format 166 examples 238 Line plot data formats multiple horizontal step plot 171 multiple spline curves 170 multiple vertical step plot 170 simple horizontal step plot 171 simple spline curve 170 vertical step plot 170 Line plots
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3D data format 167 adding drop lines 226–227 adding drop lines to 226–227 color 214 creating 243, 244 data format 166 examples 238 lines 216 midpoint step 214 multiple straight lines 170 step 214 straight 214 symbols 204–213 Line type frame lines 304 modifying 129 reference lines 414 Line/scatter graphs asymmetric error bars 249 bi-directional asymmetric error bars 251 defined 487, 491 error bars 245 lines 216 quartile plots 250 range plots 248 symbols 204–213 Linear axis scale 363, 390 defined 487 Linear Regression dialog defined 487 Linear regressions calculating 410–412 confidence/prediction intervals 409–410 defined 410–411, 487 generating 407–410 multiple curves 408 polynomial order 408 results 408 Lines adding arrow heads 130 assigning to worksheet 220 attributes 372–373 axis 372–373 changing end attributes 130 changing thickness 214 changing type 213 codes for custom sequences 456 color 214 contour 309–310 custom incrementing schemes 220–222 drawing 125 drop 226–227 error bars 253 frame 304



 Index grid 399 grid line types 398 increment customizing 220–225 incrementing 215 layering in front/behind symbols 214 line/scatter plots 216 linear regression 407–410 mesh plots 299 midpoint step plots 214 modifying 216 modifying properties 128 plot 216 radial axes 330–333 reference 268, 490 setting intervals for contour plots 312 smoothed 214 spline curves 214 step plots 214 type 214, 456 Linking defined 487 objects 113–122 Reports 113 Links breaking 121 changing source files 121 editing 121 manual/automatic updating 120 viewing object links 120–122 Locking legends 153 Logarithmic axis scale 363, 390 defined 487, 488 Logit axis scale 364 defined 487 LZW compression algorithm post-processing .TIFF files 358



M Magnifying page view 103 Major ticks Date and Time axis scale 382 Manual conventions 33 organization of 33 Maximum value (max) column statistics 64 Mean column statistics 63 error bar computation method 258 Mean computation method 258 Mean lines 267



box plots 267 Median lines 267 Menu bar defined 487 Menus using with embedded graphs 187 Mesh data converting 11 generating 11, 306 interpolating 11 Mesh lines modifying 298 Mesh plots 3D data format 167 creating 298 defined 487 example 29 examples 288 fills/color 299 light source 303 mesh data 11 mesh lines 299 modifying lines/fills 299 plotting data 290–293 smoothing data 11 transparent 297 X,Y,Z values 290 MESH.XFM file generating mesh data 306 Millimeters page units 156–157 Minimum positive value (min pos) column statistics 64 Minimum value (min) column statistics 64 Minor ticks Date and Time axes 382 modifying 382 Missing values column statistics 65 Mocha worksheets 60 Modifying 2D plots 407–414 3D graph view 299 3D plots 287–306 adding plots 197–198 angular axes 333 area plots 277–279 attributes for new pages 108 automatic legends 148–153 axes 303, 370 axis range 363 axis range by dragging 340 axis scale 365



513



 Index axis scale types 366–369 box fills/color 267 box plots 268 box widths 267 category scales 367 contour labels 313–316 contour lines 309–310 contour plots 308–316 drawn objects 127–131 drop lines 226–227 edges 218 embedded graphs 187 error bar appearance 253 error bar computation method 258 error bar direction 254 error bars 253 fill color 298 fills 219 frame lines 304 graph lighting 303 graph perspective 303 graph rotation 303 graph styles 195–196 graph titles 194 graph types 195–196 graphs 163–194 graphs using Graph Properties dialog 189–190 grid lines 303 grids 396 grids and planes 190 inserted object icons 119 line color 128 line end attributes 130 line thickness 129 line type 129 lines 216 mesh lines 298 mesh plots 299 multiple selected objects 131 multiple text labels 147 notebook items 38 object fills 127 object links 120–122 page color 157–158 page view 103–104 pasted object icon 118 patterns 219 pie charts 322 plot name 192–193 plot pattern line thickness 218 polar axes 333 polar plots 325–326 radial axes 333 radial axes arc 330–333
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radial axes tick labels 333 source files for links 121 symbol attributes 204 symbols 204–213 ternary axis direction 344 ternary plots 338 ternary tick labels 349 ternary tick marks 348 text formatting 146–147 tick labels 392 tick marks 303 titles and legends 190 whisker cap widths 267 modifying for new pages 108 Mouse moving objects 131 sizing objects 132 Moving 2D axes 372 2D axes manually 371 2D Axes with mouse 371 around the worksheet 55 axes to precise location 371 axes with Graph Properties dialog 371 axis titles 377 data 78 graphs 131–133 graphs and objects using arrow keys 134 notebook items between notebooks 45 objects 131–133 objects to back/front 134 radial axis 330–333 to worksheet cell 56 toolbars 17 Moving objects 131 Multiple area plots creating 273 Multiple axes creating 285 Multiple curves creating 244 plotting data 244 regression options 408 same X or Y for 240 Multiple error bars data format 168 Multiple error bars and regressions data format 169 Multiple plots 198 additional axes 283 Multiple regressions data format 167 Multiple scatter plot data format 167



 Index Multiple spline curve format 170 Multiple straight line data format 171 Multiple straight line plot 170 Multiple Z columns 289



N Naming graph pages 43 graphs 194 notebook files 43 notebook items 43 plots 192–193 sections 43 worksheets 43 Natural log axis scale 363 Natural log scale 363 defined 487, 488 Needle plot creating 224 New Excel worksheet 41 graphs with templates 105 pages with templates 105 sections 41 worksheets 41 New Features SigmaPlot 10 New features 10–11 Noisy data smoothing 421–425 Non-keyboard characters see text Non-notebook files exporting to original file format 46–48 opening 44 Normal using as source template for new pages 108 Notebook files adding new sections 41 adding new worksheets 41 defined 488 naming 43 opening 44 saving 46 template notebook files 108–123 viewing 44 Notebook items 43 cutting/copying between notebooks 45 exporting as non-notebook files 46–48 naming 43 opening 44



printing 49 printing selected notebook items 51 saving 46 viewing 44 Novice prompting defined 488 Options 18 Nudging graphs and objects 134 Numbers display formats 68–69 Options 18 Numeric axis values factoring out 391 Numeric data converting to date and time data 73 Numeric values changing contour labels 315–316 tick labels 315



O Object Properties dialog 96 axis attributes 373 specifying location 133 specifying size 133 Object Properties dialog box modifying line 128 Objects aligning 12, 135–136 breaking links 121 Change background color 127 change color of fill pattern lines and edge lines 128 Change fill patterns 127 changing source files for links 121 copying 111 cutting 111 displaying as icons 118, 119 Dragging 131 drawing 12, 125 editing linked 113–122 editing links 121 embedding 113–122 fills 127 grouping/ungrouping 135 inserting from file 119 inserting linked objects 120 inserting new 119 linking 113–122 modifying 127–131 modifying object links 120–122 mouse, using to size 132 moving 131–133 moving front/back 134
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 Index multiple selection 131 pasting as linked/embedded 118 pasting as specified file type 118 pasting to a page 112–122 positioning on a page 490 scaling 131–133 selecting on a page 98 set pattern and edge line thickness 128 sizing 131–133 updating links 120 using the Paste Special command 112–115 viewing object links 120–122 working on pages 122, 127–131, 158–161 OLE2 defined 488 embedding 112–121 linking 112–121 pasting graphs 112–121 One-line functions executing 419 Opening data files into Excel worksheets 90 defined 488 embedded graphs 187 Excel worksheets 89 new graph page 41 non-notebook files 44 notebook files 44 notebook items 44 worksheets 44 Options author information 20 automatic 97 automatic legends 19 backup files 19 Column statistics 65 column statistics 18–21 Date and Time 18 defined 488 graph defaults 165 graph pages 96–97 grid colors 97 grid density 97 grids 97 novice prompting 18 numbers 18 page 18–21 page undo 97 page units 96 setting program 96–97 show rulers 97 Snap-to 97 statistics 18 stretch maintains aspect ratio 97
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system 18 templates 20 worksheet 18–21 Orientation defined 488 Origin axes, defined 488 of tick marks 494 Origin axes 300 Other values column statistics 65 Outliers box plots 267 highlighting 83 removing 81–84 Output creating files 448–449 EPS files 449 HPGL files 449 PostScript files 449 Overwrite mode 58 defined 488



P Page



adding graphs 102–103 aligning objects/graphs 135–136 associating with worksheet 102 automatic legends 148–153 changing format 154 clearing graphs/objects 125 color 157–158 copying graphs 103 copying objects/graphs 111 creating graphs for current 102 creating new objects to insert 119 cutting objects/graphs 111 defined 488 deleting objects 125 editing format 154 embedding objects 113–122 exporting as non-notebook file 46–48 hiding graph titles 124 hiding graphs 123–124 hiding legends 124 inserting objects from files 119 legends 143–146 linking objects 113–122 magnifying 103 moving between notebooks 45 moving objects/graphs 131–133 naming 43 opening new 41



 Index orientation 486 paper size 155 pasting graphs 103 pasting graphs/objects 112–115 positioning graphs/objects on 490 selecting graphs 98 selecting objects 98 selecting text 98 setting grid color 97 setting grid density 97 setting Options 18–21 setting options 96–97 setting snap-to grids 97 setting units of measurement 96 setup 154 showing grids 97 showing rulers 97 sizing graphs and objects 131–133 specifying graph and object location 133 specifying graph and object size 133 starting new 41 templates 108–123 text and labels 143–146 units of measurement 156–157 viewing full 103 viewing graphs 123–124 working with graphs 122, 127–131, 158–161 working with objects 122, 127–131, 158–161 zooming in/out 103–104 Page objects selecting on a page 98 Page toolbar 125 Page undo Options 97 Pages creating 42 selecting objects 98 Paired t-test 402 defined 493 performing 402 Paper size 155 Parameters setting in equations 231 Password protecting data 355 Passwords protecting data on the Web 355 Paste shortcut 56 Paste Special command 112–115 defined 489 displaying pasted objects as icons 118 embedding objects 113–122 linking objects 113–122 modifying pasted object icons 118



pasting graphs without data 115 Pasting data 78 defined 489 graphs as metafiles 113 graphs to page 103 graphs/objects with the Paste Special command 112– 115 objects 112–115 transpose 81 see also Inserting Patterns assigning to worksheet 220 changing 217 changing color lines of fills and edges 128 changing density of plot fills 218 changing object fills 127 modifying 219 plot line thickness 218 set pattern and edge line thickness 128 setting thickness 128 Performing quick transforms 420 Perspective 3D graphs 303 defined 489 Photoshop post-processing .TIFF files 358 Picking data different columns to plot 195 different data for current plot 195 Pie charts 219 adding exploding slices 320–322 creating 318–319 data format 166 defined 489 example 23 examples 318 fills 127, 219 modifying 322 plotting data 318–319 rotating 320–322 sample graph 25 slice edges 127 slices 484 Planes defined 480 Plot fills pattern density 218 Plot styles multiple curves 244 Plot types error bars 245 Plots 306
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 Index about 283 adding new 198 contour 317–338 custom incrementing schemes 220–222 defined 489 deleting 200 displaying 200 dummy 285 hiding using shortcut menu 200 hiding/showing 200 layering lines in front/behind symbols 214 lines 216 multiple 198 multiple axes for single 285 naming 192–193 needle plot 224 offsetting radial axes 331 pattern line thickness 218 picking different data 195 pie charts 317–338 plotting portion of data 201 polar 317–338 polar axes 333 same X or Y for multiple curves 240 scatter defined 491 selecting 191–192 single curve 240 symbols 204–213 ternary 317–338 types 11 undo delete 200 Plots, 2D box plots 268 creating with asymmetric error bars 249 creating with bi-directional asymmetric error bars 251 creating with error bars 248 grouped bar charts 261, 262 line 238 line and scatter 238 linear regression lines 407–410 modifying 2D 407–414 multiple curves 244 reference lines 268 scatter 238 types available 238, 240, 266 Plots, 3D bar charts 289 mesh 288 modifying 287–306 scatter and line plots 288 types available 287 waterfall plots 289 Plotting equations onto existing graphs 230



518



saved equations 231–233 Plotting data 2D graphs 240, 242 3D graphs 293 additional data 198 asymmetric error bar plots 242 bubble plots 279 column averaged error bar plots 242 contour plots 293 multiple curves 241, 244 multiple curves, same X or Y 241 polar plots 323–324 portion of 201 scatter graphs, 3D 290 using row numbers for X or Y values 242 Plotting equations 228–236 Point defined 489 Point plot horizontal data format 169 vertical data format 169 Pointer defined 489 Points page units 156–157 Polar axes modifying 333 radial tick labels 333 Polar plots angular axes 327–329 arranging data 323–324 creating 325 data for multiple curves 324 data format 166 defined 489 example 26, 323 lines 216 modifying 325–326 offsetting radial axes 331 plotting data 323–324, 325 radial and angular values 323 radial axes 330–333 sample graph 26 symbols 204–213 using XY values 323 Polar plots, multiple curves data from one column 324 Polynomial order regression lines 408 Portrait page orientation 155 Portrait orientation defined 490 Positioning



 Index 2D axes 372 2D axes using Graph Properties dialog 371 3D axes 303 defined 490 graphs on page 490 objects/labels on page 490 toolbars 17 PostScript EPS files 449 fonts 449 printing files 449 printing fonts 446 Precise location moving axes to 371 Precision options 391 Prediction intervals adding to 2D graphs 409–410 calculating 410–412 defined 412 linear regressions 409–410 Prefixes contour labels 314 tick labels 392 Preparing graphs for publication 356–359 Printer drivers printing tips 445–449 Printer settings configuring 50 Printers fonts 445 Printing column statistics 49 Excel worksheets 91 graph pages 50 halftones 447 notebook items 49 PostScript files 449 PostScript fonts 446 reports 51 selected notebook items 51 setting options 49 tips 445–449 to graphic file formats 448–449 TrueType fonts 445–446 worksheet 49 worksheet data 49–50 Printing options setting 50 Probability axis scale 363 defined 490 Probit axis scale 364 defined 490 Producing



file for publication 357 Prompting novice 18 Properties modifying text 147 Publishing graphs in journals 356–359 journal submission requirements 356 on the World Wide Web 353



Q Quality control lines see reference lines Quartile plots 250 Quick transforms 420



R R value defined 490 Radial axes attributes 332 defined 490 lines 330–333 modifying 330–333 moving 330–333 offset from graph center 331 tick labels 333 turning on/off 330–333 Radial labels turning on/off 332 Radial values 323 Random data generating 417 Range Z data for contour plots 311–312 Range plots 248 Range, axis angular axis 327–329 axis values 312, 362 changing 363 defined 480 modifying 362 modifying by dragging 340 Rearranging data 81 Reference lines adding to 2D graphs 268 defined 490 direction 414 displaying 413 displaying in front/behind 414 labels 414 line attributes 414
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 Index line thickness 414 line type 414 lower specification 414 statistics 414 turning on/off 413 References graph design 34 Regional settings Date and Time format 72 Regression Wizard 12, 407 Regressions coefficients 491 defined 487, 490 fitting data 12 linear, defined 487 order 491 using data in Excel worksheets 93 Removing outliers 81–84 Report Editor 12 creating reports 429 formatting paragraphs 435 formatting text 435 formatting toolbar 435 ruler 432 setting paragraph indents 434 setting tabs 432 Report Options command 430 Report page defined 491 Reports creating 42, 429 embedding objects 113 inserting date and time 435 linking objects 113 printing 51 Report Editor 12 setting page size and margins 430 setting ruler units 430 Requirements submitting graphs for publication 356 Resize symbols 150 Resizing embedded graphs 188 graphs for publication 359 Restoring legends to default settings 152 Results linear regressions 408 t -test 402 Right-clicking custom color 161 hiding graphs 123
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hiding plots 200 selected graphs 192 selected graphs and objects 98 to create new sections 41 to create new worksheets 41 Rotating 3D graphs 303, 491 3D graphs axes placement 303 angular axis 327–329 axis titles 376 contour labels 314 labels 145 pie charts 320–322 text 145 Rows deleting 80–81 inserting empty 78–80 selecting 76 sizing 66, 74 titles 85–88 transposing 81 using as column titles 86, 87 Rulers aligning graphs and objects 136 Running quick transforms 420



S Sampling data 201 Saving data 46 graphs 46 JNT files 493 linear regression results 408 notebook files 46, 46 pages 46 t-test results 402 worksheets 46 Scale angular 327–329 axis 11 base/exponent labels 390 category 364, 366 changing 365 common log 363 custom 369 Date/time 365 Extreme Value Distribution 369 linear 363 logit 364 natural log 363 natural logarithmic 363



 Index probability 363 probit 364 tick labels 392 tick marks 349, 387 types 11, 365, 366–369 Scale type changing 366–369 Scale, axis base/exponent labels 315 category 481 contour plots 311–312 defined 480 linear 487 logit 487 natural log 488 natural logarithmic 487 probability 490 probit 490 Scales Arrhenius 369 using a date and time scale 368 Scaling aspect ratio 479 graphs 131–133 objects 131–133 resizing labels/legends automatically with graphs 97 setting aspect ratio option 97 using mouse 132 using Object Properties 133 Scatter and line plots examples 288 Scatter plots 3D data format 166 asymmetric error bars 249 bi-directional asymmetric error bars 251 creating 243, 244 data format 165 drop lines 227 error bars 245 examples 238 lines 216 quartile plots 250 range plots 248 symbols 204–213 Scatter plots, 3D creating 293, 294, 295, 296 defined 491 Scientific notation defined 491 using as axis values 315, 391 Scroll box defined 492 Section creating 41



defined 492 editing 43 naming 43 new 41 Selecting all data in worksheet 76 columns 76 data 75–76 defined 492 entire worksheet 76 graph style 167–177 graph type 165 graphs 191–192 graphs on page 98 objects on page 98 page objects 98 plots 191–192 right-clicking graphs 98, 192 rows 76 text on page 98 Selection mode 98 Serial numbers 13 Setting axis breaks 374–375 decimal places 67 equation parameters 231 line intervals for contour plots 312 passwords 355 printing options 49, 50 program options 459–467 report options 430 setting page options 96–97 Setting up graph page format 154 Settings 3D graph view 299 angular axis 327–329 aspect ratio 97 axis range 362 column statistics 18–21 error bars 253 frame lines 304 Graph Defaults 164 graph defaults 165 object location on page 133 program options 96–97 radial axes 330–333 reference lines 414 statistics 65 template files 108 worksheet 18–21 Shading 3D graphs 303
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 Index Shapes lines 214 Shortcut menu hide 123, 200 Shortcuts worksheet 56 Showing see Viewing SigmaPlot installing 12–13 new features 10 registration 13 system requirements 12 using in Windows 14 using OLE2 to edit graphs pasted to other applications 112–121 using this manual 33 SigmaPlot files producing files for publication 357 Simple error bars data format 168 Simple error bars and regression data format 168 Simple regression data format 167 Simple scatter plot data format 167 Simple spline curve data format 170, 171 simple spline curve simple spline curve data format 171 Simple straight line data format 171 Simple straight line plot data format 170 Single curves creating 240 Size column statistics 64 symbols 150 values from column for symbols 210 Sizing aspect ratio 479 Columns and Rows 66 columns and rows 74 graphs 131–133 labels 486 objects 131–133 resizing labels/legends automatically with graphs 97 setting aspect ratio preference 97 using mouse 132 using Object Properties dialog 133 Slices, pie chart defined 484
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edges 127 exploding 320–322 rotating 320–322 Smoothing unordered XYZ data 425–428 Smoothing data mesh plots 11 Snap-to 137 Solving equations 233–236 equations for x within range 234 functions 233–236 Solving equations 228–236 Sorting data 77 defined 492 Source templates for new pages 108 Spacing bars 223–225 bars from different plots 223–225, 263 box plots 267 Speed increasing drawing speed 201 Spline curve defined 492 SPSS creating graphs in 188 European office 32 SPSS files importing 59 SPW32.INI file editing 459–467 Stacked bar charts automatic reference lines 412 defined 492 Standard deviation column statistics 64 defined 492 Standard error column statistics 64 defined 493 Statistics calculation of t 402 Options 18 reference lines 414 setting Options 65 showing/hiding 65 using Excel worksheets 91 worksheet 12 Student’s t statistic see t -test Styles defined 485



 Index graph 167–177, 485 styles using the Graph Style Gallery 182–184 Submitting graphs to journals 356–359 Subscript 143 Suffixes/prefixes contour labels 314 tick labels 392 Sum column statistics 64 Summary Information author 20 Superscript 143 Switching between date and time and numeric display 73 Symbols alphanumeric 208 assigning to worksheet 220 box plots 267 changing edge color 206 changing edge thickness 206 changing fills 206 changing size 205 changing type 205 characters used as 208 color incrementing 206 custom codes 454–456 custom incrementing schemes 220–222 defined 493 dot/crosshair color 206 fills 127 Greek 145 increment customizing 220–225 inserting in legends 146 layering lines in front/behind 214 modifying attributes 204 modifying in plots 204–213 resize 150 restoring to default settings 152 size values from a worksheet column 210 using characters as 208 Systat exporting to 63 System requirements 12 Excel workbooks 13 hardware 13



T t -test calculation of t 402 unpaired test 403 Tempates



applying 42 template files settings 108 TEMPLATE.JNT 110, 493 Templates creating 108–123 defined 182, 493 JNT files 110, 493 notebook files 108–123 Options 20 page 108–123 templates Graph Style Gallery 182–184 Ternary axes about 338 dragging 340 Ternary axis direction modifying 344 Ternary graphs 338 changing axis direction 344 changing range direction 344 changing scale direction 344 changing scale type 342 creating 336–337 data for multiple -curve plot 335 data for single plot curve 335 data format 166 defined 335 line plots 334 line/scatter plots 334 modifying plots 338 modifying tick labels 349 modifying tick marks 348 normalizing data for 335–336 plot data set 337 scatter plots 334 selecting data 337 selecting worksheet data 336 third-column data 335 Ternary triplets data for 335 multiple-curve plots 335 Text adding to page 143–146 alignment 143 editing contour labels 315 editing tick labels 389 entering 143–148 formatting 146–147 grouping/ungrouping 135 properties dialog 147 rotating 145 subscript 143 superscript 143
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 Index using as plot symbols 208 Text box defined 493 Text files defined 494 importing 61–62 text files exporting worksheets 62 Text labels creating 143 Text mode entering non-keyboard characters 145 Text Properties dialog changing text lables 387 Thickness axis lines 372–373 contour lines 310 grid lines 398 line 129, 214 radial axes 332 reference lines 414 tick marks 349, 385 Thickness plot pattern lines 218 Three dimensional see 3D (at beginning of index) Tick 382 Tick direction 383 Tick intervals Date and Time 382 Tick labels custom 316, 394 date and time 316 Date and Time axes 394 defined 494 editing text 389 factors 391 modifying 392 modifying ternary 349 numeric notation 315 prefix/suffix 392 radial axes 333 text attributes 387 time and date 391 using from a worksheet column 316, 394 Tick Line options 385 Tick marks customizing intervals 387 Date and Time axes 382 defined 494 hiding 376–377 intervals assigned to a worksheet 387 labels 392, 494 length 349, 385 modifying 349, 387



524



modifying ternary 348 origin 494 turning on/off 384 viewing 376–377 Time and date see also Date and Time Time delimiters Date and Time format 58 Titles axis 377 column 85–88 column and row titles dialog box 85 graph 194 hiding graph 124 row 85–88 using cells as column or row titles 87 using worksheet columns as row titles 86 using worksheet rows as column titles 86 Toolbars defined 494 displaying 15–17 drawing 125 Excel 92 graph 177 hiding 15–17 positioning 17 Tools menu draw arrow 125 draw box 125 draw ellipse 125 draw line 125 Tools menu commands Text 143–148 ToolTips 17 Trajectory plots creating 293, 294, 295, 296 lines 216 symbols 204–213 Transforms applying to data 12 defined 12, 494 generating mesh data 306 HISTOGRM.XFM 406–407 quick 420 using data in Excel worksheets 93 using transform language 417 Transparent mesh creating plots 297 selecting shading 297 video card requirements 495 Transpose Paste shortcut 56 Transposing defined 495 rows and columns 81



 Index Troubleshooting installation problems 471 pasting special characters 476 problems with printing 475 SigmaPlot Errors 474 TrueType fonts printing 445–446 t-test defined 493 paired test 402 performing 402 Tukey plot see box plot Turning on/off axes 370 contour labels 314 contour lines 309 grids 399 insertion mode 58 plots 200 radial axes 330–333 radial labels 332 reference lines 413 tick marks 384 toolbars 15–17 Two dimensional see 2D (at beginning of index) Types graph 165 lines 214



U Ungrouping legends 153 objects/text 135 Units of measurement page 156–157 Unpaired t -test 403 Unprotecting Excel workbooks 89 Updating object links 120 User-defined command with bubble plots 280 Using templates 42 the equation solver 233–236



V Values angular 323 axis range 312



axis scale 312, 362 bucket 405 minimum 64 minimum and maximum 64 minimum positive 64 missing 65 radial 323 Z data for contour plots 311–312 Values, axis factors 391 labels 392 numeric labels 315 range 312, 362 time and date 316, 391 Variable bar widths 224 Vertical bar chart data format 166 Vertical dot plot data format 170 Vertical point plot data format 169 Video card requirements transparent mesh 495 View 3D graphs 299 View menu commands 103 drawing toolbar 125 full screen 103 zoom 103 Viewing axes 370 axis titles 376–377 column statistics 12, 63 column statistics in Excel worksheets 91 contour lines 309 data for embedded graphs 188 full page 103 graphs 103–104, 123 graphs on page 123–124 inserted objects as icons 119 linear regression results 408 notebook files 44 notebook items 44 object links 120–122 pasted objects as icons 118 tick marks 376–377 toolbars 15–17, 92 viewing 370



W Waterfall plots examples 289 Weibull scale see Extreme Value Distribution scale
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 Index Whiskers box plots 267 defined 495 Widths bar/box widths 224 box widths 267 whisker caps 267 Window menu commands 103 Wizards Graph 177 Histogram 403–407 Regression 12 Worksheet assigning codes 451–457 associating additional pages 102 changing data feedback colors 67 changing grid color and thickness 67 column statistics 63, 91 column titles 85–88 column type labels 394 creating 41 defined 495 delecting columns and rows 80–81 entering data 53–94 Excel 88–94 exporting as non-notebook file 46–48 exporting data 49–50, 484 going to a cell 56 importing data 58–61, 81 inserting columns and rows 78–80 inserting graphic cells 220 inserting symbol size values 210 insertion mode 58 moving around 55 moving between notebooks 45 moving data 78 naming 43 new 41 opening 44 overwrite mode 58 printing 49–50 right-click pop-up menu shortcuts 56 row titles 85–88 selecting all data 76 selecting data 75–76 selecting entire 76 Set data feedback colors 67 setting Options 18–21 SigmaPlot 12 size 12 sorting data 77 statistics 12 Statistics, showing/hiding 65 transposing rows and columns 81
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Worksheets printing 49 setting decimal places 67 worksheets exporting as text files 62



X X,Y values bubble plots 280 X,Y, many Z Contour plots 291 Mesh plots 291 X,Y,Z values Contour plots 290 Mesh plots 290



Z Zooming in/out defined 495 on graphs 103–104
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